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Safety Notices

CAUTION
A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like
that, if not correctly performed or
adhered to, could result in damage
to the product or loss of important
data. Do not proceed beyond a
CAUTION notice until the indicated
conditions are fully understood and
met.

WA R N I N G
A WARNING notice denotes a
hazard. It calls attention to an
operating procedure, practice, or
the like that, if not correctly performed or adhered to, could result
in personal injury or death. Do not
proceed beyond a WARNING
notice until the indicated conditions are fully understood and
met.
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InfiniiVision 3000 X-Series Oscilloscopes—At a Glance

Table 1

3000 X-Series Model Numbers, Bandwidths, Sample Rates

Bandwidth

100 MHz

200 MHz

350 MHz

500 MHz

1 GHz

Sample Rate
(interleaved,
non-interleaved)

4 GSa/s,
2 GSa/s

4 GSa/s,
2 GSa/s

4 GSa/s,
2 GSa/s

4 GSa/s,
2 GSa/s

5 GSa/s,
2.5 GSa/s

2-Channel + 16 Logic
Channels MSO

MSO-X 3012A

MSO-X 3032A

MSO-X 3052A

MSO-X 3102A

4-Channel + 16 Logic
Channels MSO

MSO-X 3014A

MSO-X 3034A

MSO-X 3054A

MSO-X 3104A

2-Channel DSO

DSO-X 3012A

DSO-X 3032A

DSO-X 3052A

DSO-X 3102A

4-Channel DSO

DSO-X 3014A

DSO-X 3034A

DSO-X 3054A

DSO-X 3104A

MSO-X 3024A

DSO-X 3024A

The Agilent InfiniiVision 3000 X- Series oscilloscopes deliver these features:
• 100 MHz, 200 MHz, 350 MHz, 500 MHz, and 1 GHz bandwidth models.
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• 2- and 4- channel digital storage oscilloscope (DSO) models.
• 2+16- channel and 4+16- channel mixed- signal oscilloscope (MSO)
models.
An MSO lets you debug your mixed- signal designs using analog signals
and tightly correlated digital signals simultaneously. The 16 digital
channels have a 1 GSa/s sample rate (1.25 GSa/s for the 1 GHz
models), with a 50 MHz toggle rate.
• 8.5 inch WVGA display.
• Interleaved 2 Mpts or non- interleaved 1 Mpts MegaZoom IV memory
for the fastest waveform update rates, uncompromised. Upgradeable to
4 Mpts/2 Mpts.
• All knobs are pushable for making quick selections.
• Trigger types: edge, edge then edge, pulse width, pattern, OR, rise/fall
time, Nth edge burst, runt, setup & hold, video, and USB.
• Serial decode/trigger options for: CAN/LIN, FlexRay, I2C/SPI, I2S,
UART/RS232, and MIL- STD- 1553/ARINC 429. Lister for serial decode
• Math waveforms: add, subtract, multiply, FFT, d/dt, integrate, and
square root. With the DSOX3ADVMATH option, you get these additional
math waveforms: Ax+B, square, absolute value, common logarithm,
natural logarithm, exponential, base 10 exponential, low pass filter,
high pass filter, magnify, measurement trend, chart logic bus timing,
and chart logic bus state.
• Reference waveform locations (2) for comparing with other channel or
math waveforms.
• Many built- in measurements and a measurement statistics display.
• Built- in license- enabled waveform generator with: arbitrary, sine,
square, ramp, pulse, DC, noise, sine cardinal, exponential rise,
exponential fall, cardiac, and gaussian pulse.
• USB ports make printing, saving and sharing data easy.
• Optional LAN/VGA module for connecting to a network and displaying
the screen on a different monitor.
• Optional GPIB module.
• A Quick Help system is built into the oscilloscope. Press and hold any
key to display Quick Help. Complete instructions for using the quick
help system are given in “Access the Built- In Quick Help" on page 47.
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For more information about InfiniiVision oscilloscopes, see:
"www.agilent.com/find/scope"
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In This Guide
This guide shows how to use the InfiniiVision 3000 X- Series oscilloscopes.
When unpacking and using the
oscilloscope for the first time, see:

• Chapter 1, “Getting Started,” starting on page 25

When displaying waveforms and
acquired data, see:

•
•
•
•
•
•
•
•
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Chapter 2, “Horizontal Controls,” starting on page 49
Chapter 3, “Vertical Controls,” starting on page 63
Chapter 4, “Math Waveforms,” starting on page 73
Chapter 5, “Reference Waveforms,” starting on page
101
Chapter 6, “Digital Channels,” starting on page 105
Chapter 7, “Serial Decode,” starting on page 125
Chapter 8, “Display Settings,” starting on page 131
Chapter 9, “Labels,” starting on page 137

When setting up triggers or changing
how data is acquired, see:

• Chapter 10, “Triggers,” starting on page 143
• Chapter 11, “Trigger Mode/Coupling,” starting on
page 179
• Chapter 12, “Acquisition Control,” starting on page 187

Making measurements and analyzing
data:

•
•
•
•

When using the built-in license
enabled waveform generator, see:

• Chapter 17, “Waveform Generator,” starting on page
259

When saving, recalling, or printing,
see:

• Chapter 18, “Save/Recall (Setups, Screens, Data),”
starting on page 275
• Chapter 19, “Print (Screens),” starting on page 289

When using the oscilloscope's utility
functions or web interface, see:

• Chapter 20, “Utility Settings,” starting on page 295
• Chapter 21, “Web Interface,” starting on page 315

Chapter 13, “Cursors,” starting on page 205
Chapter 14, “Measurements,” starting on page 215
Chapter 15, “Mask Testing,” starting on page 243
Chapter 16, “Digital Voltmeter,” starting on page 255
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TIP

For reference information, see:

• Chapter 22, “Reference,” starting on page 331

When using licensed serial bus
triggering and decode features, see:

• Chapter 23, “CAN/LIN Triggering and Serial Decode,”
starting on page 351
• Chapter 24, “FlexRay Triggering and Serial Decode,”
starting on page 367
• Chapter 25, “I2C/SPI Triggering and Serial Decode,”
starting on page 377
• Chapter 26, “I2S Triggering and Serial Decode,”
starting on page 397
• Chapter 27, “MIL-STD-1553/ARINC 429 Triggering and
Serial Decode,” starting on page 407
• Chapter 28, “UART/RS232 Triggering and Serial
Decode,” starting on page 423

Abbreviated instructions for pressing a series of keys and softkeys
Instructions for pressing a series of keys are written in an abbreviated manner. Instructions
for pressing [Key1], then pressing Softkey2, then pressing Softkey3 are abbreviated as
follows:
Press [Key1]> Softkey2 > Softkey3.
The keys may be a front panel [Key] or a Softkey. Softkeys are the six keys located directly
below the oscilloscope display.
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14

180

183

183

184

Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

External Trigger Input

184

Maximum voltage at oscilloscope external trigger input
12

185

Acquisition Control
Running, Stopping, and Making Single Acquisitions (Run
Control) 187
Overview of Sampling 189
Sampling Theory 189
Aliasing 189
Oscilloscope Bandwidth and Sample Rate
Oscilloscope Rise Time 191
Oscilloscope Bandwidth Required 192
Memory Depth and Sample Rate 193

190

Selecting the Acquisition Mode 193
Normal Acquisition Mode 194
Peak Detect Acquisition Mode 194
Averaging Acquisition Mode 197
High Resolution Acquisition Mode 199
Acquiring to Segmented Memory 199
Navigating Segments 201
Measurements, Statistics, and Infinite Persistence with
Segmented Memory 201
Segmented Memory Re-Arm Time 202
Saving Data from Segmented Memory 202
13

Cursors
To make cursor measurements
Cursor Examples

206

209

Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

15

14

Measurements
To make automatic measurements
Measurements Summary
Snapshot All 220
Voltage Measurements
Peak-Peak 222
Maximum 222
Minimum 222
Amplitude 222
Top 222
Base 223
Overshoot 224
Preshoot 225
Average 225
DC RMS 226
AC RMS 226
Ratio 228

216

217
221

Time Measurements 228
Period 229
Frequency 229
Counter 230
+ Width 231
– Width 231
Burst Width 231
Duty Cycle 231
Rise Time 232
Fall Time 232
Delay 232
Phase 233
X at Min Y 234
X at Max Y 235

16

Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

Count Measurements 235
Positive Pulse Count 235
Negative Pulse Count 236
Rising Edge Count 236
Falling Edges Count 236
Mixed Measurements
Area 236

236

Measurement Thresholds

237

Measurement Window with Zoom Display
Measurement Statistics
15

239

239

Mask Testing
To create a mask from a "golden" waveform (Automask)
Mask Test Setup Options
Mask Statistics

245

248

To manually modify a mask file

249

Building a Mask File 252
How is mask testing done?

254

16

Digital Voltmeter

17

Waveform Generator

243

To select generated waveform types and settings

259

To edit arbitrary waveforms 263
Creating New Arbitrary Waveforms 264
Editing Existing Arbitrary Waveforms 265
Capturing Other Waveforms to the Arbitrary Waveform
To output the waveform generator sync pulse
To specify the expected output load

Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

266

267

267

17

To use waveform generator logic presets
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To set up Amplitude Modulation (AM) 270
To set up Frequency Modulation (FM) 271
To set up Frequency-Shift Keying Modulation (FSK) 273
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This chapter describes the steps you take when using the oscilloscope for
the first time.

Inspect the Package Contents
• Inspect the shipping container for damage.
If your shipping container appears to be damaged, keep the shipping
container or cushioning material until you have inspected the contents
of the shipment for completeness and have checked the oscilloscope
mechanically and electrically.
• Verify that you received the following items and any optional
accessories you may have ordered:

s1
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Getting Started

• InfiniiVision 3000 X- Series oscilloscope.
• Power cord (country of origin determines specific type).
• Oscilloscope probes:
• Two probes for 2- channel models.
• Four probes for 4- channel models.
• Documentation CD- ROM.

26
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1

InfiniiVision 3000 X-Series oscilloscope
N2862B, N2863B,
or N2890A probes
(Qty 2 or 4)

Documentation CD

Digital Probe Kit*
(MSO models only)
Power cord
(Based on country
of origin)

*N6450-60001 Digital Probe Kit contains:
54620-61601 16-channel cable (qyt 1)
01650-82103 2-inch probe ground leads (qyt 5)
5090-4832
Grabber (qyt 20)
Digital probe replacement parts are listed in the
"Digital Channels" chapter.

See Also

• “Accessories Available" on page 338
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Install the Optional LAN/VGA or GPIB Module
If you need to install a DSOXLAN LAN/VGA module or a DSOXGPIB GPIB
module, perform this installation before you power on the oscilloscope.
1 If you need to remove a module before installing a different module,
pinch the module's spring tabs, and gently remove the module from the
slot.
2 To install a module, slide the module into the slot on the back until it
is fully seated.
The module's spring tabs will latch into the slot, keeping the module in
place.
LAN/VGA Module

Module Slot

GPIB Module
:$51,1*0$,17$,1
*5281'72 $92,'
(/(&75,&6+2&.

a 9+]
a 9+]
 :DWWV0$;

NOTE

The LAN/VGA or GPIB module must be installed before powering on the oscilloscope.

Tilt the Oscilloscope for Easy Viewing
There are tabs under the oscilloscope's front feet that can be flipped out
to tilt the oscilloscope.

28
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Flip-Out Tabs

Power-On the Oscilloscope
Power
Requirements

Line voltage, frequency, and power:
• ~Line 100- 120 Vac, 50/60/400 Hz
• 100- 240 Vac, 50/60 Hz
• 100 W max

Ventilation
Requirements

The air intake and exhaust areas must be free from obstructions.
Unrestricted air flow is required for proper cooling. Always ensure that
the air intake and exhaust areas are free from obstructions.
The fan draws air in from the left side and bottom of the oscilloscope and
pushes it out behind the oscilloscope.
When using the oscilloscope in a bench- top setting, provide at least 2"
clearance at the sides and 4" (100 mm) clearance above and behind the
oscilloscope for proper cooling.

To power-on the
oscilloscope

1 Connect the power cord to the rear of the oscilloscope, then to a
suitable AC voltage source. Route the power cord so the oscilloscope's
feet and legs do not pinch the cord.
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2 The oscilloscope automatically adjusts for input line voltages in the
range 100 to 240 VAC. The line cord provided is matched to the country
of origin.

WA R N I N G

Always use a grounded power cord. Do not defeat the power cord ground.

3 Press the power switch.
The power switch is located on the lower left corner of the front panel.
The oscilloscope will perform a self- test and will be operational in a few
seconds.

Connect Probes to the Oscilloscope
1 Connect the oscilloscope probe to an oscilloscope channel BNC
connector.
2 Connect the probe's retractable hook tip to the point of interest on the
circuit or device under test. Be sure to connect the probe ground lead
to a ground point on the circuit.

CAUTION

Maximum input voltage at analog inputs
CAT I 300 Vrms, 400 Vpk; transient overvoltage 1.6 kVpk
50Ω input: 5 Vrms Input protection is enabled in 50 Ω mode and the 50 Ω load will
disconnect if greater than 5 Vrms is detected. However the inputs could still be
damaged, depending on the time constant of the signal. The 50 Ω input protection only
functions when the oscilloscope is powered on.
With 10073C 10:1 probe: CAT I 500 Vpk
With N2862A or N2863A 10:1 probe: 300 Vrms

30
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CAUTION

1

Do not float the oscilloscope chassis
Defeating the ground connection and "floating" the oscilloscope chassis will probably
result in inaccurate measurements and may also cause equipment damage. The probe
ground lead is connected to the oscilloscope chassis and the ground wire in the power
cord. If you need to measure between two live points, use a differential probe with
sufficient dynamic range.

WA R N I N G

Do not negate the protective action of the ground connection to the oscilloscope. The
oscilloscope must remain grounded through its power cord. Defeating the ground
creates an electric shock hazard.

Input a Waveform
The first signal to input to the oscilloscope is the Demo 2, Probe Comp
signal. This signal is used for compensating probes.
1 Connect an oscilloscope probe from channel 1 to the Demo 2 (Probe
Comp) terminal on the front panel.
2 Connect the probe's ground lead to the ground terminal (next to the
Demo 2 terminal).

Recall the Default Oscilloscope Setup
To recall the default oscilloscope setup:
1 Press [Default Setup].
The default setup restores the oscilloscope's default settings. This places
the oscilloscope in a known operating condition. The major default settings
are:
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Table 2

Default Configuration Settings

Horizontal

Normal mode, 100 µs/div scale, 0 s delay, center time reference.

Vertical (Analog)

Channel 1 on, 5 V/div scale, DC coupling, 0 V position, 1 MΩ impedance.

Trigger

Edge trigger, Auto trigger mode, 0 V level, channel 1 source, DC coupling,
rising edge slope, 40 ns holdoff time.

Display

Persistence off, 20% grid intensity.

Other

Acquire mode normal, [Run/Stop] to Run, cursors and measurements off.

Labels

All custom labels that you have created in the Label Library are preserved (not
erased), but all channel labels will be set to their original names.

In the Save/Recall Menu, there are also options for restoring the complete
factory settings (see “Recalling Default Setups" on page 286) or performing
a secure erase (see “Performing a Secure Erase" on page 286).

Use Auto Scale
Use [Auto Scale] to automatically configure the oscilloscope to best display
the input signals.
1 Press [Auto Scale].
You should see a waveform on the oscilloscope's display similar to this:
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2 If you want to return to the oscilloscope settings that existed before,
press Undo AutoScale.
3 If you want to enable "fast debug" autoscaling, change the channels
autoscaled, or preserve the acquisition mode during autoscale, press
Fast Debug, Channels, or Acq Mode.
These are the same softkeys that appear in the AutoScale Preferences
Menu. See “To set AutoScale preferences" on page 303.
If you see the waveform, but the square wave is not shaped correctly as
shown above, perform the procedure “Compensate Passive Probes" on
page 34.
If you do not see the waveform, make sure the probe is connected
securely to the front panel channel input BNC and to the left side,
Demo 2, Probe Comp terminal.
How AutoScale
Works

Auto Scale analyzes any waveforms present at each channel and at the
external trigger input. This includes the digital channels, if connected.
Auto Scale finds, turns on, and scales any channel with a repetitive
waveform that has a frequency of at least 25 Hz, a duty cycle greater than
0.5%, and an amplitude of at least 10 mV peak- to- peak. Any channels that
do not meet these requirements are turned off.
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The trigger source is selected by looking for the first valid waveform
starting with external trigger, then continuing with the lowest number
analog channel up to the highest number analog channel, and finally (if
digital probes are connected) the highest number digital channel.
During Auto Scale, the delay is set to 0.0 seconds, the horizontal time/div
(sweep speed) setting is a function of the input signal (about 2 periods of
the triggered signal on the screen), and the triggering mode is set to Edge.

Compensate Passive Probes
Each oscilloscope passive probe must be compensated to match the input
characteristics of the oscilloscope channel to which it is connected. A
poorly compensated probe can introduce significant measurement errors.
1 Input the Probe Comp signal (see “Input a Waveform" on page 31).
2 Press [Default Setup] to recall the default oscilloscope setup (see “Recall
the Default Oscilloscope Setup" on page 31).
3 Press [Auto Scale] to automatically configure the oscilloscope for the
Probe Comp signal (see “Use Auto Scale" on page 32).
4 Press the channel key to which the probe is connected ([1], [2], etc.).
5 In the Channel Menu, press Probe.
6 In the Channel Probe Menu, press Probe Check; then, follow the
instructions on- screen.
If necessary, use a nonmetallic tool (supplied with the probe) to adjust
the trimmer capacitor on the probe for the flattest pulse possible.
On the N2862/63/90 probes, the trimmer capacitor is the yellow
adjustment on the probe tip. On other probes, the trimmer capacitor is
located on the probe BNC connector.
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Perfectly compensated

Over compensated

Under compensated

7 Connect probes to all other oscilloscope channels (channel 2 of a
2- channel oscilloscope, or channels 2, 3, and 4 of a 4- channel
oscilloscope).
8 Repeat the procedure for each channel.

Learn the Front Panel Controls and Connectors
On the front panel, key refers to any key (button) you can press.
Softkey specifically refers to the six keys that are directly below the
display. The legend for these keys is directly above them, on the display.
Their functions change as you navigate through the oscilloscope's menus.
For the following figure, refer to the numbered descriptions in the table
that follows.
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5. Tools keys

6. Trigger controls

7. Horizontal controls

8. Run Control keys
9. [Default Setup] key
10. [Auto Scale] key
11. Additional
waveform
controls

4. Entry knob
3. [Intensity] key

12. Measure controls
13. Waveform keys

2. Softkeys

14. File keys

1. Power switch

15. [Help] key
21. Waveform
generator
output

20. Digital
channel
inputs

18. Demo 2, Ground, 17. Analog 16 Vertical controls
and Demo 1
channel
terminals
inputs

19. USB
Host
port

1.

Power switch

Press once to switch power on; press again to switch power off. See
“Power-On the Oscilloscope" on page 29.

2.

Softkeys

The functions of these keys change based upon the menus shown on the
display directly above the keys.
The

Back

Back/Up key moves up in the softkey menu hierarchy. At the

top of the hierarchy, the Back Back/Up key turns the menus off, and
oscilloscope information is shown instead.
3.

36

[Intensity] key

Press the key to illuminate it. When illuminated, turn the Entry knob to
adjust waveform intensity.
You can vary the intensity control to bring out signal detail, much like an
analog oscilloscope.
Digital channel waveform intensity is not adjustable.
More details about using the Intensity control to view signal detail are on
“To adjust waveform intensity" on page 131.

Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

Getting Started

4.

Entry knob

1

The Entry knob is used to select items from menus and to change values.
The function of the Entry knob changes based upon the current menu
and softkey selections.
Note that the curved arrow symbol
above the entry knob
illuminates whenever the entry knob can be used to select a value. Also,
note that when the Entry knob
symbol appears on a softkey, you
can use the Entry knob, to select values.
Often, rotating the Entry knob is enough to make a selection. Sometimes,
you can push the Entry knob to enable or disable a selection. Pushing the
Entry knob also makes popup menus disappear.

5.

Tools keys

The Tools keys consist of:
• [Utility] key — Press this key to access the Utility Menu, which lets
you configure the oscilloscope's I/O settings, use the file explorer, set
preferences, access the service menu, and choose other options. See
Chapter 20, “Utility Settings,” starting on page 295.
• [Quick Action] key — Press this key to perform the selected quick
action: measure all snapshot, print, save, recall, freeze display. and
more. See “Configuring the [Quick Action] Key" on page 311.
• [Analyze] key — Press this key to access analysis features like
trigger level setting, measurement threshold setting, Video trigger
automatic set up and display, mask testing (see Chapter 15, “Mask
Testing,” starting on page 243), or the DSOX3PWR power
measurement and analysis application.
• [Wave Gen] key — Press this key to access waveform generator
functions. See Chapter 17, “Waveform Generator,” starting on page
259.

6.

Trigger controls

These controls determine how the oscilloscope triggers to capture data.
See Chapter 10, “Triggers,” starting on page 143 and Chapter 11, “Trigger
Mode/Coupling,” starting on page 179.
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7.

Horizontal
controls

The Horizontal controls consist of:
• Horizontal scale knob — Turn the knob in the Horizontal section that
is marked
to adjust the time/div (sweep speed) setting.
The symbols under the knob indicate that this control has the effect of
spreading out or zooming in on the waveform using the horizontal
scale.
• Horizontal position knob — Turn the knob marked
to pan through
the waveform data horizontally. You can see the captured waveform
before the trigger (turn the knob clockwise) or after the trigger (turn
the knob counterclockwise). If you pan through the waveform when
the oscilloscope is stopped (not in Run mode) then you are looking at
the waveform data from the last acquisition taken.
• [Horiz] key — Press this key to open the Horizontal Menu where you
can select XY and Roll modes, enable or disable Zoom, enable or
disable horizontal time/division fine adjustment, and select the
trigger time reference point.
• Zoom
key — Press the
zoom key to split the oscilloscope
display into Normal and Zoom sections without opening the
Horizontal Menu.
• [Search] key — Lets you search for events in the acquired data.
• [Navigate] keys — Press this key to navigate through captured data
(Time), search events, or segmented memory acquisitions. See
“Navigating the Time Base" on page 60.
For more information see Chapter 2, “Horizontal Controls,” starting on
page 49.
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8.

Run Control
keys

When the [Run/Stop] key is green, the oscilloscope is running, that is,
acquiring data when trigger conditions are met. To stop acquiring data,
press [Run/Stop].
When the [Run/Stop] key is red, data acquisition is stopped. To start
acquiring data, press [Run/Stop].
To capture and display a single acquisition (whether the oscilloscope is
running or stopped), press [Single]. The [Single] key is yellow until the
oscilloscope triggers.
For more information, see “Running, Stopping, and Making Single
Acquisitions (Run Control)" on page 187.

9.

[Default Setup]
key

Press this key to restore the oscilloscope's default settings (details on
“Recall the Default Oscilloscope Setup" on page 31).
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10.

[Auto Scale]
key

When you press the [AutoScale] key, the oscilloscope will quickly
determine which channels have activity, and it will turn these channels
on and scale them to display the input signals. See “Use Auto Scale" on
page 32.

11.

Additional
waveform
controls

The additional waveform controls consist of:
• [Math] key — provides access to math (add, subtract, etc.) waveform
functions. See Chapter 4, “Math Waveforms,” starting on page 73.
• [Ref] key — provides access to reference waveform functions.
Reference waveforms are saved waveforms that can be displayed and
compared against other analog channel or math waveforms. See
Chapter 5, “Reference Waveforms,” starting on page 101.
• [Digital] key — Press this key to turn the digital channels on or off
(the arrow to the left will illuminate).
When the arrow to the left of the [Digital] key is illuminated, the
upper multiplexed knob selects (and highlights in red) individual
digital channels, and the lower multiplexed knob positions the
selected digital channel.
If a trace is repositioned over an existing trace the indicator at the left
edge of the trace will change from Dnn designation (where nn is a one
or two digit channel number from 0 to 15) to D*. The "*" indicates that
two channels are overlaid.
You can rotate the upper knob to select an overlaid channel, then
rotate the lower knob to position it just as you would any other
channel.
For more information on digital channels see Chapter 6, “Digital
Channels,” starting on page 105.
• [Serial] key — This key is used to enable serial decode. The
multiplexed scale and position knobs are not used with serial decode.
For more information on serial decode, see Chapter 7, “Serial
Decode,” starting on page 125.
• Multiplexed scale knob — This scale knob is used with Math, Ref, or
Digital waveforms, whichever has the illuminated arrow to the left.
For math and reference waveforms, the scale knob acts like an analog
channel vertical scale knob.
• Multiplexed position knob — This position knob is used with Math,
Ref, or Digital waveforms, whichever has the illuminated arrow to the
left. For math and reference waveforms, the position knob acts like an
analog channel vertical position knob.
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12.

Measure
controls

The measure controls consist of:
• Cursors knob — Push this knob select cursors from a popup menu.
Then, after the popup menu closes (either by timeout or by pushing
the knob again), rotate the knob to adjust the selected cursor
position.
• [Cursors] key — Press this key to open a menu that lets you select
the cursors mode and source.
• [Meas] key — Press this key to access a set of predefined
measurements. See Chapter 14, “Measurements,” starting on page
215.

13.

Waveform keys

The [Acquire] key lets you select Normal, Peak Detect, Averaging, or
High Resolution acquisition modes (see “Selecting the Acquisition
Mode" on page 193) and use segmented memory (see “Acquiring to
Segmented Memory" on page 199).
The [Display] key lets you access the menu where you can enable
persistence (see “To set or clear persistence" on page 133), clear the
display, and adjust the display grid (graticule) intensity (see “To adjust
the grid intensity" on page 135).

14.

File keys

Press the [Save/Recall] key to save or recall a waveform or setup. See
Chapter 18, “Save/Recall (Setups, Screens, Data),” starting on page 275.
The [Print] key opens the Print Configuration Menu so you can print the
displayed waveforms. See Chapter 19, “Print (Screens),” starting on page
289.

15.

[Help] key

Opens the Help Menu where you can display overview help topics and
select the Language. See also “Access the Built-In Quick Help" on
page 47.
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16.

Vertical
controls

The Vertical controls consist of:
• Analog channel on/off keys — Use these keys to switch a channel on
or off, or to access a channel's menu in the softkeys. There is one
channel on/off key for each analog channel.
• Vertical scale knob — There are knobs marked
for each
channel. Use these knobs to change the vertical sensitivity (gain) of
each analog channel.
• Vertical position knobs — Use these knobs to change a channel's
vertical position on the display. There is one Vertical Position control
for each analog channel.
• [Label] key — Press this key to access the Label Menu, which lets
you enter labels to identify each trace on the oscilloscope display. See
Chapter 9, “Labels,” starting on page 137.
For more information, see Chapter 3, “Vertical Controls,” starting on
page 63.

17.

Analog channel
inputs

Attach oscilloscope probes or BNC cables to these BNC connectors.
With the InfiniiVision 3000 X-Series oscilloscopes, you can set the input
impedance of the analog channels to either 50 Ω or 1 MΩ. See “To
specify channel input impedance" on page 66.
The InfiniiVision 3000 X-Series oscilloscopes also provide the AutoProbe
interface. The AutoProbe interface uses a series of contacts directly
below the channel's BNC connector to transfer information between the
oscilloscope and the probe. When you connect a compatible probe to the
oscilloscope, the AutoProbe interface determines the type of probe and
sets the oscilloscope's parameters (units, offset, attenuation, coupling,
and impedance) accordingly.

18.

Demo 2,
Ground, and
Demo 1
terminals

• Demo 2 terminal — This terminal outputs the Probe Comp signal
which helps you match a probe's input capacitance to the
oscilloscope channel to which it is connected. See “Compensate
Passive Probes" on page 34. With certain licensed features, the
oscilloscope can also output demo or training signals on this terminal.
• Ground terminal — Use the ground terminal for oscilloscope probes
connected to the Demo 1 or Demo 2 terminals.
• Demo 1 terminal — With certain licensed features, the oscilloscope
can output demo or training signals on this terminal.
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19.

USB Host port

This port is for connecting USB mass storage devices or printers to the
oscilloscope.
Connect a USB compliant mass storage device (flash drive, disk drive,
etc.) to save or recall oscilloscope setup files and reference waveforms
or to save data and screen images. See Chapter 18, “Save/Recall
(Setups, Screens, Data),” starting on page 275.
To print, connect a USB compliant printer. For more information about
printing see Chapter 19, “Print (Screens),” starting on page 289.
You can also use the USB port to update the oscilloscope's system
software when updates are available.
You do not need to take special precautions before removing the USB
mass storage device from the oscilloscope (you do not need to "eject"
it). Simply unplug the USB mass storage device from the oscilloscope
when the file operation is complete.
CAUTION:
Do not connect a host computer to the oscilloscope's
USB host port. Use the device port. A host computer sees the
oscilloscope as a device, so connect the host computer to the
oscilloscope's device port (on the rear panel). See “I/O Interface
Settings" on page 295.
There is a second USB host port on the back panel.

20.

Digital channel
inputs

Connect the digital probe cable to this connector (MSO models only). See
Chapter 6, “Digital Channels,” starting on page 105.

21.

Waveform
generator
output

Outputs sine, square, ramp, pulse, DC, or noise on the Gen Out BNC.
Press the [Wave Gen] key to set up the waveform generator. See
Chapter 17, “Waveform Generator,” starting on page 259.

Front Panel Overlays for Different Languages
Front panel overlays, which have translations for the English front panel
keys and label text, are available in 10 languages. The appropriate overlay
is included when the localization option is chosen at time of purchase.
To install a front panel overlay:
1 Gently pull on the front panel knobs to remove them.
2 Insert the overlay's side tabs into the slots on the front panel.
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3 Reinstall the front panel knobs.
Front panel overlays may be ordered from "www.parts.agilent.com" using
the following part numbers:
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Language

2 Channel Overlay

4 Channel Overlay

French

75019-94324

75019-94316

German

75019-94326

75019-94318

Italian

75019-94323

75019-94331

Japanese

75019-94311

75019-94312

Korean

75019-94329

75019-94321

Polish

75019-94335

75019-94334

Portuguese

75019-94327

75019-94319

Russian

75019-94322

75019-94315

Simplified Chinese

75019-94328

75019-94320

Spanish

75019-94325

75019-94317

Thai

75019-94333

75019-94332

Traditional Chinese

75019-94330

75019-94310

Learn the Rear Panel Connectors
For the following figure, refer to the numbered descriptions in the table
that follows.
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8. USB Device port
7. USB Host port

3. LAN/VGA
option module

6. EXT TRIG IN
connector
5. Calibration
protect
button
4. TRIG OUT
connector
:$51,1*0$,17$,1
*5281'72 $92,'
(/(&75,&6+2&.

a 9+]
a 9+]
 :DWWV0$;

3. GPIB
option module

3. Module slot
2. Kensington lock hole
1. Power cord connector

1.

Power cord
connector

Attach the power cord here.

2.

Kensington
lock hole

This is where you can attach a Kensington lock for securing the
instrument.

3.

Module slot

A DSOXLAN LAN/VGA module may be ordered and installed separately.
• LAN port — lets you communicate with the oscilloscope and use the
Remote Front Panel feature using the LAN port. See Chapter 21,
“Web Interface,” starting on page 315 and “Accessing the Web
Interface" on page 316.
• VGA video output — lets you connect an external monitor or projector
to provide a larger display or to provide a display at a viewing position
away from the oscilloscope.
The oscilloscope's built-in display remains on even when an external
display is connected. The video output connector is always active.
For optimal video quality and performance, we recommend you use a
shielded video cable with ferrite cores.
A DSOXGPIB GPIB module may be ordered and installed separately.

4.

TRIG OUT
connector

Trigger output BNC connector. See “Setting the Rear Panel TRIG OUT
Source" on page 304.

5.

Calibration
protect button

See “To perform user calibration" on page 306.
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6.

EXT TRIG IN
connector

External trigger input BNC connector. See “External Trigger Input" on
page 184 for an explanation of this feature.

7.

USB Host port

This port functions identically to the USB host port on the front panel.
USB Host Port is used for saving data from the oscilloscope and loading
software updates. See also USB Host port (see page 42).

8.

USB Device
port

This port is for connecting the oscilloscope to a host PC. You can issue
remote commands from a host PC to the oscilloscope via the USB device
port. See “Remote Programming with Agilent IO Libraries" on page 322.

Learn the Oscilloscope Display
The oscilloscope display contains acquired waveforms, setup information,
measurement results, and the softkey definitions.
Analog channel
sensitivity

Trigger point,
time reference

Delay
time

Time/
div

Run/Stop Trigger
status
type

Trigger
source
Trigger level or
digital threshold

Status line
Trigger level

Information area

Analog
channels
and ground
levels
Digital channels

Cursors defining
measurement

Measurement
statistics

Measurements

Menu line
Softkeys

Figure 1
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Interpreting the oscilloscope display
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Status line

The top line of the display contains vertical, horizontal, and trigger setup
information.

Display area

The display area contains the waveform acquisitions, channel identifiers, and
analog trigger, and ground level indicators. Each analog channel's information
appears in a different color.
Signal detail is displayed using 256 levels of intensity. For more information
about viewing signal detail see “To adjust waveform intensity" on page 131.
For more information about display modes see Chapter 8, “Display Settings,”
starting on page 131.

Information area

The information area normally contains acquisition, analog channel,
automatic measurement, and cursor results.

Menu line

This line normally contains menu name or other information associated with
the selected menu.

Softkey labels

These labels describe softkey functions. Typically, softkeys let you set up
additional parameters for the selected mode or menu.

1

Pressing the Back Back/Up key at the top of the menu hierarchy turns off
softkey labels and displays additional status information describing channel
offset and other configuration parameters.

Access the Built-In Quick Help
To view Quick
Help

1 Press and hold the key or softkey for which you would like to view
help.
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Quick Help
message

Press and hold front panel key or softkey
(or right-click softkey when using web browser remote front panel).

Quick Help remains on the screen until another key is pressed or a knob
is turned.
To select the user
interface and
Quick Help
language

To select the user interface and Quick Help language:
1 Press [Help], then press the Language softkey.
2 Repeatedly press and release the Language softkey or rotate the Entry
knob until the desired language is selected.
The following languages are available: English, French, German, Italian,
Japanese, Korean, Portuguese, Russian, Simplified Chinese, Spanish, and
Traditional Chinese.
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Horizontal Controls
To adjust the horizontal (time/div) scale 50
To adjust the horizontal delay (position) 51
Panning and Zooming Single or Stopped Acquisitions 52
To change the horizontal time mode (Normal, XY, or Roll) 53
To display the zoomed time base 56
To change the horizontal scale knob's coarse/fine adjustment setting 58
To position the time reference (left, center, right) 58
Searching for Events 59
Navigating the Time Base 60

The horizontal controls include:
• The horizontal scale and position knobs.
• The [Horiz] key for accessing the Horizontal Menu.
• The
zoom key for quickly enabling/disabling the split- screen zoom
display.
• The [Search] key for finding events on analog channels or in serial
decode.
• The [Navigate] keys for navigating time, search events, or segmented
memory acquisitions.
The following figure shows the Horizontal Menu which appears after
pressing the [Horiz] key.

s1
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Trigger
point

Time
reference

Delay
time

Time/
div

Trigger
source

Trigger level
or threshold

Sample rate

XY or Roll
mode

Normal
time mode

Figure 2

Zoomed
time base

Fine
control

Time
reference

Horizontal Menu

The Horizontal Menu lets you select the time mode (Normal, XY, or Roll),
enable Zoom, set the time base fine control (vernier), and specify the time
reference.
The current sample rate is displayed in the right- side information area.

To adjust the horizontal (time/div) scale
1 Turn the large horizontal scale (sweep speed) knob marked
change the horizontal time/div setting.

50
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Notice how the time/div information in the status line changes.
The ∇ symbol at the top of the display indicates the time reference point.
The horizontal scale knob works (in the Normal time mode) while
acquisitions are running or when they are stopped. When running,
adjusting the horizontal scale knob changes the sample rate. When
stopped, adjusting the horizontal scale knob lets you zoom into acquired
data. See "Panning and Zooming Single or Stopped Acquisitions" on
page 52.
Note that the horizontal scale knob has a different purpose in the Zoom
display. See "To display the zoomed time base" on page 56.

To adjust the horizontal delay (position)
1 Turn the horizontal delay (position) knob (

).

The trigger point moves horizontally, pausing at 0.00 s (mimicking a
mechanical detent), and the delay value is displayed in the status line.
Changing the delay time moves the trigger point (solid inverted triangle)
horizontally and indicates how far it is from the time reference point
(hollow inverted triangle ∇). These reference points are indicated along
the top of the display grid.
Figure 2 shows the trigger point with the delay time set to 200 µs. The
delay time number tells you how far the time reference point is located
from the trigger point. When delay time is set to zero, the delay time
indicator overlays the time reference indicator.
All events displayed left of the trigger point happened before the trigger
occurred. These events are called pre- trigger information, and they show
events that led up to the trigger point.
Everything to the right of the trigger point is called post- trigger
information. The amount of delay range (pre- trigger and post- trigger
information) available depends on the time/div selected and memory
depth.
The horizontal position knob works (in the Normal time mode) while
acquisitions are running or when they are stopped. When running,
adjusting the horizontal scale knob changes the sample rate. When
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stopped, adjusting the horizontal scale knob lets you zoom into acquired
data. See "Panning and Zooming Single or Stopped Acquisitions" on
page 52.
Note that the horizontal position knob has a different purpose in the
Zoom display. See "To display the zoomed time base" on page 56.

Panning and Zooming Single or Stopped Acquisitions
When the oscilloscope is stopped, use the horizontal scale and position
knobs to pan and zoom your waveform. The stopped display may contain
several acquisitions worth of information, but only the last acquisition is
available for pan and zoom.
The ability to pan (move horizontally) and scale (expand or compress
horizontally) an acquired waveform is important because of the additional
insight it can reveal about the captured waveform. This additional insight
is often gained from seeing the waveform at different levels of abstraction.
You may want to view both the big picture and the specific little picture
details.
The ability to examine waveform detail after the waveform has been
acquired is a benefit generally associated with digital oscilloscopes. Often
this is simply the ability to freeze the display for the purpose of
measuring with cursors or printing the screen. Some digital oscilloscopes
go one step further by including the ability to further examine the signal
details after acquiring them by panning through the waveform and
changing the horizontal scale.
There is no limit imposed on the scaling ratio between the time/div used
to acquire the data and the time/div used to view the data. There is,
however, a useful limit. This useful limit is somewhat a function of the
signal you are analyzing.

NOTE

Zooming into stopped acquisitions
The screen will still contain a relatively good display if you zoom-in horizontally by a factor
of 1000 and zoom-in vertically by a factor of 10 to display the information from where it was
acquired. Remember that you can only make automatic measurements on displayed data.
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To change the horizontal time mode (Normal, XY, or Roll)
1 Press [Horiz].
2 In the Horizontal Menu, press Time Mode; then, select:
• Normal — the normal viewing mode for the oscilloscope.
In the Normal time mode, signal events occurring before the trigger
are plotted to the left of the trigger point (▼) and signal events after
the trigger plotted to the right of the trigger point.
• XY — XY mode changes the display from a volts- versus- time display
to a volts- versus- volts display. The time base is turned off. Channel 1
amplitude is plotted on the X- axis and Channel 2 amplitude is
plotted on the Y- axis.
You can use XY mode to compare frequency and phase relationships
between two signals. XY mode can also be used with transducers to
display strain versus displacement, flow versus pressure, volts versus
current, or voltage versus frequency.
Use the cursors to make measurements on XY mode waveforms.
For more information about using XY mode for measurements, refer
to "XY Time Mode" on page 54.
• Roll — causes the waveform to move slowly across the screen from
right to left. It only operates on time base settings of 50 ms/div and
slower. If the current time base setting is faster than the 50 ms/div
limit, it will be set to 50 ms/div when Roll mode is entered.
In Roll mode there is no trigger. The fixed reference point on the
screen is the right edge of the screen and refers to the current
moment in time. Events that have occurred are scrolled to the left of
the reference point. Since there is no trigger, no pre- trigger
information is available.
If you would like to pause the display in Roll mode press the [Single]
key. To clear the display and restart an acquisition in Roll mode,
press the [Single] key again.
Use Roll mode on low- frequency waveforms to yield a display much
like a strip chart recorder. It allows the waveform to roll across the
display.
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XY Time Mode
The XY time mode converts the oscilloscope from a volts- versus- time
display to a volts- versus- volts display using two input channels. Channel 1
is the X- axis input, channel 2 is the Y- axis input. You can use various
transducers so the display could show strain versus displacement, flow
versus pressure, volts versus current, or voltage versus frequency.
Example

This exercise shows a common use of the XY display mode by measuring
the phase difference between two signals of the same frequency with the
Lissajous method.
1 Connect a sine wave signal to channel 1, and a sine wave signal of the
same frequency but out of phase to channel 2.
2 Press the [AutoScale] key, press the [Horiz] key; then, press Time Mode
and select "XY".
3 Center the signal on the display with the channel 1 and 2 position ( )
knobs. Use the channel 1 and 2 volts/div knobs and the channel 1 and
2 Fine softkeys to expand the signal for convenient viewing.
The phase difference angle (θ) can be calculated using the following
formula (assuming the amplitude is the same on both channels):

A or C
sinθ = B
D
Signal must
be centered in
“ X”

D

A

B

C

Measuring
phase difference

Figure 3
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Signals
in phase

XY time mode signals, centered on display
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4 Press the [Cursors] key.
5 Set the Y2 cursor to the top of the signal, and set Y1 to the bottom of
the signal.
Note the ΔY value at the bottom of the display. In this example, we are
using the Y cursors, but you could have used the X cursors instead.
6 Move the Y1 and Y2 cursors to the intersection of the signal and the Y
axis. Again, note the ΔY value.

Figure 4

Phase difference measurements, automatic and using cursors

7 Calculate the phase difference using the formula below.
For example, if the first ΔY value is 1.688 and the second ΔY value is
1.031:

Δ Y 1.031
sinθ = second
first Δ Y = 1.688 ; θ = 37.65 degrees of phase shift
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NOTE

Z-Axis Input in XY Display Mode (Blanking)
When you select the XY display mode, the time base is turned off. Channel 1 is the X-axis
input, channel 2 is the Y-axis input, and the rear panel EXT TRIG IN is the Z-axis input. If you
only want to see portions of the Y versus X display, use the Z-axis input. Z-axis turns the
trace on and off (analog oscilloscopes called this Z-axis blanking because it turned the
beam on and off). When Z is low (<1.4 V), Y versus X is displayed; when Z is high (>1.4 V),
the trace is turned off.

To display the zoomed time base
Zoom, formerly called Delayed sweep mode, is a horizontally expanded
version of the normal display. When Zoom is selected, the display divides
in half. The top half of the display shows the normal time/div window and
the bottom half displays a faster Zoom time/div window.
The Zoom window is a magnified portion of the normal time/div window.
You can use Zoom to locate and horizontally expand part of the normal
window for a more detailed (higher- resolution) analysis of signals.
To turn on (or off) Zoom:
1 Press the
softkey).
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zoom key (or press the [Horiz] key and then the Zoom
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These markers show the
beginning and end of the
Zoom window

Time/div
Time/div
Delay time
for zoomed for normal momentarily displays
window
window
when the Horizontal
position knob is turned

Normal
window
Signal
anomaly
expanded
in zoom
window
Zoom
window

Select
Zoom

The area of the normal display that is expanded is outlined with a box
and the rest of the normal display is ghosted. The box shows the portion
of the normal sweep that is expanded in the lower half.
To change the time/div for the Zoom window, turn the horizontal scale
(sweep speed) knob. As you turn the knob, the zoomed window time/div
is highlighted in the status line above the waveform display area. The
Horizontal scale (sweep speed) knob controls the size of the box.
The Horizontal position (delay time) knob sets the left- to- right position of
the zoom window. The delay value, which is the time displayed relative to
the trigger point) is momentarily displayed in the upper- right portion of
the display when the delay time ( ) knob is turned.
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Negative delay values indicate you're looking at a portion of the waveform
before the trigger event, and positive values indicate you're looking at the
waveform after the trigger event.
To change the time/div of the normal window, turn off Zoom; then, turn
the horizontal scale (sweep speed) knob.
For information about using zoom mode for measurements, refer to "To
isolate a pulse for Top measurement" on page 223 and "To isolate an event
for frequency measurement" on page 229.

To change the horizontal scale knob's coarse/fine adjustment setting
1 Push the horizontal scale knob (or press [Horiz] > Fine) to toggle between
fine and coarse adjustment of the horizontal scale.
When Fine is enabled, turning the horizontal scale knob changes the
time/div (displayed in the status line at the top of the display) in smaller
increments. The time/div remains fully calibrated when Fine is on.
When Fine is turned off, the Horizontal scale knob changes the time/div
setting in a 1- 2- 5 step sequence.

To position the time reference (left, center, right)
Time reference is the reference point on the display for delay time
(horizontal position).
1 Press [Horiz].
2 In the Horizontal Menu, press Time Ref; then, select:
• Left — the time reference is set to one major division from the left
edge of the display.
• Center — the time reference is set to the center of the display.
• Right — the time reference is set to one major division from the right
edge of the display.
A small hollow triangle (∇) at the top of the display grid marks the
position of the time reference. When delay time is set to zero, the trigger
point indicator (▼) overlays the time reference indicator.
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The time reference position sets the initial position of the trigger event
within acquisition memory and on the display, with delay set to 0.
Turning the Horizontal scale (sweep speed) knob expands or contracts the
waveform about the time reference point (∇). See "To adjust the horizontal
(time/div) scale" on page 50.
Turning the Horizontal position ( ) knob in Normal mode (not Zoom)
moves the trigger point indicator (▼) to the left or right of the time
reference point (∇). See "To adjust the horizontal delay (position)" on
page 51.

Searching for Events
You can use the [Search] key and menu to search for Edge, Pulse Width,
Rise/Fall Time, Runt, and Serial events on the analog channels.
Setting up searches (see "To set up searches" on page 59) is similar to
setting up triggers. In fact, except for Serial events, you can copy search
setups to trigger setups and vice- versa (see "To copy search setups" on
page 60).
Searches are different than triggers in that they use the measurement
threshold settings instead of trigger levels.
Found search events are marked with white triangles at the top of the
graticule, and the number of events found is displayed in the menu line
just above the sofkey labels.

To set up searches
1 Press [Search].
2 In the Search Menu, press Search; then, turn the Entry knob to select
the search type.
3 Press Settings, and use the Search Settings Menu to set up the selected
search type.
Setting up searches is similar to setting up triggers:
• For setting up Edge searches, see "Edge Trigger" on page 146.
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• For setting up Pulse Width searches, see "Pulse Width Trigger" on
page 149.
• For setting up Rise/Fall Time searches, see "Rise/Fall Time
Trigger" on page 157.
• For setting up Runt searches, see "Runt Trigger" on page 160.
• For setting up Serial searches, see Chapter 10, “Triggers,” starting on
page 143 and "Searching Lister Data" on page 128.
Remember that searches use the measurement threshold settings instead
of trigger levels. Use the Thresholds softkey in the Search Menu to access
the Measurement Threshold Menu. See "Measurement Thresholds" on
page 237.

To copy search setups
Except for Serial event search setups, you can copy search setups to
trigger setups and vice- versa.
1 Press [Search].
2 In the Search Menu, press Search; then, turn the Entry knob to select
the search type.
3 Press Copy.
4 In the Search Copy Menu:
• Press Copy to Trigger to copy the setup for the selected search type to
the same trigger type. For example, if the current search type is
Pulse Width, pressing Copy to Trigger copies the search settings to the
Pulse Width trigger settings and selects the Pulse Width trigger.
• Press Copy from Trigger to copy the trigger setup for the selected search
type to the search setup.
• To undo a copy, press Undo Copy.
The softkeys in the Search Copy Menu may not be available when one
of the settings cannot be copied or there is no trigger type that
corresponds to the search type.

Navigating the Time Base
You can use the [Navigate] key and controls to navigate through:
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• Captured data (see "To navigate time" on page 61).
• Search events (see "To navigate search events" on page 61).
• Segments, when segmented memory acquisitions are turned on (see "To
navigate segments" on page 62).

To navigate time
When acquisitions are stopped, you can use the navigation controls to play
through the captured data.
1 Press [Navigate].
2 In the Navigate Menu, press Navigate; then, select Time.
3 Press the

navigation keys to play backward, stop, or play

forward in time. You can press the
or
keys multiple times to
speed up the playback. There are three speed levels.

To navigate search events
When acquisitions are stopped, you can use the navigation controls to go
to found search events (set using the [Search] key and menu, see
"Searching for Events" on page 59).
1 Press [Navigate].
2 In the Navigate Menu, press Navigate; then, select Search.
3 Press the
search event.

back and forward keys to go to the previous or next

When searching Serial decode:
• You can press the

stop key to set or clear a mark.

• The Auto zoom softkey specifies whether the waveform display is
automatically zoomed to fit the marked row as you navigate.
• Pressing the Scroll Lister softkey lets you use the Entry knob to scroll
through data rows in the Lister display.
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To navigate segments
When the segmented memory acquisition is enabled and acquisitions are
stopped, you can use the navigation controls to play through the acquired
segments.
1 Press [Navigate].
2 In the Navigate Menu, press Navigate; then, select Segments.
3 Press Play Mode; then, select:
• Manual — to play through segments manually.
In the Manual play mode:
• Press the
next segment.

back and forward keys to go to the previous or

• Press the

softkey to go to the first segment.

• Press the

softkey to go to the last segment.

• Auto — to play through segments in an automated fashion.
In the Auto play mode:
• Press the

navigation keys to play backward, stop, or

play forward in time. You can press the
or
keys multiple
times to speed up the playback. There are three speed levels.
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To turn waveforms on or off (channel or math) 64
To adjust the vertical scale 65
To adjust the vertical position 65
To specify channel coupling 65
To specify channel input impedance 66
To specify bandwidth limiting 67
To change the vertical scale knob's coarse/fine adjustment setting 67
To invert a waveform 68
Setting Analog Channel Probe Options 68

The vertical controls include:
• The vertical scale and position knobs for each analog channel.
• The channel keys for turning a channel on or off and accessing the
channel's softkey menu.
The following figure shows the Channel 1 Menu that appears after
pressing the [1] channel key.

s1
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Channel,
Volts/div

Trigger
source

Trigger level
or threshold

Channel 1
ground
level

Channel 2
ground
level

The ground level of the signal for each displayed analog channel is
identified by the position of the

icon at the far- left side of the display.

To turn waveforms on or off (channel or math)
1 Press an analog channel key turn the channel on or off (and to display
the channel's menu).
When a channel is on, its key is illuminated.

NOTE

Turning channels off
You must be viewing the menu for a channel before you can turn it off. For example, if
channel 1 and channel 2 are turned on and the menu for channel 2 is being displayed, to
turn channel 1 off, press [1] to display the channel 1 menu; then, press [1] again to turn
channel 1 off.
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To adjust the vertical scale
1 Turn the large knob above the channel key marked
vertical scale (volts/division) for the channel.

to set the

The vertical scale knob changes the analog channel scale in a 1- 2- 5 step
sequence (with a 1:1 probe attached) unless fine adjustment is enabled
(see "To change the vertical scale knob's coarse/fine adjustment setting" on
page 67).
The analog channel Volts/Div value is displayed in the status line.
The default mode for expanding the signal when you turn the
volts/division knob is vertical expansion about the ground level of the
channel; however, you can change this to expand about the center of the
display. See "To choose "expand about" center or ground" on page 301.

To adjust the vertical position
1 Turn the small vertical position knob ( ) to move the channel's
waveform up or down on the display.
The voltage value momentarily displayed in the upper right portion of the
display represents the voltage difference between the vertical center of the
display and the ground level ( ) icon. It also represents the voltage at
the vertical center of the display if vertical expansion is set to expand
about ground (see "To choose "expand about" center or ground" on
page 301).

To specify channel coupling
Coupling changes the channel's input coupling to either AC (alternating
current) or DC (direct current).
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TIP

If the channel is DC coupled, you can quickly measure the DC component of the signal by
simply noting its distance from the ground symbol.
If the channel is AC coupled, the DC component of the signal is removed, allowing you to
use greater sensitivity to display the AC component of the signal.

1 Press the desired channel key.
2 In the Channel Menu, press the Coupling softkey to select the input
channel coupling:
• DC — DC coupling is useful for viewing waveforms as low as 0 Hz
that do not have large DC offsets.
• AC — AC coupling is useful for viewing waveforms with large DC
offsets.
When AC coupling is chosen, you cannot select 50Ω mode. This is
done to prevent damage to the oscilloscope.
AC coupling places a 10 Hz high- pass filter in series with the input
waveform that removes any DC offset voltage from the waveform.
Note that Channel Coupling is independent of Trigger Coupling. To change
trigger coupling see "To select the trigger coupling" on page 182.

To specify channel input impedance
NOTE

When you connect an AutoProbe, self-sensing probe, or a compatible InfiniiMax probe, the
oscilloscope automatically configures the analog input channels to the correct impedance.

1 Press the desired channel key.
2 In the Channel Menu, press Imped (impedance); then, select either:
• 50 Ohm — matches 50 ohm cables commonly used in making high
frequency measurements, and 50 ohm active probes.
When 50 Ohm input impedance is selected, it is displayed with the
channel information on- screen.
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When AC coupling is selected (see "To specify channel coupling" on
page 65) or excessive voltage is applied to the input, the oscilloscope
automatically switches to 1M Ohm mode to prevent possible damage.
• 1M Ohm — is for use with many passive probes and for
general- purpose measurements. The higher impedance minimizes the
loading effect of the oscilloscope on the device under test.
This impedance matching gives you the most accurate measurements
because reflections are minimized along the signal path.
See Also

• For more information on probing, visit:
"www.agilent.com/find/scope_probes"
• Information about selecting a probe can be found in document number
"Agilent Oscilloscope Probes and Accessories Selection Guide (part
number 5989- 6162EN)", available at "www.agilent.com".

To specify bandwidth limiting
1 Press the desired channel key.
2 In the Channel Menu, press the BW Limit softkey to enable or disable
bandwidth limiting.
When bandwidth limit is on, the maximum bandwidth for the channel is
approximately 20 MHz. For waveforms with frequencies below this, turning
bandwidth limit on removes unwanted high frequency noise from the
waveform. The bandwidth limit also limits the trigger signal path of any
channel that has BW Limit turned on.

To change the vertical scale knob's coarse/fine adjustment setting
1 Push the channel's vertical scale knob (or press the channel key and
then the Fine softkey in the Channel Menu) to toggle between fine and
coarse adjustment of the vertical scale.
When Fine adjustment is selected, you can change the channel's vertical
sensitivity in smaller increments. The channel sensitivity remains fully
calibrated when Fine is on.
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The vertical scale value is displayed in the status line at the top of the
display.
When Fine is turned off, turning the volts/division knob changes the
channel sensitivity in a 1- 2- 5 step sequence.

To invert a waveform
1 Press the desired channel key.
2 In the Channel Menu, press the Invert softkey to invert the selected
channel.
When Invert is selected, the voltage values of the displayed waveform are
inverted.
Invert affects how a channel is displayed. However, when using basic
triggers, the oscilloscope attempts to maintain the same trigger point by
changing trigger settings.
Inverting a channel also changes the result of any math function selected
in the Waveform Math Menu or any measurement.

Setting Analog Channel Probe Options
1 Press the probe's associated channel key.
2 In the Channel Menu, press the Probe softkey to display the Channel
Probe Menu.
This menu lets you select additional probe parameters such as
attenuation factor and units of measurement for the connected probe.

The Channel Probe Menu changes depending on the type of probe
connected.
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For passive probes (such as the N2862A/B, N2863A/B, N2889A, N2890A,
10073C, 10074C, or 1165A probes), the Probe Check softkey appears; it
guides you through the process of compensating probes.
For some active probes (such as InfiniiMax probes), the oscilloscope can
accurately calibrate its analog channels for the probe. When you
connect a probe that can be calibrated, the Calibrate Probe softkey
appears (and the probe attenuation softkey may change). See "To
calibrate a probe" on page 70.
See Also

• "To specify the channel units" on page 69
• "To specify the probe attenuation" on page 69
• "To specify the probe skew" on page 70

To specify the channel units
1 Press the probe's associated channel key.
2 In the Channel Menu, press Probe.
3 In the Channel Probe Menu, press Units; then, select:
• Volts — for a voltage probe.
• Amps — for a current probe.
Channel sensitivity, trigger level, measurement results, and math functions
will reflect the measurement units you have selected.

To specify the probe attenuation
This is set automatically if the oscilloscope can identify the connected
probe. See Analog channel inputs (see page 41).
The probe attenuation factor must be set properly for accurate
measurement results.
If you connect a probe that is not automatically identified by the
oscilloscope, you can manually set the attenuation factor as follows:
1 Press the channel key.
2 Press the Probe softkey until you have selected how you want to specify
the attenuation factor, choosing either Ratio or Decibels.
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3 Turn the Entry knob
connected probe.

to set the attenuation factor for the

When measuring voltage values, the attenuation factor can be set from
0.1:1 to 1000:1 in a 1- 2- 5 sequence.
When measuring current values with a current probe, the attenuation
factor can be set from 10 V/A to 0.001 V/A.
When specifying the attenuation factor in decibels, you can select values
from - 20 dB to 60 dB.
If Amps is chosen as the units and a manual attenuation factor is chosen,
then the units as well as the attenuation factor are displayed above the
Probe softkey.

To specify the probe skew
When measuring time intervals in the nanoseconds (ns) range, small
differences in cable length can affect the measurement. Use Skew to
remove cable- delay errors between any two channels.
1 Probe the same point with both probes.
2 Press one of the probes associated channel key.
3 In the Channel Menu, press Probe.
4 In the Channel Probe Menu, press Skew; then, select the desired skew
value.
Each analog channel can be adjusted ±100 ns in 10 ps increments for a
total of 200 ns difference.
The skew setting is not affected by pressing [Default Setup] or [Auto Scale].

To calibrate a probe
The Calibrate Probe softkey guides you through the process of calibrating
probes.
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For certain active probes, such as InfiniiMax probes, the oscilloscope can
accurately calibrate its analog channels for the probe. When you connect a
probe that can be calibrated, the Calibrate Probe softkey in the Channel
Probe Menu becomes active.
To calibrate one of these probes:
1 First, plug your probe into one of the oscilloscope channels.
This could be, for example, an InfiniiMax probe amplifier/probe head
with attenuators attached.
2 Connect the probe to the left side, Demo 2, Probe Comp terminal, and
the probe ground to the ground terminal.

NOTE

When calibrating a differential probe, connect the positive lead to the Probe Comp terminal
and the negative lead to the ground terminal. You may need to connect an alligator clip to
the ground lug to allow a differential probe to span between the Probe Comp test point and
ground. A good ground connection ensures the most accurate probe calibration.

3 Press the Channel on/off key to turn the channel on (if the channel is
off).
4 In the Channel Menu, press the Probe softkey.
5 In the Channel Probe Menu, the second softkey from the left is for
specifying your probe head (and attenuation). Repeatedly press this
softkey until the probe head selection matches the attenuator you are
using.
The choices are:
• 10:1 single- ended browser (no attenuator).
• 10:1 differential browser (no attenuator).
• 10:1 (+6 dB Atten) single- ended browser.
• 10:1 (+6 dB Atten) differential browser.
• 10:1 (+12 dB Atten) single- ended browser.
• 10:1 (+12 dB Atten) differential browser.
• 10:1 (+20 dB Atten) single- ended browser.
• 10:1 (+20 dB Atten) differential browser.
6 Press the Calibrate Probe softkey and follow the instructions on the
display.
Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

71

3

Vertical Controls

For more information on InfiniiMax probes and accessories, see the
probe's User's Guide.
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To display math waveforms 73
To perform transforms or filters on an arithmetic operation 75
To adjust the math waveform scale and offset 75
Units for Math Waveforms 76
Math Operators 76
Math Transforms 78
Math Filters 94
Math Visualizations 96

Math functions can be performed on analog channels. The resulting math
waveform is displayed in light purple.
You can use a math function on a channel even if you choose not to
display the channel on- screen.
You can:
• Perform an arithmetic operation (like add, subtract, or multiply) on
analog input channels.
• Perform a transform function (like differentiate, integrate, FFT, or
square root) on an analog input channel.
• Perform a transform function on the result of an arithmetic operation.

To display math waveforms
1 Press the [Math] key on the front panel to display the Waveform Math
Menu.
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2 If f(t) is not already shown on the Function softkey, press the Function
sofkey and select f(t): Displayed.
3 Use the Operator softkey to select an operator or transform.
For more information on the operators, see:
• "Math Operators" on page 76
• "Math Transforms" on page 78
• "Math Filters" on page 94
• "Math Visualizations" on page 96
4 Use the Source 1 softkey to select the analog channel on which to
perform math. You can rotate the Entry knob or repetitively press the
Source 1 softkey to make your selection. If you choose a transform
function (differentiate, integrate, FFT, or square root) the result is
displayed.
5 If you select an arithmetic operator, use the Source 2 softkey to select
the second source for the arithmetic operation. The result is displayed.
6 To re- size and re- position the math waveform, see "To adjust the math
waveform scale and offset" on page 75.

TIP

Math Operating Hints
If the analog channel or math function is clipped (not fully displayed on screen) the
resulting displayed math function will also be clipped.
Once the function is displayed, the analog channel(s) may be turned off for better viewing
of the math waveform.
The vertical scaling and offset of each math function can be adjusted for ease of viewing
and measurement considerations.
The math function waveform can be measured using [Cursors] and/or [Meas].
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To perform transforms or filters on an arithmetic operation
To perform a transform function (see "Math Transforms" on page 78) or
filter (see "Math Filters" on page 94) on the add, subtract, or multiply
arithmetic operations:
1 Press the Function softkey and select g(t): Internal.
2 Use the Operator, Source 1, and Source 2 softkeys to set up an arithmetic
operation.
3 Press the Function softkey and select f(t): Displayed.
4 Use the Operator softkey to select a transform function or filter.
5 Press the Source 1 softkey and select g(t) as the source. Note that g(t) is
only available when you select a transform function in the previous
step.

To adjust the math waveform scale and offset
1 Make sure the multiplexed scale and position knobs to the right of the
[Math] key are selected for the math waveform.
If the arrow to the left of the [Math] key is not illuminated, press the
key.
2 Use the multiplexed scale and position knobs just to the right of the
[Math] key to re- size and re- position the math waveform.

NOTE

Math Scale and Offset are Set Automatically
Any time the currently displayed math function definition is changed, the function is
automatically scaled for optimum vertical scale and offset. If you manually set scale and
offset for a function, select a new function, then select the original function, the original
function will be automatically rescaled.

See Also

• "Units for Math Waveforms" on page 76
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Units for Math Waveforms
Units for each input channel can be set to Volts or Amps using the Units
softkey in the channel's Probe Menu. Units for math function waveforms
are:
Math function

Units

add or subtract

V or A

multiply

V2, A2, or W (Volt-Amp)

d/dt

V/s or A/s (V/second or A/second)

 dt

Vs or As (V-seconds or A-seconds)

FFT

dB* (decibels). See also "FFT Units" on
page 88.

√(square root)

V1/2, A1/2, or W1/2 (Volt-Amp)

* When the FFT source is channel 1, 2, 3 or 4, FFT units will be displayed in dBV when channel
units is set to Volts and channel impedance is set to 1 MΩ. FFT units will be displayed in dBm
when channel units is set to Volts and channel impedance is set to 50Ω. FFT units will be
displayed as dB for all other FFT sources or when a source channel's units has been set to Amps.

A scale unit of U (undefined) will be displayed for math functions when
two source channels are used and they are set to dissimilar units and the
combination of units cannot be resolved.

Math Operators
Math operators perform arithmetic operations (like add, subtract, or
multiply) on analog input channels.
• "Add or Subtract" on page 77
• "Multiply or Divide" on page 77
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Add or Subtract
When you select add or subtract, the Source 1 and Source 2 values are
added or subtracted point by point, and the result is displayed.
You can use subtract to make a differential measurement or to compare
two waveforms.
If your waveforms' DC offsets are larger than the dynamic range of the
oscilloscope's input channels you will need to use a differential probe
instead.

Figure 5
See Also

Example of Subtract Channel 2 from Channel 1

• "Units for Math Waveforms" on page 76

Multiply or Divide
When you select the multiply or divide math function, the Source 1 and
Source 2 values are multiplied or divided point by point, and the result is
displayed.
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The divide by zero case places holes (that is, zero values) in the output
waveform.
Multiply is useful for seeing power relationships when one of the channels
is proportional to the current.

Figure 6
See Also

Example of Multiply Channel 1 by Channel 2

• "Units for Math Waveforms" on page 76

Math Transforms
Math transforms perform a transform function (like differentiate, integrate,
FFT, or square root) on an analog input channel or on the result of an
arithmetic operation.
• "Differentiate" on page 79
• "Integrate" on page 80
• "FFT Measurement" on page 83
• "Square Root" on page 90
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With the DSOX3ADVMATH advanced math measurements license, these
additional transforms are available:
• "Ax + B" on page 90
• "Square" on page 91
• "Absolute Value" on page 92
• "Common Logarithm" on page 92
• "Natural Logarithm" on page 93
• "Exponential" on page 93
• "Base 10 Exponential" on page 94

Differentiate
d/dt (differentiate) calculates the discrete time derivative of the selected
source.
You can use differentiate to measure the instantaneous slope of a
waveform. For example, the slew rate of an operational amplifier may be
measured using the differentiate function.
Because differentiation is very sensitive to noise, it is helpful to set
acquisition mode to Averaging (see "Selecting the Acquisition Mode" on
page 193).
d/dt plots the derivative of the selected source using the "average slope
estimate at 4 points" formula. The equation is:

di =

yi+4 + 2yi+2 − 2yi−2 − yi−4
8Δt

Where:
• d = differential waveform.
• y = channel 1, 2, 3, or 4, or g(t) (internal arithmetic operation) data
points.
• i = data point index.
• Δt = point- to- point time difference.
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Figure 7
See Also

Example of Differentiate Function

• "To perform transforms or filters on an arithmetic operation" on
page 75
• "Units for Math Waveforms" on page 76

Integrate
 dt (integrate) calculates the integral of the selected source. You can use
integrate to calculate the energy of a pulse in volt- seconds or measure the
area under a waveform.
 dt plots the integral of the source using the "Trapezoidal Rule". The
equation is:
n

I n = co + Δ t∑ yi
i=0

Where:
• I = integrated waveform.
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• Δt = point- to- point time difference.
• y = channel 1, 2, 3, or 4, or g(t) (internal arithmetic operation).
• co = arbitrary constant.
• i = data point index.
The integrate operator provides an Offset softkey that lets you enter a DC
offset correction factor for the input signal. Small DC offset in the
integrate function input (or even small oscilloscope calibration errors) can
cause the integrate function output to "ramp" up or down. This DC offset
correction lets you level the integrate waveform.
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0 V level
Integrate
without
DC offset
correction

Integrate
with DC offset
correction

Figure 8
See Also
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Integrate and Signal Offset

• "To perform transforms or filters on an arithmetic operation" on
page 75
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• "Units for Math Waveforms" on page 76

FFT Measurement
FFT is used to compute the fast Fourier transform using analog input
channels or an arithmetic operation g(t). FFT takes the digitized time
record of the specified source and transforms it to the frequency domain.
When the FFT function is selected, the FFT spectrum is plotted on the
oscilloscope display as magnitude in dBV versus frequency. The readout
for the horizontal axis changes from time to frequency (Hertz) and the
vertical readout changes from volts to dB.
Use the FFT function to find crosstalk problems, to find distortion
problems in analog waveforms caused by amplifier non- linearity, or for
adjusting analog filters.
To display a FFT waveform:
1 Press the [Math] key, press the Function softkey and select f(t), press the
Operator softkey and select FFT.

• Source 1 — selects the source for the FFT. (See "To perform transforms
or filters on an arithmetic operation" on page 75 for information
about using g(t) as the source.)
• Span — sets the overall width of the FFT spectrum that you see on
the display (left to right). Divide span by 10 to calculate the number
of Hertz per division. It is possible to set Span above the maximum
available frequency, in which case the displayed spectrum will not
take up the whole screen. Press the Span softkey, then turn the Entry
knob to set the desired frequency span of the display.
• Center — sets the FFT spectrum frequency represented at the center
vertical grid line of the display. It is possible to set the Center to
values below half the span or above the maximum available
frequency, in which case the displayed spectrum will not take up the
whole screen. Press the Center softkey, then turn the Entry knob to
set the desired center frequency of the display.
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• Scale — lets you set your own vertical scale factors for FFT expressed
in dB/div (decibels/division). See "To adjust the math waveform scale
and offset" on page 75.
• Offset — lets you set your own offset for the FFT. The offset value is
in dB and is represented by the center horizontal grid line of the
display. See "To adjust the math waveform scale and offset" on
page 75.
• More FFT — displays the More FFT Settings Menu.
2 Press the More FFT softkey to display additional FFT settings.

• Window— selects a window to apply to your FFT input signal:
• Hanning — window for making accurate frequency measurements or
for resolving two frequencies that are close together.
• Flat Top — window for making accurate amplitude measurements of
frequency peaks.
• Rectangular — good frequency resolution and amplitude accuracy,
but use only where there will be no leakage effects. Use on
self- windowing waveforms such as pseudo- random noise, impulses,
sine bursts, and decaying sinusoids.
• Blackman Harris — window reduces time resolution compared to a
rectangular window, but improves the capacity to detect smaller
impulses due to lower secondary lobes.
• Vertical Units — lets you select Decibels or V RMS as the units for the
FFT vertical scale.
• Auto Setup — sets the frequency Span and Center to values that will
cause the entire available spectrum to be displayed. The maximum
available frequency is half the FFT sample rate, which is a function
of the time per division setting. The FFT resolution is the quotient of
the sampling rate and the number of FFT points (fS/N). The current
FFT Resolution is displayed above the softkeys.
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NOTE

Scale and offset considerations
If you do not manually change the FFT scale or offset settings, when you turn the horizontal
scale knob, the span and center frequency settings will automatically change to allow
optimum viewing of the full spectrum.
If you do manually set scale or offset, turning the horizontal scale knob will not change the
span or center frequency settings, allowing you see better detail around a specific
frequency.
Pressing the FFT Auto Setup softkey will automatically rescale the waveform and span and
center will again automatically track the horizontal scale setting.

3 To make cursor measurements, press the [Cursors] key and set the
Source softkey to Math: f(t).
Use the X1 and X2 cursors to measure frequency values and difference
between two frequency values (ΔX). Use the Y1 and Y2 cursors to
measure amplitude in dB and difference in amplitude (ΔY).
4 To make other measurements, press the [Meas] key and set the Source
softkey to Math: f(t).
You can make peak- to- peak, maximum, minimum, and average dB
measurements on the FFT waveform. You can also find the frequency
value at the first occurrence of the waveform maximum by using the X
at Max Y measurement.
The following FFT spectrum was obtained by connecting a 4 V, 75 kHz
square wave to channel 1. Set the horizontal scale to 50 µs/div, vertical
sensitivity to 1 V/div, Units/div to 20 dBV, Offset to - 60.0 dBV, Center
frequency to 250 kHz, frequency Span to 500 kHz, and window to
Hanning.
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See Also

• "To perform transforms or filters on an arithmetic operation" on
page 75
• "FFT Measurement Hints" on page 86
• "FFT Units" on page 88
• "FFT DC Value" on page 88
• "FFT Aliasing" on page 88
• "FFT Spectral Leakage" on page 89
• "Units for Math Waveforms" on page 76

FFT Measurement Hints
The number of points acquired for the FFT record can be up to 65,536,
and when frequency span is at maximum, all points are displayed. Once
the FFT spectrum is displayed, the frequency span and center frequency
controls are used much like the controls of a spectrum analyzer to
examine the frequency of interest in greater detail. Place the desired part
of the waveform at the center of the screen and decrease frequency span
to increase the display resolution. As frequency span is decreased, the
number of points shown is reduced, and the display is magnified.
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While the FFT spectrum is displayed, use the [Math] and [Cursors] keys to
switch between measurement functions and frequency domain controls in
FFT Menu.

NOTE

FFT Resolution
The FFT resolution is the quotient of the sampling rate and the number of FFT points (fS/N).
With a fixed number of FFT points (up to 65,536), the lower the sampling rate, the better the
resolution.

Decreasing the effective sampling rate by selecting a greater time/div
setting will increase the low frequency resolution of the FFT display and
also increase the chance that an alias will be displayed. The resolution of
the FFT is the effective sample rate divided by the number of points in
the FFT. The actual resolution of the display will not be this fine as the
shape of the window will be the actual limiting factor in the FFTs ability
to resolve two closely space frequencies. A good way to test the ability of
the FFT to resolve two closely spaced frequencies is to examine the
sidebands of an amplitude modulated sine wave.
For the best vertical accuracy on peak measurements:
• Make sure the probe attenuation is set correctly. The probe attenuation
is set from the Channel Menu if the operand is a channel.
• Set the source sensitivity so that the input signal is near full screen,
but not clipped.
• Use the Flat Top window.
• Set the FFT sensitivity to a sensitive range, such as 2 dB/division.
For best frequency accuracy on peaks:
• Use the Hanning window.
• Use Cursors to place an X cursor on the frequency of interest.
• Adjust frequency span for better cursor placement.
• Return to the Cursors Menu to fine tune the X cursor.
For more information on the use of FFTs please refer to Agilent
Application Note 243, The Fundamentals of Signal Analysis at
"http://cp.literature.agilent.com/litweb/pdf/5952- 8898E.pdf". Additional
information can be obtained from Chapter 4 of the book Spectrum and
Network Measurements by Robert A. Witte.
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FFT Units
0 dBV is the amplitude of a 1 Vrms sinusoid. When the FFT source is
channel 1 or channel 2 (or channel 3 or 4 on 4- channel models), FFT
units will be displayed in dBV when channel units is set to Volts and
channel impedance is set to 1 MΩ.
FFT units will be displayed in dBm when channel units is set to Volts and
channel impedance is set to 50Ω.
FFT units will be displayed as dB for all other FFT sources or when a
source channel's units has been set to Amps.

FFT DC Value
The FFT computation produces a DC value that is incorrect. It does not
take the offset at center screen into account. The DC value is not
corrected in order to accurately represent frequency components near DC.

FFT Aliasing
When using FFTs, it is important to be aware of frequency aliasing. This
requires that the operator have some knowledge as to what the frequency
domain should contain, and also consider the sampling rate, frequency
span, and oscilloscope vertical bandwidth when making FFT
measurements. The FFT resolution (the quotient of the sampling rate and
the number of FFT points) is displayed directly above the softkeys when
the FFT Menu is displayed.

NOTE

Nyquist Frequency and Aliasing in the Frequency Domain
The Nyquist frequency is the highest frequency that any real-time digitizing oscilloscope
can acquire without aliasing. This frequency is half of the sample rate. Frequencies above
the Nyquist frequency will be under sampled, which causes aliasing. The Nyquist
frequency is also called the folding frequency because aliased frequency components fold
back from that frequency when viewing the frequency domain.

Aliasing happens when there are frequency components in the signal
higher than half the sample rate. Because the FFT spectrum is limited by
this frequency, any higher components are displayed at a lower (aliased)
frequency.
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The following figure illustrates aliasing. This is the spectrum of a 990 Hz
square wave, which has many harmonics. The sample rate is set to
100 kSa/s, and the oscilloscope displays the spectrum. The displayed
waveform shows the components of the input signal above the Nyquist
frequency to be mirrored (aliased) on the display and reflected off the
right edge.

Figure 9

Aliasing

Because the frequency span goes from ≈ 0 to the Nyquist frequency, the
best way to prevent aliasing is to make sure that the frequency span is
greater than the frequencies of significant energy present in the input
signal.

FFT Spectral Leakage
The FFT operation assumes that the time record repeats. Unless there is
an integral number of cycles of the sampled waveform in the record, a
discontinuity is created at the end of the record. This is referred to as
leakage. In order to minimize spectral leakage, windows that approach
zero smoothly at the beginning and end of the signal are employed as
filters to the FFT. The FFT Menu provides four windows: Hanning, Flat
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Top, Rectangular, and Blackman- Harris. For more information on leakage,
see Agilent Application Note 243, The Fundamentals of Signal Analysis at
"http://cp.literature.agilent.com/litweb/pdf/5952- 8898E.pdf."

Square Root
Square root (√) calculates the square root of the selected source.
Where the transform is undefined for a particular input, holes (zero
values) appear in the function output.

Figure 10
See Also

Example of √ (Square Root)

• "To perform transforms or filters on an arithmetic operation" on
page 75
• "Units for Math Waveforms" on page 76

Ax + B
The Ax + B function (available with the DSOX3ADVMATH advanced math
measurements license) lets you apply a gain and offset to an existing
input source.
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Figure 11

Example of Ax + B

Use the Gain (A) softkey to specify the gain.
Use the Offset (B) softkey to specify the offset.
The Ax + B function differs from the Magnify math visualization function
in that the output is likey different than the input.
See Also

• "Magnify" on page 96

Square
The square function (available with the DSOX3ADVMATH advanced math
measurements license) calculates the square of the selected source, point
by point, and displays the result.
Press the Source softkey to select the signal source.
See Also

• "Square Root" on page 90
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Absolute Value
The absolute value function (available with the DSOX3ADVMATH advanced
math measurements license) changes negative values in the input to
positive values and displays the resulting waveform.

Figure 12
See Also

Example of Absolute Value

• "Square" on page 91

Common Logarithm
The Common Logarithm (log) function (available with the
DSOX3ADVMATH advanced math measurements license) performs a
transform of the input source. Where the transform is undefined for a
particular input, holes (zero values) appear in the function output.
See Also

92

• "Natural Logarithm" on page 93
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Natural Logarithm
The Natural Logarithm (ln) function (available with the DSOX3ADVMATH
advanced math measurements license) performs a transform of the input
source. Where the transform is undefined for a particular input, holes
(zero values) appear in the function output.

Figure 13
See Also

Example of Natural Logarithm

• "Common Logarithm" on page 92

Exponential
The Exponential (e^x) function (available with the DSOX3ADVMATH
advanced math measurements license) performs a transform of the input
source.
See Also

• "Base 10 Exponential" on page 94
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Base 10 Exponential
The Base 10 Exponential (10^x) function (available with the
DSOX3ADVMATH advanced math measurements license) performs a
transform of the input source.

Figure 14
See Also

Example of Base 10 Exponential

• "Exponential" on page 93

Math Filters
With the DSOX3ADVMATH advanced math measurements license, you can
use math filters to create a waveform that is the result of a high- or
low- pass filter on an analog input channel or on the result of an
arithmetic operation.
• "High Pass and Low Pass Filter" on page 95
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High Pass and Low Pass Filter
The high- pass or low- pass filter functions (available with the
DSOX3ADVMATH advanced math measurements license) apply the filter to
the selected source waveform and display the resut in the math waveform.
The high- pass filter is a single- pole high- pass filter.
The low- pass filter is a 4th order Bessel- Thompson filter.
Use the Bandwidth softkey to select the filter's - 3 dB cutoff frequency.

NOTE

The ratio of the input signal's Nyquist frequency and the selected -3 dB cutoff frequency
affects how many points are available in the output, and under some circumstances, there
are no points in the output waveform.

Figure 15

Example of Low Pass Filter
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Math Visualizations
With the DSOX3ADVMATH advanced math measurements license, you can
apply visualization math functions that give you different ways of viewing
captured data and measurement values.
• "Magnify" on page 96
• "Measurement Trend" on page 97
• "Chart Logic Bus Timing" on page 98
• "Chart Logic Bus State" on page 99

Magnify
The magnify math function (available with the DSOX3ADVMATH advanced
math measurements license) lets you display an existing input source at
different vertical settings to provide more vertical detail.

Figure 16
See Also
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Example of Magnify

• "Ax + B" on page 90
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Measurement Trend
The measurement trend math function (available with the
DSOX3ADVMATH advanced math measurements license) shows
measurement values for a waveform (based on measurement threshold
settings) as the waveform progresses across the screen. For every cycle, a
measurement is made, and the value is displayed on the screen for the
cycle.

Figure 17

Example of Measurement Trend

Use the Type: softkey to select the measurement whose trend you want to
look at. You can display trend values for these measurements:
• Average
• RMS - AC
• Ratio
• Period
• Frequency
• +Width
• - Width
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• Duty Cycle
• Rise Time
• Fall Time
Use the Thresholds softkey to access the Measurement Threshold Menu. See
"Measurement Thresholds" on page 237.
If a measurement cannot be made for part of a waveform, the trend
function output is a hole (that is, no value) until a measurement can be
made.

Chart Logic Bus Timing
The Chart Logic Bus Timing function (available with the DSOX3ADVMATH
advanced math measurements license) displays bus data values as an
analog waveform (like a D/A conversion). When the bus value is
transitioning, the function output is the bus's last stable state.

Figure 18

Example of Chart Logic Bus Timing

Use the Units/Code softkey to specify the analog value equivalent of each
increment in the bus data value.
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Use the 0 Offset softkey to specify the analog value equivalent of a bus data
value of zero.
Use the Units softkey to specify the type of values the bus data represents
(volts, amps, etc.).
See Also

• "Chart Logic Bus State" on page 99

Chart Logic Bus State
The Chart Logic Bus State function (available with the DSOX3ADVMATH
advanced math measurements license) displays bus data values, sampled
on a clock signal's edge, as an analog waveform (like a D/A conversion).

Figure 19

Example of Chart Logic Bus State

Use the Clock softkey to select the clock signal.
Use the Slope softkey to select the edge of the clock signal to be used.
Use the More Chart softkey to open a submenu for specifying the analog
value equivalent of each bus value increment, the analog equivalent of a
zero bus value, and the type of values the charted bus data represents
(volts, amps, etc.).
Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide
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Use the Units/Code softkey to specify the analog value equivalent of each
increment in the bus data value.
Use the 0 Offset softkey to specify the analog value equivalent of a bus data
value of zero.
Use the Units softkey to specify the type of values the bus data represents
(volts, amps, etc.).
See Also
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• "Chart Logic Bus Timing" on page 98
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Reference Waveforms
To save a waveform to a reference waveform location 101
To display a reference waveform 102
To scale and position reference waveforms 103
To adjust reference waveform skew 103
To display reference waveform information 104
To save/recall reference waveform files to/from a USB storage
device 104

Analog channel or math waveforms can be saved to one of two reference
waveform locations in the oscilloscope. Then, a reference waveform can be
displayed and compared against other waveforms. One reference waveform
can be displayed at a time.
When the multiplexed knobs are assigned to reference waveforms (this
happens when you press the [Ref] key and the LED to the left of it is lit),
you can use the knobs to scale and position reference waveforms. There is
also a skew adjustment for reference waveforms. Reference waveform
scale, offset, and skew information can optionally be included on the
oscilloscope display.
Analog channel, math, or reference waveforms can be saved to a reference
waveform file on a USB storage device. You can recall a reference
waveform file from a USB storage device into one of the reference
waveform locations.

To save a waveform to a reference waveform location
1 Press the [Ref] key to turn on reference waveforms.

s1
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2 In the Reference Waveform Menu, press the Ref softkey and turn the
Entry knob to select the desired reference waveform location.
3 Press the Source softkey and turn the Entry knob to select the source
waveform.
4 Press the Save to R1/R2 softkey to save the waveform to the reference
waveform location.

NOTE

To clear a
reference
waveform
location

Reference waveforms are non-volatile — they remain after power cycling or performing a
default setup.

1 Press the [Ref] key to turn on reference waveforms.
2 In the Reference Waveform Menu, press the Ref softkey and turn the
Entry knob to select the desired reference waveform location.
3 Press the Clear R1/R2 softkey to clear the reference waveform location.
Reference waveforms are also cleared by a Factory Default or Secure
Erase (see Chapter 18, “Save/Recall (Setups, Screens, Data),” starting on
page 275).

To display a reference waveform
1 Press the [Ref] key to turn on reference waveforms.
2 In the Reference Waveform Menu, press the Ref softkey and turn the
Entry knob to select the desired reference waveform location.
3 Then, press the Ref softkey again to enable/disable the reference
waveform display.
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One reference waveform can be displayed at a time.
See Also

• "To display reference waveform information" on page 104

To scale and position reference waveforms
1 Make sure the multiplexed scale and position knobs to the right of the
[Ref] key are selected for the reference waveform.
If the arrow to the left of the [Ref] key is not illuminated, press the key.
2 Turn the upper multiplexed knob to adjust the reference waveform
scale.
3 Turn the lower multiplexed knob to adjust the reference waveform
position.

To adjust reference waveform skew
Once reference waveforms are displayed, you can adjust their skew.
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1 Display the desired reference waveform (see "To display a reference
waveform" on page 102).
2 Press the Skew softkey and turn the Entry knob to adjust the reference
waveform skew.

To display reference waveform information
1 Press the [Ref] key to turn on reference waveforms.
2 In the Reference Waveform Menu, press the Options softkey.
3 In the Reference Waveform Options Menu, press the Display Info softkey
to enable or disable reference waveform information on the oscilloscope
display.
4 Press the Transparent softkey to enable or disable transparent
information backgrounds.
This setting is also used for other oscilloscope information on the
display, like mask test statistics, etc.

To save/recall reference waveform files to/from a USB storage device
Analog channel, math, or reference waveforms can be saved to a reference
waveform file on a USB storage device. See "To save reference waveform
files to a USB storage device" on page 281.
You can recall a reference waveform file from a USB storage device into
one of the reference waveform locations. See "To recall reference waveform
files from a USB storage device" on page 285.
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Digital Channels
To connect the digital probes to the device under test 105
Acquiring waveforms using the digital channels 109
To display digital channels using AutoScale 109
Interpreting the digital waveform display 110
To switch all digital channels on or off 112
To switch groups of channels on or off 112
To switch a single channel on or off 112
To change the displayed size of the digital channels 111
To reposition a digital channel 113
To change the logic threshold for digital channels 112
To display digital channels as a bus 114
Digital channel signal fidelity: Probe impedance and grounding 117
To replace digital probe leads 122

This chapter describes how to use the digital channels of a Mixed- Signal
Oscilloscope (MSO).
The digital channels are enabled on MSOX3000 X- Series models and
DSOX3000 X- Series models that have the MSO upgrade license installed.

To connect the digital probes to the device under test
1 If necessary, turn off the power supply to the device under test.

s1
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Turning off power to the device under test would only prevent damage
that might occur if you accidentally short two lines together while
connecting probes. You can leave the oscilloscope powered on because
no voltage appears at the probes.

Off

2 Connect the digital probe cable to the DIGITAL Dn - D0 connector on
the front panel of the mixed- signal oscilloscope. The digital probe cable
is keyed so you can connect it only one way. You do not need to
power- off the oscilloscope.

CAUTION

Probe cable for digital channels
Use only the Agilent logic probe and accessory kit supplied with the mixed-signal
oscilloscope (see "Accessories Available" on page 338).

3 Connect the ground lead on each set of channels (each pod), using a
probe grabber. The ground lead improves signal fidelity to the
oscilloscope, ensuring accurate measurements.
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Channel
Pod Ground

Circuit
Ground

4 Connect a grabber to one of the probe leads. (Other probe leads are
omitted from the figure for clarity.)

Grabber

5 Connect the grabber to a node in the circuit you want to test.
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6 For high- speed signals, connect a ground lead to the probe lead,
connect a grabber to the ground lead, and attach the grabber to ground
in the device under test.

Signal

Ground

Grabber

7 Repeat these steps until you have connected all points of interest.
Signals

Ground
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Acquiring waveforms using the digital channels
When you press [Run/Stop] or [Single] to run the oscilloscope, the
oscilloscope examines the input voltage at each input probe. When the
trigger conditions are met the oscilloscope triggers and displays the
acquisition.
For digital channels, each time the oscilloscope takes a sample it compares
the input voltage to the logic threshold. If the voltage is above the
threshold, the oscilloscope stores a 1 in sample memory; otherwise, it
stores a 0.

To display digital channels using AutoScale
When signals are connected to the digital channels — be sure to connect
the ground leads — AutoScale quickly configures and displays the digital
channels.
• To configure the instrument quickly, press the [AutoScale] key.

Figure 20

Example: AutoScale of digital channels (MSO models only)
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Any digital channel with an active signal will be displayed. Any digital
channels without active signals will be turned off.
• To undo the effects of AutoScale, press the Undo AutoScale softkey before
pressing any other key.
This is useful if you have unintentionally pressed the [AutoScale] key or do
not like the settings AutoScale has selected. This will return the
oscilloscope to its previous settings. See also: "How AutoScale Works" on
page 33.
To set the instrument to the factory- default configuration, press the
[Default Setup] key.

Interpreting the digital waveform display
The following figure shows a typical display with digital channels.
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Delay
time

Time/
div

Trigger
mode or
run status

Trigger
type and
source
Threshold
level

Activity
indicators

Digital
channel
identifiers

Waveform
size

Activity indicator

Turn
individual
channels
on/off

Turn
groups of
channels
on/off

Threshold
menu key

When any digital channels are turned on, an activity indicator is displayed
in the status line at the bottom of the display. A digital channel can be
always high ( ), always low ( ), or actively toggling logic states ( ). Any
channel that is turned off will be grayed out in the activity indicator.

To change the displayed size of the digital channels
1 Press the [Digital] key.
2 Press the size (
displayed.

) softkey to select how the digital channels are
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The sizing control lets you spread out or compress the digital traces
vertically on the display for more convenient viewing.

To switch a single channel on or off
1 With the Digital Channel Menu displayed, rotate the Entry knob to
select the desired channel from the popup menu.
2 Push the Entry knob or press the softkey that is directly below the
popup menu to switch the selected channel on or off.

To switch all digital channels on or off
1 Press the [Digital] key to toggle the display of digital channels. The
Digital Channel Menu is displayed above the softkeys.
If you want to switch the digital channels off, and the Digital Channel
Menu is not already displayed, you must push the [Digital] key twice to
switch the digital channels off. The first push displays the Digital Channel
Menu, and the second push switches the channels off.

To switch groups of channels on or off
1 Press the [Digital] key on the front panel if the Digital Channel Menu is
not already displayed.
2 Press the Turn off (or Turn on) softkey for the D15 - D8 group or the D7 - D0
group.
Each time you press the softkey, the softkey's mode toggles between Turn on
and Turn off.

To change the logic threshold for digital channels
1 Press the [Digital] key so that the Digital Channel Menu is displayed.
2 Press the Thresholds softkey
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3 Press the D15 - D8 or D7 - D0 softkey, then select a logic family preset or
select User to define your own threshold.
Logic family

Threshold Voltage

TTL

+1.4 V

CMOS

+2.5 V

ECL

–1.3 V

User

Variable from –8 V to +8 V

The threshold you set applies to all channels within the selected D15 - D8
or D7 - D0 group. Each of the two channel groups can be set to a
different threshold if desired.
Values greater than the set threshold are high (1) and values less than the
set threshold are low (0).
If the Thresholds softkey is set to User, press the User softkey for the
channel group, then turn the Entry knob to set the logic threshold. There
is one User softkey for each group of channels.

To reposition a digital channel
1 Make sure the multiplexed scale and position knobs to the right of the
key are selected for digital channels.
If the arrow to the left of the [Digital] key is not illuminated, press the
key.
2 Use the multiplexed Select knob to select the channel.
The selected waveform is highlighted in red.
3 Use the multiplexed Position knob to move the selected channel
waveform.
If a channel waveform is repositioned over another channel waveform,
the indicator at the left edge of the trace will change from Dnn
designation (where nn is a one or two digit channel number) to D*. The
"*" indicates that two channels are overlaid.
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To display digital channels as a bus
Digital channels may be grouped and displayed as a bus, with each bus
value displayed at the bottom of the display in hex or binary. You can
create up to two buses. To configure and display each bus, press the
[Digital] key on the front panel. Then press the Bus softkey.

Next, select a bus. Rotate the Entry knob, then press the Entry knob or
the Bus1/Bus2 softkey to switch it on.
Use the Channel softkey and the Entry knob to select individual channels
to be included in the bus. You can rotate the Entry knob and push it or
push the softkey to select channels. You can also press the Select/Deselect
D15-D8 and Select/Deselect D7-D0 softkeys to include or exclude groups of
eight channels in each bus.

If the bus display is blank, completely white, or if the display includes "...",
you need to expand the horizontal scale to allow space for the data to be
shown, or use the cursors to display the values (see "Using cursors to read
bus values" on page 115).
The Base softkey lets you choose to display the bus values in hex or
binary.
The buses are shown at the bottom of the display.
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Bus values can be shown in hex or binary.
Using cursors to
read bus values

To read the digital bus value at any point using the cursors:
1 Turn on Cursors (by pressing the [Cursors] key on the front panel)
2 Press the cursor Mode softkey and change the mode to Hex or Binary.
3 Press the Source softkey and select Bus1 or Bus2.
4 Use the Entry knob and the X1 and X2 softkeys to position the cursors
where you want to read the bus values.
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X1 cursor
X2 cursor

Bus values

Set cursors
mode to
Binary or Hex

Bus values are
displayed when
using Pattern
trigger

Select Bus1
or Bus2 source

Bus values
at cursors
shown here

The bus values are also displayed when using the Pattern trigger function.
Press the [Pattern] key on the front panel to display the Pattern Trigger
Menu and the bus values will be displayed on the right, above the
softkeys.
The dollar sign ($) will be displayed in the bus value when the bus value
cannot be displayed as a hex value. This occurs when one or more "don't
cares" (X) are combined with low (0) and high (1) logic levels in the
pattern specification, or when a transition indicator — rising edge ( ) or
falling edge ( ) — are included in the pattern specification. A byte that
consists of all don't cares (X) will be displayed in the bus as a don't care
(X).
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See "Pattern Trigger" on page 152 for more information on Pattern
triggering.

Digital channel signal fidelity: Probe impedance and grounding
When using the mixed- signal oscilloscope you may encounter problems
that are related to probing. These problems fall into two categories: probe
loading and probe grounding. Probe loading problems generally affect the
device under test, while probe grounding problems affect the accuracy of
the data to the measurement instrument. The design of the probes
minimizes the first problem, while the second is easily addressed by good
probing practices.
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Input Impedance
The logic probes are passive probes, which offer high input impedance and
high bandwidths. They usually provide some attenuation of the signal to
the oscilloscope, typically 20 dB.
Passive probe input impedance is generally specified in terms of a parallel
capacitance and resistance. The resistance is the sum of the tip resistor
value and the input resistance of the test instrument (see the following
figure). The capacitance is the series combination of the tip compensating
capacitor and the cable, plus instrument capacitance in parallel with the
stray tip capacitance to ground. While this results in an input impedance
specification that is an accurate model for DC and low frequencies, the
high- frequency model of the probe input is more useful (see the following
figure). This high- frequency model takes into account pure tip capacitance
to ground as well as series tip resistance, and the cable's characteristic
impedance (Zo).

Figure 21
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DC and Low-Frequency Probe Equivalent Circuit
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High-Frequency Probe Equivalent Circuit

The impedance plots for the two models are shown in these figures. By
comparing the two plots, you can see that both the series tip resistor and
the cable's characteristic impedance extend the input impedance
significantly. The stray tip capacitance, which is generally small (1 pF),
sets the final break point on the impedance chart.
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Figure 23

Impedance versus Frequency for Both Probe Circuit Models

The logic probes are represented by the high- frequency circuit model
shown above. They are designed to provide as much series tip resistance
as possible. Stray tip capacitance to ground is minimized by the proper
mechanical design of the probe tip assembly. This provides the maximum
input impedance at high frequencies.

Probe Grounding
A probe ground is the low- impedance path for current to return to the
source from the probe. Increased length in this path will, at high
frequencies, create large common mode voltages at the probe input. The
voltage generated behaves as if this path were an inductor according to
the equation:

di
V = L dt
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Increasing the ground inductance (L), increasing the current (di) or
decreasing the transition time (dt), will all result in increasing the voltage
(V). When this voltage exceeds the threshold voltage defined in the
oscilloscope, a false data measurement will occur.
Sharing one probe ground with many probes forces all the current that
flows into each probe to return through the same common ground
inductance of the probe whose ground return is used. The result is
increased current (di) in the above equation, and, depending on the
transition time (dt), the common mode voltage may increase to a level that
causes false data generation.

Probe 1

Z in
i1
L (GND)

Probe
Ground

Vn (Common Mode)

i1+i 2+i n

i2 +i n
Probe 2

Z in

in

Probe N

Figure 24

Z in

Common Mode Input Voltage Model

In addition to the common mode voltage,longer ground returns also
degrade the pulse fidelity of the probe system. Rise time is increased, and
ringing, due to the undamped LC circuit at the input of the probe, is also
increased. Because the digital channels display reconstructed waveforms,
they do not show ringing and perturbations. You will not find ground
problems through examination of the waveform display. In fact, it is likely
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you will discover the problem through random glitches or inconsistent
data measurements. Use the analog channels to view ringing and
perturbations.

Best Probing Practices
Because of the variables L, di, and dt, you may be unsure how much
margin is available in your measurement setup. The following are
guidelines for good probing practices:
• The ground lead from each digital channel group (D15–D8 and D7–D0)
should be attached to the ground of the device under test if any
channel within the group is being used for data capture.
• When capturing data in a noisy environment, every third digital channel
probe's ground should be used in addition to the channel group's
ground.
• High- speed timing measurements (rise time < 3 ns) should make use of
each digital channel probe's own ground.
When designing a high- speed digital system, you should consider designing
dedicated test ports that interface directly to the instrument's probe
system. This will ease measurement setup and ensure a repeatable method
for obtaining test data. The 01650- 61607 16- channel logic probe cable and
the 01650- 63203 termination adapter are designed to make it easy to
connect to industry- standard, 20- pin board connectors. The cable is a 2 m
logic analyzer probe cable, and the termination adapter provides the
proper RC networks in a very convenient package. These parts, as well as
the 1251- 8106 20- pin, low- profile, straight board connector, can be
ordered from Agilent Technologies.

To replace digital probe leads
If you need to remove a probe lead from the cable, insert a paper clip or
other small pointed object into the side of the cable assembly, and push to
release the latch while pulling out the probe lead.
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Digital Probe Replacement Parts

Part Number

Description

N6450-60001

Digital probe kit, contains: 54620-61601 16-channel cable,
01650-82103 2-inch probe grounds (qty 5), and 5090-4832
grabbers (qty 20)

54620-61601

16-channel cable with 16 probe leads and 2 pod ground leads
(qty 1)

5959-9333

Replacement probe leads (qty 5), also contains 01650-94309
probe labels

5959-9334

Replacement 2-inch probe grounds (qty 5)

5959-9335

Replacement pod ground leads (qty 5)

5090-4833

Grabbers (qty 20)

01650-94309

Package of probe labels

For other replacement parts, consult the InfiniiVision 2000/3000 X- Series
Oscilloscopes Service Guide.
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Serial Decode
Serial Decode Options 125
Lister 126
Searching Lister Data 128

Triggering on
Serial Data

In some cases, such as when triggering on a slow serial signal (for
example, I2C, SPI, CAN, LIN, etc.) it may be necessary to switch from the
Auto trigger mode to the Normal trigger mode to prevent the oscilloscope
from Auto- triggering and stabilize the display. You can select the trigger
mode by pressing the [Mode/Coupling] key, then the Mode softkey.
Also, the threshold voltage level must be set appropriately for each source
channel. The threshold level for each serial signal can be set in the Signals
Menu. Press the [Serial] key, then the Signals softkey.

Serial Decode Options
Agilent's hardware- accelerated serial decode options can be installed when
the oscilloscope is manufactured, or added later. The following serial
decode licenses are available:
• With the DSOX3AUTO license, you can decode CAN (Controller Area
Network) and LIN (Local Interconnect Network) serial buses. See:
• "CAN Serial Decode" on page 355.
• "LIN Serial Decode" on page 363.
• With the DSOX3FLEX license, you can decode FlexRay serial buses. See
"FlexRay Serial Decode" on page 371.

s1

125

7

Serial Decode

• With the DSOX3EMBD license, you can decode I2C (Inter- IC) and SPI
(Serial Peripheral Interface) serial buses. See:
• "I2C Serial Decode" on page 382.
• "SPI Serial Decode" on page 391.
• With the DSOX3AUDIO license, you can decode I2S (Inter- IC Sound or
Integrated Interchip Sound) serial buses. See "I2S Serial Decode" on
page 403.
• With the DSOX3COMP license, you can decode many UART (Universal
Asynchronous Receiver/Transmitter) protocols including RS232
(Recommended Standard 232). See "UART/RS232 Serial Decode" on
page 427.
• With the DSOX3AERO license, you can decode MIL- STD- 1553 and
ARINC 429 serial buses. See:
• "MIL- STD- 1553 Serial Decode" on page 410.
• "ARINC 429 Serial Decode" on page 417.
To determine whether these licenses are installed on your oscilloscope, see
"To display oscilloscope information" on page 309.
To order serial decode licenses, go to "www.agilent.com" and search for the
product number (for example, DSOX3AUTO) or contact your local Agilent
Technologies representative (see "www.agilent.com/find/contactus)."

Lister
Lister is a powerful tool for investigating protocol failures. You can use
Lister to view large amounts of packet level serial data in a tabular
format, including time tags and specific decoded values. After pressing the
[Single] key, you can press the Scroll Lister softkey and then rotate the
Entry knob to select an event and press the Zoom to Selection softkey to
jump to the event.
To use the Lister:
1 Set up trigger and decode on the serial data signals to be analyzed.
2 Press [Serial] > Lister.
3 Press Display; then, turn the Entry knob to select the serial slot (Serial 1
or Serial 2) on which the serial bus signals are being decoded. (If you
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select All, the decode information for different buses is interleaved in
time.)

Before you can select a row or navigate through the Lister data,
oscilloscope acquisitions must be stopped.
4 Press the [Single] key (in the Run Control group on the front panel) to
stop the acquisition.
Pressing [Single] instead of [Stop] fills the maximum memory depth.
When zoomed out and viewing a large number of packets, the Lister
may not be able to display information for all packets. However, when
you press the [Single] key the Lister will contain all on- screen serial
decode information.
5 Press the Scroll Lister softkey and use the Entry knob to scroll through
the data.
Time tags in the Time column indicate the event time relative to the
trigger point. The time tags of events that are shown in the waveform
display area are displayed with a dark background.
6 Press the Zoom to Selection softkey (or push the Entry knob) to center
the waveform display at the time associated with the selected Lister
row and automatically set the horizontal scale setting.
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7 Press the Undo Zoom softkey to return to the horizontal scale and delay
settings before the last Zoom to Selection.
8 Press the Options softkey to open the Lister Options Menu. In this menu,
you can:
• Enable or disable the Track Time option. When enabled, as you select
different Lister rows (using the Entry knob while acquisitions are
stopped), the horizontal delay changes to the Time of the selected
row. Also, changing the horizontal delay will scroll the Lister.
• Press the Scroll Lister softkey and use the Entry knob to scroll though
data rows in the Lister display.
• Press the Time Ref softkey and use the Entry knob to select whether
the Time column in the Lister display shows times relative to the
trigger or relative to the previous packet row.

Searching Lister Data
When serial decode is enabled, you can use the [Search] key to find and
place marks on rows in the Lister.
The Search softkey lets you specify events to find. It is similar to
specifying protocol triggers.
Events found are marked in orange in the far left Lister column. The total
number of events found is displayed above the softkeys.
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Each serial decode option lets you find protocol- specific headers, data,
errors, etc. See:
• "Searching for ARINC 429 Data in the Lister" on page 421
• "Searching for CAN Data in the Lister" on page 359
• "Searching for FlexRay Data in the Lister" on page 374
• "Searching for I2C Data in the Lister" on page 385
• "Searching for I2S Data in the Lister" on page 405
• "Searching for LIN Data in the Lister" on page 366
• "Searching for MIL- STD- 1553 Data in the Lister" on page 413
• "Searching for SPI Data in the Lister" on page 394
• "Searching for UART/RS232 Data in the Lister" on page 431
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To adjust the grid intensity 135
To freeze the display 135

To adjust waveform intensity
You can adjust the intensity of displayed waveforms to account for various
signal characteristics, such as fast time/div settings and low trigger rates.
Increasing the intensity lets you see the maximum amount of noise and
infrequently occurring events.
Reducing the intensity can expose more detail in complex signals as
shown in the following figures.
1 Press the [Intensity] key to illuminate it.
This key is located just below the Entry knob.
2 Turn the Entry knob to adjust the waveform instensity.
Waveform intensity adjustment affects analog channel waveforms only (not
math waveforms, referencewaveforms, digital waveforms, etc.).
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Figure 25

Amplitude Modulation Shown at 100% Intensity

Figure 26

Amplitude Modulation Shown at 40% Intensity
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To set or clear persistence
With persistence, the oscilloscope updates the display with new
acquisitions, but does not immediately erase the results of previous
acquisitions. All previous acquisitions are displayed with reduced
intensity. New acquisitions are shown in their normal color with normal
intensity.
Waveform persistence is kept only for the current display area; you cannot
pan and zoom the persistence display.
To use persistence:
1 Press the [Display] key.

2 Press Persistence; then, turn the Entry knob to select between:
• Off — turns off persistence.
When persistence is off, you can press the Capture Waveforms softkey
to perform a single- shot infinite persistence. A single acquisition's
data is displayed with reduced intensity, and it remains on the
display until you clear persistence or clear the display.
• ∞ Persistence — (infinite presistence) Results of previous acquisitions
are never erased.
Use infinite persistence to measure noise and jitter, to see the
worst- case extremes of varying waveforms, to look for timing
violations, or to capture events that occur infrequently.
• Variable Persistence — Results of previous acquisitions are erased after
a certain amount of time.
Variable persistence gives you a view of acquired data that is similar
to analog oscilloscopes.
When variable persistence is selected, press the Time softkey and use
the Entry knob to specify the amount of time that previous
acquisitions are to be displayed.
The display will begin accumulating multiple acquisitions.
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3 To erase the results of previous acquisitions from the display, press the
Clear Persistence softkey.
The oscilloscope will start to accumulate acquisitions again.
4 To return the oscilloscope to the normal display mode, turn off
persistence; then, press the Clear Persistence softkey.
Turning off persistence does not clear the display. The display is
cleared if you press the Clear Display softkey or if you press the
[AutoScale] key (which also turns off persistence).
For another method of seeing worst- case extremes of varying waveforms,
see "Glitch or Narrow Pulse Capture" on page 195.

To clear the display
1 Press [Display] > Clear Display.
You can also configure the [Quick Action] key to clear the display. See
"Configuring the [Quick Action] Key" on page 311.

To select the grid type
When the Video trigger type is selected (see "Video Trigger" on page 163),
and the vertical scaling of at least one displayed channel is 140 mV/div,
the Grid softkey lets you select from these grid types:
• Full — the normal oscilloscope grid.
• mV — shows vertical grids, labeled on the left, from - 0.3 V to 0.8 V.
• IRE — (Institute of Radio Engineers) shows vertical grids in IRE units,
labeled on the left, from - 40 to 100 IRE. The 0.35 V and 0.7 V levels
from the mV grid are also shown and labeled at the right. When the IRE
grid is selected, cursor values are also shown in IRE units. (Cursor
values via the remote interface are not in IRE units.)
The mV and IRE grid values are accurate (and match Y cursor values)
when the vertical scaling is 140 mV/division and the vertical offset is
245 mV.
To select the grid type:
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1 Press [Display].
2 Press the Grid softkey; then, turn the Entry knob
type.

to select the grid

To adjust the grid intensity
To adjust the display grid (graticule) intensity:
1 Press [Display].
2 Press the Intensity softkey; then, turn the Entry knob
intensity of the displayed grid.

to change the

The intensity level is shown in the Intensity softkey and is adjustable from
0 to 100%.
Each major vertical division in the grid corresponds to the vertical
sensitivity shown in the status line at the top of the display.
Each major horizontal division in the grid corresponds to the time/div
shown in the status line at the top of the display.

To freeze the display
To freeze the display without stopping running acquisitions, you must
configure the [Quick Action] key. See "Configuring the [Quick Action]
Key" on page 311.
1 Once the [Quick Action] key has been configured, press it to freeze the
display.
2 To un- freeze the display, press [Quick Action] again.
Manual cursors can be used on the frozen display.
Many activities, such as adjusting the trigger level, adjusting vertical or
horizontal settings, or saving data will un- freeze the display.
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To turn the label display on or off 137
To assign a predefined label to a channel 138
To define a new label 139
To load a list of labels from a text file you create 140
To reset the label library to the factory default 141

You can define labels and assign them to each analog input channel, or
you can turn labels off to increase the waveform display area. Labels can
also be applied to digital channels on MSO models.

To turn the label display on or off
1 Press the [Label] key on the front panel.
This turns on labels for the displayed analog and digital channels.
Labels are displayed at the left edge of the displayed traces.
The figure below shows an example of displayed labels.
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2 To turn the labels off, press the [Label] key again.

To assign a predefined label to a channel
1 Press the [Label] key.
2 Press the Channel softkey, then turn the Entry knob or successively
press the Channel softkey to select a channel for label assignment.
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The figure above shows the list of channels and their default labels. The
channel does not have to be turned on to have a label assigned to it.
3 Press the Library softkey, then turn the Entry knob or successively press
the Library softkey to select a predefined label from the library.
4 Press the Apply New Label softkey to assign the label to your selected
channel.
5 Repeat the above procedure for each predefined label you want to
assign to a channel.

To define a new label
1 Press the [Label] key.
2 Press the Channel softkey; then, turn the Entry knob or successively
press the softkey to select a channel for label assignment.
The channel does not have to be turned on to have a label assigned to
it. If the channel is turned on, its current label will be highlighted.
3 Press the Spell softkey; then, turn the Entry knob to select the first
character in the new label.
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Turning the Entry knob selects a character to enter into the highlighted
position shown in the "New label =" line above the softkeys and in the
Spell softkey. Labels can be up to ten characters in length.
4 Press the Enter softkey to enter the selected character and to go to the
next character position.
5 You may position the highlight on any character in the label name by
successively pressing the Enter softkey.
6 To delete a character from the label, press the Enter softkey until the
letter you want to delete is highlighted, then press the Delete Character
softkey.

NOTE

You can use a connected USB keyboard instead of using the Spell (and other) character
editing softkeys.

7 When you are done entering characters for the label, press the
Apply New Label softkey to assign the label to the selected channel.
When you define a new label, it is added to the nonvolatile label list.
Label Assignment
Auto-Increment

When you assign a label ending in a digit, such as ADDR0 or DATA0, the
oscilloscope automatically increments the digit and displays the modified
label in the "New label" field after you press the Apply New Label softkey.
Therefore, you only need to select a new channel and press the Apply New
Label softkey again to assign the label to the channel. Only the original
label is saved in the label list. This feature makes it easier to assign
successive labels to numbered control lines and data bus lines.

To load a list of labels from a text file you create
It may be convenient to create a list of labels using a text editor, then
load the label list into the oscilloscope. This lets you type on a keyboard
rather than edit the label list using the oscilloscope's controls.
You can create a list of up to 75 labels and load it into the oscilloscope.
Labels are added to the beginning of the list. If more than 75 labels are
loaded, only the first 75 are stored.
To load labels from a text file into the oscilloscope:
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1 Use a text editor to create each label. Each label can be up to ten
characters in length. Separate each label with a line feed.
2 Name the file labellist.txt and save it on a USB mass storage device
such as a thumb drive.
3 Load the list into the oscilloscope using the File Explorer (press [Utility]
> File Explorer).

NOTE

Label List Management
When you press the Library softkey, you will see a list of the last 75 labels used. The list
does not save duplicate labels. Labels can end in any number of trailing digits. As long as
the base string is the same as an existing label in the library, the new label will not be put in
the library. For example, if label A0 is in the library and you make a new label called A12345,
the new label is not added to the library.
When you save a new user-defined label, the new label will replace the oldest label in the
list. Oldest is defined as the longest time since the label was last assigned to a channel.
Any time you assign any label to a channel, that label will move to the newest in the list.
Thus, after you use the label list for a while, your labels will predominate, making it easier
to customize the instrument display for your needs.
When you reset the label library list (see next topic), all of your custom labels will be
deleted, and the label list will be returned to its factory configuration.

To reset the label library to the factory default
NOTE

Pressing the Default Library softkey will remove all user-defined labels from the library and
set the labels back to the factory default. Once deleted, these user-defined labels cannot be
recovered.

1 Press [Utility] > Options > Preferences.
2 Press the Default Library softkey.
This will delete all user- defined labels from the library and set the
labels in the library back to the factory default. However, this does not
default the labels currently assigned to the channels (those labels that
appear in the waveform area).
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NOTE

Defaulting labels without erasing the default library
Pressing [Default Setup] sets all channel labels back to the default labels but does not
erase the list of user-defined labels in the library.
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A trigger setup tells the oscilloscope when to acquire and display data.
For example, you can set up to trigger on the rising edge of the analog
channel 1 input signal.
You can adjust the vertical level used for analog channel edge detection by
turning the Trigger Level knob.
In addition to the edge trigger type, you can also set up triggers on
rise/fall times, Nth edge bursts, patterns, pulse widths, runt pulses, setup
and hold violations, TV signals, USB signals, and serial signals (if option
licenses are installed).
You can use any input channel or the "External Trigger Input" on
page 184 BNC as the source for most trigger types.

s1
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Changes to the trigger setup are applied immediately. If the oscilloscope is
stopped when you change a trigger setup, the oscilloscope uses the new
specification when you press [Run/Stop] or [Single]. If the oscilloscope is
running when you change a trigger setup, it uses the new trigger
definition when it starts the next acquisition.
You can use the [Force Trigger] key to acquire and display data when
triggers are not occurring.
You can use the [Mode/Coupling] key to set options that affect all trigger
types (see Chapter 11, “Trigger Mode/Coupling,” starting on page 179).
You can save trigger setups along with the oscilloscope setup (see
Chapter 18, “Save/Recall (Setups, Screens, Data),” starting on page 275).
Triggers - General
Information

A triggered waveform is one in which the oscilloscope begins tracing
(displaying) the waveform, from the left side of the display to the right,
each time a particular trigger condition is met. This provides stable
display of periodic signals such as sine waves and square waves, as well
as nonperiodic signals such as serial data streams.
The figure below shows the conceptual representation of acquisition
memory. You can think of the trigger event as dividing acquisition memory
into a pre- trigger and post- trigger buffer. The position of the trigger event
in acquisition memory is defined by the time reference point and the
delay (horizontal position) setting (see "To adjust the horizontal delay
(position)" on page 51).
Trigger Event

Pre-Trigger Buffer

Post-Trigger Buffer

Acquisition Memory
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Adjusting the Trigger Level
You can adjust the trigger level for a selected analog channel by turning
the Trigger Level knob.
You can push the Trigger Level knob to set the level to the waveform's
50% value. If AC coupling is used, pushing the Trigger Level knob sets the
trigger level to about 0 V.
The position of the trigger level for the analog channel is indicated by the
trigger level icon T (if the analog channel is on) at the far left side of the
display. The value of the analog channel trigger level is displayed in the
upper- right corner of the display.
The trigger level for a selected digital channel is set using the threshold
menu in the Digital Channel Menu. Press the [Digital] key on the front
panel, then press the Thresholds softkey to set the threshold level (TTL,
CMOS, ECL, or user defined) for the selected digital channel group. The
threshold value is displayed in the upper- right corner of the display.
The line trigger level is not adjustable. This trigger is synchronized with
the power line supplied to the oscilloscope.

NOTE

You can also change the trigger level of all channels by pressing [Analyze] > Features and
then selecting Trigger Levels.

Forcing a Trigger
The [Force Trigger] key causes a trigger (on anything) and displays the
acquisition.
This key is useful in the Normal trigger mode where acquisitions are made
only when the trigger condition is met. In this mode, if no triggers are
occurring (that is, the "Trig'd?" indicator is displayed), you can press [Force
Trigger] to force a trigger and see what the input signals look like.
In the Auto trigger mode, when the trigger condition is not met, triggers
are forced and the "Auto?" indicator is displayed.
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Edge Trigger
The Edge trigger type identifies a trigger by looking for a specified edge
(slope) and voltage level on a waveform. You can define the trigger source
and slope in this menu. The trigger type, source, and level are displayed in
the upper- right corner of the display.
1 On the front panel, in the Trigger section, press the [Trigger] key.
2 In the Trigger Menu, press the Trigger softkey, and use the Entry knob
to select Edge.
3 Select the trigger source:
• Analog channel, 1 to the number of channels
• Digital channel (on mixed- signal oscilloscopes), D0 to the number of
digital channels minus one.
• External — triggers on the rear panel EXT TRIG IN signal.
• Line — triggers at the 50% level of the rising or falling edge of the AC
power source signal.
• WaveGen — triggers at the 50% level of the rising edge of the
waveform generator output signal. (Not available when the DC, Noise,
or Cardiac waveforms are selected.)
You can choose a channel that is turned off (not displayed) as the
source for the edge trigger.
The selected trigger source is indicated in the upper- right corner of the
display next to the slope symbol:
• 1 through 4 = analog channels.
• D0 through Dn = digital channels.
• E = External trigger input.
• L = Line trigger.
• W = Waveform generator.
4 Press the Slope softkey and select rising edge, falling edge, alternating
edges, or either edge (depending on the selected source). The selected
slope is displayed in the upper- right corner of the display.
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Alternating edge mode is useful when you want to trigger on both edges of a clock (for
example, DDR signals).
Either edge mode is useful when you want to trigger on any activity of a selected source.
All modes operate up to the bandwidth of the oscilloscope except Either edge mode, which
has a limitation. Either edge mode will trigger on Constant Wave signals up to 100 MHz, but
can trigger on isolated pulses down to 1/(2*oscilloscope's bandwidth).

Using AutoScale
to Set Up Edge
Triggers

NOTE

The easiest way to set up an Edge trigger on a waveform is to use
AutoScale. Simply press the [AutoScale] key and the oscilloscope will
attempt to trigger on the waveform using a simple Edge trigger type. See
"Use Auto Scale" on page 32.

MegaZoom Technology Simplifies Triggering
With the built-in MegaZoom technology, you can simply AutoScale the waveforms, then
stop the oscilloscope to capture a waveform. You can then pan and zoom through the data
using the Horizontal and Vertical knobs to find a stable trigger point. AutoScale often
produces a triggered display.
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Edge then Edge Trigger
The Edge then Edge trigger mode triggers when the Nth edge occurs after
an arming edge and a delay period.
The arm and trigger edges can be specified as
edges on analog or digital channels.

(Rising) or

(Falling)

1 Press the [Trigger] key.
2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select Edge then Edge.

3 Press the Sources softkey.
4 In the Edge then edge Sources Menu:
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a Press the Arm A softkey, and turn the Entry knob to select the
channel on which the arming edge will occur.
b Press the Slope A softkey to specify which edge of the Arm A signal
will arm the oscilloscope.
c Press the Trigger B softkey, and turn the Entry knob to select the
channel on which the trigger edge will occur.
d Press the Slope B softkey to specify which edge of the Trigger B
signal will trigger the oscilloscope.
Adjust the trigger level for the selected analog channel by turning the
Trigger Level knob. Press the [Digital] key and select Thresholds to set
the threshold level for digital channels. The value of the trigger level or
digital threshold is displayed in the upper- right corner of the display.
5 Press the

Back

Back/Up key to return to the Trigger Menu.

6 Press the Delay softkey; then, turn the Entry knob to enter the delay
time between the Arm A edge and the Trigger B edge.
7 Press the Nth Edge B softkey; then, turn the Entry knob to select the Nth
edge of the Trigger B signal to trigger on.

Pulse Width Trigger
Pulse Width (glitch) triggering sets the oscilloscope to trigger on a positive
or negative pulse of a specified width. If you want to trigger on a specific
timeout value, use Pattern trigger in the Trigger Menu (see "Pattern
Trigger" on page 152).
1 Press the [Trigger] key.
2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select Pulse Width.

Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

149

10 Triggers

3 Press the Source softkey; then, rotate the Entry knob to select a channel
source for the trigger.
The channel you select is shown in the upper- right corner of the
display next to the polarity symbol.
The source can be any analog or digital channel available on your
oscilloscope.
4 Adjust the trigger level:
• For analog channels, turn the Trigger Level knob.
• For digital channels, press the [Digital] key and select Thresholds to set
the threshold level.
The value of the trigger level or digital threshold is displayed in the
upper- right corner of the display.
5 Press the pulse polarity softkey to select positive (
polarity for the pulse width you want to capture.

) or negative (

)

The selected pulse polarity is displayed in the upper- right corner of the
display. A positive pulse is higher than the current trigger level or
threshold and a negative pulse is lower than the current trigger level or
threshold.
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When triggering on a positive pulse, the trigger will occur on the high
to low transition of the pulse if the qualifying condition is true. When
triggering on a negative pulse, the trigger will occur on the low to high
transition of the pulse if the qualifying condition is true.
6 Press the qualifier softkey (< > ><) to select the time qualifier.
The Qualifier softkey can set the oscilloscope to trigger on a pulse
width that is:
• Less than a time value (<).
For example, for a positive pulse, if you set t<10 ns:
10 ns

10 ns

Trigger

• Greater than a time value (>).
For example, for a positive pulse, if you set t>10 ns:
10 ns

10 ns

Trigger

• Within a range of time values (><).
For example, for a positive pulse, if you set t>10 ns and t<15 ns:
10 ns

15 ns

12 ns

Trigger

7 Select the qualifier time set softkey (< or >), then rotate the Entry
knob to set the pulse width qualifier time.
The qualifiers can be set as follows:
• 2 ns to 10 s for > or < qualifier (5 ns to 10 s for 350 MHz
bandwidth models).
• 10 ns to 10 s for >< qualifier, with minimum difference of 5 ns
between upper and lower settings.
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Pulse width
trigger < qualifier
time set softkey

• When the less than (<) qualifier is selected, the Entry knob sets the
oscilloscope to trigger on a pulse width less than the time value
displayed on the softkey.
• When the time range (><) qualifier is selected, the Entry knob sets the
upper time range value.

Pulse width
trigger > qualifier
time set softkey

• When the greater than (>) qualifier is selected, the Entry knob sets the
oscilloscope to trigger on a pulse width greater than the time value
displayed on the softkey.
• When the time range (><) qualifier is selected, the Entry knob sets the
lower time range value.

Pattern Trigger
The Pattern trigger identifies a trigger condition by looking for a specified
pattern. This pattern is a logical AND combination of the channels. Each
channel can have a value of 0 (low), 1 (high), or don't care (X). A rising
or falling edge can be specified for one channel included in the pattern.
You can also trigger on a hex bus value as described on "Hex Bus Pattern
Trigger" on page 155.
1 Press the [Trigger] key.
2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select Pattern.
3 Press the Qualifier softkey; then, turn the Entry knob to select from the
pattern duration qualifier options:
• Entered – when the pattern is entered.
• < (Less Than) – when the pattern is present for less than a time
value.
• > (Greater Than) – when the pattern is present for greater than a
time value. The trigger occurs when the pattern exits (not when the
> softkey time value is exceeded).
• Timeout – when the pattern is present for greater than a time value.
In this case, the trigger occurs when the > softkey time value is
exceeded (not when the pattern exits).
• >< (In Range) – when the pattern is present for a time within a range
of values.
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• <> (Out of Range) – when the pattern is present for a time outside of
range of values.
Pattern durations are evaluated using a timer. The timer starts on the
last edge that makes the pattern (logical AND) true. Except when the
Timeout qualifier is selected, the trigger occurs on the first edge that
makes the pattern false, provided the time qualifier criteria has been
met.
The time values for the selected qualifier are set using the qualifier
time set softkeys (< and >) and the Entry knob.
4 For each analog or digital channel you want to include in the desired
pattern, press the Channel softkey to select the channel.
This is the channel source for the 0, 1, X, or edge condition. As you
press the Channel softkey (or rotate the Entry knob), the channel you
select is highlighted in the Pattern = line directly above the softkeys
and in the upper- right corner of the display next to "Pat".
Adjust the trigger level for the selected analog channel by turning the
Trigger Level knob. Press the [Digital] key and select Thresholds to set
the threshold level for digital channels. The value of the trigger level or
digital threshold is displayed in the upper- right corner of the display.
5 For each channel you select, press the Pattern softkey; then, turn the
Entry knob to set the condition for that channel in the pattern.
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• 0 sets the pattern to zero (low) on the selected channel. A low is a
voltage level that is less than the channel's trigger level or threshold
level.
• 1 sets the pattern to 1 (high) on the selected channel. A high is a
voltage level that is greater than the channel's trigger level or
threshold level.
• X sets the pattern to don't care on the selected channel. Any channel
set to don't care is ignored and is not used as part of the pattern.
However, if all channels in the pattern are set to don't care, the
oscilloscope will not trigger.
• The rising edge ( ) or falling edge ( ) softkey sets the pattern to an
edge on the selected channel. Only one rising or falling edge can be
specified in the pattern. When an edge is specified, the oscilloscope
will trigger at the edge specified if the pattern set for the other
channels is true.
If no edge is specified, the oscilloscope will trigger on the last edge
that makes the pattern true.
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NOTE

Specifying an Edge in a Pattern
You are allowed to specify only one rising or falling edge term in the pattern. If you define an
edge term, then select a different channel in the pattern and define another edge term, the
previous edge definition is changed to a don't care.

Hex Bus Pattern Trigger
You can specify a bus value on which to trigger. To do this, first define
the bus. See "To display digital channels as a bus" on page 114 for details.
You can trigger on a bus value whether you are displaying the bus or not.
To trigger on a bus value:
1 Press the [Pattern] key on the front panel.
2 Press the Channel softkey and rotate the Entry knob to select Bus1 or
Bus2.
3 Press the Digit softkey and rotate the Entry knob to select a digit of the
selected bus.
4 Press the Hex softkey and rotate the Entry knob to select a value for
the digit.

NOTE

If a digit is made up of less than four bits, then the value of the digit will be limited to the
value that can be created by the selected bits.

5 You can use the Set all Digits softkey to set all digits to a particular
value.
When a hex bus digit contains one or more don't care (X) bits and one or
more bit with a value or 0 or 1, the "$" sign will be displayed for the digit.
For information regarding digital bus display when Pattern triggering see
"Bus values are displayed when using Pattern trigger" on page 116.

OR Trigger
The OR trigger mode triggers when any one (or more) of the specified
edges on analog or digital channels is found.
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1 On the front panel, in the Trigger section, press the [Trigger] key.
2 In the Trigger Menu, press the Trigger softkey, and use the Entry knob
to select OR.
3 Press the Slope softkey and select rising edge, falling edge, either edge,
or don't care. The selected slope is displayed in the upper- right corner
of the display.
4 For each analog or digital channel you want to include in the OR
trigger, press the Channel softkey to select the channel.
As you press the Channel softkey (or rotate the Entry knob), the channel
you select is highlighted in the OR = line directly above the softkeys
and in the upper- right corner of the display next to the OR gate
symbol.
Adjust the trigger level for the selected analog channel by turning the
Trigger Level knob. Press the [Digital] key and select Thresholds to set
the threshold level for digital channels. The value of the trigger level or
digital threshold is displayed in the upper- right corner of the display.
5 For each channel you select, press the Slope softkey and select
(Rising),
(Falling), (Either), or X (Don't Care). The selected slope is
displayed above the softkeys.
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If all channels in the OR trigger are set to don't care, the oscilloscope
will not trigger.
6 To set all analog and digital channels to the edge selected by the Slope
softkey, press the Set all Edges softkey.

Rise/Fall Time Trigger
The Rise/Fall Time trigger looks for a rising or falling transition from one
level to another level in greater than or less than a certain amount of
time.

High level

Low level
Rising edge time

Falling edge time

1 Press the [Trigger] key.
2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select Rise/Fall Time.
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3 Press the Source softkey, and turn the Entry knob to select the input
channel source.
4 Press the Rising Edge or Falling Edge softkey to toggle between edge types.
5 Press the Level Select softkey to select High; then, turn the Trigger Level
knob to adjust the high level.
6 Press the Level Select softkey to select Low; then, turn the Trigger Level
knob to adjust the low level.
You can also push the Trigger Level knob to toggle between High and
Low selection.
7 Press the Qualifier softkey to toggle between "greater than" or "less than".
8 Press the Time softkey, and turn the Entry knob to select the time.

Nth Edge Burst Trigger
The Nth Edge Burst trigger lets you trigger on the Nth edge of a burst that
occurs after an idle time.
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Nth Edge Burst trigger set up consists of selecting the source, the slope of
the edge, the idle time, and the number of the edge:
1 Press the [Trigger] key.
2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select Nth Edge Burst.

3 Press the Source softkey, and turn the Entry knob to select the input
channel source.
4 Press the Slope softkey to specify the slope of the edge.
5 Press the Idle softkey; then, turn the Entry knob to specify the idle
time.
6 Press the Edge softkey; then, turn the Entry knob to which edge number
to trigger on.
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Runt Trigger
The Runt trigger looks for pulses that cross one threshold but not another.

High level

Low level
Positive runt pulse

Negative runt pulse

• A positive runt pulse crosses through a lower threshold but not an
upper threshold.
• A negative runt pulse crosses through an upper threshold but not a
lower threshold.
To trigger on runt pulses:
1 Press the [Trigger] key.
2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select Runt.
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3 Press the Source softkey, and turn the Entry knob to select the input
channel source.
4 Press the Positive, Negative, or Either Runt Pulse softkey to toggle between
pulse types.
5 Press the Level Select softkey to select High; then, turn the Trigger Level
knob to adjust the high level.
6 Press the Level Select softkey to select Low; then, turn the Trigger Level
knob to adjust the low level.
You can also push the Trigger Level knob to toggle between High and
Low selection.
7 Press the Qualifier softkey to toggle between "less than", "greater than",
or None.
This lets you specify that a runt pulse be less than or greater than a
certain width.
8 If you selected the "less than" or "greater than" Qualifier, press the Time
softkey; then, turn the Entry knob to select the time.
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Setup and Hold Trigger
The Setup and Hold trigger looks for setup and hold violations.

Data

Clock
(rising
edge)
Setup time

Hold time

One oscilloscope channel probes the clock signal and another channel
probes the data signal.
To trigger on setup & hold violations:
1 Press the [Trigger] key.
2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select Setup and Hold.
3 Press the Clock softkey; then, turn the Entry knob to select the input
channel with the clock signal.
4 Set the appropriate trigger tevel for the clock signal using the Trigger
Level knob.
5 Press the Rising Edge or Falling Edge softkey to specify the clock edge being
used.
6 Press the Data softkey; then, turn the Entry knob to select the input
channel with the data signal.
7 Set the appropriate trigger tevel for the data signal using the Trigger
Level knob.
8 Press the < Setup softkey, and turn the Entry knob to select the setup
time.
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9 Press the < Hold softkey, and turn the Entry knob to select the hold
time.

Video Trigger
Video triggering can be used to capture the complicated waveforms of
most standard analog video signals. The trigger circuitry detects the
vertical and horizontal interval of the waveform and produces triggers
based on the video trigger settings you have selected.
The oscilloscope's MegaZoom IV technology gives you bright, easily viewed
displays of any part of the video waveform. Analysis of video waveforms is
simplified by the oscilloscope's ability to trigger on any selected line of the
video signal.

NOTE

It is important, when using a 10:1 passive probe, that the probe is correctly compensated.
The oscilloscope is sensitive to this and will not trigger if the probe is not properly
compensated, especially for progressive formats.

1 Press the [Trigger] key.
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2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select Video.

3 Press the Source softkey and select any analog channel as the video
trigger source.
The selected trigger source is displayed in the upper- right corner of the
display. Turning the Trigger Level knob does not change the trigger level
because the trigger level is automatically set to the sync pulse. Trigger
coupling is automatically set to TV in the Trigger Mode and Coupling
Menu.

NOTE

Provide Correct Matching
Many video signals are produced from 75 Ω sources. To provide correct matching to these
sources, a 75 Ω terminator (such as an Agilent 11094B) should be connected to the
oscilloscope input.

4 Press the sync polarity softkey to set the Video trigger to either positive
(

) or negative (

) sync polarity.

5 Press the Settings softkey.
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6 In the Video Trigger Menu, press the Standard softkey to set the video
standard.
The oscilloscope supports triggering on the following television (TV) and
video standards.
Standard

Type

Sync Pulse

NTSC

Interlaced

Bi-level

PAL

Interlaced

Bi-level

PAL-M

Interlaced

Bi-level

SECAM

Interlaced

Bi-level

With the DSOX3VID extended video triggering license, the oscilloscope
additionally supports these standards:
Standard

Type

Sync Pulse

Generic

Interlaced/Progressive

Bi-level/Tri-level

EDTV 480p/60

Progressive

Bi-level

EDTV 567p/50

Progressive

Bi-level

HDTV 720p/50

Progressive

Tri-level

HDTV 720p/60

Progressive

Tri-level

HDTV 1080p/24

Progressive

Tri-level

HDTV 1080p/25

Progressive

Tri-level

HDTV 1080p/30

Progressive

Tri-level

HDTV 1080p/50

Progressive

Tri-level

HDTV 1080p/60

Progressive

Tri-level

HDTV 1080i/50

Interlaced

Tri-level

HDTV 1080i/60

Interlaced

Tri-level
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The Generic selection lets you trigger on custom bi- level and tri- level
sync video standards. See "To set up Generic video triggers" on
page 168.
7 Press the Auto Setup softkey to automatically set up the oscilloscope for
the selected Source and Standard:
• Source channel vertical scaling is set to 140 mV/div.
• Source channel offset is set to 245 mV.
• Source channel is turned on.
• Trigger type is set to Video.
• Video trigger mode is set to All Lines (but left unchanged if Standard is
Generic).
• Display Grid type is set to IRE (when Standard is NTSC) or mV (see "To
select the grid type" on page 134).
• Horizontal time/division is set to 10 µs/div for NTSC/PAL/SECAM
standards or 4 µs/div for EDTV or HDTV standards (unchanged for
Generic).
• Horizontal delay is set so that trigger is at first horizontal division
from the left (unchanged for Generic).
You can also press [Analyze]> Features and then select Video to quickly
access the video triggering automatic set up and display options.
8 Press the Mode softkey to select the portion of the video signal that you
would like to trigger on.
The Video trigger modes available are:
• Field1 and Field2 — Trigger on the rising edge of the first serration
pulse of field 1 or field 2 (interlaced standards only).
• All Fields — Trigger on the rising edge of the first pulse in the vertical
sync interval.
• All Lines — Trigger on all horizontal sync pulses.
• Line — Trigger on the selected line number (EDTV and HDTV
standards only).
• Line: Field1 and Line:Field2 — Trigger on the selected line # in field 1 or
field 2 (interlaced standards only).
• Line: Alternate — Alternately trigger on the selected line # in field 1
and field 2 (NTSC, PAL, PAL- M, and SECAM only).
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9 If you select a line # mode, press the Line # softkey, then rotate the
Entry knob to select the line number on which you want to trigger.
The following table lists the line (or count) numbers per field for each
video standard.
Video standard

Field 1

Field 2

Alt Field

NTSC

1 to 263

1 to 262

1 to 262

PAL

1 to 313

314 to 625

1 to 312

PAL-M

1 to 263

264 to 525

1 to 262

SECAM

1 to 313

314 to 625

1 to 312

The following table lists the line numbers for each EDTV/HDTV video
standard (available with the DSOX3VID extended video triggering
license).

Video Triggering
Examples

EDTV 480p/60

1 to 525

EDTV 567p/50

1 to 625

HDTV 720p/50, 720p/60

1 to 750

HDTV 1080p/24, 1080p/25, 1080p/30,
1080p/50, 1080p/60

1 to 1125

HDTV 1080i/50, 1080i/60

1 to 1125

The following are exercises to familiarize you with video triggering. These
exercises use the NTSC video standard.
• "To trigger on a specific line of video" on page 168
• "To trigger on all sync pulses" on page 170
• "To trigger on a specific field of the video signal" on page 170
• "To trigger on all fields of the video signal" on page 171
• "To trigger on odd or even fields" on page 172
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To set up Generic video triggers
When Generic (available with the DSOX3VID extended video triggering
license) is selected as the Video trigger Standard, you can trigger on custom
bi- level and tri- level sync video standards. The Video Trigger Menu
changes as follows.

1 Press the Time > softkey; then, turn the Entry knob to set the time to
greater- than the sync- pulse width so that the oscilloscope synchronizes
to the vertical sync.
2 Press the Edge # softkey; then, turn the Entry knob to select the Nth
edge after after vertical sync to trigger on.
3 To enable or disable the horizontal sync control, press the first
Horiz Sync softkey.
• For interleaved video, enabling the Horiz Sync control and setting the
Horiz Sync adjustment to the sync time of the probed video signal
allows the Edge # function to count only lines and not double count
during equalization. Additionally, the Field Holdoff can be adjusted so
that the oscilloscope triggers once per frame.
• Similarly, for progressive video with a tri- level sync, enabling the
Horiz Sync control and setting the Horiz Sync adjustment to the sync
time of the probed video signal allows the Edge # function to count
only lines and not double count during vertical sync.
When the horizontal sync control is enabled, press the second Horiz Sync
softkey; then, turn the Entry knob to set the minimum time the
horizontal sync pulse must be present to be considered valid.

To trigger on a specific line of video
Video triggering requires greater than 1/2 division of sync amplitude with
any analog channel as the trigger source. Turning the trigger Level knob in
Video trigger does not change the trigger level because the trigger level is
automatically set to the sync pulse tips.
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One example of triggering on a specific line of video is looking at the
vertical interval test signals (VITS), which are typically in line 18. Another
example is closed captioning, which is typically in line 21.
1 Press the [Trigger] key.
2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select Video.
3 Press the Settings softkey, then press the Standard softkey to select the
appropriate TV standard (NTSC).
4 Press the Mode softkey and select the TV field of the line you want to
trigger on. You can choose Line:Field1, Line:Field2, or Line:Alternate.
5 Press the Line # softkey and select the number of the line you want to
examine.

NOTE

Alternate Triggering
If Line:Alternate is selected, the oscilloscope will alternately trigger on the selected line
number in Field 1 and Field 2. This is a quick way to compare the Field 1 VITS and Field 2
VITS or to check for the correct insertion of the half line at the end of Field 1.

Figure 27

Example: Triggering on Line 136
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To trigger on all sync pulses
To quickly find maximum video levels, you could trigger on all sync
pulses. When All Lines is selected as the Video trigger mode, the
oscilloscope will trigger on all horizontal sync pulses.
1 Press the [Trigger] key.
2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select Video.
3 Press the Settings softkey, then press the Standard softkey to select the
appropriate TV standard.
4 Press the Mode softkey and select All Lines.

Figure 28

Triggering on All Lines

To trigger on a specific field of the video signal
To examine the components of a video signal, trigger on either Field 1 or
Field 2 (available for interleaved standards). When a specific field is
selected, the oscilloscope triggers on the rising edge of the first serration
pulse in the vertical sync interval in the specified field (1 or 2).
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1 Press the [Trigger] key.
2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select Video.
3 Press the Settings softkey, then press the Standard softkey to select the
appropriate TV standard.
4 Press the Mode softkey and select Field1 or Field2.

Figure 29

Triggering on Field 1

To trigger on all fields of the video signal
To quickly and easily view transitions between fields, or to find the
amplitude differences between the fields, use the All Fields trigger mode.
1 Press the [Trigger] key.
2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select Video.
3 Press the Settings softkey, then press the Standard softkey to select the
appropriate TV standard.
4 Press the Mode softkey and select All Fields.
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Figure 30

Triggering on All Fields

To trigger on odd or even fields
To check the envelope of your video signals, or to measure worst case
distortion, trigger on the odd or even fields. When Field 1 is selected, the
oscilloscope triggers on color fields 1 or 3. When Field 2 is selected, the
oscilloscope triggers on color fields 2 or 4.
1 Press the [Trigger] key.
2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select Video.
3 Press the Settings softkey, then press the Standard softkey to select the
appropriate TV standard.
4 Press the Mode softkey and select Field1 or Field2.
The trigger circuits look for the position of the start of Vertical Sync to
determine the field. But this definition of field does not take into
consideration the phase of the reference subcarrier. When Field 1 is
selected, the trigger system will find any field where the vertical sync
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starts on Line 4. In the case of NTSC video, the oscilloscope will trigger
on color field 1 alternating with color field 3 (see the following figure).
This setup can be used to measure the envelope of the reference burst.

Figure 31

Triggering on Color Field 1 Alternating with Color Field 3

If a more detailed analysis is required, then only one color field should be
selected to be the trigger. You can do this by using the Field Holdoff softkey
in the Video Trigger Menu. Press the Field Holdoff softkey and use the Entry
knob to adjust the holdoff in half- field increments until the oscilloscope
triggers on only one phase of the color burst.
A quick way to synchronize to the other phase is to briefly disconnect the
signal and then reconnect it. Repeat until the correct phase is displayed.
When holdoff is adjusted using the Field Holdoff softkey and the Entry knob,
the corresponding holdoff time will be displayed in the Trigger Mode and
Coupling Menu.

Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

173

10 Triggers

Table 4

174

Half-field holdoff time

Standard

Time

NTSC

8.35 ms

PAL

10 ms

PAL-M

10 ms

SECAM

10 ms

Generic

8.35 ms

EDTV 480p/60

8.35 ms

EDTV 567p/50

10 ms

HDTV 720p/50

10 ms

HDTV 720p/60

8.35 ms

HDTV 1080p/24

20.835 ms

HDTV 1080p/25

20 ms

HDTV 1080p/30

20 ms

HDTV 1080p/50

16.67 ms

HDTV 1080p/60

8.36 ms

HDTV 1080i/50

10 ms

HDTV 1080i/60

8.35 ms
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Using Field Holdoff to Synchronize to Color Field 1 or 3 (Field 1 mode)

USB Trigger
USB trigger will trigger on a Start of Packet (SOP), End of Packet (EOP)
signal, Reset Complete (RC), Enter Suspend (Suspend), or Exit Suspend
(Exit Sus) on the differential USB data lines (D+ and D- ). USB Low Speed
and Full Speed are supported by this trigger.
End of packet trigger
D+,Bus Idle
D-,+
SOP

SEO portion of EOP

1 Press [Default Setup].
2 Press the [Label] key to switch labels on.
3 Turn on any analog or digital channels that you will be using for the
USB signals.
4 Press the [Trigger] key.
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5 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select USB.

6 Press the Trigger: softkey to select where the USB trigger will occur:
• SOP (Start of Packet) — triggers at the Sync bit at the beginning of
the packet.
• EOP (End of Packet) — triggers at the end of the SE0 portion of the
EOP.
• RC (Reset Complete) — triggers when SE0 is > 10 ms.
• Suspend (Enter Suspend) — triggers when the bus is idle > 3 ms.
• Exit Sus (Exit Suspend) — triggers when exiting an idle state > 10 ms.
This is used to see the suspend/resume transition.
7 Press the Speed softkey to select the speed of the transaction being
probed.
You may select Low Speed (1.5 Mb/s) or Full Speed (12 Mb/s).
8 Press the D+ and D– softkeys to select the channel connected to the
USB signal D+ and D– lines. The D+ and D– labels for the source
channels are automatically set.
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As you press the D+ or D– softkey (or rotate the Entry knob), the D+
and D– label for the source channel is automatically set and the
channel you select is shown in the upper- right corner of the display
next to "USB".
If you have connected the oscilloscope's analog source channels to the
D+ and D- signals: Adjust the trigger level for each connected analog
channel to the middle of the waveform by pressing the D+ or D- softkey,
then turning the Trigger Level knob.
If you have connected the oscilloscope's digital source channels to the
D+ and D- signals (this applies to MSO model oscilloscopes only): Press
the [Digital] key and select Thresholds to set an appropriate threshold
level for the digital channels.
The value of the trigger level or digital threshold is displayed in the
upper- right corner of the display.

Serial Trigger
With serial decode option licenses (see "Serial Decode Options" on
page 125), you can enable serial trigger types. To set up these triggers,
see:
• "ARINC 429 Triggering" on page 415
• "CAN Triggering" on page 353
• "FlexRay Triggering" on page 368
• "I2C Triggering" on page 378
• "I2S Triggering" on page 400
• "LIN Triggering" on page 361
• "MIL- STD- 1553 Triggering" on page 409
• "SPI Triggering" on page 389
• "UART/RS232 Triggering" on page 425
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To access the Trigger Mode and Coupling Menu:
• In the Trigger section of the front panel, press the [Mode/Coupling] key.

Noisy Signals

If the signal you are probing is noisy, you can set up the oscilloscope to
reduce the noise in the trigger path and on the displayed waveform. First,
stabilize the displayed waveform by removing the noise from the trigger
path. Second, reduce the noise on the displayed waveform.
1 Connect a signal to the oscilloscope and obtain a stable display.
2 Remove the noise from the trigger path by turning on high- frequency
rejection ("To enable or disable trigger HF Reject" on page 183),
low- frequency rejection ("To select the trigger coupling" on page 182),
or "To enable or disable trigger noise rejection" on page 183.
3 Use "Averaging Acquisition Mode" on page 197 to reduce noise on the
displayed waveform.
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To select the Auto or Normal trigger mode
When the oscilloscope is running, the trigger mode tells the oscilloscope
what to do when triggers are not occurring.
In the Auto trigger mode (the default setting), if the specified trigger
conditions are not found, triggers are forced and acquisitions are made so
that signal activity is displayed on the oscilloscope.
In the Normal trigger mode, triggers and acquisitions only occur when the
specified trigger conditions are found.
To select the trigger mode:
1 Press the [Mode/Coupling] key.
2 In the Trigger Mode and Coupling Menu, press the Mode softkey; then
select either Auto or Normal.
See the following "When to Use Auto Trigger Mode" on page 181 and
"When to Use Normal Trigger Mode" on page 181 descriptions.
You can also configure the [Quick Action] key to toggle between the Auto
and Normal trigger modes. See "Configuring the [Quick Action] Key" on
page 311.
Triggering and
the Pre- and
Post-Trigger
Buffers

After the oscilloscope starts running (after pressing [Run] or [Single] or
changing the trigger condition), the oscilloscope first fills the pre- trigger
buffer. Then, after the pre- trigger buffer is filled, the oscilloscope starts
searching for a trigger, and sampled data continues to flow data through
the pre- trigger buffer in a first- in first- out (FIFO) manner.
When a trigger is found, the pre- trigger buffer contains the events that
occurred just before the trigger. Then, the oscilloscope fills the post- trigger
buffer and displays the acquisition memory. If the acquisition was
initiated by [Run/Stop], the process repeats. If the acquisition was initiated
by pressing [Single], the acquisition stops (and you can Pan and Zoom the
waveform).
In either Auto or Normal trigger mode, a trigger may be missed if the
event occurs while the pre- trigger buffer is being filled. This may be more
likely, for example, when the horizontal scale knob is set to a slow
time/div setting, such as 500 ms/div.
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Trigger Indicator

The trigger indicator at the top right of the display shows whether triggers
are occurring.
In the Auto trigger mode, the trigger indicator can show:
• Auto? (flashing) — the trigger condition is not found (after the
pre- trigger buffer has filled), and forced triggers and acquisitions are
occurring.
• Auto (not flashing) — the trigger condition is found (or the pre- trigger
buffer is being filled).
In the Normal trigger mode, the trigger indicator can show:
• Trig'd? (flashing) — the trigger condition is not found (after the
pre- trigger buffer has filled), and no acquisitions are occurring.
• Trig'd (not flashing) — trigger condition is found (or pre- trigger buffer is
being filled).
When the oscilloscope is not running, the trigger indicator area shows
Stop.

When to Use Auto
Trigger Mode

The Auto trigger mode is appropriate when:
• Checking DC signals or signals with unknown levels or activity.
• When trigger conditions occur often enough that forced triggers are
unnecessary.

When to Use
Normal Trigger
Mode

The Normal trigger mode is appropriate when:
• You only want to acquire specific events specified by the trigger
settings.
• Triggering on an infrequent signal from a serial bus (for example, I2C,
SPI, CAN, LIN, etc.) or another signal that arrives in bursts. The Normal
trigger mode lets you stabilize the display by preventing the oscilloscope
from auto- triggering.
• Making single- shot acquisitions with the [Single] key.
Often with single- shot acquisitions, you must initiate some action in the
device under test, and you don't want the oscilloscope to auto- trigger
before that happens. Before initiating the action in the circuit, wait for
the trigger condition indicator Trig'd? to flash (this tells you the
pre- trigger buffer is filled).

See Also

• "Forcing a Trigger" on page 145
• "To set the trigger holdoff" on page 184
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• "To position the time reference (left, center, right)" on page 58

To select the trigger coupling
1 Press the [Mode/Coupling] key.
2 In the Trigger Mode and Coupling Menu, press the Coupling softkey;
then, turn the Entry knob to select:
• DC coupling — allows DC and AC signals into the trigger path.
• AC coupling — places a 10 Hz high- pass filter in the trigger path
removing any DC offset voltage from the trigger waveform.
The high- pass filter in the External Trigger input path is 50 Hz for
all models.
Use AC coupling to get a stable edge trigger when your waveform has
a large DC offset.
• LF (low frequency) Reject coupling — adds a high- pass filter with the
3- dB point at 50 kHz in series with the trigger waveform.
0 dB
3 dB down point
Pass
Band

DC

50 kHz

Low frequency reject removes any unwanted low frequency
components from a trigger waveform, such as power line frequencies,
etc., that can interfere with proper triggering.
Use LF Reject coupling to get a stable edge trigger when your
waveform has low frequency noise.
• TV coupling — is normally grayed- out, but is automatically selected
when TV trigger is enabled in the Trigger Menu.
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Note that Trigger Coupling is independent of Channel Coupling (see "To
specify channel coupling" on page 65).

To enable or disable trigger noise rejection
Noise Rej adds additional hysteresis to the trigger circuitry. By increasing
the trigger hysteresis band, you reduce the possibility of triggering on
noise. However, this also decreases the trigger sensitivity so that a slightly
larger signal is required to trigger the oscilloscope.
1 Press the [Mode/Coupling] key.
2 In the Trigger Mode and Coupling Menu, press the Noise Rej softkey to
enable or disable.

To enable or disable trigger HF Reject
HF Reject adds a 50 kHz low- pass filter in the trigger path to remove high
frequency components from the trigger waveform.

0 dB
-3 dB

Pass
Band

DC

50 kHz

You can use HF Reject to remove high- frequency noise, such as AM or FM
broadcast stations or noise from fast system clocks, from the trigger path.
1 Press the [Mode/Coupling] key.
2 In the Trigger Mode and Coupling Menu, press the HF Reject softkey to
enable or disable.
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To set the trigger holdoff
Trigger holdoff sets the amount of time the oscilloscope waits after a
trigger before re- arming the trigger circuitry.
Use the holdoff to trigger on repetitive waveforms that have multiple edges
(or other events) between waveform repetitions. You can also use holdoff
to trigger on the first edge of a burst when you know the minimum time
between bursts.
For example, to get a stable trigger on the repetitive pulse burst shown
below, set the holdoff time to be >200 ns but <600 ns.
Holdoff

Oscilloscope triggers here

200 ns

600 ns

To set the trigger holdoff:
1 Press the [Mode/Coupling] key.
2 In the Trigger Mode and Coupling Menu, press the Holdoff softkey; then,
turn the Entry knob to increase or decrease the trigger holdoff time.
Trigger Holdoff
Operating Hints

The correct holdoff setting is typically slightly less than one repetition of
the waveform. Set the holdoff to this time to generate a unique trigger
point for a repetitive waveform.
Changing the time base settings does not affect the trigger holdoff time.
With Agilent's MegaZoom technology, you can press [Stop], then pan and
zoom through the data to find where the waveform repeats. Measure this
time using cursors; then, set the holdoff.

External Trigger Input
The external trigger input can be used as a source in several of the trigger
types. The external trigger BNC input is on the rear panel and is labeled
EXT TRIG IN.
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Maximum voltage at oscilloscope external trigger input
CAT I 300 Vrms, 400 Vpk; transient overvoltage 1.6 kVpk
1 M ohm input: For steady-state sinusoidal waveforms derate at 20 dB/decade above
57 kHz to a minimum of 5 Vpk
With N2863A 10:1 probe: CAT I 600 V (DC + peak AC)
With 10073C or 10074C 10:1 probe: CAT I 500 Vpk

The external trigger input impedance is 1M Ohm. This lets you use passive
probes for general- purpose measurements. The higher impedance
minimizes the loading effect of the oscilloscope on the device under test.
To set the EXT TRIG IN units and probe attenuation:
1 Press the [Mode/Coupling] key in the Trigger section of the front panel.

2 In the Trigger Mode and Coupling Menu, press the External softkey.

3 In the External Trigger Menu, press the Units softkey to select between:
• Volts — for a voltage probe.
• Amps — for a current probe.
Measurement results, channel sensitivity, and the trigger level will
reflect the measurement units you have selected.
4 Press the Probe softkey; then, turn the entry knob to specify the probe
attenuation.
The attenuation factor can be set from 0.1:1 to 1000:1 in a 1- 2- 5
sequence.
The probe attenuation factor must be set properly for measurements to
be made correctly.
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This chapter shows how to use the oscilloscope's acquisition and run
controls.

Running, Stopping, and Making Single Acquisitions (Run Control)
There are two front panel keys for starting and stopping the oscilloscope's
acquisition system: [Run/Stop] and [Single].
• When the [Run/Stop] key is green, the oscilloscope is running, that is,
acquiring data when trigger conditions are met.
To stop acquiring data, press [Run/Stop]. When stopped, the last
acquired waveform is displayed.
• When the [Run/Stop] key is red, data acquisition is stopped.
"Stop" is displayed next to the trigger type in the status line at the top
of the display.
To start acquiring data, press [Run/Stop].
• To capture and display a single acquisition (whether the oscilloscope is
running or stopped), press [Single].
The [Single] run control lets you view single- shot events without
subsequent waveform data overwriting the display. Use [Single] when
you want maximum memory depth for pan and zoom.
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When you press [Single], the display is cleared, the trigger mode is
temporarily set to Normal (to keep the oscilloscope from auto- triggering
immediately), the trigger circuitry is armed, the [Single] key is
illuminated, and the oscilloscope waits until a trigger condition occurs
before it displays a waveform.
When the oscilloscope triggers, the single acquisition is displayed and
the oscilloscope is stopped (the [Run/Stop] key is illuminated in red).
Press [Single] again to acquire another waveform.
If the oscilloscope doesn't trigger, you can press the [Force Trigger] key to
trigger on anything and make a single acquisition.
To display the results of multiple acquisitions, use persistence. See "To set
or clear persistence" on page 133.
Single vs.
Running and
Record Length

The maximum data record length is greater for a single acquisition than
when the oscilloscope is running (or when the oscilloscope is stopped
after running):
• Single — Single acquisitions always use the maximum memory available
— at least twice as much memory as acquisitions captured when
running — and the oscilloscope stores at least twice as many samples.
At slower time/div settings, because there is more memory available for
a single acquisition, the acquisition has a higher effective sample rate.
• Running — When running (versus taking a single acquisition), the
memory is divided in half. This lets the acquisition system acquire one
record while processing the previous acquisition, dramatically improving
the number of waveforms per second processed by the oscilloscope.
When running, a high waveform update rate provides the best
representation of your input signal.
To acquire data with the longest possible record length, press the [Single]
key.
For more information on settings that affect record length, see "Length
Control" on page 279.
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Overview of Sampling
To understand the oscilloscope's sampling and acquisition modes, it is
helpful to understand sampling theory, aliasing, oscilloscope bandwidth
and sample rate, oscilloscope rise time, oscilloscope bandwidth required,
and how memory depth affects sample rate.

Sampling Theory
The Nyquist sampling theorem states that for a limited bandwidth
(band- limited) signal with maximum frequency fMAX, the equally spaced
sampling frequency fS must be greater than twice the maximum frequency
fMAX, in order to have the signal be uniquely reconstructed without
aliasing.
fMAX = fS/2 = Nyquist frequency (fN) = folding frequency

Aliasing
Aliasing occurs when signals are under- sampled (fS < 2fMAX). Aliasing is
the signal distortion caused by low frequencies falsely reconstructed from
an insufficient number of sample points.

Figure 33

Aliasing
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Oscilloscope Bandwidth and Sample Rate
An oscilloscope's bandwidth is typically described as the lowest frequency
at which input signal sine waves are attenuated by 3 dB (- 30% amplitude
error).
At the oscilloscope bandwidth, sampling theory says the required sample
rate is fS = 2fBW. However, the theory assumes there are no frequency
components above fMAX (fBW in this case) and it requires a system with
an ideal brick- wall frequency response.
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Figure 34

Theoretical Brick-Wall Frequency Response

However, digital signals have frequency components above the fundamental
frequency (square waves are made up of sine waves at the fundamental
frequency and an infinite number of odd harmonics), and typically, for
500 MHz bandwidths and below, oscilloscopes have a Gaussian frequency
response.
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Limiting oscilloscope bandwidth (fBW) to 1/4 the sample rate (fS/4)
reduces frequency components above the Nyquist frequency (fN).

Figure 35

Sample Rate and Oscilloscope Bandwidth

So, in practice, an oscilloscope's sample rate should be four or more times
its bandwidth: fS = 4fBW. This way, there is less aliasing, and aliased
frequency components have a greater amount of attenuation.
Note that 1 GHz bandwidth 3000 X- Series oscilloscope models have more
of a brick- wall type frequency response (also known a flat response) than
the Gaussian response of lower bandwidth 3000 X- Series oscilloscope
models. To understand the characteristics of each type of oscilloscope
frequency response, see Understanding Oscilloscope Frequency Response
and Its Effect on Rise- Time Accuracy, Agilent Application Note 1420
("http://cp.literature.agilent.com/litweb/pdf/5988- 8008EN.pdf").
See Also

Evaluating Oscilloscope Sample Rates vs. Sampling Fidelity: How to
Make the Most Accurate Digital Measurements, Agilent Application Note
1587 ("http://cp.literature.agilent.com/litweb/pdf/5989- 5732EN.pdf")

Oscilloscope Rise Time
Closely related to an oscilloscope's bandwidth specification is its rise time
specification. Oscilloscopes with a Gaussian- type frequency response have
an approximate rise time of 0.35/fBW based on a 10% to 90% criterion.
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An oscilloscope's rise time is not the fastest edge speed that the
oscilloscope can accurately measure. It is the fastest edge speed the
oscilloscope can possibly produce.

Oscilloscope Bandwidth Required
The oscilloscope bandwidth required to accurately measure a signal is
primarily determined by the signal's rise time, not the signal's frequency.
You can use these steps to calculate the oscilloscope bandwidth required:
1 Determine the fastest edge speeds.
You can usually obtain rise time information from published
specifications for devices used in your designs.
2 Compute the maximum "practical" frequency component.
From Dr. Howard W. Johnson's book, High- Speed Digital Design – A
Handbook of Black Magic, all fast edges have an infinite spectrum of
frequency components. However, there is an inflection (or "knee") in the
frequency spectrum of fast edges where frequency components higher
than fknee are insignificant in determining the shape of the signal.
fknee = 0.5 / signal rise time (based on 10% - 90% thresholds)
fknee = 0.4 / signal rise time (based on 20% - 80% thresholds)
3 Use a multiplication factor for the required accuracy to determine the
oscilloscope bandwidth required.

See Also
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Required accuracy

Oscilloscope bandwidth required

20%

fBW = 1.0 x fknee

10%

fBW = 1.3 x fknee

3%

fBW = 1.9 x fknee

Choosing an Oscilloscope with the Right Bandwidth for your
Application, Agilent Application Note 1588
("http://cp.literature.agilent.com/litweb/pdf/5989- 5733EN.pdf")
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Memory Depth and Sample Rate
The number of points of oscilloscope memory is fixed, and there is a
maximum sample rate associated with oscilloscope's analog- to- digital
converter; however, the actual sample rate is determined by the time of
the acquisition (which is set according to the oscilloscope's horizontal
time/div scale).
sample rate = number of samples / time of acquisition
For example, when storing 50 µs of data in 50,000 points of memory, the
actual sample rate is 1 GSa/s.
Likewise, when storing 50 ms of data in 50,000 points of memory, the
actual sample rate is 1 MSa/s.
The actual sample rate is displayed in the right- side information area.
The oscilloscope achieves the actual sample rate by throwing away
(decimating) unneeded samples.

Selecting the Acquisition Mode
When selecting the oscilloscope acquisition mode, keep in mind that
samples are normally decimated at slower time/div settings.
At slower time/div settings, the effective sample rate drops (and the
effective sample period increases) because the acquisition time increases
and the oscilloscope's digitizer is sampling faster than is required to fill
memory.
For example, suppose an oscilloscope's digitizer has a sample period of
1 ns (maximum sample rate of 1 GSa/s) and a 1 M memory depth. At that
rate, memory is filled in 1 ms. If the acquisition time is 100 ms
(10 ms/div), only 1 of every 100 samples is needed to fill memory.
To select the acquisition mode:
1 Press the [Acquire] key on the front panel.
2 In the Acquire Menu, press the Acq Mode softkey; then, turn the Entry
knob to select the acquisition mode.
The InfiniiVision oscilloscopes have the following acquisition modes:

Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

193

12 Acquisition Control

• Normal — at slower time/div settings, normal decimation occurs, and
there is no averaging. Use this mode for most waveforms. See
"Normal Acquisition Mode" on page 194.
• Peak Detect — at slower time/div settings, the maximum and minimum
samples in the effective sample period are stored. Use this mode for
displaying narrow pulses that occur infrequently. See "Peak Detect
Acquisition Mode" on page 194.
• Averaging — at all time/div settings, the specified number of triggers
are averaged together. Use this mode for reducing noise and
increasing resolution of periodic signals without bandwidth or rise
time degradation. See "Averaging Acquisition Mode" on page 197.
• High Resolution — at slower time/div settings, all samples in the
effective sample period are averaged and the average value is stored.
Use this mode for reducing random noise. See "High Resolution
Acquisition Mode" on page 199.

Normal Acquisition Mode
In Normal mode at slower time/div settings, extra samples are decimated
(in other words, some are thrown away). This mode yields the best display
for most waveforms.

Peak Detect Acquisition Mode
In Peak Detect mode at slower time/div settings, minimum and maximum
samples are kept in order to capture infrequent and narrow events (at the
expense of exaggerating any noise). This mode displays all pulses that are
at least as wide as the sample period.
For InfiniiVision 3000 X- Series oscilloscopes, which have a maximum
sample rate of 4 GSa/s, a sample is taken every 250 ps (sample period).
See Also

• "Glitch or Narrow Pulse Capture" on page 195
• "Using Peak Detect Mode to Find a Glitch" on page 196
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Glitch or Narrow Pulse Capture
A glitch is a rapid change in the waveform that is usually narrow as
compared to the waveform. Peak detect mode can be used to more easily
view glitches or narrow pulses. In peak detect mode, narrow glitches and
sharp edges are displayed more brightly than when in Normal acquire
mode, making them easier to see.
To characterize the glitch, use the cursors or the automatic measurement
capabilities of the oscilloscope.

Figure 36

Sine With Glitch, Normal Mode
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Figure 37

Sine With Glitch, Peak Detect Mode

Using Peak Detect Mode to Find a Glitch
1 Connect a signal to the oscilloscope and obtain a stable display.
2 To find the glitch, press the [Acquire] key; then, press the Acq Mode
softkey until Peak Detect is selected.
3 Press the [Display] key then press the ∞ Persistence (infinite persistence)
softkey.
Infinite persistence updates the display with new acquisitions but does
not erase previous acquisitions. New sample points are shown at normal
intensity while previous acquisitions are displayed at reduced intensity.
Waveform persistence is not kept beyond the display area boundary.
Press the Clear Display softkey to erase previously acquired points. The
display will accumulate points until ∞ Persistence is turned off.
4 Characterize the glitch with Zoom mode:
a Press the
softkey).

zoom key (or press the [Horiz] key and then the Zoom

b To obtain a better resolution of the glitch, expand the time base.
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Use the horizontal position knob ( ) to pan through the waveform to set
the expanded portion of the normal window around the glitch.

Averaging Acquisition Mode
The Averaging mode lets you average multiple acquisitions together to
reduce noise and increase vertical resolution (at all time/div settings).
Averaging requires a stable trigger.
The number of averages can be set from 2 to 65536 in power- of- 2
increments.
A higher number of averages reduces noise more and increases vertical
resolution.
# Avgs

Bits of resolution

2

8

4

9

16

10

64

11

≥ 256

12

The higher the number of averages, the slower the displayed waveform
responds to waveform changes. You must compromise between how quickly
the waveform responds to changes and how much you want to reduce the
displayed noise on the signal.
To use the Averaging mode:
1 Press the [Acquire] key, then press the Acq Mode softkey until the
Averaging mode is selected.
2 Press the #Avgs softkey and turn the Entry knob to set the number of
averages that best eliminates the noise from the displayed waveform.
The number of acquisitions being averaged is displayed in the # Avgs
softkey.

Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

197

12 Acquisition Control

198

Figure 38

Random noise on the displayed waveform

Figure 39

128 Averages used to reduce random noise
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See Also

• Chapter 11, “Trigger Mode/Coupling,” starting on page 179

High Resolution Acquisition Mode
In High Resolution mode, at slower time/div settings extra samples are
averaged in order to reduce random noise, produce a smoother trace on
the screen, and effectively increase vertical resolution.
High Resolution mode averages sequential sample points within the same
acquisition. An extra bit of vertical resolution is produced for every factor
of 2 averages. Random noise is reduced by ½ for every factor of 4
averages. The number of extra bits of vertical resolution is dependent on
the time per division setting (sweep speed) of the oscilloscope.
The slower the time/div setting, the greater the number of samples that
are averaged together for each display point.
High Resolution mode can be used on both single- shot and repetitive
signals and it does not slow waveform update because the computation is
done in the MegaZoom custom ASIC. High Resolution mode limits the
oscilloscope's real- time bandwidth because it effectively acts like a
low- pass filter.
Sweep speed

Bits of resolution

≤ 1 µs/div

8

2 µs/div

9

5 µs/div

10

10 µs/div

11

≥ 20 µs/div

12

Acquiring to Segmented Memory
You can purchase the oscilloscope with the segmented memory option
factory- installed (Option SGM) or you can install a license to enable it
(order model number DSOX3SGM "Segmented Memory").
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When capturing multiple infrequent trigger events it is advantageous to
divide the oscilloscope's memory into segments. This lets you capture
signal activity without capturing long periods of signal inactivity.
Each segment is complete with all analog channel, digital channel (on MSO
models), and serial decode data.
When using segmented memory, use the Analyze Segments feature (see
"Measurements, Statistics, and Infinite Persistence with Segmented
Memory" on page 201) to show infinite persistence across all acquired
segments. See also "To set or clear persistence" on page 133 for details.
To acquire to
segmented
memory

1 Set up a trigger condition. (See Chapter 10, “Triggers,” starting on page
143 for details.)
2 Press the [Acquire] key in the Waveform section of the front panel.
3 Press the Segmented softkey.
4 In the Segmented Memory Menu, press the Segmented softkey to enable
segmented memory acquisitions.
5 Press the # of Segs softkey and turn the Entry knob to select the
number of segments into which you would like to divide the
oscilloscope's memory.
Memory can be divided into as few as two segments and as many as
1000 segments, depending on the oscilloscope model.
6 Press the [Run] or [Single] key.
The oscilloscope runs and fills a memory segment for each trigger event.
When the oscilloscope is busy acquiring multiple segments, the progress is
displayed in the upper right area of the display. The oscilloscope
continues to trigger until memory is filled, then the oscilloscope stops.
If the signal you are measuring has more than about 1 s of inactivity,
consider selecting the Normal trigger mode to prevent AutoTriggering. See
"To select the Auto or Normal trigger mode" on page 180.
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Progress indicator
Sample rate

See Also

• "Navigating Segments" on page 201
• "Measurements, Statistics, and Infinite Persistence with Segmented
Memory" on page 201
• "Segmented Memory Re- Arm Time" on page 202
• "Saving Data from Segmented Memory" on page 202

Navigating Segments
1 Press the Current Seg softkey and turn the Entry knob to display the
desired segment along with a time tag indicating the time from the first
trigger event.
You can also navigate segments using the [Navigate] key and controls. See
"To navigate segments" on page 62.

Measurements, Statistics, and Infinite Persistence with Segmented Memory
To perform measurements and view statistical information, press [Meas]
and set up your desired measurements (see Chapter 14, “Measurements,”
starting on page 215). Then, press Analyze Segments. Statistical data will be
accumulated for the measurements you have chosen.
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The Analyze Segments softkey appears when the acquisition is stopped and
the segmented memory feature is on or when the serial Lister is enabled.
You can also turn on infinite persistence (in the Display Menu) and press
the Analyze Segments softkey to create an infinite persistence display.

Segmented Memory Re-Arm Time
After each segment fills, the oscilloscope re- arms and is ready to trigger
in about 1 µs.
Remember though, for example: if the horizontal time per division control
is set to 5 µs/div, and the Time Reference is set to Center, it will take at
least 50 µs to fill all ten divisions and re- arm. (That is 25 µs to capture
pre- trigger data and 25 µs to capture post- trigger data.)

Saving Data from Segmented Memory
You can save either the currently displayed segment (Save Segment Current), or all segments (Save Segment - All) in the following data formats:
CSV, ASCII XY, and BIN.
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Be sure to set the Length control to capture enough points to accurately
represent the captured data. When the oscilloscope is busy saving multiple
segments, progress is displayed in the upper right area of the display.
For more information, see "To save CSV, ASCII XY, or BIN data files" on
page 278.
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To make cursor measurements 206
Cursor Examples 209

Cursors are horizontal and vertical markers that indicate X- axis values
and Y- axis values on a selected waveform source. You can use cursors to
make custom voltage, time, phase, or ratio measurements on oscilloscope
signals.
Cursor information is displayed in the right- side information area.
Cursors are not always limited to the visible display. If you set a cursor,
then pan and zoom the waveform until the cursor is off screen, its value
will not be changed. It will still be there when you return to its original
location.
X Cursors

X cursors are vertical dashed lines that adjust horizontally and can be
used to measure time (s), frequency (1/s), phase (°), and ratio (%).
The X1 cursor is the short- dashed vertical line, and the X2 cursor is the
long- dashed vertical line.
When used with the FFT math function as a source, the X cursors
indicate frequency.
In XY horizontal mode, the X cursors display channel 1 values (Volts or
Amps).
The X1 and X2 cursor values for the selected waveform source are
displayed in the softkey menu area.
The difference between X1 and X2 (ΔX) and 1/ΔX are displayed in the
Cursors box in the right- side information area.

s1
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Y Cursors

Y cursors are horizontal dashed lines that adjust vertically and can be
used to measure Volts or Amps, dependent on the channel Probe Units
setting, or they can measure ratios (%). When math functions are used as
a source, the measurement units correspond to that math function.
The Y1 cursor is the short- dashed horizontal line and the Y2 cursor is the
long- dashed horizontal line.
The Y cursors adjust vertically and typically indicate values relative to the
waveform's ground point, except math FFT where the values are relative
to 0 dB.
In XY horizontal mode, the Y cursors display channel 2 values (Volts or
Amps).
When active, the Y1 and Y2 cursor values for the selected waveform
source are displayed in the softkey menu area.
The difference between Y1 and Y2 (ΔY) is displayed in the Cursors box in
the right- side information area.

To make cursor measurements
1 Connect a signal to the oscilloscope and obtain a stable display.
2 Press the [Cursors] key.
The Cursors box in the right- side information area appears, indicating
that cursors are "on". (Press the [Cursors] key again when you want to
turn cursors off.)
3 In the Cursors Menu, press Mode; then, select the desired mode:
• Manual — ΔX, 1/ΔX, and ΔY values are displayed. ΔX is the difference
between the X1 and X2 cursors and ΔY is the difference between the
Y1 and Y2 cursors.
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• Track Waveform — As you move a marker horizontally, the vertical
amplitude of the waveform is tracked and measured. The time and
voltage positions are shown for the markers. The vertical (Y) and
horizontal (X) differences between the markers are shown as ΔX and
ΔY values.
• Binary — Logic levels of displayed waveforms at the current X1 and
X2 cursor positions are displayed above the softkeys in binary. The
display is color coded to match the color of the related channel's
waveform.

• Hex — Logic levels of displayed waveforms at the current X1 and X2
cursor positions are displayed above the softkeys in hexadecimal.

Manual and Track Waveform modes can be used on waveforms that are
displayed on the analog input channels (including math functions).
Binary and Hex modes apply to digital signals (of MSO oscilloscope
models).
In Hex and Binary modes, a level can be displayed as 1 (higher than
trigger level), 0 (lower than trigger level), indeterminate state ( ), or X
(don't care).
In Binary mode, X is displayed if the channel is turned off.
In Hex mode, the channel is interpreted as 0 if turned off.
4 Press Source (or X1 Source, X2 Source in the Track Waveform mode); then,
select the input source for cursor values.
5 Select the cursor(s) to be adjusted:
• Push the Cursors knob; then, turn the Cursors knob. To finalize your
selection, either push the Cursors knob again or wait about five
seconds for the popup menu to disappear.
Or:
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• Press the Cursors softkey; then, turn the Entry knob.
The X1 X2 linked and Y1 Y2 linked selections let you adjust both cursors at
the same time, while the delta value remains the same. This can be
useful, for example, for checking pulse width variations in a pulse train.
The currently selected cursor(s) display brighter than the other cursors.
6 To change the cursor units, press the Units softkey.
In the Cursor Units Menu:

You can press the X Units softkey to select:
• Seconds (s).
• Hz (1/s).
• Phase (°) — when selected, use the Use X Cursors softkey to set the
current X1 location as 0 degrees and the current X2 location as 360
degrees.
• Ratio (%) — when selected, use the Use X Cursors softkey to set the
current X1 location as 0% and the current X2 location as 100%.
You can press the Y Units softkey to select:
• Base — the same units used for the source waveform.
• Ratio (%) — when selected, use the Use Y Cursors softkey to set the
current Y1 location as 0% and the current Y2 location as 100%.
For phase or ratio units, once the 0 and 360 degree or 0 and 100%
locations are set, adjusting cursors will display measurements relative
to the set locations.
7 Adjust the selected cursor(s) by turning the Cursors knob.
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Cursor Examples

Figure 40

Cursors used to measure pulse widths other than middle threshold points
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Figure 41

Cursors measure frequency of pulse ringing

Expand the display with Zoom mode, then characterize the event of
interest with the cursors.
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Cursors track Zoom window

Put the X1 cursor on one side of a pulse and the X2 cursor on the other
side of the pulse.
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Figure 43

Measuring pulse width with cursors

Press the X1 X2 linked softkey and move the cursors together to check for
pulse width variations in a pulse train.
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Moving the cursors together to check pulse width variations
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To make automatic measurements 216
Measurements Summary 217
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Time Measurements 228
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Mixed Measurements 236
Measurement Thresholds 237
Measurement Window with Zoom Display 239
Measurement Statistics 239

The [Meas] key lets you make automatic measurements on waveforms.
Some measurements can only be made on analog input channels.
The results of the last four selected measurements are displayed in the
Measurements information area on the right- hand side of the screen.
Cursors are turned on to show the portion of the waveform being
measured for the most recently selected measurement (bottom- most on the
right- side measurement area).

NOTE

Post Acquisition Processing
In addition to changing display parameters after the acquisition, you can perform all of the
measurements and math functions after the acquisition. Measurements and math
functions will be recalculated as you pan and zoom and turn channels on and off. As you
zoom in and out on a signal using the horizontal scale knob and vertical volts/division knob,
you affect the resolution of the display. Because measurements and math functions are
performed on displayed data, you affect the resolution of functions and measurements.
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To make automatic measurements
1 Press the [Meas] key to display the Measurement Menu.

2 Press the Source softkey to select the channel, running math function,
or reference waveform to be measured.
Only channels, math functions, or reference waveforms that are
displayed are available for measurements.
If a portion of the waveform required for a measurement is not
displayed or does not display enough resolution to make the
measurement, the result will display "No Edges", "Clipped", "Low Signal",
"< value", or "> value", or a similar message to indicate that the
measurement may not be reliable.
3 Press the Type: softkey; then, rotate the Entry knob to select a
measurement to be made.
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For more information on the types of measurements, see "Measurements
Summary" on page 217.
4 The Settings softkey will be available to make additional measurement
settings on some measurements.
5 Press the Add Measurement softkey or push the Entry knob to display the
measurement.
Cursors are turned on to show the portion of the waveform being
measured for the most recently added measurement (bottom- most on
the display). To view the cursors for a previously added measurement
(but not the last one), add the measurement again.
By default, measurement statistics are displayed. See "Measurement
Statistics" on page 239.
6 To turn off measurements, press the [Meas] key again.
Measurements are erased from the display.
7 To stop making one or more measurements, press the Clear Meas softkey
and choose the measurement to clear, or press Clear All.

After all measurements have been cleared, when [Meas] is pressed
again, the default measurements will be Frequency and Peak- Peak.

Measurements Summary
The automatic measurements provided by the oscilloscope are listed in the
following table. All measurements are available for analog channel
waveforms. All measurements except Counter are available for reference
waveforms and math waveforms other than FFT. A limited set of
measurements is available for math FFT waveforms and for digital channel
waveforms (as described in the following table).
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Measurement

Valid
for
Math
FFT*

Valid for
Digital
Channels

Notes

Yes

Not valid for math waveforms.

"Snapshot All" on page 220
"Amplitude" on page 222
"Area" on page 236
"Average" on page 225

Yes, Full
Screen

"Base" on page 223
"Burst Width" on page 231
"Counter" on page 230
"Delay" on page 232

Measures between two sources.
Press Settings to specify the
second source.

"Duty Cycle" on page 231

Yes

"Fall Time" on page 232
"Frequency" on page 229

Yes

"Maximum" on page 222

Yes

"Minimum" on page 222

Yes

"Rising Edge Count" on
page 236
"Falling Edges Count" on
page 236
"Positive Pulse Count" on
page 235
"Negative Pulse Count" on
page 236
"Overshoot" on page 224
"Peak-Peak" on page 222
"Period" on page 229

218

Yes
Yes
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Measurement

Valid
for
Math
FFT*

Valid for
Digital
Channels

"Phase" on page 233

14

Notes

Measures between two sources.
Press Settings to specify the
second source.

"Preshoot" on page 225
"Ratio" on page 228

Measures between two sources.
Press Settings to specify the
second source.

"Rise Time" on page 232
"DC RMS" on page 226
"AC RMS" on page 226
"Top" on page 222
"+ Width" on page 231

Yes

"– Width" on page 231

Yes

"X at Max Y" on page 235

Yes

The resultant units are in Hertz.

"X at Min Y" on page 234

Yes

The resultant units are in Hertz.

* Use the cursors to make other measurements on FFT.

Power App
Measurements

Note that additional Power App measurements are available when the
DSOX3PWR power measurement and analysis license is installed and the
Power Application is enabled. For more information, see the DSOX3PWR
Power Measurement Application User's Guide at
"www.agilent.com/find/3000X- Series- manual" or on the Documentation CD.

Dual-Channel
(N2820A Probe)
Measurements

Note that additional measurements are available with the N2820A
high- sensitivity current probe when both the Primary and Secondary
probe cables are used. Zoom In waveform data below the probe's clamp
level is joined with Zoom Out waveform data above the probe's clamp level
to create the waveform on which the measurement is made. These
measurements are only valid for analog input channels.
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Dual-Channel (N2820A Probe)
Measurement

Notes

Amplitude

See "Amplitude" on page 222.

Charge

Charge (in Amp-hours) is the measured area under
the waveform. See "Area" on page 236.

Average

See "Average" on page 225.

Base

See "Base" on page 223.

Peak-Peak

See "Peak-Peak" on page 222.

DC RMS

See "DC RMS" on page 226.

AC RMS

See "AC RMS" on page 226.

When using the N2820A probe to make measurements on a
battery- powered (floating) device, always connect the supplied ground lead
between ground on your device and the probe's ground connector as
shown in the following figure. Simply snap the end of the ground lead
onto the probe's connector. Without the ground connection, the probe's
common- mode input amplifier cannot properly display waveforms.

Figure 45

Measurements on Battery Powered Devices Using the N2820A Probe

Snapshot All
The Snapshot All measurement type displays a popup containing a
snapshot of all the single waveform measurements.
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You can also configure the [Quick Action] key to display the Snapshot All
popup. See "Configuring the [Quick Action] Key" on page 311.

Voltage Measurements
The following figure shows the voltage measurement points.
Maximum

Top
Amplitude

Peak-Peak
Base
Minimum

Measurement units for each input channel can be set to Volts or Amps
using the channel Probe Units softkey. See "To specify the channel units" on
page 69.
The units of math waveforms are described in "Units for Math
Waveforms" on page 76.
• "Peak- Peak" on page 222
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• "Maximum" on page 222
• "Minimum" on page 222
• "Amplitude" on page 222
• "Top" on page 222
• "Base" on page 223
• "Overshoot" on page 224
• "Preshoot" on page 225
• "Average" on page 225
• "DC RMS" on page 226
• "AC RMS" on page 226
• "Ratio" on page 228

Peak-Peak
The peak- to- peak value is the difference between Maximum and Minimum
values. The Y cursors show the values being measured.

Maximum
Maximum is the highest value in the waveform display. The Y cursor
shows the value being measured.

Minimum
Minimum is the lowest value in the waveform display. The Y cursor shows
the value being measured.

Amplitude
The Amplitude of a waveform is the difference between its Top and Base
values. The Y cursors show the values being measured.

Top
The Top of a waveform is the mode (most common value) of the upper
part of the waveform, or if the mode is not well defined, the top is the
same as Maximum. The Y cursor shows the value being measured.
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• "To isolate a pulse for Top measurement" on page 223

To isolate a pulse for Top measurement
The following figure shows how to use Zoom mode to isolate a pulse for a
Top measurement.
You may need to change the measurement window setting so that the
measurement is made in the lower, Zoom window. See "Measurement
Window with Zoom Display" on page 239.

Figure 46

Isolating area for Top measurement

Base
The Base of a waveform is the mode (most common value) of the lower
part of the waveform, or if the mode is not well defined, the base is the
same as Minimum. The Y cursor shows the value being measured.
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Overshoot
Overshoot is distortion that follows a major edge transition expressed as a
percentage of Amplitude. The X cursors show which edge is being
measured (edge closest to the trigger reference point).

Rising edge overshοot =

local Maximum − D Top
× 100
Amplitude

D local Minimum × 100
Falling edge overshοot = Base − Amplitude
Overshoot
local Maximum
Top
Base
local Minimum

Figure 47
224

Overshoot

Automatic Overshoot measurement
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Preshoot
Preshoot is distortion that precedes a major edge transition expressed as a
percentage of Amplitude. The X cursors show which edge is being
measured (edge closest to the trigger reference point).

Rising edge preshοot =

local Maximum − D Top
× 100
Amplitude

D local Minimum × 100
Falling edge preshοot = Base − Amplitude

local Maximum

Preshoot
Top
Base

Preshoot

local Minimum

Average
Average is the sum of the levels of the waveform samples divided by the
number of samples.

∑ xi
Average = n
Where xi = value at ith point being measured, n = number of points in
measurement interval.
The Full Screen measurement interval variation measures the value on all
displayed data points.
The N Cycles measurement interval variation measures the value on an
integral number of periods of the displayed signal. If less than three edges
are present, the measurement shows "No edges".
The X cursors show what interval of the waveform is being measured.
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DC RMS
DC RMS is the root- mean- square value of the waveform over one or more
full periods.
n

RMS (dc) =

∑i=1xi2
n

Where xi = value at ith point being measured, n = number of points in
measurement interval.
The Full Screen measurement interval variation measures the value on all
displayed data points.
The N Cycles measurement interval variation measures the value on an
integral number of periods of the displayed signal. If less than three edges
are present, the measurement shows "No edges".
The X cursors show the interval of the waveform being measured.

AC RMS
AC RMS is the root- mean- square value of the waveform, with the DC
component removed. It is useful, for example, for measuring power supply
noise.
The N Cycles measurement interval measures the value on an integral
number of periods of the displayed signal. If less than three edges are
present, the measurement shows "No edges".
The X cursors show the interval of the waveform being measured.
The Full Screen (Std Deviation) measurement interval variation is an RMS
measurement across the full screen with the DC component removed. It
shows the standard deviation of the displayed voltage values.
The standard deviation of a measurement is the amount that a
measurement varies from the mean value. The Mean value of a
measurement is the statistical average of the measurement.
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The following figure graphically shows the mean and standard deviation.
Standard deviation is represented by the Greek letter sigma: σ. For a
Gaussian distribution, two sigma (± 1σ) from the mean, is where 68.3
percent of the measurement results reside. Six sigma (± 3σ) from is where
99.7 percent of the measurement results reside.

PHDQ

-3σ -2σ -1σ  1σ 2σ 3σ



The mean is calculated as follows:

x̄ =

N
xi
∑i=1

N

where:
• x = the mean.
• N = the number of measurements taken.
• xi = the ith measurement result.
The standard deviation is calculated as follows:

σ=

N
∑i=1
(xi − x̄)2

N

where:
• σ = the standard deviation.
• N = the number of measurements taken.
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• xi = the ith measurement result.
• x = the mean.

Ratio
The Ratio measurement displays the ratio of the AC RMS voltages of two
sources, expressed in dB. Press the Settings softkey to select the source
channels for the measurement.

Time Measurements
The following figure shows time measurement points.
Rise Time

Fall Time
Thresholds
Upper
Middle
Lower

+ Width

- Width
Period

The default lower, middle, and upper measurement thresholds are 10%,
50%, and 90% between Top and Base values. See "Measurement
Thresholds" on page 237 for other percentage threshold and absolute value
threshold settings.
• "Period" on page 229
• "Frequency" on page 229
• "Counter" on page 230
• "+ Width" on page 231
• "– Width" on page 231
• "Burst Width" on page 231
• "Duty Cycle" on page 231
• "Rise Time" on page 232
• "Fall Time" on page 232
• "Delay" on page 232
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• "Phase" on page 233
• "X at Min Y" on page 234
• "X at Max Y" on page 235

Period
Period is the time period of the complete waveform cycle. The time is
measured between the middle threshold points of two consecutive,
like- polarity edges. A middle threshold crossing must also travel through
the lower and upper threshold levels which eliminates runt pulses. The X
cursors show what portion of the waveform is being measured. The Y
cursor shows the middle threshold point.

Frequency
Frequency is defined as 1/Period. Period is defined as the time between
the middle threshold crossings of two consecutive, like- polarity edges. A
middle threshold crossing must also travel through the lower and upper
threshold levels which eliminates runt pulses. The X cursors show what
portion of the waveform is being measured. The Y cursor shows the
middle threshold point.
See Also

• "To isolate an event for frequency measurement" on page 229

To isolate an event for frequency measurement
The following figure shows how to use Zoom mode to isolate an event for
a frequency measurement.
You may need to change the measurement window setting so that the
measurement is made in the lower, Zoom window. See "Measurement
Window with Zoom Display" on page 239.
If the waveform is clipped, it may not be possible to make the
measurement.
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Figure 48

Isolating an event for Frequency measurement

Counter
The InfiniiVision 3000 X- Series oscilloscopes have an integrated hardware
frequency counter which counts the number of cycles that occur within a
period of time (known as the gate time) to measure the frequency of a
signal.
The gate time for the Counter measurement is automatically adjusted to
be 100 ms or twice the current time window, whichever is longer, up to 1
second.
The Counter can measure frequencies up to the bandwidth of the
oscilloscope. The minimum frequency supported is 1/(2 X gate time).
The hardware counter uses the trigger comparator output. Therefore, the
counted channel's trigger level (or threshold for digital channels) must be
set correctly. The Y cursor shows the threshold level used in the
measurement.
Analog and digital channels can be selected as the source.
Only one Counter measurement can be displayed at a time.
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+ Width
+ Width is the time from the middle threshold of the rising edge to the
middle threshold of the next falling edge. The X cursors show the pulse
being measured. The Y cursor shows the middle threshold point.

– Width
– Width is the time from the middle threshold of the falling edge to the
middle threshold of the next rising edge. The X cursors show the pulse
being measured. The Y cursor shows the middle threshold point.

Burst Width
The Burst Width measurement is the time from the first edge to the last
edge on screen.

Burst width

Duty Cycle
The duty cycle of a repetitive pulse train is the ratio of the positive pulse
width to the period, expressed as a percentage. The X cursors show the
time period being measured. The Y cursor shows the middle threshold
point.

Width × 100
Duty cycle = +Period
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Rise Time
The rise time of a signal is the time difference between the crossing of the
lower threshold and the crossing of the upper threshold for a
positive- going edge. The X cursor shows the edge being measured. For
maximum measurement accuracy, set the horizontal time/div as fast as
possible while leaving the complete rising edge of the waveform on the
display. The Y cursors show the lower and upper threshold points.

Fall Time
The fall time of a signal is the time difference between the crossing of the
upper threshold and the crossing of the lower threshold for a
negative- going edge. The X cursor shows the edge being measured. For
maximum measurement accuracy, set the horizontal time/div as fast as
possible while leaving the complete falling edge of the waveform on the
display. The Y cursors show the lower and upper threshold points.

Delay
Delay measures the time difference from the selected edge on source 1
and the selected edge on source 2 closest to the trigger reference point at
the middle threshold points on the waveforms. Negative delay values
indicate that the selected edge of source 1 occurred after the selected
edge of source 2.
Source 1
Delay
Source 2

1 Press the [Meas] key to display the Measurement Menu.
2 Press the Source softkey; then turn the Entry knob to select the first
analog channel source.
3 Press the Type: softkey; then, turn the Entry knob to select Delay.
4 Press the Settings softkey to select the second analog channel source
and slope for the delay measurement.
The default Delay settings measure from the rising edge of channel 1 to
the rising edge of channel 2.
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Back/Up key to return to the Measurement Menu.

6 Press the Add Measurement softkey to make the measurement.
The example below shows a delay measurement between the rising edge of
channel 1 and the rising edge of channel 2.

Phase
Phase is the calculated phase shift from source 1 to source 2, expressed in
degrees. Negative phase shift values indicate that the rising edge of source
1 occurred after the rising edge of source 2.

Delay
Phase = Source 1 Period × 360
Period
Source 1
Delay
Source 2
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1 Press the [Meas] key to display the Measurement Menu.
2 Press the Source softkey; then turn the Entry knob to select the first
analog channel source.
3 Press the Type: softkey; then, turn the Entry knob to select Delay.
4 Press the Settings softkey to select the second analog channel source for
the phase measurement.
The default Phase settings measure from channel 1 to channel 2.
5 Press the

Back

Back/Up key to return to the Measurement Menu.

6 Press the Add Measurement softkey to make the measurement.
The example below shows a phase measurement between the channel 1
and the math d/dt function on channel 1.

X at Min Y
X at Min Y is the X axis value (usually time) at the first displayed
occurrence of the waveform Minimum, starting from the left- side of the
display. For periodic signals, the position of the minimum may vary
throughout the waveform. The X cursor shows where the current X at Min
Y value is being measured.
234
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X at Max Y
X at Max Y is the X axis value (usually time) at the first displayed
occurrence of the waveform Maximum, starting from the left- side of the
display. For periodic signals, the position of the maximum may vary
throughout the waveform. The X cursor shows where the current X at Max
Y value is being measured.
See Also

• "To measure the peak of an FFT" on page 235

To measure the peak of an FFT
1 Select FFT as the Operator in the Waveform Math Menu.
2 Choose Math: f(t) as the source in the Measurement Menu.
3 Choose Maximum and X at Max Y measurements.
Maximum units are in dB and X at Max Y units are in Hertz for FFT.

Count Measurements
• "Positive Pulse Count" on page 235
• "Negative Pulse Count" on page 236
• "Rising Edge Count" on page 236
• "Falling Edges Count" on page 236

Positive Pulse Count
The Positive Pulse Count measurement is a pulse count for the selected
waveform source.

Positive pulse count
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This measurement is available for analog channels.

Negative Pulse Count
The Negative Pulse Count measurement is a pulse count for the selected
waveform source.

Negative pulse count

This measurement is available for analog channels.

Rising Edge Count
The Rising Edge Count measurement is an edge count for the selected
waveform source.
This measurement is available for analog channels.

Falling Edges Count
The Falling Edges Count measurement is an edge count for the selected
waveform source.
This measurement is available for analog channels.

Mixed Measurements
• "Area" on page 236

Area
Area measures the area between the waveform and the ground level. Area
below the ground level is subtracted from area above the ground level.
236
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Positive area

T

N cycles
Negative area

The Full Screen measurement interval variation measures the value on all
displayed data points.
The N Cycles measurement interval variation measures the value on an
integral number of periods of the displayed signal. If less than three edges
are present, the measurement shows "No edges".
The X cursors show what interval of the waveform is being measured.

Measurement Thresholds
Setting measurement thresholds defines the vertical levels where
measurements will be taken on an analog channel or math waveform.

NOTE

Changing default thresholds may change measurement results
The default lower, middle, and upper threshold values are 10%, 50%, and 90% of the value
between Top and Base. Changing these threshold definitions from the default values may
change the returned measurement results for Average, Delay, Duty Cycle, Fall Time,
Frequency, Overshoot, Period, Phase, Preshoot, Rise Time, +Width, and -Width.

1 From the Measurement Menu, press the Settings softkey; then, press the
Thresholds softkey to set analog channel measurement thresholds.
You can also open the Measurement Threshold Menu by pressing
[Analyze] > Features and then selecting Measurement Thresholds.
2 Press the Source softkey to select the analog channel or math waveform
source for which you want to change measurement thresholds.

Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

237

14 Measurements

Each analog channel and the math waveform can be assigned unique
threshold values.

3 Press the Type softkey to set the measurement threshold to %
(percentage of Top and Base value) or to Absolute (absolute value).
• Percentage thresholds can be set from 5% to 95%.
• The units for absolute threshold for each channel is set in the
channel probe menu.
• When the Source is set to Math: f(t), the threshold Type can only be set
to Percent.

TIP

Absolute threshold hints
• Absolute thresholds are dependent on channel scaling, probe attenuation, and probe units.
Always set these values first before setting absolute thresholds.
• The minimum and maximum threshold values are limited to on-screen values.
• If any of the absolute threshold values are above or below the minimum or maximum waveform
values, the measurement may not be valid.

4 Press the Lower softkey; then, turn the Entry knob to set the lower
measurement threshold value.
Increasing the lower value beyond the set middle value will
automatically increase the middle value to be more than the lower
value. The default lower threshold is 10% or 800 mV.
If threshold Type is set to %, the lower threshold value can be set from
5% to 93%.
5 Press the Middle softkey; then, turn the Entry knob to set the middle
measurement threshold value.
The middle value is bounded by the values set for lower and upper
thresholds. The default middle threshold is 50% or 1.20 V.
• If threshold Type is set to %, the middle threshold value can be set
from 6% to 94%.
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6 Press the Upper softkey; then, turn the Entry knob to set the upper
measurement threshold value.
Decreasing the upper value below the set middle value will
automatically decrease the middle value to be less than the upper value.
The default upper threshold is 90% or 1.50 V.
• If threshold Type is set to %, the upper threshold value can be set
from 7% to 95%.

Measurement Window with Zoom Display
When the zoomed time base is displayed, you can choose whether
measurements are made in the Main window portion of the display or the
Zoom window portion of the display.
1 Press the [Meas] key.
2 In the Measurement Menu, press the Settings softkey.
3 In the Measurement Settings Menu, press the Meas Window softkey; then,
turn the Entry knob to select from:
• Auto Select — The measurement is attempted in the lower, Zoom
window; if it cannot be made there, the upper, Main window is used.
• Main — The measurement window is the upper, Main window.
• Zoom — The measurement window is the lower, Zoom window.

Measurement Statistics
Press the [Meas] key to enter the Measurement Menu. By default, statistics
are displayed, and frequency and voltage are measured on channel 1.
Select the measurements you desire for the channels you are using (see
"Measurements Summary" on page 217).
From the Measurement Menu, press the Statistics softkey to enter the
Statistics Menu.
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The following statistics are shown: Name of the measurement, current
measured value, mean, minimum measured value, maximum measured
value, standard deviation, and the number of times the measurement has
been made (count). Statistics are based on the total number of captured
waveforms (count).
The standard deviation shown in Statistics is calculated using the same
formula used for calculating the standard deviation measurement. The
formula is shown in the section titled "AC RMS" on page 226.
The source channel of the measurement is shown in parenthesis after the
measurement name. For example: "Freq(1)" indicates a frequency
measurement on channel 1.
You can switch the statistics Display On or Display Off. Statistics continue to
accumulate even when the statistics display is off.
When you navigate away from the Measurements Menu, the statistics
display will no longer be displayed, but statistical data collection will
continue. Return to the Measurements Menu to see the data again.
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To reset the statistics measurements, press the Reset Statistics softkey. This
resets all statistics and begins recording statistical data again.
Each time a new measurement (for example: frequency, period, or
amplitude) is added the statistics are reset and accumulation of statistical
data begins again.
When the [Single] key is pressed, statistics are reset and a single
measurement is done (count = 1). Successive [Single] acquisitions
accumulate statistical data (and the count is incremented).
Press the Transparent softkey to disable the Transparent mode. This shows
statistics with a gray background. Press the Transparent softkey again to
enable Transparent mode. This writes measurement values, statistics, and
cursor values on the screen without a background. The Transparent
setting affects measurement statistics, reference waveform information,
and the optional Mask test feature's statistics display.
Relative σ — When enabled, the standard deviation shown in measurement
statistics becomes a relative standard deviation, that is, standard
deviation/mean.
Max Count — This softkey specifies the number of values used when
calculating measurement statistics.
The Increment Statistics softkey only appears when the acquisition is stopped
and the optional segmented memory feature is off. Press the [Single] or
[Run/Stop] key to stop the acquisition. You can use the horizontal position
control (in the Horizontal control section of the front panel) to pan
through the waveform. Active measurements will stay on screen, allowing
you to measure various aspects of the captured waveforms. Press Increment
Statistics to add the currently measured waveform to the collected
statistical data.
The Analyze Segments softkey only appears when the acquisition is stopped
and the optional segmented memory feature is on. After an acquisition
has completed (and the oscilloscope is stopped), you can press the Analyze
Segments softkey to accumulate measurement statistics for the acquired
segments.
You can also turn on infinite persistence (in the Display Menu) and press
the Analyze Segments softkey to create an infinite persistence display.
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One way to verify a waveform's compliance to a particular set of
parameters is to use mask testing. A mask defines a region of the
oscilloscope's display in which the waveform must remain in order to
comply with chosen parameters. Compliance to the mask is verified
point- by- point across the display. Mask test operates on displayed analog
channels; it does not operate on channels that are not displayed.
To enable mask test order Option LMT at time of oscilloscope purchase, or
order DSOX3MASK as a stand- alone item after oscilloscope purchase.

To create a mask from a "golden" waveform (Automask)
A golden waveform meets all chosen parameters, and it is the waveform to
which all others will be compared.
1 Configure the oscilloscope to display the golden waveform.
2 Press the [Analyze] key.
3 Press Features; then, select Mask Test.
4 Press Features again to enable mask testing.

s1
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5 Press Automask.
6 In the Automask Menu, press the Source softkey and ensure the desired
analog channel is selected.

7 Adjust the mask's horizontal tolerance (± Y) and vertical tolerance
(± X). These are adjustable in graticule divisions or in absolute units
(volts or seconds), selectable using the Units softkey.
8 Press the Create Mask softkey.
The mask is created and testing begins.
Whenever the Create Mask softkey is pressed the old mask is erased and
a new mask is created.
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9 To clear the mask and switch off mask testing, press the Back Back/Up
key to return to the Mask Test Menu, then press the Clear Mask softkey.
If infinite persistence display mode (see "To set or clear persistence" on
page 133) is "on" when mask test is enabled, it stays on. If infinite
persistence is "off" when mask test is enabled, it is switched on when
mask test is switched on, then infinite persistence is switched off when
mask test is switched off.
Troubleshooting
Mask Setup

If you press Create Mask and the mask appears to cover the entire screen,
check the ± Y and ± X settings in the Automask Menu. If these are set to
zero the resulting mask will be extremely tight around the waveform.
If you press Create Mask and it appears that no mask was created, check
the ± Y and ± X settings. They may be set so large that the mask is not
visible.

Mask Test Setup Options
From the Mask Test Menu, press the Setup softkey to enter the Mask Setup
Menu.
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The Run Until softkey lets you specify a condition on which to terminate
testing.
• Forever — The oscilloscope runs continuously. However, if an error occurs
the action specified using the On Error softkey will occur.
• Minimum # of Tests — Choose this option and then use the # of Tests
softkey to select the number of times the oscilloscope will trigger, display
the waveform(s), and compare them to the mask. The oscilloscope will
stop after the specified number of tests have been completed. The
specified minimum number of tests may be exceeded. If an error occurs the
action specified using the On Error softkey will occur. The actual number of
tests completed is displayed above the softkeys.
• Minimum Time — Choose this option and then use the Test Time softkey
to select how long the oscilloscope will run. When the selected time has
passed the oscilloscope will stop. The specified time may be exceeded. If
an error occurs the action specified using the On Error softkey will occur.
The actual test time is displayed above the softkeys.
• Minimum Sigma — Choose this option and then use the Sigma softkey to
select a minimum sigma. The mask test runs until enough waveforms are
tested to achieve a minimum test sigma. (If an error occurs the
oscilloscope will perform the action specified by the On Error softkey.)
Note that this is a test sigma (the max achievable process sigma,
assuming no defects, for a certain number of tested waveforms) as
opposed to a process sigma (which is tied to the amount of failures per
test). The sigma value may exceed the selected value when a small sigma
value is chosen. The actual sigma is displayed.

Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

Mask Testing

15

On Error

The On Error setting specifies the action(s) to take when the input waveform
does not conform to the mask. This setting supersedes the Run Until setting.
• Stop — The oscilloscope will stop when the first error is detected (on the
first waveform that does not conform to the mask). This setting
supersedes the Minimum # of Tests and Minimum Time settings.
• Save — The oscilloscope saves the screen image when an error is
detected. In the Save Menu (press [Save/Recall] > Save), select an
image format (*.bmp or *.png), destination (on a USB storage device), and
file name (which can be auto-incrementing). If errors occur too frequently
and the oscilloscope spends all its time saving images, press the [Stop]
key to stop acquisitions.
• Print — The oscilloscope prints the screen image when an error is
detected. This option is only available when a printer is connected as
described in "To print the oscilloscope's display" on page 289.
• Measure — Measurements (and measurement statistics if your
oscilloscope supports them) run only on waveforms that contain a mask
violation. Measurements are not affected by passing waveforms. This
mode is not available when the acquisition mode is set to Averaging.
Note that you can choose to Print or Save, but you cannot select both at the
same time. All other actions may be selected at the same time. For example,
you can select both Stop and Measure to cause the oscilloscope to measure
and stop on the first error..
You can also output a signal on the rear panel TRIG OUT BNC connector when
there is a mask test failure. See "Setting the Rear Panel TRIG OUT Source" on
page 304.

Source Lock

When you turn on Source Lock using the Source Lock softkey, the mask is
redrawn to match the source whenever you move the waveform. For example,
if you change the horizontal timebase or the vertical gain the mask is redrawn
with the new settings.
When you turn off Source Lock, the mask is not redrawn when horizontal or
vertical settings are changed.

Source

If you change the Source channel, the mask is not erased. It is re-scaled to the
vertical gain and offset settings of the channel to which it is assigned. To
create a new mask for the selected source channel, go back up in the menu
hierarchy; then, press Automask, and press Create Mask.
The Source softkey in the Mask Setup Menu is the same as the Source
softkey in the Automask Menu.

Test All

When enabled, all displayed analog channels are included in the mask test.
When disabled, just the selected source channel is included in the test.
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Mask Statistics
From the Mask Test Menu, press the Statistics softkey to enter the Mask
Statistics Menu.

Show Stats

248

When you enable Show Statistics the following information is displayed:
• Current mask, name of mask, Channel number, date and time.
• # of Tests (total number of mask tests executed).
• Status (Passing, Failing, or Untested).
• Accumulated test time (in hours, minutes, seconds, and tenths of
seconds).
And for each analog channel:
• Number of failures (acquisitions in which the signal excursion went
beyond the mask).
• Failure rate (percentage of failures).
• Sigma (the ratio of process sigma to maximum achievable sigma, based on
number of waveforms tested).
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Reset Statistics

Note that statistics are also reset when:
• Mask Test is switched on after being switched off.
• Clear Mask softkey is pressed.
• An Automask is created.
Additionally, the accumulated time counter is reset whenever the
oscilloscope is run after the acquisition was stopped.

Transparent

Enable Transparent mode to write measurement values and statistics on the
screen without a background. Disable the Transparent mode to show them
with a gray background. The Transparent setting affects mask test statistics,
measurement statistics, and reference waveform information display.

Clear Display

Clears acquisition data from the oscilloscope display.

To manually modify a mask file
You can manually modify a mask file that you created using the Automask
function.
1 Follow the steps 1- 7 in "To create a mask from a "golden" waveform
(Automask)" on page 243. Do not clear the mask after creating it.
2 Attach a USB mass storage device to the oscilloscope.
3 Press the [Save/Recall] key.
4 Press the Save softkey.
5 Press the Format softkey and select Mask.
6 Press the second softkey and select a destination folder on your USB
mass storage device.
7 Press the Press to Save softkey. This creates an ASCII text file that
describes the mask.
8 Remove the USB mass storage device and connect it to a PC.
9 Open the .msk file your created using a text editor (such as Wordpad).
10 Edit, save, and close the file.
The mask file contains the following sections:
• Mask File Identifier.
• Mask Title.
• Mask Violation Regions.
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• Oscilloscope Setup Information.
Mask File
Identifier

The Mask File Identifier is MASK_FILE_548XX.

Mask Title

The Mask Title is a string of ASCII characters. Example: autoMask CH1
OCT 03 09:40:26 2008
When a mask file contains the keyword "autoMask" in the title, the edge of
the mask is passing by definition. Otherwise, the edge of the mask is
defined as a failure.

Mask Violation
Regions

Region 1

Region 2

Up to 8 regions can be defined for a mask. They can be numbered 1- 8.
They can appear in any order in the .msk file. The numbering of the
regions must go from top to bottom, left to right.
An Automask file contains two special regions: the region "glued" to the
top of the display, and the region that is "glued" to the bottom. The top
region is indicated by y- values of "MAX" for the first and last points. The
bottom region is indicated by y- values of "MIN" for the first and last
points.
The top region must be the lowest numbered region in the file. The
bottom region must be the highest numbered region in the file.
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Region number 1 is the top mask region. The vertices in Region 1 describe
points along a line; that line is the bottom edge of the top portion of the
mask.
Similarly, the vertices in Region 2 describe the line that forms the top of
the bottom part of the mask.
The vertices in a mask file are normalized. There are four parameters that
define how values are normalized:
• X1
• ΔX
• Y1
• Y2
These four parameters are defined in the Oscilloscope Setup portion of the
mask file.
The Y- values (normally voltage) are normalized in the file using the
following equation:
Ynorm = (Y - Y1)/ΔY
where ΔY = Y2 - Y1
To convert the normalized Y- values in the mask file to voltage:
Y = (Ynorm * ΔY) + Y1
where ΔY = Y2 - Y1
The X- values (normally time) are normalized in the file using the
following equation:
Xnorm = (X - X1)/ΔX
To convert the normalized X- values to time:
X = (Xnorm * ΔX) + X1
Oscilloscope
Setup Information

The keywords "setup" and "end_setup" (appearing alone on a line) define
the beginning and end of the oscilloscope setup region of the mask file.
The oscilloscope setup information contains remote programming language
commands that the oscilloscope executes when the mask file is loaded.
Any legal remote programming command can be entered in this section.
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The mask scaling controls how the normalized vectors are interpreted.
This in turn controls how the mask is drawn on the display. The remote
programming commands that control mask scaling are:
:MTES:SCAL:BIND 0
:MTES:SCAL:X1 -400.000E-06
:MTES:SCAL:XDEL +800.000E-06
:MTES:SCAL:Y1 +359.000E-03
:MTES:SCAL:Y2 +2.35900E+00

Building a Mask File
The following mask uses all eight mask regions. The most difficult part of
creating a mask file is normalizing the X and Y values from the time and
voltage values. This example shows an easy way to convert voltage and
time to normalized X and Y values in the mask file.

The following mask file produced the mask shown above:
MASK_FILE_548XX
"All Regions"
/* Region Number */ 1
/* Number of vertices */ 4
-12.50,
MAX
-10.00, 1.750

252

Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

Mask Testing

10.00,
12.50,

15

1.750
MAX

/* Region Number */ 2
/* Number of vertices */ 5
-10.00, 1.000
-12.50, 0.500
-15.00, 0.500
-15.00, 1.500
-12.50, 1.500
/* Region Number */ 3
/* Number of vertices */ 6
-05.00, 1.000
-02.50, 0.500
02.50, 0.500
05.00, 1.000
02.50, 1.500
-02.50, 1.500
/* Region Number */ 4
/* Number of vertices */ 5
10.00, 1.000
12.50, 0.500
15.00, 0.500
15.00, 1.500
12.50, 1.500
/* Region Number */ 5
/* Number of vertices */ 5
-10.00, -1.000
-12.50, -0.500
-15.00, -0.500
-15.00, -1.500
-12.50, -1.500
/* Region Number */ 6
/* Number of vertices */ 6
-05.00, -1.000
-02.50, -0.500
02.50, -0.500
05.00, -1.000
02.50, -1.500
-02.50, -1.500
/* Region Number */ 7
/* Number of vertices */ 5
10.00, -1.000
12.50, -0.500
15.00, -0.500
15.00, -1.500
12.50, -1.500
/* Region Number */ 8
/* Number of vertices */ 4
-12.50,
MIN
-10.00, -1.750
10.00, -1.750
12.50,
MIN
setup
:MTES:ENAB 1
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:CHAN1:RANG +4.00E+00;OFFS +0.0E+00;COUP DC;IMP ONEM;DISP 1;BWL 0;INV 0
:CHAN1:LAB "1";UNIT VOLT;PROB +1.0E+00;PROB:SKEW +0.0E+00;STYP SING
:CHAN2:RANG +16.0E+00;OFFS +1.62400E+00;COUP DC;IMP FIFT;DISP 0;BWL 0;INV
0
:CHAN2:LAB "2";UNIT VOLT;PROB +1.0E+00;PROB:SKEW +0.0E+00;STYP SING
:CHAN3:RANG +40.0E+00;OFFS +0.0E+00;COUP DC;IMP ONEM;DISP 0;BWL 0;INV 0
:CHAN3:LAB "3";UNIT VOLT;PROB +1.0E+00;PROB:SKEW +0.0E+00;STYP SING
:CHAN4:RANG +40.0E+00;OFFS +0.0E+00;COUP DC;IMP ONEM;DISP 0;BWL 0;INV 0
:CHAN4:LAB "4";UNIT VOLT;PROB +1.0E+00;PROB:SKEW +0.0E+00;STYP SING
:EXT:BWL 0;IMP ONEM;RANG +5E+00;UNIT VOLT;PROB +1.0E+00;PROB:STYP SING
:TIM:MODE MAIN;REF CENT;MAIN:RANG +50.00E-09;POS +0.0E+00
:TRIG:MODE EDGE;SWE AUTO;NREJ 0;HFR 0;HOLD +60E-09
:TRIG:EDGE:SOUR CHAN1;LEV -75.00E-03;SLOP POS;REJ OFF;COUP DC
:ACQ:MODE RTIM;TYPE NORM;COMP 100;COUNT 8;SEGM:COUN 2
:DISP:LAB 0;CONN 1;PERS MIN;SOUR PMEM1
:HARD:APR "";AREA SCR;FACT 0;FFE 0;INKS 1;PAL NONE;LAY PORT
:SAVE:FIL "mask_0"
:SAVE:IMAG:AREA GRAT;FACT 0;FORM NONE;INKS 0;PAL COL
:SAVE:WAV:FORM NONE
:MTES:SOUR CHAN1;ENAB 1;LOCK 1
:MTES:AMAS:SOUR CHAN1;UNIT DIV;XDEL +3.00000000E-001;YDEL +2.00000000E-00
1
:MTES:SCAL:BIND 0;X1 +0.0E+00;XDEL +1.0000E-09;Y1 +0.0E+00;Y2 +1.00000E+0
0
:MTES:RMOD FOR;RMOD:TIME +1E+00;WAV 1000;SIGM +6.0E+00
:MTES:RMOD:FACT:STOP 0;PRIN 0;SAVE 0
end_setup

How is mask testing done?
InfiniiVision oscilloscopes start mask testing by creating a database that is
200 x 640 for the waveform viewing area. Each location in the array is
designated as either a violation or a pass area. Each time a data point
from a waveform occurs in a violation area a failure is logged. If Test All
was selected, every active analog channel is tested against the mask
database for each acquisition. Over 2 billion failures can be logged
per- channel. The number of acquisitions tested is also logged and
displayed as "# of Tests".
The mask file allows greater resolution than the 200 X 640 database. Some
quantization of data occurs to reduce the mask file data for display
on- screen.
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The Digital Voltmeter (DVM) analysis feature provides 3- digit voltage and
5- digit frequency measurements using any analog channel. DVM
measurements are asynchronous from the oscilloscope's acquisition system
and are always acquiring.
To enable the digital voltmeter analysis feature, order Option DVM at time
of oscilloscope purchase, or order DSOXDVM as a stand- alone item after
oscilloscope purchase.
The DVM display is a seven- segment readout like you would see on a
digital voltmeter. It shows the selected mode as well as the units. Units
are selected using the Units softkey in the channel's Probe Menu.
After pressing the [Analyze] key, the DVM display also appears in the
graticule along with a scale and the frequency counter value. The DVM
scale is determined by the channel's vertical scale and reference level. The
scale's blue triangle pointer shows the most recent measurement. The
white bar above that shows the measurement extrema over the last 3
seconds.
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The DVM makes accurate RMS measurements when the signal frequency is
between 20 Hz and 100 kHz. When the signal frequency is outside this
range, "<BW Limit?" or ">BW Limit?" appears in the DVM display to
caution you about inaccurate RMS measurement results.
To use the digital voltmeter:
1 Press the [Analyze] key.
2 Press Features; then, select Digital Voltmeter.
3 Press Features again to enable the DVM measurements.
4 Press the Source softkey and turn the Entry knob to select the analog
channel on which digital voltmeter (DVM) measurements are made.
The selected channel does not have to be on (displaying a waveform) in
order for DVM measurements to be made.
5 Press the Mode softkey and turn the Entry knob to select the digital
voltmeter (DVM) mode:
• AC RMS — displays the root- mean- square value of the acquired data,
with the DC component removed.
• DC — displays the DC value of the acquired data.
• DC RMS — displays the root- mean- square value of the acquired data.
• Frequency — displays the frequency counter measurement.
256
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6 Press Transparent to toggle between a transparent and shaded
background for the DVM display.
7 If the selected source channel is not used in oscilloscope triggering,
press Auto Range to disable or enable automatic adjustment of the DVM
channel's vertical scale, vertical (ground level) position, and trigger
(threshold voltage) level (used for the counter frequency measurement).
When enabled, Auto Range overrides attempted adjustments of the
channel's vertical scale and position knobs.
When disabled, you can use the channel's vertical scale and position
knobs normally.
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To select generated waveform types and settings 259
To edit arbitrary waveforms 263
To output the waveform generator sync pulse 267
To specify the expected output load 267
To use waveform generator logic presets 268
To add noise to the waveform generator output 269
To add modulation to the waveform generator output 269
To restore waveform generator defaults 274

A waveform generator is built into the oscilloscope. It is enabled by
Option WGN or the DSOX3WAVEGEN upgrade. The waveform generator
gives you an easy way to provide input signals when testing circuitry with
the oscilloscope.
Waveform generator settings can be saved and recalled with oscilloscope
setups. See Chapter 18, “Save/Recall (Setups, Screens, Data),” starting on
page 275.

To select generated waveform types and settings
1 To access the Waveform Generator Menu and enable or disable the
waveform generator output on the front panel Gen Out BNC, press the
[Wave Gen] key.
When waveform generator output is enabled, the [Wave Gen] key is
illuminated. When waveform generator output is disabled, the [Wave
Gen] key is off.
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The waveform generator output is always disabled when the instrument
is first turned on.
The waveform generator output is automatically disabled if excessive
voltage is applied to the Gen Out BNC.
2 In the Waveform Generator Menu, press the Waveform softkey and turn
the Entry knob to select the waveform type.

3 Depending on the selected waveform type, use the remaining softkeys
and the Entry knob to set the waveform's characteristics.
Waveform
Type

Characteristics

Frequency
Range

Max.
Amplitude
(High-Z)1

Offset
(High-Z)1

Arbitrary

Use the Frequency/Frequency
Fine/Period/Period Fine, Amplitude/High-Level,
and Offset/Low-Level softkeys to set the arbitrary
waveform signal parameters.
Use the Edit Waveform softkey to define the
arbitrary waveform shape. See "To edit arbitrary
waveforms" on page 263.

100 mHz to
12 MHz

20 mVpp to
5 Vpp

±2.50 V
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Waveform
Type

Characteristics

Frequency
Range

Max.
Amplitude
(High-Z)1

Offset
(High-Z)1

Sine

Use the Frequency/Frequency
Fine/Period/Period Fine, Amplitude/High-Level,
and Offset/Low-Level softkeys to set the sine
signal parameters.

100 mHz to
20 MHz

20 mVpp to
5 Vpp

±2.50 V

Square

Use the Frequency/Frequency
Fine/Period/Period Fine, Amplitude/High-Level,
Offset/Low-Level, and Duty Cycle softkeys to set
the square wave signal parameters.
The duty cycle can be adjusted from 20% to 80%.

100 mHz to
10 MHz

20 mVpp to
5 Vpp

±2.50 V

Ramp

Use the Frequency/Frequency
Fine/Period/Period Fine, Amplitude/High-Level,
Offset/Low-Level, and Symmetry softkeys to set
the ramp signal parameters.
Symmetry represents the amount of time per cycle
that the ramp waveform is rising and can be
adjusted from 0% to 100%.

100 mHz to
200 kHz

20 mVpp to
5 Vpp

±2.50 V

Pulse

Use the Frequency/Frequency
Fine/Period/Period Fine, Amplitude/High-Level,
Offset/Low-Level, and Width/Width Fine
softkeys to set the pulse signal parameters.
The pulse width can be adjusted from 20 ns to the
period minus 20 ns.

100 mHz to
10 MHz.

20 mVpp to
5 Vpp

±2.50 V

DC

Use the Offset softkey to set the DC level.

n/a

n/a

±2.50 V

Noise

Use the Amplitude/High-Level and
Offset/Low-Level to set the noise signal
parameters.

n/a

20 mVpp to
5 Vpp

±2.50 V

Sine Cardinal

Use the Frequency/Frequency
Fine/Period/Period Fine, Amplitude, and Offset
softkeys to set the sinc signal parameters.

100 mHz to
1 MHz

20 mVpp to
5 Vpp

±1.25 V

Exponential
Rise

Use the Frequency/Frequency
Fine/Period/Period Fine, Amplitude/High-Level,
and Offset/Low-Level softkeys to set the
exponential rise signal parameters.

100 mHz to
5 MHz

20 mVpp to
5 Vpp

±2.50 V
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Waveform
Type

Characteristics

Frequency
Range

Max.
Amplitude
(High-Z)1

Offset
(High-Z)1

Exponential
Fall

Use the Frequency/Frequency
Fine/Period/Period Fine, Amplitude/High-Level,
and Offset/Low-Level softkeys to set the
exponential fall signal parameters.

100 mHz to
5 MHz

20 mVpp to
5 Vpp

±2.50 V

Cardiac

Use the Frequency/Frequency
Fine/Period/Period Fine, Amplitude, and Offset
softkeys to set the cardiac signal parameters.

100 mHz to
200 kHz

20 mVpp to
5 Vpp

±1.25 V

Gaussian
Pulse

Use the Frequency/Frequency
Fine/Period/Period Fine, Amplitude, and Offset
softkeys to set the gaussian pulse signal
parameters.

100 mHz to
5 MHz

20 mVpp to
4 Vpp

±1.25 V

1When the output load is 50 Ω, these values are halved.

Pressing a signal parameter softkey can open a menu for selecting the
type of adjustment. For example, you can choose to enter amplitude
and offset values, or you can choose to enter high- level and low- level
values. Or, you can choose to enter frequency values or period values.
Keep pressing the softkey to select the type of adjustment. Turn the
Entry knob to adjust the value.
Notice that you can select between coarse and fine adjustments for
frequency, period, and width. Also, pushing the Entry knob is a quick
way to toggle between coarse and fine adjustments.
The Settings softkey opens the Waveform Generator Settings Menu which
lets you make other settings related to the waveform generator.

See:
• "To output the waveform generator sync pulse" on page 267
• "To specify the expected output load" on page 267
• "To use waveform generator logic presets" on page 268
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• "To add noise to the waveform generator output" on page 269
• "To restore waveform generator defaults" on page 274

To edit arbitrary waveforms
1 When Arbitrary is selected as the generated waveform type (see "To
select generated waveform types and settings" on page 259), press the
Edit Waveform softkey to open the Edit Waveform Menu.

When you open the Edit Waveform Menu, you see the existing arbitrary
waveform definition. The voltage and time period you see in the
diagram are the bounding parameters — they come from the frequency
and amplitude settings in the main Waveform Generator Menu.
2 Use the softkeys in the Edit Waveform Menu to define the shape of the
arbitrary waveform:
Softkey

Description

Create New

Opens the New Waveform Menu. See "Creating New Arbitrary Waveforms" on page 264.
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Softkey

Description

Edit Existing

Opens the Edit Waveform Points Menu. See "Editing Existing Arbitrary Waveforms" on
page 265.

Interpolate

Specifies how lines are drawn between arbitrary waveform points.
When enabled, lines are drawn between points in the waveform editor. Voltage levels
change linearly between one point and the next.
When disabled, all line segments in the waveform editor are horizontal. The voltage level of
one point remains until the next point.

Source

Selects the analog channel or reference waveform to be captured and stored to the arbitrary
waveform. See "Capturing Other Waveforms to the Arbitrary Waveform" on page 266.

Store Source to Arb

Captures the selected waveform source and copy it to the arbitrary waveform. See
"Capturing Other Waveforms to the Arbitrary Waveform" on page 266.

NOTE

You can use the [Save/Recall] key and menu to save arbitrary waveforms to one of four
internal storage locations or to a USB storage device, and you can recall them later. See "To
save arbitrary waveforms" on page 282 and "To recall arbitrary waveforms" on page 285.

Creating New Arbitrary Waveforms
The New Waveform Menu is opened by pressing Create New in the Edit
Waveform Menu.

To create a new arbitrary waveform:
1 In the New Waveform Menu, press Initial Pts; then, use the Entry knob to
select the initial number of points in the new waveform.
The new waveform will be a square wave with the number of points
you specify. The points are evenly spaced over the time period.
2 Use the Frequency/Frequency Fine/Period/Period Fine softkey to set the time
period bounding parameter (repetition frequency) of the arbitrary
waveform.
3 Use the Amplitude/High-Level and Offset/Low-Level softkeys to set the
voltage bounding parameter of the arbitrary waveform.
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4 When you are ready to create the new arbitrary waveform, press Apply
& Edit.

CAUTION

When you create a new arbitrary waveform, the existing arbitrary waveform definition
is overwritten. Note that you can use the [Save/Recall] key and menu to save
arbitrary waveforms to one of four internal storage locations or to a USB storage
device, and you can recall them later. See "To save arbitrary waveforms" on page 282
and "To recall arbitrary waveforms" on page 285.

The new waveform is created and the Edit Waveform Points menu is
opened. See "Editing Existing Arbitrary Waveforms" on page 265.
Note that you can also create a new arbitrary waveform by capturing
another waveform. See "Capturing Other Waveforms to the Arbitrary
Waveform" on page 266.

Editing Existing Arbitrary Waveforms
The Edit Waveform Points Menu is opened by pressing Edit Existing in the
Edit Waveform Menu or by pressing Apply & Edit when creating a new
arbitrary waveform.
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To specify the voltage values of points:
1 Press Point #; then, use the Entry knob to select the point whose voltage
value you wish to set.
2 Press Voltage; then, use the Entry knob to set the point's voltage value.
To insert a point:
1 Press Point #; then, use the Entry knob to select the point after which
the new point will be inserted.
2 Press Insert Point.
All points are adjusted to maintain uniform time spacing between
points.
To remove a point:
1 Press Point #; then, use the Entry knob to select the point you want to
remove.
2 Press Remove Point.
All points are adjusted to maintain uniform time spacing between
points.
The Transparent softkey enables or disables transparent backgrounds. When
enabled, you can view underlying waveforms. When disabled, the
background is shaded.

Capturing Other Waveforms to the Arbitrary Waveform
The Edit Waveform Menu is opened by pressing Edit Waveform in the main
Waveform Generator Menu.

To capture another waveform to the arbitrary waveform:
1 Press Source; then, use the Entry knob to select the analog channel,
math, or reference location whose waveform you wish to capture.
2 Press Store Source to Arb.
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When you create a new arbitrary waveform, the existing arbitrary waveform definition
is overwritten. Note that you can use the [Save/Recall] key and menu to save
arbitrary waveforms to one of four internal storage locations or to a USB storage
device, and you can recall them later. See "To save arbitrary waveforms" on page 282
and "To recall arbitrary waveforms" on page 285.

The source waveform is decimated into 8192 (maximum) or fewer
arbitrary waveform points.

NOTE

If the source waveform frequency and/or voltage exceed the capabilities of the waveform
generator, the arbitrary waveform will be limited to the capabilities of the waveform
generator. For example, a 20 MHz waveform captured as the arbitrary waveform, becomes a
12 MHz waveform.

To output the waveform generator sync pulse
1 If the Waveform Generator Menu is not currently displayed on the
oscilloscope's softkeys, press the [Wave Gen] key.
2 In the Waveform Generator Menu, press the Settings softkey.
3 In the Waveform Generator Settings Menu, press the Trig Out softkey and
turn the Entry knob to select Waveform Generator Sync Pulse.
Waveform Type

Sync Signal Characteristics

All waveforms except
DC, Noise, and
Cardiac

The Sync signal is a TTL positive pulse that occurs when the waveform
rises above zero volts (or the DC offset value).

DC, Noise, and
Cardiac

N/A

To specify the expected output load
1 If the Waveform Generator Menu is not currently displayed on the
oscilloscope's softkeys, press the [Wave Gen] key.
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2 In the Waveform Generator Menu, press the Settings softkey.
3 In the Waveform Generator Settings Menu, press the Out Load softkey
and turn the Entry knob to select:
• 50 Ω
• High-Z
The output impedance of the Gen Out BNC is fixed at 50 ohms. However,
the output load selection lets the waveform generator display the correct
amplitude and offset levels for the expected output load.
If the actual load impedance is different than the selected value, the
displayed amplitude and offset levels will be incorrect.

To use waveform generator logic presets
With logic level presets, you can easily set the output voltage to TTL,
CMOS (5.0V), CMOS (3.3V), CMOS (2.5V), or ECL compatible Low and High
levels.
1 If the Waveform Generator Menu is not currently displayed on the
oscilloscope's softkeys, press the [Wave Gen] key.
2 In the Waveform Generator Menu, press the Settings softkey.
3 In the Waveform Generator Settings Menu, press the Logic Presets
softkey.
4 In the Waveform Generator Logic Level Presets Menu, press one of the
softkeys to set the generated signal's Low and High voltages to logic
compatible levels:
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Softkey (logic levels)

Low level

High level, 50 ohm
expected output load

High level, high-Z
expected output load

TTL

0V

+2.5 V (TTL compatible)

+5 V

CMOS (5.0V)

0V

Not Available

+5 V

CMOS (3.3V)

0V

+2.5 V (CMOS
compatible)

+3.3 V

CMOS (2.5V)

0V

+2.5 V

+2.5 V

ECL

-1.7 V

-0.8 V (ECL compatible)

-0.9 V
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To add noise to the waveform generator output
1 If the Waveform Generator Menu is not currently displayed on the
oscilloscope's softkeys, press the [Wave Gen] key.
2 In the Waveform Generator Menu, press the Settings softkey.
3 In the Waveform Generator Settings Menu, press the Add Noise softkey
and turn the Entry knob to select the amount of white noise to add to
the waveform generator output.
Note that adding noise affects edge triggering on the waveform generator
source (see "Edge Trigger" on page 146) as well as the waveform generator
sync pulse output signal (which can be sent to TRIG OUT, see "Setting the
Rear Panel TRIG OUT Source" on page 304). This is because the trigger
comparator is located after the noise source.

To add modulation to the waveform generator output
Modulation is where an original carrier signal is modified according to the
amplitude of a second modulating signal. The modulation type (AM, FM, or
FSK) specifies how the carrier signal is modified.
To enable and set up modulation for the waveform generator output:
1 If the Waveform Generator Menu is not currently displayed on the
oscilloscope's softkeys, press the [Wave Gen] key.
2 In the Waveform Generator Menu, press the Settings softkey.
3 In the Waveform Generator Settings Menu, press the Modulation softkey.
4 In the Waveform Generator Modulation Menu:

• Press the Modulation softkey to enable or disable modulated waveform
generator output.
You can enable modulation for all waveform generator function types
except pulse, DC, and noise.
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• Press the Type softkey and turn the Entry knob to select the
modulation type:
• Amplitude Modulation (AM) — the amplitude of the original carrier
signal is modified according to the amplitude of the modulating
signal. See "To set up Amplitude Modulation (AM)" on page 270.
• Frequency Modulation (FM) — the frequency of the original carrier
signal is modified according to the amplitude of the modulating
signal. See "To set up Frequency Modulation (FM)" on page 271.
• Frequency-Shift Keying Modulation (FSK) — the output frequency "shifts"
between the original carrier frequency and a "hop frequency" at
the specified FSK rate. The FSK rate specifies a digital square
wave modulating signal. See "To set up Frequency- Shift Keying
Modulation (FSK)" on page 273.

To set up Amplitude Modulation (AM)
In the Waveform Generator Modulation Menu (under [Wave Gen] > Settings >
Modulation):
1 Press the Type softkey and turn the Entry knob to select Amplitude
Modulation (AM).
2 Press the Waveform softkey and turn the Entry knob to select the shape
of the modulating signal:
• Sine
• Square
• Ramp
• Sine Cardinal
• Exponential Rise
• Exponential Fall
When the Ramp shape is selected, a Symmetry softkey appears so that
you can specify the amount of time per cycle that the ramp waveform is
rising.
3 Press the AM Freq softkey and turn the Entry knob to specify the
frequency of the modulating signal.
4 Press the AM Depth softkey and turn the Entry knob to specify the
amount of amplitude modulation.
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AM Depth refers to the portion of the amplitude range that will be used
by the modulation. For example, a depth setting of 80% causes the
output amplitude to vary from 10% to 90% (90% – 10% = 80%) of the
original amplitude as the modulating signal goes from its minimum to
maximum amplitude.
The following screen shows an AM modulation of a 100 kHz sine wave
carrier signal.

To set up Frequency Modulation (FM)
In the Waveform Generator Modulation Menu (under [Wave Gen] > Settings >
Modulation):
1 Press the Type softkey and turn the Entry knob to select Frequency
Modulation (FM).
2 Press the Waveform softkey and turn the Entry knob to select the shape
of the modulating signal:
• Sine
• Square
• Ramp
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• Sine Cardinal
• Exponential Rise
• Exponential Fall
When the Ramp shape is selected, a Symmetry softkey appears so that
you can specify the amount of time per cycle that the ramp waveform is
rising.
3 Press the FM Freq softkey and turn the Entry knob to specify the
frequency of the modulating signal.
4 Press the FM Dev softkey and turn the Entry knob to specify the
frequency deviation from the original carrier signal frequency.
When the
frequency
when the
frequency

modulating signal is at its maximum amplitude, the output
is the carrier signal frequency plus the deviation amount, and
modulating signal is at its minimum amplitude, the output
is the carrier signal frequency minus the deviation amount.

The frequency deviation cannot be greater than the original carrier
signal frequency.
Also, the sum of the original carrier signal frequency and the frequency
deviation must be less than or equal to the maximum frequency for the
selected waveform generator function plus 100 kHz.
The following screen shows an FM modulation of a 100 kHz sine wave
carrier signal.
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To set up Frequency-Shift Keying Modulation (FSK)
In the Waveform Generator Modulation Menu (under [Wave Gen] > Settings >
Modulation):
1 Press the Type softkey and turn the Entry knob to select Frequency-Shift
Keying Modulation (FSK).
2 Press the Hop Freq softkey and turn the Entry knob to specify the "hop
frequency".
The output frequency "shifts" between the original carrier frequency and
this "hop frequency".
3 Press the FSK Rate softkey and turn the Entry knob to specify the rate
at which the output frequency "shifts".
The FSK rate specifies a digital square wave modulating signal.
The following screen shows an FSK modulation of a 100 kHz sine wave
carrier signal.
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To restore waveform generator defaults
1 If the Waveform Generator Menu is not currently displayed on the
oscilloscope's softkeys, press the [Wave Gen] key.
2 In the Waveform Generator Menu, press the Settings softkey.
3 In the Waveform Generator Settings Menu, press the Default Wave Gen
softkey.
The waveform generator factory default settings (1 kHz sine wave,
500 mVpp, 0 V offset, High- Z output load) are restored.
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Save/Recall (Setups, Screens, Data)
Saving Setups, Screen Images, or Data 275
Recalling Setups, Masks, or Data 283
Recalling Default Setups 286
Performing a Secure Erase 286

Oscilloscope setups, reference waveforms, and mask files can be saved to
internal oscilloscope memory or to a USB storage device and recalled
later. You can also recall default or factory default setups.
Oscilloscope screen images can be saved to a USB storage device in BMP
or PNG formats.
Acquired waveform data can be saved to a USB storage device in
comma- separated value (CSV), ASCII XY, and binary (BIN) formats.
There is also a command to securely erase all the oscilloscope's
non- volatile internal memory.

Saving Setups, Screen Images, or Data
1 Press the [Save/Recall] key.
2 In the Save/Recall Menu, press Save.
3 In the Save Trace and Setup Menu, press Format; then, turn the Entry
knob to select the type of file you want to save:
• Setup (*.scp) — The oscilloscope's horizontal timebase,
sensitivity, trigger mode, trigger level, measurements,
math function settings that tell the oscilloscope how
particular measurement. See "To save setup files" on
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• 8-bit Bitmap image (*.bmp) — The complete screen image in a reduced
color (8- bit) bitmap format. See "To save BMP or PNG image files" on
page 277.
• 24-bit Bitmap image (*.bmp) — The complete screen image in a 24- bit
color bitmap format. See "To save BMP or PNG image files" on
page 277.
• 24-bit image (*.png) — The complete screen image in a 24- bit color PNG
format that uses lossless compression. Files are much smaller than
the BMP format. See "To save BMP or PNG image files" on page 277.
• CSV data (*.csv) — This creates a file of comma- separated values of all
displayed channels and math waveforms. This format is suitable for
spreadsheet analysis. See "To save CSV, ASCII XY, or BIN data
files" on page 278.
• ASCII XY data (*.csv) — This creates separate files of comma- separated
values for each displayed channel. This format is also suitable for
spreadsheets. See "To save CSV, ASCII XY, or BIN data files" on
page 278.
• Reference Waveform data (*.h5) — Saves waveform data in a format that
can be recalled to one of the oscilloscope's reference waveform
locations. See "To save reference waveform files to a USB storage
device" on page 281.
• Multi Channel Waveform data (*.h5) — Saves multiple channels of
waveform data in a format that can be opened by the N8900A
InfiniiView oscilloscope analysis software. You can recall the first
Analog or Math channel from a multi channel waveform data file.
• Binary data (*.bin) — This creates a binary file, with a header, and data
in the form of time and voltage pairs. This file is much smaller than
the ASCII XY data file. See "To save CSV, ASCII XY, or BIN data
files" on page 278.
• Lister data (*.csv) — This is a CSV format file containing serial decode
row information with commas separating the columns. See "To save
Lister data files" on page 280.
• Mask (*.msk) — This creates a mask file in an Agilent proprietary
format that can be read by Agilent InfiniiVision oscilloscopes. A mask
data file includes some oscilloscope setup information, but not all
setup information. To save all setup information including the mask
data file, choose "Setup (*.scp)" format instead. See "To save
masks" on page 281.
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• Arbitrary Waveform data (*.csv) — This creates a file of comma- separated
values for the arbitrary waveform points' time and voltage values. See
"To save arbitrary waveforms" on page 282.
• Power Harmonics data (*.csv) — When the DSOX3PWR power analysis
allication is licensed, this creates a file of comma- separated values
for the current harmonics power analysis results. See the DSOX3PWR
Power Measurement Application User's Guide for more information.
You can also configure the [Quick Action] key to save setups, screen images,
or data. See "Configuring the [Quick Action] Key" on page 311.

To save setup files
Setup files can be saved to one of 10 internal (\Agilent Flash) locations or
to an external USB storage device.
1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select
Setup (*.scp).
2 Press the softkey in the second position and use the Entry knob to
navigate to the save location. See "To navigate storage locations" on
page 282.
3 Finally, press the Press to Save softkey.
A message indicating whether the save was successful is displayed.
Setup files have the extension SCP. These extensions appear when using
the File Explorer (see "File Explorer" on page 299), but they do not
appear when using the Recall Menu.

To save BMP or PNG image files
Image files can be saved to an external USB storage device.
1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select
8-bit Bitmap image (*.bmp), 24-bit Bitmap image (*.bmp), or 24-bit image (*.png).
2 Press the softkey in the second position and use the Entry knob to
navigate to the save location. See "To navigate storage locations" on
page 282.
3 Press the Settings softkey.
In the File Settings Menu, you have these softkeys and options:
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• Setup Info — setup information (vertical, horizontal, trigger, acquisition,
math, and display settings) is also saved in a separate file with a
TXT extension.
• Invert Grat — the graticule in the image file has a white background
instead of the black backgound that appears on- screen.

Graticule Not Inverted

Graticule Inverted

• Palette — lets you choose between Color or Grayscale images.
4 Finally, press the Press to Save softkey.
A message indicating whether the save was successful is displayed.

NOTE

When saving screen images, the oscilloscope uses the last menu visited before pressing
the [Save/Recall] key. This lets you save any relevant information within the softkey menu
area.
To save a screen image showing the Save/Recall Menu at the bottom, press the
[Save/Recall] key twice before saving the image.

NOTE

See Also

You can also save the oscilloscope's display image using a web browser. See "Get
Image" on page 325 for details.

• "Adding an Annotation" on page 312

To save CSV, ASCII XY, or BIN data files
Data files can be saved to an external USB storage device.
1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select
CSV data (*.csv), ASCII XY data (*.csv), or Binary data (*.bin).
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2 Press the softkey in the second position and use the Entry knob to
navigate to the save location. See "To navigate storage locations" on
page 282.
3 Press the Settings softkey.
In the File Settings Menu, you have these softkeys and options:
• Setup Info — when enabled, setup information (vertical, horizontal,
trigger, acquisition, math, and display settings) is also saved in a
separate file with a TXT extension.
• Length — sets the number of data points that will be output to the
file. For more information, see "Length Control" on page 279.
• Save Seg — when data is acquired to segmented memory, you can
specify whether the currently displayed segment is saved or all
acquired segments are saved. (See also "Saving Data from Segmented
Memory" on page 202.)
4 Finally, press the Press to Save softkey.
A message indicating whether the save was successful is displayed.
See Also

• "Binary Data (.bin) Format" on page 342
• "CSV and ASCII XY files" on page 348
• "Minimum and Maximum Values in CSV Files" on page 349

Length Control
The Length control is available when saving data to CSV, ASCII XY, or BIN
format files. It sets the number of data points that will be output to the
file. Only displayed data points are saved.
The maximum number of data points depends on these things:
• Whether acquisitions are running. When stopped, data comes from the
raw acquisition record. When running, data comes from the smaller
measurement record.
• Whether the oscilloscope was stopped using [Stop] or [Single]. Running
acquisitions split memory to provide fast waveform update rates. Single
acquisitions use full memory.
• Whether only one channel of a pair is turned on. (Channels 1 and 2 are
one pair, channels 3 and 4 are the other.) Acquisition memory is
divided among the channels in a pair.
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• Whether reference waveforms are on. Displayed reference waveforms
consume acquisition memory.
• Whether digital channels are on. Displayed digital channels consume
acquisition memory.
• Whether segmented memory is on. Acquisition memory is divided by
the number of segments.
• The horizontal time/div (sweep speed) setting. At faster settings, fewer
data points appear on the display.
• When saving to a CSV format file, the maximum number of data points
is 64K.
When necessary, the Length control performs a "1 of n" decimation of the
data . For example: if the Length is set to 1000, and you are displaying a
record that is 5000 data points in length, four of each five data points will
be decimated, creating an output file 1000 data points in length.
When saving waveform data, the save times depend on the chosen format:

See Also

Data File Format

Save Times

BIN

fastest

ASCII XY

medium

CSV

slowest

• "Binary Data (.bin) Format" on page 342
• "CSV and ASCII XY files" on page 348
• "Minimum and Maximum Values in CSV Files" on page 349

To save Lister data files
Lister data files can be saved to an external USB storage device.
1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select
Lister data file.
2 Press the softkey in the second position and use the Entry knob to
navigate to the save location. See "To navigate storage locations" on
page 282.
3 Press the Settings softkey.
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In the File Settings Menu, you have these softkeys and options:
• Setup Info — when enabled, setup information (vertical, horizontal,
trigger, acquisition, math, and display settings) is also saved in a
separate file with a TXT extension.
4 Finally, press the Press to Save softkey.
A message indicating whether the save was successful is displayed.

To save reference waveform files to a USB storage device
1 Press the [Save/Recall] key.
2 In the Save/Recall Menu, press the Save softkey.
3 In the Save Menu, press the Format softkey and turn the Entry knob to
select Reference Waveform data (*.h5) .
4 Press the Source softkey and turn the Entry knob to select the source
waveform.
5 Press the softkey in the second position and use the Entry knob to
navigate to the save location. See "To navigate storage locations" on
page 282.
6 Finally, press the Press to Save softkey.
A message indicating whether the save was successful is displayed.

To save masks
Mask files can be saved to one of four internal (\Agilent Flash) locations
or to an external USB storage device.
1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select
Mask (*.msk).
2 Press the softkey in the second position and use the Entry knob to
navigate to the save location. See "To navigate storage locations" on
page 282.
3 Finally, press the Press to Save softkey.
A message indicating whether the save was successful is displayed.
Mask files have the extension MSK.
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NOTE

See Also

Masks are also saved as part of setup files. See "To save setup files" on page 277.

• Chapter 15, “Mask Testing,” starting on page 243

To save arbitrary waveforms
Arbitrary waveform files can be saved to one of four internal (\Agilent
Flash) locations or to an external USB storage device.
1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select
Arbitrary Waveform data (*.csv).
2 Press the softkey in the second position and use the Entry knob to
navigate to the save location. See "To navigate storage locations" on
page 282.
3 Finally, press the Press to Save softkey.
A message indicating whether the save was successful is displayed.
See Also

• "To edit arbitrary waveforms" on page 263

To navigate storage locations
When saving or recalling files, the softkey in the second position of the
Save Menu or Recall Menu, along with the Entry knob, are used to
navigate to storage locations. The storage locations can be internal
oscilloscope storage locations (for setup files or mask files) or they can be
external storage locations on a connected USB storage device.
The softkey in the second position can have these labels:
• Press to go — when you can push the Entry knob to navigate to a new
folder or storage location.
• Location — when you have navigated to the current folder location (and
are not saving files).
• Save to — when you can save to the selected location.
• Load from — when you can recall from the selected file.
When saving files:
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• The proposed file name is shown in the Save to file = line above the
softkeys.
• To overwrite an existing file, browse to that file and select it. To create
a new file name, see "To enter file names" on page 283.

To enter file names
To create new file names when saving files to a USB storage device:
1 In the Save Menu, press the File Name softkey.
You must have a USB storage device connected to the oscilloscope for
this softkey to be active.
2 In the File Name Menu, use the Spell, Enter, and Delete Character softkeys
to enter the file name:
• Spell — press this softkey and turn the Entry knob to select the
character at the current position.
• Enter — press this softkey to enter characters and move the cursor to
the next character position. Pushing the Entry knob is the same as
pressing the Enter softkey.
• Delete Character — press this softkey to delete the character at the
current position.

NOTE

You can use a connected USB keyboard instead of using the Spell (and other) character
editing softkeys.

When available, the Increment softkey can be used to enable or disable
automatically incremented file names. Auto increment adds a numeric
suffix to your file name and increments the number with each
successive save. It will truncate characters as necessary when the file
name length is at maximum and more digits are required for the
numeric portion of the file name.

Recalling Setups, Masks, or Data
1 Press the [Save/Recall] key.
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2 In the Save/Recall Menu, press Recall.
3 In the Recall Menu, press Recall:, then, turn the Entry knob to select
the type of file you want to recall:
• Setup (*.scp) — See "To recall setup files" on page 284.
• Mask (*.msk) — See "To recall mask files" on page 284.
• Reference Waveform data (*.h5) — See "To recall reference waveform files
from a USB storage device" on page 285.
• Arbitrary Waveform data (*.csv) — See "To recall arbitrary waveforms" on
page 285.
You can also recall setups and mask files by loading them using the File
Explorer. See "File Explorer" on page 299.
You can also configure the [Quick Action] key to recall setups, masks, or
reference waveforms. See "Configuring the [Quick Action] Key" on
page 311.

To recall setup files
Setup files can be recalled from one of 10 internal (\Agilent Flash)
locations or from an external USB storage device.
1 Press [Save/Recall] > Recall > Recall:; then, turn the Entry knob to select
Setup (*.scp).
2 Press the softkey in the second position and use the Entry knob to
navigate to the file to recall. See "To navigate storage locations" on
page 282.
3 Press the Press to Recall softkey.
A message indicating whether the recall was successful is displayed.
4 If you would like to clear the display, press Clear Display.

To recall mask files
Mask files can be recalled from one of four internal (\Agilent Flash)
locations or from an external USB storage device.
1 Press [Save/Recall] > Recall > Recall:; then, turn the Entry knob to select
Mask (*.msk).
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2 Press the softkey in the second position and use the Entry knob to
navigate to the file to recall. See "To navigate storage locations" on
page 282.
3 Press the Press to Recall softkey.
A message indicating whether the recall was successful is displayed.
4 If you would like to clear the display or clear the recalled mask, press
Clear Display or Clear Mask.

To recall reference waveform files from a USB storage device
1 Press the [Save/Recall] key.
2 In the Save/Recall Menu, press the Recall softkey.
3 In the Recall Menu, press the Recall softkey and turn the Entry knob to
select Reference Waveform data (*.h5) .
4 Press the To Ref: softkey and turn the Entry knob to select the desired
reference waveform location.
5 Press the softkey in the second position and use the Entry knob to
navigate to the file to recall. See "To navigate storage locations" on
page 282.
6 Press the Press to Recall softkey.
A message indicating whether the recall was successful is displayed.
7 If you would like to clear the display of everything except the reference
waveform, press Clear Display.

To recall arbitrary waveforms
Arbitrary waveform files can be recalled from one of four internal (\
Agilent Flash) locations or from an external USB storage device.
When recalling arbitrary waveforms (from an external USB storage device)
that were not saved from the oscilloscope, be aware that:
• If the file contains two columns, the second column is automatically
chosen.
• If the file contains more than two columns, you are prompted to select
which column to load. Up to five columns are parsed by the
oscilloscope; columns above the fifth are ignored.
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• The oscilloscope uses a maximum of 8192 points for an arbitrary
waveform. For more efficient recalls, make sure your arbitrary
waveforms are 8192 points or less.
To recall an arbitrary waveform:
1 Press [Save/Recall] > Recall > Recall:; then, turn the Entry knob to select
Arbitrary Waveform data (*.csv).
2 Press the softkey in the second position and use the Entry knob to
navigate to the file to recall. See "To navigate storage locations" on
page 282.
3 Press the Press to Recall softkey.
A message indicating whether the recall was successful is displayed.
4 If you would like to clear the display, press Clear Display.
See Also

• "To edit arbitrary waveforms" on page 263

Recalling Default Setups
1 Press the [Save/Recall] key.
2 In the Save/Recall Menu, press Default/Erase.
3 In the Default Menu, press one of these softkeys:
• Default Setup— recalls the oscilloscope's default setup. This is the same
as pressing the front panel [Default Setup] key. See "Recall the Default
Oscilloscope Setup" on page 31.
Some user settings are not changed when recalling the default setup.
• Factory Default— recalls the oscilloscope's factory default settings.
You must confirm the recall because there are no user settings that
are left unchanged.

Performing a Secure Erase
1 Press the [Save/Recall] key.
2 In the Save/Recall Menu, press Default/Erase.
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3 In the Default menu, press Secure Erase.
This performs a secure erase of all non- volatile memory in compliance
with National Industrial Security Program Operation Manual (NISPOM)
Chapter 8 requirements.
You must confirm the secure erase, and the oscilloscope will reboot
when finished.
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You can print the complete display, including the status line and softkeys,
to a USB printer or a network printer when the DSOXLAN LAN/VGA
module is installed.
The Print Configuration Menu is displayed when you press the [Print] key.
The print option softkeys and the Press to Print softkey are ghosted (not
available) until a printer is connected.

To print the oscilloscope's display
1 Connect a printer. You can:
• Connect a USB printer to either the USB port on the front panel or
the rectangular USB host port on the rear panel.
For the most up- to- date listing of printers that are compatible with
the InfiniiVision oscilloscopes, please visit
"www.agilent.com/find/InfiniiVision- printers".
• Set up a network printer connection. See "To set up network printer
connections" on page 290.
2 Press the [Print] key on the front panel.
3 In the Print Configuration Menu, press the Print to softkey; then, turn
the Entry knob to select the desired printer.

s1
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4 Press the Options softkey to select the print options.

See "To specify the print options" on page 292.
5 Press the Palette softkey to select the print palette. See "To specify the
palette option" on page 293.
6 Press the Press to Print softkey.
You can stop printing by pressing the Cancel Print softkey.

NOTE

The oscilloscope will print the last menu visited before you pressed the [Print] key.
Therefore, if you have measurements (Amplitude, Frequency, etc.) showing on the display
before you press [Print], the measurements will be shown on the printout.
To print the display showing the Print Configuration Menu at the bottom, press the [Print]
key twice; then, press the Press to Print softkey.

You can also configure the [Quick Action] key to print the display. See
"Configuring the [Quick Action] Key" on page 311.
See Also

• "Adding an Annotation" on page 312

To set up network printer connections
When the DSOXLAN LAN/VGA module is installed, you can set up
network printer connections.
A network printer is a printer attached to a computer or print server on
the network.
1 Press the [Print] key on the front panel.
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2 In the Print Configuration Menu, press the Print to softkey; then, turn
the Entry knob to select the network printer you want to configure
(either #0 or #1).
3 Press the Network Setup softkey.
4 In the Network Printer Setup Menu, press the Modify softkey; then, turn
the Entry knob to select the network parameter you want to enter.
The setting that must be entered is:
• Printer Address — this is the printer or print server's address in one of
the following formats:
• IP address of a network- enabled printer (for example:
192.168.1.100 or 192.168.1.100:650). Optionally, a non- standard
port number can be specified following a colon.
• IP address of a print server followed by the path to the printer
(for example: 192.168.1.100/printers/printer- name or
192.168.1.100:650/printers/printer- name).
• Path to a Windows network printer share (for example: \\server\
share).
When the Printer Address is a Windows network printer share, the
Modify softkey also lets you enter these settings:
• Network Domain — this is the Windows network domain name.
• Username — this is your login name for the Windows network domain.
• Password — this is your login password for the Windows network
domain.
To clear an entered password, press the Clear Password softkey.
5 Use the Spell, Enter, and Delete Character softkeys to enter the network
printer settings:
• Spell — press this softkey and turn the entry knob to select the
character at the current position.
• Enter — press this softkey to enter characters and move the cursor to
the next character position.
• Delete Character — press the Enter softkey until the desired character is
highlighted; then, press this softkey to delete the character.
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NOTE

You can use a connected USB keyboard instead of using the Spell (and other) character
editing softkeys.

6 Press the Apply softkey to make the printer connection.
A message appears to tell you whether the connection was successful.

To specify the print options
In the Print Configuration Menu, press the Options softkey to change the
following options:
• Setup Information — Select this to print oscilloscope setup information on
your printout, including vertical, horizontal, trigger, acquisition, math,
and display settings.
• Invert Graticule Colors — Select this to reduce the amount of black ink it
takes to print oscilloscope images by changing the black background to
white. Invert Graticule Colors is the default mode.

Graticule Not Inverted

Graticule Inverted

• Form Feed — Select this to send a form feed command to the printer
after the waveform is printed and before the setup information is
printed. Switch Form Feed off if you want setup information printed on
the same sheet of paper with the waveform. This option only has an
effect when the Setup Information option is selected. Also, if the amount
of setup information will not fit on the same page with the waveform, it
will be printed on a new page regardless of the Form Feed setting.
• Landscape — Select this to print horizontally on the page instead of
vertically (portrait mode).
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To specify the palette option
In the Print Configuration Menu, press the Palette softkey to change the
following options.
• Color — Select this to print the screen in color.
The oscilloscope's print driver cannot print color images to color laser
printers, so the Color option is not available when connected to laser
printers.
• Grayscale — Select this to print the screen in shades of gray rather than
in color.
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This chapter explains oscilloscope utility functions.

I/O Interface Settings
The oscilloscope can be accessed and/or controlled remotely via these I/O
interfaces:
• USB device port on the rear panel (square shaped USB port).
• LAN interface when a LAN/VGA module is installed in the rear panel
module slot.
• GPIB interface when a GPIB module is installed in the rear panel
module slot.
To configure the I/O interfaces:
1 On the oscilloscope's front panel, press [Utility].
2 In the Utility Menu, press I/O.
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3 In the I/O Menu, press Configure.
• LAN — When a DSOXLAN LAN/VGA module is installed, you can use
the LAN Settings and LAN Reset softkeys to configure the LAN
interface. See "Setting up the Oscilloscope's LAN Connection" on
page 296.
• GPIB — When a DSOXGPIB GPIB module is installed, you can use the
Address softkey to configure the GPIB address.
• There are no configuration settings for the USB interface.
When an I/O interface is installed, remote control over that interface is
always enabled. Also, the oscilloscope can be controlled via multiple I/O
interfaces (for example, USB and LAN) at the same time.
See Also

• Chapter 21, “Web Interface,” starting on page 315 (when the
oscilloscope is connected to a LAN).
• "Remote Programming via the Web Interface" on page 321
• The oscilloscope's Programmer's Guide.
• "Remote Programming with Agilent IO Libraries" on page 322

Setting up the Oscilloscope's LAN Connection
When the DSOXLAN LAN/VGA module is installed, you can place the
oscilloscope on the network and set up its LAN connection. Once that is
done, you can use the oscilloscope's web interface or remotely control the
oscilloscope via the LAN interface.
The oscilloscope supports methods for automated LAN configuration or
manual LAN configuration (see "To establish a LAN connection" on
page 297). It is also possible to set up a point- to- point LAN connection
between a PC and the oscilloscope (see "Stand- alone (Point- to- Point)
Connection to a PC" on page 298).
Once the oscilloscope is set up on the network, you can use the
oscilloscope's web page to view or change its network configuration and
access additional settings (like the network password). See Chapter 21,
“Web Interface,” starting on page 315.
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NOTE

When you connect the oscilloscope to a LAN it is a good practice to limit access to the
oscilloscope by setting a password. By default, the oscilloscope is not password protected.
See "Setting a Password" on page 327 to set a password.

NOTE

Any time you modify the oscilloscope's hostname, it breaks the connection between the
oscilloscope and the LAN. You need to re-establish communication to the oscilloscope
using the new hostname.

To establish a LAN connection
Automatic
Configuration

1 Press [Utility] > I/O.
2 Press the LAN Settings softkey.
3 Press the Config softkey; then, turn the Entry knob to select Automatic,
and press the softkey again to enable it.
If your network supports DHCP or AutoIP, enabling Automatic lets the
oscilloscope use those services to get its LAN configuration settings
4 If your network provides Dynamic DNS, you can enable the Dynamic DNS
option to let the oscilloscope register its hostname and use the DNS
server for name resolution.
5 You can enable the Multicast DNS option to let the oscilloscope use
Multicast DNS for name resolution on small networks without a
conventional DNS server.
6 Connect the oscilloscope to the local area network (LAN) by inserting
the LAN cable into the "LAN" port on the rear panel of the
oscilloscope.
In a few moments the oscilloscope will connect to the network
automatically.
If the oscilloscope does not automatically connect to the network, press
[Utility] > I/O > LAN Reset. In a few moments the oscilloscope will connect
to the network.

Manual
Configuration

1 Get the oscilloscope's network parameters (host name, IP address,
subnet mask, gateway IP, DNS IP, etc.) from your network
administrator.
2 Press [Utility] > I/O.
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3 Press the LAN Settings softkey.
4 Press the Config softkey; then, turn the Entry knob to select Automatic,
and press the softkey again to disable it.
If Automatic is not enabled, the oscilloscope's LAN configuration must
be set up manually using the Addresses and Host name softkeys
5 Configure the oscilloscope's LAN interface:
a Press the Addresses softkey.
b Use the Modify softkey (and the other softkeys and the Entry knob)
to enter the IP Address, Subnet Mask, Gateway IP, and DNS IP
values. When you are done, go back up in the menu hierarchy.
c Press the Host name softkey. Use the softkeys and the Entry knob to
enter the Host name. When you are done, go back up in the menu
hierarchy.
d Press the Apply softkey.
6 Connect the oscilloscope to the local area network (LAN) by inserting
the LAN cable into the "LAN" port on the rear panel of the
oscilloscope.

Stand-alone (Point-to-Point) Connection to a PC
The following procedure describes how to establish a point- to- point (stand
alone) connection to the oscilloscope. This is useful if you want to control
the oscilloscope using a laptop computer or a stand- alone computer.
1 Press [Utility] > I/O.
2 Press the LAN Settings softkey.
3 Press the Config softkey; then, turn the Entry knob to select Automatic,
and press the softkey again to enable it.
If your network supports DHCP or AutoIP, enabling Automatic lets the
oscilloscope use those services to get its LAN configuration settings
4 Connect your PC to the oscilloscope using a cross- over LAN cable such
as Agilent part number 5061- 0701, available on the web at
"www.parts.agilent.com".
5 Cycle power on the oscilloscope. Wait until the LAN connection is
configured:
• Press [Utility] > I/O and wait until the LAN status shows "configured".
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This may take a few minutes.
Now, the instrument is connected, and the instrument's web interface or
remote control via LAN may be used.

File Explorer
The File Explorer lets you navigate the oscilloscope's internal file system
and the file systems of connected USB storage devices.
From the internal file system, you can load oscilloscope setup files or
mask files.
From a connected USB storage device, you can load setup files, mask files,
license files, firmware update (*.cab) files, label files, etc. Also, you can
delete files on a connected USB storage device.

NOTE

The USB port on the front panel, and the USB port on the rear panel labeled "HOST" are
USB Series A receptacles. These are the receptacles to which you can connect USB mass
storage devices and printers.
The square receptacle on the rear panel labeled "DEVICE" is provided for controlling the
oscilloscope over USB. See the Programmer's Guide for more information.

The oscilloscope's internal file system, under "\Agilent Flash", consists of
10 locations for oscilloscope setup files, and four locations for mask files.
To use the File Explorer:
1 Press [Utility] > File Explorer.
2 In the File Explorer Menu, press the softkey in the first position and
use the Entry knob to navigate.
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The softkey in the first position can have these labels:
• Press to go — when you can push the Entry knob to navigate to a new
folder or storage location.
• Location — when pointing to a directory that is currently selected.
• Selected — when pointing to a file that can be loaded or deleted.
When this label appears, you can press the Load File or Delete File
softkeys to take the action.
Pushing the Entry knob is the same as pressing the Load File softkey.
A file that has been deleted from a USB storage device cannot be
recovered by the oscilloscope.
Use your PC to create directories on a USB storage device.
USB Storage
Devices

Most USB mass storage devices are compatible with the oscilloscope.
However, certain devices may be incompatible, and may not be able to be
read or written to.
When the USB mass storage device is connected to the oscilloscope's front
or rear USB host port, a small four- color circle icon may be displayed
briefly as the USB device is read.
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You do not need to "eject" the USB mass storage device before removing it.
Simply ensure that any file operation you've initiated is done, and remove
the USB drive from the oscilloscope's host port.
Do not connect USB devices that identify themselves as hardware type
"CD" because these devices are not compatible with the InfiniiVision
X- Series oscilloscopes.
If two USB mass storage devices are connected to the oscilloscope, the
first one is designated "\usb" and the second one is designated "\usb2".
See Also

• Chapter 18, “Save/Recall (Setups, Screens, Data),” starting on page 275

Setting Oscilloscope Preferences
The User Preferences Menu (under [Utility] > Options > Preferences) lets you
specify oscilloscope preferences.
• "To choose "expand about" center or ground" on page 301
• "To disable/enable transparent backgrounds" on page 302
• "To load the default label library" on page 302
• "To set up the screen saver" on page 302
• "To set AutoScale preferences" on page 303

To choose "expand about" center or ground
When you change a channel's volts/division setting, the waveform display
can be set to expand (or compress) about the signal ground level or the
center of the display.
To set the waveform expansion reference point:
1 Press [Utility] > Options > Preferences > Expand and select:
• Ground— The displayed waveform will expand about the position of
the channel's ground. This is the default setting.
The ground level of the signal is identified by the position of the
ground level (

) icon at the far- left side of the display.

The ground level will not move when you adjust the vertical
sensitivity (volts/division) control.
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If the ground level is off screen, the waveform will expand about the
top or bottom edge of the screen based on where the ground is off
screen.
• Center— The displayed waveform will expand about the center of the
display.

To disable/enable transparent backgrounds
There is a preference setting for whether measurements, statistics,
reference waveform information, and other text displays have transparent
or solid backgrounds.
1 Press [Utility] > Options > Preferences.
2 Press Transparent to toggle between transparent and solid text display
backgrounds.

To load the default label library
See "To reset the label library to the factory default" on page 141.

To set up the screen saver
The oscilloscope can be configured to turn on a display screen saver when
the oscilloscope has been idle for a specified length of time.
1 Press [Utility] > Options > Preferences > Screen Saver to display the Screen
Saver Menu.

2 Press the Saver softkey to select the screen saver type.
The screen saver can be set to Off, to display any of the images shown
in the list, or can display a user- defined text string.
If User is selected, press the Spell softkey to select the first character of
the text string. Use the Entry knob to choose a character. Then press
the Enter softkey to advance to the next character and repeat the
process.
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NOTE

You can use a connected USB keyboard instead of using the Spell (and other) character
editing softkeys.

The resultant string is displayed in the "Text =" line above the softkeys.

3 Press the Wait softkey; then, turn the Entry knob to select the number
of minutes to wait before the selected screen saver activates.
When you turn the Entry knob, the number of minutes is displayed on
the Wait softkey. The default time is 180 minutes (3 hours).
4 Press the Preview softkey to preview the screen saver you have selected
with the Saver softkey.
5 To view the normal display after the screen saver has started, press any
key or turn any knob.

To set AutoScale preferences
1 Press [Utility] > Options > Preferences > AutoScale.
2 In the AutoScale Preferences Menu, you can:
• Press the Fast Debug softkey enable/disable this type of autoscale.
When fast debug is enabled, autoscale lets you make quick visual
comparisons to determine whether the signal being probed is a DC
voltage, ground, or an active AC signal.
Channel coupling is maintained to allow easy viewing of oscillating
signals.
• Press the Channels softkey and turn the Entry knob to specify the
channels to be autoscaled:
• All Channels — The next time you press [AutoScale], all channels that
meet the requirements of AutoScale will be displayed.
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• Only Displayed Channels — The next time you press [AutoScale], only
the channels that are turned on will be examined for signal
activity. This is useful if you only want to view specific active
channels after pressing [AutoScale].
• Press the Acq Mode softkey and turn the Entry knob to select whether
the acquisition mode should be preserved during autoscale:
• Normal — to make the oscilloscope switch to Normal acquisition
mode whenever the [AutoScale] key is pressed. This is the default
mode.
• Preserve — to make the oscilloscope remain in the acquisition mode
you have chosen when the [AutoScale] key is pressed.

Setting the Oscilloscope's Clock
The Clock Menu lets you set the current date and time of day (24- hour
format). This time/date stamp will appear on hardcopy prints and
directory information on the USB mass storage device.
To set the date and time, or to view the current date and time:
1 Press [Utility] > Options > Clock.

2 Press the Year, Month, Day, Hour or Minute softkey; then, rotate the Entry
knob to set to the desired number.
The hours are shown in the 24- hour format. So 1:00 PM is hour 13.
The real- time clock only allows selection of valid dates. If a day is
selected and the month or year is changed so the day is invalid, the day
is automatically adjusted.

Setting the Rear Panel TRIG OUT Source
You can choose the source of the TRIG OUT connector on the rear panel
of the oscilloscope:
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1 Press [Utility] > Options > Rear Panel.
2 In the Rear Panel Menu, press Trig Out; then, turn the Entry knob to
select from:
• Triggers— Each time the oscilloscope triggers, a rising edge occurs on
TRIG OUT. The rising edge is delayed 30 ns from the oscilloscope's
trigger point. The output level is 0- 5 V into an open circuit, and
0- 2.5 V into 50 Ω. See Chapter 10, “Triggers,” starting on page 143.
• Mask— The pass/fail status is evaluated periodically. When the
evaluation of the testing period results in a failure, the trigger output
pulses high (+5 V). Otherwise, the trigger output remains at low
(0 V). See Chapter 15, “Mask Testing,” starting on page 243.
• Waveform Generator Sync Pulse— All of the waveform generator output
functions (except DC, Noise, and Cardiac) have an associated Sync
signal:
The Sync signal is a TTL positive pulse that occurs when the
waveform rises above zero volts (or the DC offset value).
See Chapter 17, “Waveform Generator,” starting on page 259.
The TRIG OUT connector also provides the User Cal signal. See "To
perform user calibration" on page 306.

Performing Service Tasks
The Service Menu (under [Utility] > Service) lets you perform service- related
tasks:

• "To perform user calibration" on page 306
• "To perform hardware self test" on page 308
• "To perform front panel self test" on page 309
• "To display oscilloscope information" on page 309
• "To display the user calibration status" on page 309
For other information related to oscilloscope maintenance and service, see:
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• "To clean the oscilloscope" on page 309
• "To check warranty and extended services status" on page 310
• "To contact Agilent" on page 310
• "To return the instrument" on page 310

To perform user calibration
Perform user- calibration:
• Every two years or after 4000 hours of operation.
• If the ambient temperature is >10° C from the calibration temperature.
• If you want to maximize the measurement accuracy.
The amount of use, environmental conditions, and experience with other
instruments help determine if you need shorter User Cal intervals.
User Cal performs an internal self- alignment routine to optimize the signal
path in the oscilloscope. The routine uses internally generated signals to
optimize circuits that affect channel sensitivity, offset, and trigger
parameters.
Performing User Cal will invalidate your Certificate of Calibration. If NIST
(National Institute of Standards and Technology) traceability is required,
perform the "Performance Verification" procedure in the Agilent
InfiniiVision 2000/3000 X- Series Oscilloscopes Service Guide using
traceable sources.
To perform user calibration:
1 Disconnect all inputs from the front and rear panels, including the
digital channels cable on an MSO, and allow the oscilloscope to warm
up before performing this procedure.
2 Press the rear- panel CAL button to disable calibration protection.
3 Connect short (12 inch maximum) equal length cables to each analog
channel's BNC connector on the front of the oscilloscope. You will need
two equal- length cables for a 2- channel oscilloscope or four
equal- length cables for a 4- channel oscilloscope.
Use 50W RG58AU or equivalent BNC cables when performing User Cal.
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For a 2- channel oscilloscope, connect a BNC tee to the equal length
cables. Then connect a BNC(f)- to- BNC(f) (also called a barrel
connector) to the tee as shown below.
Long cable
to TRIG OUT
To Channel 1

To Channel 2

Figure 49

User Calibration cable for 2-channel oscilloscope

For a 4- channel oscilloscope, connect BNC tees to the equal- length
cables as shown below. Then connect a BNC(f)- to- BNC(f) (barrel
connector) to the tee as shown below.
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To Channel 1

To Channel 2

To Channel 3

To Channel 4

Figure 50

Longer cable
to TRIG OUT

User Calibration cable for 4-channel oscilloscope

4 Connect a BNC cable (40 inches maximum) from the TRIG OUT
connector on the rear panel to the BNC barrel connector.
5 Press the [Utility] key; then, press the Service softkey.
6 Begin the Self Cal by pressing the Start User Cal softkey.

To perform hardware self test
Pressing [Utility] > Service > Hardware Self Test performs a series of internal
procedures to verify that the oscilloscope is operating properly.
It is recommended you run Hardware Self Test:
• After experiencing abnormal operation.
• For additional information to better describe an oscilloscope failure.
• To verify proper operation after the oscilloscope has been repaired.
Successfully passing Hardware Self Test does not guarantee 100% of the
oscilloscope's functionality. Hardware Self Test is designed to provide an
80% confidence level that the oscilloscope is operating properly.
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To perform front panel self test
Pressing [Utility] > Service > Front Panel Self Test lets you test the front panel
keys and knobs as well as the oscilloscope display.
Follow the on- screen instructions.

To display oscilloscope information
Press [Help] > About Oscilloscope to display information about your
oscilloscope:
• Model number.
• Serial number.
• Bandwidth.
• Module installed.
• Software version.
• Installed licenses. See also "Loading Licenses and Displaying License
Information" on page 339.

To display the user calibration status
Pressing [Utility] > Service > User Cal Status displays the summary results of
the previous User Cal, and the status of probe calibrations for probes that
can be calibrated. Note that passive probes do not need to be calibrated,
but InfiniiMax probes can be calibrated. For more information about
calibrating probes see "To calibrate a probe" on page 70.
Results:
User Cal date:
Change in temperature since last User Cal:
Failure:
Comments:
Probe Cal Status:

To clean the oscilloscope
1 Remove power from the instrument.
2 Clean the external surfaces of the oscilloscope with a soft cloth
dampened with a mixture of mild detergent and water.
3 Make sure that the instrument is completely dry before reconnecting it
to a power source.
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To check warranty and extended services status
To learn the warranty status of your oscilloscope:
1 Point your web browser to: "www.agilent.com/find/warrantystatus"
2 Enter your product's model number and serial number. The system will
search for the warranty status of your product and display the results.
If the system cannot find your product's warranty status, select Contact
Us and speak with an Agilent Technologies representative.

To contact Agilent
Information on contacting Agilent Technologies can be found at:
"www.agilent.com/find/contactus"

To return the instrument
Before shipping the oscilloscope to Agilent Technologies, contact your
nearest Agilent Technologies sales or service office for additional details.
Information on contacting Agilent Technologies can be found at:
"www.agilent.com/find/contactus"
1 Write the following information on a tag and attach it to the
oscilloscope.
• Name and address of owner.
• Model number.
• Serial number.
• Description of service required or failure indication.
2 Remove accessories from the oscilloscope.
Only return accessories to Agilent Technologies if they are associated
with the failure symptoms.
3 Package the oscilloscope.
You can use the original shipping container, or provide your own
materials sufficient to protect the instrument during shipping.
4 Seal the shipping container securely, and mark it FRAGILE.
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Configuring the [Quick Action] Key
The [Quick Action] key lets you perform common, repetitive actions by
pressing a single key.
To configure the [Quick Action] key:
1 Press [Utility] > Quick Action > Action; then, select the action that should be
performed:
• Off — disables the [Quick Action] key.
• Quick Measure All — displays a popup containing a snapshot of all the
single waveform measurements. The Source softkey lets you select the
waveform source (which also becomes the source selection in the
Measurement Menu). See Chapter 14, “Measurements,” starting on
page 215.
• Quick Print — prints the current screen image. Press Settings to set up
the printing options. See Chapter 19, “Print (Screens),” starting on
page 289.
• Quick Save — saves the current image, waveform data, or setup. Press
Settings to set up the save options. See Chapter 18, “Save/Recall
(Setups, Screens, Data),” starting on page 275.
• Quick Recall — recalls a setup, mask, or reference waveform. Press
Settings to set up the recall options. See Chapter 18, “Save/Recall
(Setups, Screens, Data),” starting on page 275.
• Quick Freeze Display — freezes the display without stopping running
acquisitions or un- freezes the display if currently frozen. For more
information, see "To freeze the display" on page 135.
• Quick Trigger Mode — toggles the trigger mode between Auto and
Normal, see "To select the Auto or Normal trigger mode" on
page 180.
• Quick Clear Display — clears the display, see "To clear the display" on
page 134.
Once the [Quick Action] key is configured, you simply press it to perform
the selected action.
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Adding an Annotation
You can add an annotation to the upper left corner of the oscilloscope's
display. The annotation is useful for documentation purposes, to add notes
before capturing screens.
To add an annotation:
1 On the oscilloscope's front panel, press [Utility].
2 In the Utility Menu, press Annotation.
3 In the Annotation Menu, press Annotation to enable the annotation.
4 Press Edit.
5 In the Edit Annotation Menu:

• Use the Spell,
,
annotation text:

, and Delete Character softkeys to enter the

• Spell — press this softkey and turn the Entry knob to select the
character at the current position.
•
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— press this softkey to enter characters and move the cursor
to the next character position.
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•

— press this softkey to enter characters and move the cursor
to the previous character position.

• Delete Character — press the
or
softkeys until the desired
character is highlighted; then, press this softkey to delete the
character.

NOTE

You can use a connected USB keyboard instead of using the Spell (and other) character
editing softkeys.

• Use the Clear softkey to delete all annotation characters.
• Press OK to save the annotation edits.
6 Press the Text Color softkey and turn the Entry knob to select the
annotation color.
You can choose white, red, or colors that match analog channels, digital
channels, math waveforms, reference waveforms, or markers.
7 Press the Background softkey and turn the Entry knob to select the
annotation background:
• Opaque — the annotation has a solid background.
• Inverted — the annotation's foreground and background colors are
switched.
• Transparent — the annotation has a transparent background.
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See Also

• "To save BMP or PNG image files" on page 277
• "To print the oscilloscope's display" on page 289
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When the Agilent InfiniiVision X- Series oscilloscopes have the DSOXLAN
LAN/VGA option module installed, you can access the oscilloscope's
built- in web server using a Java- enabled web browser. The oscilloscope's
web interface lets you:
• View information about the oscilloscope like its model number, serial
number, host name, IP address, and VISA (address) connect string.
• Control the oscilloscope using the Remote Front Panel.
• Send SCPI (Standard Commands for Programmable Instrumentation)
remote programming commands via the SCPI Commands applet window.
• Save setups, screen images, waveform data, and mask files.
• Recall setup files, reference waveform data files, or mask files.
• Get screen images and save or print them from the browser.
• Activate the Identification function to identify a particular instrument
by causing a message to be displayed or a front panel light to blink.
• View installed options, view firmware versions and install firmware
upgrade files, and view calibration status (via the Instrument Utilities
page).
• View and modify the oscilloscope's network configuration.

s1
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The web interface for InfiniiVision X- Series oscilloscopes also provides
help for each of its pages.
Microsoft Internet Explorer is the recommended Web browser for
communication and control of the oscilloscope. Other Web browsers may
work but are not guaranteed to work with the oscilloscope. The Web
browser must be Java- enabled with Sun Microsystems Java Plug- in.
Before you can use the web interface, you must place the oscilloscope on
the network and set up its LAN connection.

Accessing the Web Interface
To access the oscilloscope's web interface:
1 Connect the oscilloscope to your LAN (see "To establish a LAN
connection" on page 297) or establish a point- to- point connection (see
"Stand- alone (Point- to- Point) Connection to a PC" on page 298).
It is possible to use a point- to- point connection, but using a normal
LAN connection is the preferred method.
2 Type the oscilloscope's hostname or IP address in the web browser.
The oscilloscope's web interface Welcome Page is displayed.
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Browser Web Control
The web interface's Browser Web Control page gives you access to:
• The Real Scope Remote Front Panel (see "Real Scope Remote Front
Panel" on page 318).
• The Simple Remote Front Panel (see "Simple Remote Front Panel" on
page 319).
• The Browser- Based Remote Front Panel (see "Browser- Based Remote
Front Panel" on page 320).
• The SCPI Command window applet for Remote Programming (see
"Remote Programming via the Web Interface" on page 321).
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NOTE

If Java is not installed on your PC, you will be prompted to install the Sun Microsystems
Java Plug-in. This plug-in must be installed on the controlling PC for the web interface's
Remote Front Panel or Remote Programming operations.

The SCPI Command window is useful for testing commands or entering a
few commands interactively. When creating automated programs for
controlling the oscilloscope, you will typically use the Agilent IO Libraries
from within a programming environment like Microsoft Visual Studio (see
"Remote Programming with Agilent IO Libraries" on page 322).

Real Scope Remote Front Panel
To operate the oscilloscope using the web interface's Real Scope Remote
Front Panel:
1 Access the oscilloscope's web interface (see "Accessing the Web
Interface" on page 316).
2 When the oscilloscope's web interface is displayed, select
Browser Web Control, then select Real Scope Remote Front Panel. After a few
seconds the Remote Front Panel appears.
3 Click keys or knobs that you would normally press on the oscilloscope's
front panel. Drag on edges of knobs to turn them.
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Simple Remote Front Panel
To operate the oscilloscope using the web interface's Simple Remote Front
Panel:
1 Access the oscilloscope's web interface (see "Accessing the Web
Interface" on page 316).
2 When the oscilloscope's web interface is displayed, select
Browser Web Control, then select Simple Remote Front Panel. After a few
seconds the Remote Front Panel appears.
3 Use the Main Menu and the Function Keys to control the oscilloscope.
To view Quick Help, right- click on a softkey.
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Main Menu
Function Keys

Hint appears
when you roll
over with
mouse

Softkeys
(left-click to
select, right-click
for Quick Help)

Scrolling and
Monitor
Resolution

When using a monitor resolution of 800 x 600 or less on the remote
computer, you need to scroll to access the full remote front panel. To
display the remote front panel without scroll bars, use a monitor
resolution greater than 800 x 600 on your computer's display.

Browser-Based Remote Front Panel
To operate the oscilloscope using the web interface's Browser- Based
Remote Front Panel:
1 Access the oscilloscope's web interface (see "Accessing the Web
Interface" on page 316).
2 When the oscilloscope's web interface is displayed, select
Browser Web Control, then select Browser-Based Remote Front Panel. After a
few seconds the Remote Front Panel appears.
3 Click keys or knobs that you would normally press on the oscilloscope's
front panel. Buttons have been added for turning knobs.
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Remote Programming via the Web Interface
To send remote programming commands to the oscilloscope via the SCPI
Commands applet window:
1 Access the oscilloscope's web interface (see "Accessing the Web
Interface" on page 316).
2 When the oscilloscope's web interface is displayed, select
Browser Web Control, then select Remote Programming.
The SCPI Commands applet appears within the browser web page.
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Remote Programming with Agilent IO Libraries
While the SCPI Commands applet window lets you enter and remote
programming commands, remote programming for automated test and data
acquisition is typically done using the Agilent IO Libraries, which are
separate from the instrument's web interface.
The Agilent IO Libraries let a controller PC communicate with Agilent
InfiniiVision oscilloscopes via their USB, LAN (when the LAN/VGA option
module is installed), or GPIB (when the GPIB option module is installed)
interfaces.
The Agilent IO Libraries Suite connectivity software to enables
communication over these interfaces. You can download the Agilent IO
Libraries Suite from "www.agilent.com/find/iolib".
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Information about controlling the oscilloscope through remote commands
is contained in the Programmer's Guide, which is included on the
documentation CD supplied with this oscilloscope. You can also access this
document on the Agilent web site.
For more information about connecting to the oscilloscope, refer to the
Agilent Technologies USB/LAN/GPIB Interfaces Connectivity Guide. For a
printable electronic copy of the Connectivity Guide, direct your Web
browser to "www.agilent.com" and search for "Connectivity Guide".

Save/Recall
You can save setup files, screen images, waveform data files, or mask files
to your PC via the oscilloscope's web interface (see "Saving Files via the
Web Interface" on page 323).
You can recall setup files, reference waveform data files, or mask files
from your PC via the oscilloscope's web interface (see "Recalling Files via
the Web Interface" on page 324).

Saving Files via the Web Interface
To save setup files, screen images, waveform data, Lister data, or mask
files to your PC via the oscilloscope's web interface:
1 Access the oscilloscope's web interface (see "Accessing the Web
Interface" on page 316).
2 When the oscilloscope's web interface is displayed, select the Save/Recall
tab from the left side of the Welcome screen.
3 Click the Save link.
4 On the Save page:
a Enter the name of the file you are saving to.
b Select the format.

Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

323

21 Web Interface

You can click Preview to view the oscilloscope's current screen image.
When previewing, you can use the New Acquisition check box to force
a new acquisition before the preview.
With some formats, you can click Save Setup Info to save setup
information to an ASCII .txt format file.
c Click Save.
The current acquisition is saved.
d In the File Download dialog, click Save.
e In the Save As dialog, navigate to the folder where you want to save
the file; then, click Save.

Recalling Files via the Web Interface
To recall setup files, reference waveform data files, or mask files from
your PC via the oscilloscope's web interface:
1 Access the oscilloscope's web interface (see "Accessing the Web
Interface" on page 316).
2 When the oscilloscope's web interface is displayed, select the Save/Recall
tab from the left side of the Welcome screen.
3 Click the Recall link.
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4 On the Recall page:
a Click Browse....
b In the "Choose file" dialog, select the file you want to recall; then,
click Open.
c When recalling reference waveform data files, select the To Reference
Waveform location.

d Click Recall.

Get Image
To save (or print) the oscilloscope's display from the web interface:
1 Access the oscilloscope's web interface (see "Accessing the Web
Interface" on page 316).
2 When the oscilloscope's web interface is displayed, select the Get Image
tab from the left side of the Welcome screen. After a delay of several
seconds, the oscilloscope's screen image will be displayed.
3 Right- click on the image and select Save Picture As... (or Print Picture...).
4 Select a storage location for the image file and click Save.
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Identification Function
The Identification web interface feature is useful when trying to locate a
specific instrument in a rack of equipment.
1 Access the oscilloscope's web interface (see "Accessing the Web
Interface" on page 316).
2 When the oscilloscope's web interface Welcome Page is displayed, select
the Identification on radio button.
An "Identify" message is displayed on the oscilloscope; you can either
select Identification off or press the OK softkey on the oscilloscope to
continue.

Identification option

Instrument Utilities
The Instrument Utilities page of the web interface lets you:
• View installed options.
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• View firmware versions.
• Install firmware upgrade files.
• View calibration status.
You can select these cababilities via a drop- down menu.

Setting a Password
Whenever you connect the oscilloscope to a LAN, it is good practice to set
a password. The password prevents someone from remotely accessing the
oscilloscope via a Web browser and changing parameters. Remote users
can still view the Welcome screen, view network status, etc., but they can't
operate the instrument or change its setup without the password.
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To set a password:
1 Access the oscilloscope's web interface (see "Accessing the Web
Interface" on page 316).
2 When the oscilloscope's web interface is displayed, select the Configure
Network tab from the instrument's Welcome page.
3 Click the Modify Configuration button.

Modify Configuration

Configure
Network
tab

4 Enter your desired password, and click Apply Changes.
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Enter
password

When accessing the password protected oscilloscope, the user name is the
IP address of the oscilloscope.
To reset the
password

Do one of these things to reset the password:
• Using the keys on the front panel of the oscilloscope, press [Utility] > I/O
> LAN Reset.
• Using the web browser select the Configure Network tab, select Modify
Configuration, erase the Password, and select Apply Changes.
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Specifications and Characteristics
Please see the InfiniiVision oscilloscope data sheets for complete,
up- to- date specifications and characteristics. To download a data sheet,
please visit: "www.agilent.com/find/3000X- Series"
Then, select the Library tab, followed by Specifications.
Or, go to the Agilent home page at "www.agilent.com" and search for "3000
X- Series oscilloscopes data sheet".
To order a data sheet by phone, please contact your local Agilent office.
The complete list is available at: "www.agilent.com/find/contactus".

Measurement Category
• "Oscilloscope Measurement Category" on page 332
• "Measurement Category Definitions" on page 332
• "Transient Withstand Capability" on page 333

s1
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Oscilloscope Measurement Category
The InfiniiVision oscilloscopes are intended to be used for measurements
in Measurement Category I.

WA R N I N G

Use this instrument only for measurements within its specified measurement
category.

Measurement Category Definitions
Measurement category I is for measurements performed on circuits not
directly connected to MAINS. Examples are measurements on circuits not
derived from MAINS, and specially protected (internal) MAINS derived
circuits. In the latter case, transient stresses are variable; for that reason,
the transient withstand capability of the equipment is made known to the
user.
Measurement category II is for measurements performed on circuits
directly connected to the low voltage installation. Examples are
measurements on household appliances, portable tools and similar
equipment.
Measurement category III is for measurements performed in the building
installation. Examples are measurements on distribution boards,
circuit- breakers, wiring, including cables, bus- bars, junction boxes,
switches, socket- outlets in the fixed installation, and equipment for
industrial use and some other equipment, for example, stationary motors
with permanent connection to the fixed installation.
Measurement category IV is for measurements performed at the source of
the low- voltage installation. Examples are electricity meters and
measurements on primary overcurrent protection devices and ripple
control units.
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Transient Withstand Capability
CAUTION

Maximum input voltage at analog inputs
CAT I 300 Vrms, 400 Vpk; transient overvoltage 1.6 kVpk
50Ω input: 5 Vrms Input protection is enabled in 50 Ω mode and the 50 Ω load will
disconnect if greater than 5 Vrms is detected. However the inputs could still be
damaged, depending on the time constant of the signal. The 50 Ω input protection only
functions when the oscilloscope is powered on.
With 10073C 10:1 probe: CAT I 500 Vpk
With N2862A or N2863A 10:1 probe: 300 Vrms

CAUTION

Maximum input voltage at digital channels
±40 V peak CAT I; transient overvoltage 800 Vpk

Environmental Conditions
Environment

Indoor use only.

Ambient
temperature

Operating 0 °C to +55 °C; non-operating –40 °C to +71 °C

Humidity

Operating: Up to 80% RH at or below +40 °C. Up to 45% RH up to +50 °C.
Non-operating: Up to 95% RH up to +40 °C. Up to 45% RH up to +50 °C.

Altitude

Operating and non-operating to 4,000 m (13,123 ft)

Overvoltage
Category

This product is intended to be powered by MAINS that comply to Overvoltage
Category II, which is typical of cord-and-plug connected equipment.

Pollution Degree

The InfiniiVision 2000/3000 X-Series oscilloscopes may be operated in
environments of Pollution Degree 2 (or Pollution Degree 1).
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Pollution Degree
Definitions

Pollution Degree 1: No pollution or only dry, non-conductive pollution occurs.
The pollution has no influence. Example: A clean room or climate controlled
office environment.
Pollution Degree 2. Normally only dry non-conductive pollution occurs.
Occasionally a temporary conductivity caused by condensation may occur.
Example: General indoor environment.
Pollution Degree 3: Conductive pollution occurs, or dry, non-conductive
pollution occurs which becomes conductive due to condensation which is
expected. Example: Sheltered outdoor environment.

Probes and Accessories
This setion lists the probes and accessories that are compatible with the
3000 X- Series oscilloscopes.
• "Passive Probes" on page 335
• "Single- Ended Active Probes" on page 335
• "Differential Probes" on page 336
• "Current Probes" on page 337
• "Accessories Available" on page 338
AutoProbe
Interface

Most Agilent single- ended active, differential, and current probes are
compatible with the AutoProbe interface. Active probes that do not have
their own external power supply require substantial power from the
AutoProbe interface.
In the following tables, for AutoProbe interface compatible probes,
"Quantity Supported" indicates the maximum number of each type of
active probe that can be connected to the oscilloscope.
If too much current is drawn from the AutoProbe interface, an error
message will be displayed, indicating that you must momentarily
disconnect all probes to reset the AutoProbe interface, then connect only
the supported quantity of active probes.

See Also

For more information on probes and accessories, see "www.agilent.com"
for:
• "Probes and Accessories Selection Guide (5989- 6162EN)"
• "5000, 6000, and 7000 Series InfiniiVision Oscilloscope Probes and
Accessories Data Sheet (5968- 8153EN)"
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Passive Probes
All InfiniiVision oscilloscopes recognize passive probes such as the
N2862A/B, N2863A/B, N2889A, N2890A, 10073C, 10074C, and 1165A.
These probes have a pin on their connector that connects to the ring
around the oscilloscope's BNC connector. Therefore, the oscilloscope will
automatically set the attenuation factor for recognized Agilent passive
probes.
Passive probes that do not have a pin that connects to the ring around
the BNC connector will not be recognized by the oscilloscope, and you
must set the probe attenuation factor manually. See "To specify the probe
attenuation" on page 69.
The following passive probes can be used with the InfiniiVision
3000 X- Series oscilloscopes. Any combination of passive probes can be
used.
Table 5

Passive Probes

Model

Description

1165A

Passive probe, 10:1, 600 MHz, 1.5 m

10070C/D

Passive probe, 1:1 20 MHz, 1.5 m

10073C

Passive probe, 10:1, 500 MHz, 1.5 m

10074C

Passive probe, 10:1, 150 MHz, 1.5 m

10076A/B

Passive probe, 100:1, 4 kV, 250 MHz

N2771A/B

Passive probe, 1000:1, 30 kV, 50 MHz

N2862A/B

Passive probe, 10:1, 150 MHz, 1.2 m

N2863A/B

Passive probe, 10:1, 300 MHz, 1.2 m

N2889A

Passive probe, 10:1/1:1, 350 MHz, 1.2 m

N2890A

Passive probe, 10:1, 500 MHz, 1.2 m

Single-Ended Active Probes
The following single- ended active probes can be used with the
InfiniiVision 3000 X- Series oscilloscopes.
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Table 6

Active Probes

Model

Description

Quantity
Supported1

1130A

1.5 GHz InfiniiMax amplifier, requires one or more
InfiniiMax probe heads: E2675A, E2668A, E2669A

2

1131A

InfiniiMax 3.5 GHz probe

2

1132A

InfiniiMax 5 GHz probe

2

1134A

InfiniiMax 7 GHz probe

2

1156A

Active probe, 1.5 GHz

4

1157A

Active probe, 2.5 GHz

4

1158A

Active probe, 4 GHz

4

N2744A

T2A probe interface adapter

Unknown,
depends on
probes
connected

N2795A

Active probe, 1 GHz with AutoProbe interface

2

N2796A

Active probe, 2 GHz with AutoProbe interface

2

1See "AutoProbe Interface" on page 334.

Differential Probes
The following differential probes can be used with the InfiniiVision
3000 X- Series oscilloscopes.
Table 7

Differential Probes

Model

Description

1141A

Active differential probe, 200 MHz, 200 VDC + peak AC max (requires
1142A power supply)

1144A

Active probe, 800 MHz (requires 1142A power supply)

1145A

Active probe, 750 MHz 2-ch (requires 1142A power supply)
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Differential Probes (continued)

Model

Description

N2772A

Active differential probe, 20 MHz, 1.2 kVDC + peak AC max (requires
N2773A power supply)

N2790A

High-voltage differential probe, 50:1 or 500:1 (switchable), 100 MHz with
AutoProbe interface

N2791A

High-voltage differential probe, 25 MHz, +/-700 V, 1 MOhm termination,
10:1 or 100:1 (switchable)

N2792A

Differential probe, 200 MHz 10:1, 50 Ohm termination

N2793A

Differential probe, 800 MHz 10:1, +/-15 V, 50 Ohm termination

N2891A

70 MHz, 7 kV high-voltage differential probe

Quantity
Supported1

4

1See "AutoProbe Interface" on page 334.

Current Probes
The following current probes can be used with the InfiniiVision
3000 X- Series oscilloscopes.
Table 8

Current Probes

Model

Description

1146A

Current probe, 100 kHz, 100 A, AC/DC

1147A

Current probe, 50 MHz, 15 A, AC/DC with AutoProbe interface

N2774A

(Obsolete, replaced by N2782A) with N2775A power supply

N2780A

Current probe, 2 MHz, 500 A, AC/DC (use with N2779A power supply)

N2781A

Current probe, 10 MHz, 150 A, AC/DC (use with N2779A power supply)

N2782A

Current probe, 50 MHz, 30 A, AC/DC (use with N2779A power supply)

N2783A

Current probe, 100 MHz, 30 A, AC/DC (use with N2779A power supply)

N2893A

Current probe, 100 MHz, 15 A, AC/DC with AutoProbe interface
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Table 8
Model

Current Probes (continued)
Description

Quantity
Supported1

1See "AutoProbe Interface" on page 334.

Accessories Available
In addition to passive proves ("Passive Probes" on page 335), single- ended
active probes ("Single- Ended Active Probes" on page 335), differential
probes ("Differential Probes" on page 336), and current probes ("Current
Probes" on page 337), the following accessories are available for the
InfiniiVision 3000 X- Series oscilloscopes.
Table 9

Accessories Available for InfiniiVision 3000 X-Series Oscilloscopes

Model/Part #

Description

DSOXLAN

LAN/VGA connection module

DSOXGPIB

GPIB connection module

N6456A

Rack mount kit

N6457A

Soft carrying case and front panel cover

N2786A

2-leg probe positioner

N2787A

3D probe positioner

1180CZ

Testmobile

N6459A

Hardcopy user's guide

various

Front panel overlays - see "Front Panel Overlays for Different Languages" on
page 42.

N6450-60001

16-channel logic probe and accessory kit (standard with MSO models and
with MSO upgrade)

01650-61607

Logic cable and terminator (40 pin to 40 pin MSO cable)

You can find these items at "www.agilent.com" or at
"www.parts.agilent.com".
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For information on more probes and accessories, see "www.agilent.com"
for:
• "Probes and Accessories Selection Guide (5989- 6162EN)"
• "5000, 6000, and 7000 Series InfiniiVision Oscilloscope Probes and
Accessories Data Sheet (5968- 8153EN)"

Loading Licenses and Displaying License Information
License files are loaded from a USB storage device using the File Explorer
(see "File Explorer" on page 299).
License information is displayed with other oscilloscope information (see
"To display oscilloscope information" on page 309).
For more information about the licenses and other oscilloscope options
available, see:
• "Licensed Options Available" on page 339
• "Other Options Available" on page 341
• "Upgrading to an MSO" on page 341

Licensed Options Available
The following licensed options can be easily installed without returning
the oscilloscope to a Service Center. See data sheets for details.
Table 10

Licensed Options Available

License

Description

After purchase model number, notes

ADVMATH

Advanced Math Measurements.

Order DSOX3ADVMATH.

AERO

MIL-STD-1553 and ARINC 429 Serial Triggering and
Analysis.

Order DSOX3AERO.

AUDIO

Audio Serial Triggering and Analysis (I2S).

Order DSOX3AUDIO.

AUTO

Automotive Serial Triggering and Analysis (CAN,LIN).

Order DSOX3AUTO.
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Table 10

Licensed Options Available (continued)

License

Description

After purchase model number, notes

COMP

Computer Serial Triggering and Analysis
(RS232/422/485/UART).
Provides trigger and decode capability for many UART
(Universal Asynchronous Receiver/Transmitter) protocols
including RS232 (Recommended Standard 232).

Order DSOX3COMP.

DVM

Digital Voltmeter
Provides provides 3-digit voltage and 5-digit frequency
measurements using any analog channel.

Order DSOXDVM.

EDK

Educator's Kit
Provides training signals on the oscilloscope's Demo
terminals and a lab guide/tutorial for education
environments.

Order DSOXEDK.

EMBD

Embedded Serial Triggering and Analysis (I2C, SPI).

Order DSOX3EMBD.

FLEX

FlexRay Triggering and Analysis.

Order DSOX3FLEX.

MASK

Mask Limit Test
Lets you create a mask and test waveforms to determine
whether they comply to the mask.

Order DSOX3MASK.

mem4M

Memory Upgrade.
It shows the total memory depth (4 Mpts interleaved).

Order DSOX3MEMUP.

MSO

Mixed Signal Oscilloscope (MSO). Upgrade a DSO to an
MSO.
Adds 16 digital channels. You do not have to install any
hardware.

Order DSOX3MSO for 500 MHz and lower
bandwidth models or DSOXPERFMSO for
1 GHz bandwidth models.
The digital probe cable kit is supplied with
the MSO license.

PWR

Power Measurement and Analysis.

Order DSOX3PWR.
You can find the DSOX3PWR Power
Measurement Application User's Guide at
"www.agilent.com/find/3000X-Series-man
ual" or on the Documentation CD.

SGM

Segmented Memory.
Lets you capture infrequent or burst signals with great
resolution by eliminating the capture of your signal's
"inactivity".

Order DSOX3SGM.

VID

Extended Video Triggering and Analysis.

Order DSOX3VID.

340

Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

22

Reference

Table 10

Licensed Options Available (continued)

License

Description

After purchase model number, notes

WAVEGEN

Waveform Generator.

Order DSOX3WAVEGEN.

Other Options Available
Table 11

Calibration Option

Option

Order

A6J

ANSI Z540 Compliant Calibration

Upgrading to an MSO
A license can be installed to activate the digital channels of an
oscilloscope that was not originally ordered as a mixed- signal oscilloscope
(MSO). A mixed signal oscilloscope has analog channels plus 16
time- correlated digital timing channels.
For information about upgrading your oscilloscope through licensing,
contact your local Agilent Technologies representative or see
"www.agilent.com/find/3000X- Series".

Software and Firmware Updates
From time to time Agilent Technologies releases software and firmware
updates for its products. To search for firmware updates for your
oscilloscope, direct your web browser to
"www.agilent.com/find/3000X- Series- sw".
To view the currently installed software and firmware press [Help] > About
Oscilloscope.
Once you have downloaded a firmware update file, you can place it on a
USB storage device and load the file using File Explorer (see "File
Explorer" on page 299), or you can use the Instrument Utilities page of
the oscilloscope's web interface (see "Instrument Utilities" on page 326).
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Binary Data (.bin) Format
The binary data format stores waveform data in binary format and
provides data headers that describe that data.
Because the data is in binary format, the size of the file is approximately
5 times smaller than the ASCII XY format.
If more than one source is on, all displayed sources will be saved, except
math functions.
When using segmented memory, each segment is treated as a separate
waveform. All segments for a channel are saved, then all segments of the
next (higher numbered) channel are saved. This continues until all
displayed channels are saved.
When the oscilloscope is in the Peak Detect acquisition mode, the
minimum and maximum value waveform data points are saved to the file
in separate waveform buffers. The minimum value data points are saved
first; then, the maximum value data points are saved.
BIN data - using
segmented
memory

When saving all segments, each segment has its own waveform header (see
"Binary Header Format" on page 343).
In BIN file format, data are presented as follows:
• Channel 1 data (all segments)
• Channel 2 data (all segments)
• Channel 3 data (all segments)
• Channel 4 data (all segments)
• Digital channel data (all segments)
• Math waveform data (all segments)
When not saving all segments, the number of waveforms is equivalent to
the number of active channels (including math and digital channels, with
up to seven waveforms for each digital pod). When saving all segments,
the number of waveforms is equal to the number of active channels
multiplied by the number of segments acquired.
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Binary Data in MATLAB
Binary data from an InfiniiVision oscilloscope can be imported to The
MathWorks MATLAB®. You can download the appropriate MATLAB
functions from the Agilent Technologies web site at
"www.agilent.com/find/3000X- Series- examples".
Agilent provides the .m files, which need to be copied into the work
directory for MATLAB. The default work directory is C:\MATLAB7\work.

Binary Header Format
File Header

Waveform Header

There is only one file header in a binary file. The file header consists of
the following information.
Cookie

Two byte characters, AG, that indicate the file is in the Agilent Binary Data file
format.

Version

Two bytes that represent the file version.

File Size

A 32-bit integer that is the number of bytes that are in the file.

Number of
Waveforms

A 32-bit integer that is the number of waveforms that are stored in the file.

It is possible to store more than one waveform in the file, and each
waveform stored will have a waveform header. When using segmented
memory, each segment is treated as a separate waveform. The waveform
header contains information about the type of waveform data that is
stored following the waveform data header.
Header Size

A 32-bit integer that is the number of bytes in the header.

Waveform Type

A 32-bit integer that is the type of waveform stored in the file:
• 0 = Unknown.
• 1 = Normal.
• 2 = Peak Detect.
• 3 = Average.
• 4 = Not used in InfiniiVision oscilloscopes.
• 5 = Not used in InfiniiVision oscilloscopes.
• 6 = Logic.
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Number of
Waveform
Buffers

A 32-bit integer that is the number of waveform buffers required to read the
data.

Points

A 32-bit integer that is the number of waveform points in the data.

Count

A 32-bit integer that is the number of hits at each time bucket in the waveform
record when the waveform was created using an acquisition mode like
averaging. For example, when averaging, a count of four would mean every
waveform data point in the waveform record has been averaged at least four
times. The default value is 0.

X Display Range

A 32-bit float that is the X-axis duration of the waveform that is displayed. For
time domain waveforms, it is the duration of time across the display. If the
value is zero then no data has been acquired.

X Display Origin

A 64-bit double that is the X-axis value at the left edge of the display. For time
domain waveforms, it is the time at the start of the display. This value is
treated as a double precision 64-bit floating point number. If the value is zero
then no data has been acquired.

X Increment

A 64-bit double that is the duration between data points on the X axis. For
time domain waveforms, this is the time between points. If the value is zero
then no data has been acquired.

X Origin

A 64-bit double that is the X-axis value of the first data point in the data
record. For time domain waveforms, it is the time of the first point. This value
is treated as a double precision 64-bit floating point number. If the value is
zero then no data has been acquired.

X Units

A 32-bit integer that identifies the unit of measure for X values in the acquired
data:
• 0 = Unknown.
• 1 = Volts.
• 2 = Seconds.
• 3 = Constant.
• 4 = Amps.
• 5 = dB.
• 6 = Hz.

Y Units

A 32-bit integer that identifies the unit of measure for Y values in the acquired
data. The possible values are listed above under X Units.

Date

A 16-byte character array, left blank in InfiniiVision oscilloscopes.

Time

A 16-byte character array, left blank in the InfiniiVision oscilloscopes.
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Frame

A 24 byte character array that is the model number and serial number of the
oscilloscope in the format of: MODEL#:SERIAL#.

Waveform Label

A 16 byte character array that contains the label assigned to the waveform.

Time Tags

A 64-bit double, only used when saving multiple segments (requires
segmented memory option). This is the time (in seconds) since the first
trigger.

Segment Index

A 32-bit unsigned integer. This is the segment number. Only used when saving
multiple segments.

A waveform may have more than one data set. Each waveform data set
will have a waveform data header. The waveform data header consists of
information about the waveform data set. This header is stored
immediately before the data set.
Waveform Data
Header Size

A 32-bit integer that is the size of the waveform data header.

Buffer Type

A 16-bit short that is the type of waveform data stored in the file:
• 0 = Unknown data.
• 1 = Normal 32-bit float data.
• 2 = Maximum float data.
• 3 = Minimum float data.
• 4 = Not used in InfiniiVision oscilloscopes.
• 5 = Not used in InfiniiVision oscilloscopes.
• 6 = Digital unsigned 8-bit char data (for digital channels).

Bytes Per Point

A 16-bit short that is the number of bytes per data point.

Buffer Size

A 32-bit integer that is the size of the buffer required to hold the data points.

Example Program for Reading Binary Data
To find an example program for reading binary data, direct your web
browser to "www.agilent.com/find/3000X- Series- examples", and select
"Example Program for Reading Binary Data".
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Examples of Binary Files
Single
Acquisition
Multiple Analog
Channels

The following picture shows a binary file of a single acquisition with
multiple analog channels.
File Header
12 bytes

Waveform Header 1
140 bytes

Waveform Data
Header 1
12 bytes

Number of Waveforms = N

Number of Waveform Buffers = 1

Buffer Type = 1 (floating point)
Bytes per Point = 4

Voltage Data 1
buffer size

Waveform Header 2
140 bytes

Waveform Data
Header 2
12 bytes

Number of Waveform Buffers = 1

Buffer Type = 1 (floating point)
Bytes per Point = 4

Voltage Data 2
buffer size

Waveform Header N
140 bytes

Waveform Data
Header N
12 bytes

Number of Waveform Buffers = 1

Buffer Type = 1 (floating point)
Bytes per Point = 4

Voltage Data N
buffer size
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The following picture shows a binary file of a single acquisition with all
pods for the logic channels saved.
File Header
12 bytes

Number of Waveforms = 2

Waveform Header 1
140 bytes

Number of Waveform Buffers = 1

Waveform Data
Header 1
12 bytes

Buffer Type = 6 (unsigned char)
Bytes per Point = 1

Pod 1 Timing Data
buffer size

Waveform Header 2
140 bytes

Number of Waveform Buffers = 1

Waveform Data
Header 2
12 bytes

Buffer Type = 6 (unsigned char)
Bytes per Point = 1

Pod 2 Timing Data
buffer size

Segmented
Memory
Acquisition on
One Analog
Channel

The following picture shows a binary file of a segmented memory
acquisition on one analog channel.
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File Header
12 bytes

Waveform Header 1
140 bytes

Waveform Data
Header 1
12 bytes

Number of Waveforms = N = Number of Segments

Number of Waveform Buffers = 1
Index = 1
Time Tag = 0.0
Buffer Type = 1 (floating point)
Bytes per Point = 4

Voltage Data 1
buffer size

Waveform Header 2
140 bytes

Waveform Data
Header 2
12 bytes

Number of Waveform Buffers = 1
Index = 2
Time Tag = time between segment 1 and 2
Buffer Type = 1 (floating point)
Bytes per Point = 4

Voltage Data 2
buffer size

Waveform Header N
140 bytes

Waveform Data
Header N
12 bytes

Number of Waveform Buffers = 1
Index = N
Time Tag = time between segment 1 and N
Buffer Type = 1 (floating point)
Bytes per Point = 4

Voltage Data N
buffer size

CSV and ASCII XY files
• "CSV and ASCII XY file structure" on page 349
• "Minimum and Maximum Values in CSV Files" on page 349
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CSV and ASCII XY file structure
In CSV or ASCII XY format the Length control selects the number of points
per segment. All segments are contained in the CSV file or in each ASCII
XY data file.
For example: If the Length control is set to 1000 points, there will be 1000
points (rows in the spreadsheet) per segment. When saving all segments
there are three header rows, so the data for the first segment starts at
row 4. The second segment's data starts at row 1004. The time column
shows the time since the trigger on the first segment. The top row shows
the selected number of points per segment.
BIN files are a more efficient data transfer format than CSV or ASCII XY.
Use this file format for fastest data transfer.

Minimum and Maximum Values in CSV Files
If you are running a Minimum or Maximum measurement, the minimum
and maximum values shown in the measurement display may not appear
in the CSV file.
Explanation:

When the oscilloscope's sample rate is 4 GSa/s, a sample will be taken
every 250 ps. If the horizontal scale is set to 10 us/div, there will be
100 us of data displayed (because there are ten divisions across the
screen). To find the total number of samples the oscilloscope will take:
100 us x 4 GSa/s = 400K samples
The oscilloscope is required to display those 400K samples using 640 pixel
columns. The oscilloscope will decimate the 400K samples to 640 pixel
columns, and this decimation keeps track of the min and max values of all
the points that are represented by any given column. Those min and max
values will be displayed in that screen column.
A similar process is used to reduce the acquired data to produce a record
usable for various analysis needs such as measurements and CSV data.
This analysis record (or measurement record) is much larger than 640
and may in fact contain up to 65536 points. Still, once the # of acquired
points > 65536, some form of decimation is required. The decimator used
to produce a CSV record is configured to provide a best- estimate of all
the samples that each point in the record represents. Therefore, the min
and max values may not appear in the CSV file.
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RealVNC

RealVNC is licensed under the GNU General Public License. Copyright (C)
2002- 2005 RealVNC Ltd. All Rights Reserved.
This is free software; you can redistribute it and/or modify it under the
terms of the GNU General Public License as published by the Free
Software Foundation; either version 2 of the License, or (at your option)
any later version.
This software is distributed in the hope that it will be useful, but
WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
GNU General Public License for more details.
This license is located on the Agilent InfiniiVision Oscilloscopes
Documentation CD- ROM.
RealVNC source code can be obtained from RealVNC or by contacting
Agilent. Agilent will charge for the cost of physically performing the
source distribution.

HDF5

Reference Waveform files use HDF5.
HDF5 was developed by "The HDF Group" and by the National Center for
Supercomputing Applications at the University of Illinois at
Urbana- Champaign.

CUPS

Network printing uses the CUPS (Common Unix Printing System) library.
The CUPS and CUPS Imaging libraries are developed by Apple Inc. and
licensed under the GNU Library General Public License ("LGPL"), Version
2.
This license is located on the Agilent InfiniiVision Oscilloscopes
Documentation CD- ROM.

mDNSResponder

CUPS network printing uses the mDNSResponder library.
The mDNSResponder library is developed by Apple Inc. and licensed
under the Apache License, Version 2.0.
This license is located on the Agilent InfiniiVision Oscilloscopes
Documentation CD- ROM.
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CAN/LIN triggering and serial decode requires Option AUTO or the
DSOX3AUTO upgrade.

Setup for CAN Signals
Setup consists of connecting the oscilloscope to a CAN signal, using the
Signals Menu to specify the signal source, threshold voltage level, baud
rate, and sample point.
To set up the oscilloscope to capture CAN signals, use the Signals softkey
which appears in the Serial Decode Menu:
1 Press [Label] to turn on labels.
2 Press [Serial].
3 Press the Serial softkey, turn the Entry knob to select the desired slot
(Serial 1 or Serial 2), and press the softkey again to enable decode.
4 Press the Mode softkey; then, select CAN trigger type.
5 Press the Signals softkey to open the CAN Signals Menu.

s1
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6 Press Source; then, select the channel for the CAN signal.
The label for the CAN source channel is automatically set.
7 Press the Threshold softkey; then, turn the Entry knob to select the CAN
signal threshold voltage level.
The threshold voltage level is used in decoding, and it will become the
trigger level when the trigger type is set to the selected serial decode
slot.
8 Press the Baud softkey; then, turn the Entry knob to select the baud
rate that matches match your CAN bus signal.
The CAN baud rate can be set to predefined baud rates from 10 kb/s
up to 5 Mb/s or a user- defined baud rate from 10.0 kb/s to 4 Mb/s in
increments of 100 b/s. Fractional user- defined baud rates between
4 Mb/s and 5 Mb/s are not allowed.
The default baud rate is 125 kb/s
If none of the pre- defined selections match your CAN bus signal, select
User Defined; then, press the User Baud softkey and turn the Entry knob
to enter the baud rate.
9 Press the Sample Point softkey; then, turn the Entry knob to select the
point between phase segments 1 and 2 where the state of the bus is
measured. This controls the point within the bit's time where the bit
value is captured.
One Bit

60%
70%
80%

Sample Point

10 Press the Signal softkey and select the type and polarity of the CAN
signal. This also automatically sets the channel label for the source
channel.
• CAN_H — The actual CAN_H differential bus.
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• Differential (H-L) — The CAN differential bus signals connected to an
analog source channel using a differential probe. Connect the probe's
positive lead to the dominant- high CAN signal (CAN_H) and connect
the negative lead to the dominant- low CAN signal (CAN_L).
Dominant low signals:
• Rx — The Receive signal from the CAN bus transceiver.
• Tx — The Transmit signal from the CAN bus transceiver.
• CAN_L — The actual CAN_L differential bus signal.
• Differential (L-H) — The CAN differential bus signals connected to an
analog source channel using a differential probe. Connect the probe's
positive lead to the dominant- low CAN signal (CAN_L) and connect
the negative lead to the dominant- high CAN signal (CAN_H).

CAN Triggering
To set up the oscilloscope to capture a CAN signal, see "Setup for CAN
Signals" on page 351.
The Controller Area Network (CAN) trigger allows triggering on CAN
version 2.0A and 2.0B signals.
A CAN message frame in CAN_L signal type is shown below:
Bus
Idle

Arbitration Control
Field
Field

Data
Field

CRC
Field

ACK
EOF
Field

Intermission

SOF edge

After setting up the oscilloscope to capture a CAN signal:
1 Press [Trigger].
2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select the serial slot (Serial 1 or Serial 2) on which the CAN signal
is being decoded.
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3 Press the Trigger: softkey; then, turn the Entry knob to select the trigger
condition:
• SOF - Start of Frame — The oscilloscope triggers at the start of a frame.
• Remote Frame ID (RTR) — The oscilloscope triggers on remote frames
with the specified ID. Press the Bits softkey to select the ID.
• Data Frame ID (~RTR) — The oscilloscope will trigger on data frames
matching the specified ID. Press the Bits softkey to select the ID.
• Remote or Data Frame ID — The oscilloscope will trigger on remote or
data frames matching the specified ID. Press the Bits softkey to select
the ID.
• Data Frame ID and Data — The oscilloscope will trigger on data frames
matching the specified ID and data. Press the Bits softkey to select
the ID and set up the number of data bytes and values.
• Error Frame — The oscilloscope will trigger on CAN active error frames.
• All Errors — The oscilloscope will trigger when any form error or
active error is encountered.
• Acknowledge Error — The oscilloscope will trigger when the
acknowledge bit is recessive (high).
• Overload Frame — The oscilloscope will trigger on CAN overload
frames.
4 If you select a condition that lets you trigger on ID or data values, use
the Bits softkey and the CAN Bits Menu to specify those values.
For details about using the CAN Bits Menu softkeys, press and hold the
softkey in question to display the built- in help.
You can use the Zoom mode for easier navigation of the decoded data.

NOTE

354

If the setup does not produce a stable trigger, the CAN signal may be slow enough that the
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode
softkey to set the trigger mode from Auto to Normal.
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To display CAN serial decode, see "CAN Serial Decode" on page 355.

CAN Serial Decode
To set up the oscilloscope to capture CAN signals, see "Setup for CAN
Signals" on page 351.

NOTE

For CAN triggering set up see "CAN Triggering" on page 353.

To set up CAN serial decode:
1 Press [Serial] to display the Serial Decode Menu.

2 If the decode line does not appear on the display, press the [Serial] key
to turn it on.
3 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and
decode data.

NOTE

If the setup does not produce a stable trigger, the CAN signal may be slow enough that the
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode
softkey to set the trigger mode from Auto to Normal.

You can use the horizontal Zoom window for easier navigation of the
decoded data.
See Also

• "Interpreting CAN Decode" on page 356
• "CAN Totalizer" on page 357
• "Interpreting CAN Lister Data" on page 358
• "Searching for CAN Data in the Lister" on page 359
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Interpreting CAN Decode

Active Error Frame (red)
Missing Acknowledge (red)
CRC (blue)
Data (white)
Data Length Code (blue)
Frame ID (yellow)

• Frame ID appears in hex digits in yellow. Frames of 11 or 29 bits are
automatically detected.
• Remote frame (RMT) appears in green.
• Data length code (DLC) appears in blue for data frames and green for
remote frames.
• Data bytes appear in hex digits in white for data frames.
• Cyclic redundancy check (CRC) appears in hex digits in blue when
valid, or in red to indicate that the oscilloscope's hardware decode
calculated a CRC that is different from the incoming CRC data stream.
• Angled waveforms show an active bus (inside a packet/frame).
• Mid- level blue lines show an idle bus.
• Decoded text is truncated at the end of the associated frame when
there is insufficient space within frame boundaries.
• Pink vertical bars indicate you need to expand the horizontal scale (and
run again) to see decode.
• Red dots in the decode line indicate that there is data that is not being
displayed. Scroll or expand the horizontal scale to view the information.
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• Aliased bus values (undersampled or indeterminate) are drawn in pink.
• Unknown bus values (undefined or error conditions) are drawn in red
with a "?" label.
• Flagged error frames are drawn in red with an "ERR" label.

CAN Totalizer
The CAN totalizer provides a direct measure of bus quality and efficiency.
The CAN totalizer measures total CAN frames, flagged error frames,
overload frames, and bus utilization.

The totalizer is always running (counting frames and calculating
percentages) and is displayed whenever CAN decode is displayed. The
totalizer counts even when the oscilloscope is stopped (not acquiring
data). Pressing the [Run/Stop] key does not affect the totalizer. When an
overflow condition occurs, the counter displays OVERFLOW. The counters
can be reset to zero by pressing the Reset CAN Counters softkey.
Types of Frames

• Active error frames are CAN frames in which a CAN node recognizes
an error condition during a data or remote frame and issues an active
error flag.
• A partial frame occurs when the oscilloscope detects any error
condition during a frame that is not followed by an active error flag.
Partial frames are not counted.

Counters

• The FRAMES counter gives the total number of completed remote, data,
overload, and active error frames.
• The OVLD counter gives the total number of completed overload frames
and their percentage of the total number of frames.
• The ERR counter gives the total number of completed active error
frames and their percentage of the total number of frames.
• The UTIL (bus load) indicator measures the percentage of time the bus
is active. The calculation is done on 330 ms periods, approximately
every 400 ms.
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Example: If a data frame contains an active error flag, both the FRAMES
counter and the ERR counter will be incremented. If a data frame
contains an error that is not an active error it is considered a partial
frame and no counters are incremented.

Interpreting CAN Lister Data

In addition to the standard Time column, the CAN Lister contains these
columns:
• ID — frame ID.
• Type — frame type (RMT remote frame or Data).
• DLC — data length code.
• Data — data bytes.
• CRC — cyclic redundancy check.
• Errors — highlighted in red. Errors can be Acknowledge (Ack, A), Form
(Fo), or Frame (Fr). Different kinds of errors can be combined like
"Fo,Fr" in the above example.
Aliased data is highlighted in pink. When this happens, decrease the
horizontal time/div setting and run again.
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Searching for CAN Data in the Lister
The oscilloscope's search capability lets you search for (and mark) certain
types of CAN data in the Lister. You can use the [Navigate] key and
controls to navigate through the marked rows.
1 With CAN selected as the serial decode mode, press [Search].
2 In the Search Menu, press the Search softkey; then, turn the Entry knob
to select the serial slot (Serial 1 or Serial 2) on which the CAN signal
is being decoded.
3 Press Search; then, select from these options:
• Remote Frame ID (RTR) — Finds remote frames with the specified ID.
Press the Bits softkey to enter the ID.
• Data Frame ID (~RTR) — Finds data frames matching the specified ID.
Press the Bits softkey to enter the ID.
• Remote or Data Frame ID — Finds remote or data frames matching the
specified ID. Press the Bits softkey to select the ID.
• Data Frame ID and Data — Finds data frames matching the specified ID
and data. Press the Bits softkey to set the ID length, ID value,
number of data bytes, and data value.
• Error Frame — Finds CAN active error frames.
• All Errors — Finds any form error or active error.
• Overload Frame — Finds CAN overload frames.
For more information on searching data, see "Searching Lister Data" on
page 128.
For more information on using the [Navigate] key and controls, see
"Navigating the Time Base" on page 60.

Setup for LIN Signals
LIN (Local Interconnect Network) signal setup consists of connecting the
oscilloscope to a serial LIN signal, specifying the signal source, threshold
voltage level, baud rate, sample point, and other LIN signal parameters.
To set up the oscilloscope to capture LIN signals:
1 Press [Label] to turn on labels.
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2 Press [Serial].
3 Press the Serial softkey, turn the Entry knob to select the desired slot
(Serial 1 or Serial 2), and press the softkey again to enable decode.
4 Press the Mode softkey; then, select LIN trigger type.
5 Press the Signals softkey to open the LIN Signals Menu.

6 Press the Source softkey to select the channel connected to the LIN
signal line.
The label for the LIN source channel is automatically set.
7 Press the Threshold softkey; then, turn the Entry knob to set the LIN
signal threshold voltage level to the middle of the LIN signal.
The threshold voltage level is used in decoding, and it will become the
trigger level when the trigger type is set to the selected serial decode
slot.
8 Press the Baud Rate softkey to open the LIN Baud Rate Menu.
9 Press the Baud softkey; then, turn the Entry knob to select the baud
rate that matches match your LIN bus signal.
The default baud rate is 19.2 kb/s.
If none of the pre- defined selections match your LIN bus signal, select
User Defined; then, press the User Baud softkey and turn the Entry knob
to enter the baud rate.
You can set the LIN baud rate from 2.4 kb/s to 625 kb/s in increments
of 100 b/s.
10 Press the

Back

Back/Up key to return to the LIN Signals Menu.

11 Press the Sample Point softkey; then, turn the Entry knob to select the
sample point at which the oscilloscope will sample the bit value.
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One Bit

60%
70%
80%

Sample Point

12 Press the Standard softkey; then, turn the Entry knob to select the LIN
standard you are measuring (LIN 1.3 or LIN 2.0).
For LIN 1.2 signals, use the LIN 1.3 setting. The LIN 1.3 setting assumes
the signal follows the "Table of Valid ID Values" as shown in section A.2
of the LIN Specification dated December 12, 2002. If your signal does
not comply with the table, use the LIN 2.0 setting.
13 Press the Sync Break softkey and select the minimum number of clocks
that define a sync break in your LIN signal.

LIN Triggering
To set up the oscilloscope to capture a LIN signal, see "Setup for LIN
Signals" on page 359.
LIN triggering can trigger on the rising edge at the Sync Break exit of the
LIN single- wire bus signal (that marks the beginning of the message
frame), the Frame ID, or the Frame ID and Data.
A LIN signal message frame is shown below:
Sync
Break

Sync
Field

Identifier
Break

Data
Fields

Checksum
Field

Sync Break Exit

1 Press [Trigger].
2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select the serial slot (Serial 1 or Serial 2) on which the CAN signal
is being decoded.
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3 Press the Trigger: softkey; then, turn the Entry knob to select the trigger
condition:
• Sync (Sync Break) — The oscilloscope triggers on the rising edge at
the Sync Break exit of the LIN single- wire bus signal that marks the
beginning the message frame.
• ID (Frame ID) — The oscilloscope triggers when a frame with an ID
equal to the selected value is detected. Use the Entry knob to select
the value for the Frame ID.
• ID & Data (Frame ID and Data) — The oscilloscope triggers when a
frame with an ID and data equal to the selected values is detected.
When triggering on a frame ID and data:
• To select the frame ID value, press the Frame ID softkey, and use
the Entry knob.
Note that you can enter a "don't care" value for the frame ID and
trigger on data values only.
• To set up the number of data bytes and enter their values (in
hexadecimal or binary), press the Bits softkey to open the LIN Bits
Menu.
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NOTE

For details about using the LIN Bits Menu softkeys, press and hold the softkey in question
to display the built-in help.

NOTE

For LIN decode information see "LIN Serial Decode" on page 363.
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LIN Serial Decode
To set up the oscilloscope to capture LIN signals, see "Setup for LIN
Signals" on page 359.

NOTE

For LIN triggering setup see "LIN Triggering" on page 361.

To set up LIN serial decode:
1 Press [Serial] to display the Serial Decode Menu.

2 Choose whether to include the parity bits in the identifier field.
a If you want to mask the upper two parity bits, ensure that the box
under the Show Parity softkey is not selected.
b If you want to include the parity bits in the identifier field, ensure
that the box under the Show Parity softkey is selected.
3 If the decode line does not appear on the display, press the [Serial] key
to turn it on.
4 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and
decode data.

NOTE

If the setup does not produce a stable trigger, the LIN signal may be slow enough that the
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode
softkey to set the trigger mode from Auto to Normal.

You can use the horizontal Zoom window for easier navigation of the
decoded data.
See Also

• "Interpreting LIN Decode" on page 364
• "Interpreting LIN Lister Data" on page 365
• "Searching for LIN Data in the Lister" on page 366

Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

363

23 CAN/LIN Triggering and Serial Decode

Interpreting LIN Decode

• Angled waveforms show an active bus (inside a packet/frame).
• Mid- level blue lines show an idle bus (LIN 1.3 only).
• The hexadecimal ID and parity bits (if enabled) appear in yellow. If a
parity error is detected the hexadecimal ID and parity bits (if enabled)
appear in red.
• Decoded hexadecimal data values appear in white.
• For LIN 1.3, the checksum appears in blue if correct, or red if
incorrect. The checksum always appears in white for LIN 2.0.
• Decoded text is truncated at the end of the associated frame when
there is insufficient space within frame boundaries.
• Pink vertical bars indicate you need to expand the horizontal scale (and
run again) to see decode.
• Red dots in the decode line indicate that there is data that is not being
displayed. Scroll or expand the horizontal scale to view the information.
• Unknown bus values (undefined or error conditions) are drawn in red.
• If there is an error in the synch field, SYNC will appear in red.
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• If the header exceeds the length specified in the standard, THM will
appear red.
• If the total frame count exceeds the length specified in the standard,
TFM will appear red (LIN 1.3 only).
• For LIN 1.3 a wakeup signal is indicated by WAKE in blue. If the
wakeup signal is not followed by a valid wakeup delimiter a wakeup
error is detected and displayed as WUP in red.

Interpreting LIN Lister Data

In addition to the standard Time column, the LIN Lister contains these
columns:
• ID — frame ID.
• Data — (LIN 1.3 only) data bytes.
• Checksum — (LIN 1.3 only).
• Data and Checksum — (LIN 2.0 only).
• Errors — highlighted in red.
Aliased data is highlighted in pink. When this happens, decrease the
horizontal time/div setting and run again.
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Searching for LIN Data in the Lister
The oscilloscope's search capability lets you search for (and mark) certain
types of LIN data in the Lister. You can use the [Navigate] key and
controls to navigate through the marked rows.
1 With LIN selected as the serial decode mode, press [Search].
2 In the Search Menu, press the Search softkey; then, turn the Entry knob
to select the serial slot (Serial 1 or Serial 2) on which the LIN signal is
being decoded.
3 Press Search; then, select from these options:
• ID — Finds frames with the specified ID. Press the Frame ID softkey
to select the ID.
• ID & Data — Finds frames with the specified ID and data. Press the
Frame ID softkey to select the ID. Press the Bits softkey to enter the
data value.
• Errors — Finds all errors.
For more information on searching data, see "Searching Lister Data" on
page 128.
For more information on using the [Navigate] key and controls, see
"Navigating the Time Base" on page 60.
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FlexRay triggering and serial decode requires Option FLEX or the
DSOX3FLEX upgrade.

Setup for FlexRay Signals
FlexRay signal setup consists of first connecting the oscilloscope to a
differential FlexRay signal using a differential active probe (the Agilent
N2792A is recommended), specifying the signal source, threshold voltage
trigger level, baud rate, and bus type.
To set up the oscilloscope to capture FlexRay signals:
1 Press [Label] to turn on labels.
2 Press [Serial].
3 Press the Serial softkey, turn the Entry knob to select the desired serial
bus (Serial 1 or Serial 2), and press the softkey again to enable decode.
4 Press the Mode softkey; then, select FlexRay mode.
5 Press the Signals softkey to open the FlexRay Signals Menu.

s1
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6 Press Source and select the analog channel that is probing the FlexRay
signal.
7 Press Threshold; then, turn the Entry knob to set the threshold voltage
level.
The threshold level should be set below the idle level.
The threshold voltage level is used in decoding and will become the
trigger level when the trigger type is set to the selected serial decode
bus.
8 Press Baud and select the baud rate of the FlexRay signal being probed.
9 Press Bus and select the bus type of the FlexRay signal being probed.
It is important to specify the correct bus because this setting affects
CRC error detection.
10 Press Auto Setup to perform the following actions:
• Sets the selected source channel's impedance to 50 Ohms, assuming a
differential active probe that requires a 50 ohm termination is being
used .
• Sets the selected source channel's probe attenuation to 10:1.
• Sets the trigger level (on the selected source channel) to - 300 mV.
• Turns on trigger Noise Reject.
• Turns on Serial Decode.
• Sets the trigger type to FlexRay.

FlexRay Triggering
To set up the oscilloscope to capture a FlexRay signal, see "Setup for
FlexRay Signals" on page 367.
After you have set up the oscilloscope to capture a FlexRay signal, you
can then set up triggers on frames (see page 369), errors (see page 370),
or events (see page 370).

NOTE

368

To display FlexRay serial decode, see "FlexRay Serial Decode" on page 371.
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Triggering on FlexRay Frames
1 Press [Trigger].
2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select the serial bus (Serial 1 or Serial 2) on which the FlexRay
signals are being decoded.

3 Press the Trigger softkey; then, turn the Entry knob to select Frame.
4 Press the Frames softkey to open the FlexRay Frame Trigger Menu.

5 Press the Frame ID softkey, and use the Entry knob to select the frame
ID value from All or 1 to 2047.
6 Press the Frame Type softkey to select the frame type:
• All Frames
• Startup Frames
• NULL Frames
• Sync Frames
• Normal Frames
• NOT Startup Frames
• NOT NULL Frames
• NOT Sync Frames
7 Press the Cyc Ct Rep softkey, and use the Entry knob to select the cycle
count repetition factor (2, 4, 8, 16, 32, or 64, or All).
8 Press the Cyc Ct Bas softkey, and use the Entry knob to select the cycle
count base factor from 0 through the Cyc Ct Rep factor minus 1.
For example, with a base factor of 1 and a repetition factor of 16, the
oscilloscope triggers on cycles 1, 17, 33, 49, and 65.
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To trigger on a particular cycle, set the Cycle Repetition factor to 64
and use the cycle base factor to choose a cycle.
To trigger all (any) cycles, set the Cycle Repetition factor to All. The
scope will trigger on any and all cycles.

NOTE

Because specific FlexRay frames may occur infrequently, it may be helpful to press the
[Mode/Coupling] key, then press the Mode softkey to set the trigger mode from Auto to
Normal. This prevents the oscilloscope from Auto triggering while waiting for a particular
frame and cycle combination.

Triggering on FlexRay Errors
1 Press [Trigger].
2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select the serial bus (Serial 1 or Serial 2) on which the FlexRay
signals are being decoded.
3 Press the Trigger softkey; then, turn the Entry knob to select Error.

4 Press the Errors softkey; then, select the error type:
• All Errors
• Header CRC Error — cyclic redundancy check error in the header.
• Frame CRC Error — cyclic redundancy check error in the frame.

NOTE

Because FlexRay errors occur infrequently it may be helpful to set the oscilloscope to press
the [Mode/Coupling] key, then press the Mode softkey to set the trigger mode from Auto
to Normal. This prevents the oscilloscope from Auto triggering while waiting for an error to
occur. You may need to adjust trigger holdoff to see a particular error when multiple errors
exist.

Triggering on FlexRay Events
1 Press [Trigger].
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2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select the serial bus (Serial 1 or Serial 2) on which the FlexRay
signals are being decoded.
3 Press the Trigger softkey; then, turn the Entry knob to select Event.

4 Press the Event softkey; then, select the event type:
• Wake-up
• TSS — Transmission Start Sequence.
• BSS — ByteStart Sequence.
• FES/DTS — Frame End or Dynamic Trailing Sequence.
5 Press Auto Setup for Event.
This automatically configures oscilloscope settings (as shown on the
display) for the selected event trigger.

FlexRay Serial Decode
To set up the oscilloscope to capture FlexRay signals, see "Setup for
FlexRay Signals" on page 367.

NOTE

For FlexRay triggering setup see "FlexRay Triggering" on page 368.

To set up FlexRay serial decode:
1 Press [Serial] to display the Serial Decode Menu.

2 If the decode line does not appear on the display, press the [Serial] key
to turn it on.
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3 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and
decode data.
You can use the horizontal Zoom window for easier navigation of the
acquired data.
See Also

• "Interpreting FlexRay Decode" on page 372
• "FlexRay Totalizer" on page 373
• "Interpreting FlexRay Lister Data" on page 374
• "Searching for FlexRay Data in the Lister" on page 374

Interpreting FlexRay Decode

• Frame type (NORM, SYNC, SUP, NULL in blue).
• Frame ID (decimal digits in yellow).
• Payload- length (decimal number of words in green).
• Header CRC (hex digits in blue plus red HCRC error message if
invalid).
• Cycle number (decimal digits in yellow).
• Data bytes (HEX digits in white).
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• Frame CRC (hex digits in blue plus red FCRC error message if invalid).
• Frame/coding errors (specific error symbol in red).

FlexRay Totalizer
The FlexRay totalizer consists of counters that provide a direct measure of
bus quality and efficiency. The totalizer appears on screen whenever
FlexRay Decode is ON in the Serial Decode Menu.

• The FRAMES counter gives a real- time count of all captured frames.
• The NULL counter gives the number and percentage of null frames.
• The SYNC counter gives the number and percentage of sync frames.
The totalizer runs, counting frames and calculating percentages, even when
the oscilloscope is stopped (not acquiring data).
When an overflow condition occurs, the counter displays OVERFLOW.
The counters can be reset to zero by pressing the Reset FlexRay Counters
softkey.
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Interpreting FlexRay Lister Data

In addition to the standard Time column, the FlexRay Lister contains
these columns:
• FID — frame ID.
• Len — payload length.
• HCRC — header CRC.
• CYC — cycle number.
• Data.
• FCRC — frame CRC.
• Frames with errors are highlighted in red.

Searching for FlexRay Data in the Lister
The oscilloscope's search capability lets you search for (and mark) certain
types of FlexRay data in the Lister. You can use the [Navigate] key and
controls to navigate through the marked rows.
1 With FlexRay selected as the serial decode mode, press [Search].
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2 In the Search Menu, press the Search softkey; then, turn the Entry knob
to select the serial bus (Serial 1 or Serial 2) on which the FlexRay
signals are being decoded.
3 In the Search Menu, press Search for; then, select from these options:
• Frame ID — Finds frames with the specified ID. Press the Frame ID
softkey to select the ID.
• Cycle number (+ Frame ID) — Finds frames with the specified cycle
number and ID. Press the Frame ID softkey to select the ID. Press
the Cycle # softkey to select the number.
• Data (+ Frame ID + Cycle number) — Finds frames with the specified data,
cycle number, and frame ID. Press the Frame ID softkey to select the
ID. Press the Cycle # softkey to select the number. Press the Data
sofkey to open a menu where you can enter the data value.
• Header CRC Error — Finds cyclic redundancy check errors in headers.
• Frame CRC Error — Finds cyclic redundancy check errors in frames.
• Errors — finds all errors.
For more information on searching data, see "Searching Lister Data" on
page 128.
For more information on using the [Navigate] key and controls, see
"Navigating the Time Base" on page 60.

Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

375

24 FlexRay Triggering and Serial Decode

376

Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

Agilent InfiniiVision 3000 X-Series Oscilloscopes
User's Guide

25
I2C/SPI Triggering and Serial Decode
Setup for I2C Signals 377
I2C Triggering 378
I2C Serial Decode 382
Setup for SPI Signals 386
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I2C/SPI triggering and serial decode requires Option EMBD or the
DSOX3EMBD upgrade.

NOTE

Only one SPI serial bus can be decoded at a time.

Setup for I2C Signals
I2C (Inter- IC bus) signals setup consists of connecting the oscilloscope to
the serial data (SDA) line and the serial clock (SCL) line and then
specifying the input signal threshold voltage levels.
To set up the oscilloscope to capture I2C signals, use the Signals softkey
which appears in the Serial Decode Menu:
1 Press [Label] to turn on labels.
2 Press [Serial].
3 Press the Serial softkey, turn the Entry knob to select the desired slot
(Serial 1 or Serial 2), and press the softkey again to enable decode.

s1
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4 Press the Mode softkey; then, select I2C trigger type.
5 Press the Signals softkey to open the I2C Signals Menu.

6 For both the SCL (serial clock) and SDA (serial data) signals:
a Connect an oscilloscope channel to the signal in the device under
test.
b Press the SCL or SDA softkey; then, turn the Entry knob to select the
channel for the signal.
c Press the corresponding Threshold softkey; then, turn the Entry knob
to select the signal threshold voltage level.
The threshold voltage level is used in decoding, and it will become
the trigger level when the trigger type is set to the selected serial
decode slot.
Data must be stable during the whole high clock cycle or it will be
interpreted as a start or stop condition (data transitioning while the
clock is high).
The SCL and SDA labels for the source channels are automatically set.

I2C Triggering
To set up the oscilloscope to capture I2C signals, see "Setup for I2C
Signals" on page 377.
After the oscilloscope has been set up to capture I2C signals, you can
trigger on a stop/start condition, a restart, a missing acknowledge, an
EEPROM data read, or on a read/write frame with a specific device
address and data value.
1 Press [Trigger]; then, select the I2C trigger type.
2 Press [Trigger].
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3 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select the serial slot (Serial 1 or Serial 2) on which the I2C signals
are being decoded.

4 Press the Trigger: softkey; then, turn the Entry knob to select the trigger
condition:
• Start Condition— The oscilloscope triggers when SDA data transitions
from high to low while the SCL clock is high. For triggering purposes
(including frame triggers), a restart is treated as a start condition.
• Stop Condition— The oscilloscope triggers when data (SDA) transitions
from low to high while the clock (SCL) is high.

SDA
SCL

Address
Start
Condition

R/

Ack

Data

Ack

Stop
Condition

• Missing Acknowledge— The oscilloscope triggers when SDA data is high
during any Ack SCL clock bit.
• Address with no Ack— The oscilloscope triggers when the acknowledge
of the selected address field is false. The R/W bit is ignored.
• Restart— The oscilloscope triggers when another start condition occurs
before a stop condition.
• EEPROM Data Read— The trigger looks for EEPROM control byte value
1010xxx on the SDA line, followed by a Read bit and an Ack bit. It
then looks for the data value and qualifier set by the Data softkey
and the Data is softkey. When this event occurs, the oscilloscope will
trigger on the clock edge for the Ack bit after the data byte. This
data byte does not need to occur directly after the control byte.
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Read
SDA
SCL

Start or Control
byte
Restart
Condition

Ack

R/

Ack

Data

Trigger point

• Frame (Start: Addr7: Read: Ack: Data) or Frame (Start: Addr7: Write: Ack: Data)—
The oscilloscope triggers on a read or write frame in 7- bit addressing
mode on the 17th clock edge if all bits in the pattern match. For
triggering purposes, a restart is treated as a start condition.
Read

Write

SDA
SCL

Start or Address
Restart
Condition

R/

Ack

Data

Ack

Stop
Condition

Trigger point
17th clock edge

• Frame (Start: Addr7: Read: Ack: Data: Ack: Data2) or Frame (Start: Addr7: Write:
Ack: Data: Ack: Data2)— The oscilloscope triggers on a read or write
frame in 7- bit addressing mode on the 26th clock edge if all bits in
the pattern match. For triggering purposes, a restart is treated as a
start condition.
Read

Write

Start Address R/W
Condition

Ack

Data

Ack

Data 2

Ack

Trigger point
26th clock edge

Stop
Condition

• 10-bit Write — The oscilloscope triggers on a 10- bit write frame on the
26th clock edge if all bits in the pattern match. The frame is in the
format:
Frame (Start: Address byte 1: Write: Address byte 2: Ack: Data)
For triggering purposes, a restart is treated as a start condition.
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Write
SDA
SCL

Start or Address
Restart 1st byte
Condition

R/

Ack1 Address Ack2
2nd byte

Data

Ack

Trigger point
26th clock edge

Stop
Condition

5 If you have set the oscilloscope to trigger on an EEPROM Data Read
condition:
Press the Data is softkey to set the oscilloscope to trigger when data is
= (equal to), ≠ (not equal to), < (less than), or > (greater than) the data
value set in the Data softkey.
The oscilloscope will trigger on the clock edge for the Ack bit after the
trigger event is found. This data byte does not need to occur directly
after the control byte. The oscilloscope will trigger on any data byte
that meets the criteria defined by the Data is and Data softkeys during a
current address read or a random read or a sequential read cycle.
6 If you have set the oscilloscope to trigger on a 7- bit address read or
write frame condition or a 10- bit write frame condition:
a Press the Address softkey and turn the Entry knob to select the 7- bit
or 10- bit device address.
You can select from an address range of 0x00 to 0x7F (7- bit) or
0x3FF (10- bit) hexadecimal. When triggering on a read/write frame,
the oscilloscope will trigger after the start, address, read/write,
acknowledge, and data events occur.
If don't care is selected (0xXX or 0xXXX) for the address, the
address will be ignored. The trigger will always occur on the 17th
clock for 7- bit addressing or 26th clock for 10- bit addressing.
b Press the Data value softkey and turn the Entry knob to select the
8- bit data pattern on which to trigger.
You can select a data value in the range of 0x00 to 0xFF
(hexadecimal). The oscilloscope will trigger after the start, address,
read/write, acknowledge, and data events occur.
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If don't care (0xXX) is selected for data, the data will be ignored.
The trigger will always occur on the 17th clock for 7- bit addressing
or 26th clock for 10- bit addressing.
c If you have selected a three- byte trigger, press the Data2 value softkey
and turn the Entry knob to select the 8- bit data pattern on which to
trigger.

NOTE

To display I2C serial decode, see "I2C Serial Decode" on page 382.

I2C Serial Decode
To set up the oscilloscope to capture I2C signals, see "Setup for I2C
Signals" on page 377.

NOTE

For I2C triggering setup see "I2C Triggering" on page 378.

To set up I2C serial decode:
1 Press [Serial] to display the Serial Decode Menu.

2 Choose 7- bit or 8- bit address size. Use 8- bit address size to include the
R/W bit as part of the address value, or choose 7- bit address size to
exclude the R/W bit from the address value.
3 If the decode line does not appear on the display, press the [Serial] key
to turn it on.
4 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and
decode data.
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If the setup does not produce a stable trigger, the I2C signals may be slow enough that the
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode
softkey to set the trigger mode from Auto to Normal.

You can use the horizontal Zoom window for easier navigation of the
acquired data.
See Also

• "Interpreting I2C Decode" on page 383
• "Interpreting I2C Lister Data" on page 384
• "Searching for I2C Data in the Lister" on page 385

Interpreting I2C Decode

• Angled waveforms show an active bus (inside a packet/frame).
• Mid- level blue lines show an idle bus.
• In the decoded hexadecimal data:
• Address values appear at the start of a frame.
• Write addresses appear in light- blue along with the "W" character.
• Read addresses appear in yellow along with the "R" character.
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• Restart addresses appear in green along with the "S" character.
• Data values appear in white.
• "A" indicates Ack (low), "~A" indicates No Ack (high).
• Decoded text is truncated at the end of the associated frame when
there is insufficient space within frame boundaries.
• Pink vertical bars indicate you need to expand the horizontal scale (and
run again) to see decode.
• Red dots in the decode line indicate that more data can be displayed.
Scroll or expand the horizontal scale to view the data.
• Aliased bus values (undersampled or indeterminate) are drawn in pink.
• Unknown bus values (undefined or error conditions) are drawn in red.

Interpreting I2C Lister Data

In addition to the standard Time column, the I2C Lister contains these
columns:
• Restart — indicated with an "X".
• Address — colored blue for writes, yellow for reads.
• Data — data bytes.
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• Missing Ack — indicated by an "X", highlighted in red if an error.
Aliased data is highlighted in pink. When this happens, decrease the
horizontal time/div setting and run again.

Searching for I2C Data in the Lister
The oscilloscope's search capability lets you search for (and mark) certain
types of I2C data in the Lister. You can use the [Navigate] key and controls
to navigate through the marked rows.
1 With I2C selected as the serial decode mode, press [Search].
2 In the Search Menu, press the Search softkey; then, turn the Entry knob
to select the serial slot (Serial 1 or Serial 2) on which the I2C signal is
being decoded.
3 Press Search; then, select from these options:
• Missing Acknowledge — finds SDA data is high during any Ack SCL
clock bit.
• Address with no Ack — finds when the acknowledge of the selected
address field is false. The R/W bit is ignored.
• Restart — finds when another start condition occurs before a stop
condition.
• EEPROM Data Read — finds EEPROM control byte value 1010xxx on the
SDA line, followed by a Read bit and an Ack bit. It then looks for the
data value and qualifier set by the Data is softkey and the Data
softkeys.
• Frame(Start:Address7:Read:Ack:Data) — finds a read frame on the 17th
clock edge if all bits in the pattern match.
• Frame(Start:Address7:Write:Ack:Data) — finds a write frame on the 17th
clock edge if all bits in the pattern match.
• Frame(Start:Address7:Read:Ack:Data:Ack:Data2) — finds a read frame on
the 26th clock edge if all bits in the pattern match.
• Frame(Start:Address7:Write:Ack:Data:Ack:Data2) — finds a write frame on
the 26th clock edge if all bits in the pattern match.
For more information on searching data, see "Searching Lister Data" on
page 128.
For more information on using the [Navigate] key and controls, see
"Navigating the Time Base" on page 60.
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Setup for SPI Signals
Serial Peripheral Interface (SPI) signals setup consists of connecting the
oscilloscope to a clock, MOSI data, MISO data, and framing signal, then
setting the threshold voltage level for each input channel, and finally
specifying any other signal parameters.
To set up the oscilloscope to capture SPI signals, use the Signals softkey
which appears in the Serial Decode Menu:
1 Press [Label] to turn on labels.
2 Press [Serial].
3 Press the Serial softkey, turn the Entry knob to select the desired slot
(Serial 1 or Serial 2), and press the softkey again to enable decode.
4 Press the Mode softkey; then, select SPI trigger type.
5 Press the Signals softkey to open the SPI Signals Menu.

6 Press the Clock softkey to open the SPI Clock Menu.

In the SPI Clock Menu:
a Press the Clock softkey; then, turn the Entry knob to select the
channel connected to the SPI serial clock line.
The CLK label for the source channel is automatically set.
b Press the Threshold softkey; then, turn the Entry knob to select the
clock signal threshold voltage level.
The threshold voltage level is used in decoding, and it will become
the trigger level when the trigger type is set to the selected serial
decode slot.
c Press the slope softkey (
the selected Clock source.
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This determines which clock edge the oscilloscope will use to latch
the serial data. When Display Info is enabled, the graphic changes to
show the current state of the clock signal.
7 Press the MOSI softkey to open the SPI Master- Out Slave- In Menu.

In the SPI Master- Out Slave- In Menu:
a Press the MOSI Data softkey; then, turn the Entry knob to select the
channel that is connected to a SPI serial data line. (If the channel
you selected is off, switch it on.)
The MOSI label for the source channel is automatically set.
b Press the Threshold softkey; then, turn the Entry knob to select the
MOSI signal threshold voltage level.
The threshold voltage level is used in decoding, and it will become
the trigger level when the trigger type is set to the selected serial
decode slot.
8 (Optional) Press the MISO softkey to open the SPI Master- In Slave- Out
Menu.

In the SPI Master- In Slave- Out Menu:
a Press the MISO Data softkey; then, turn the Entry knob to select the
channel that is connected to a second SPI serial data line. (If the
channel you selected is off, switch it on.)
The MISO label for the source channel is automatically set.
b Press the Threshold softkey; then, turn the Entry knob to select the
MISO signal threshold voltage level.
The threshold voltage level is used in decoding, and it will become
the trigger level when the trigger type is set to the selected serial
decode slot.
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9 Press the CS softkey to open the SPI Chip Select Menu.

In the SPI Chip Select Menu:
a Press the Frame by softkey to select a framing signal that the
oscilloscope will use for determining which clock edge is the first
clock edge in the serial stream.
You can set the oscilloscope to trigger during a high chip select (CS),
a low chip select (~CS), or after a Timeout period during which the
clock signal has been idle.
• If the framing signal is set to CS (or ~CS), the first clock edge as
defined, rising or falling, seen after the CS (or ~CS) signal
transitions from low to high (or high to low) is the first clock in
the serial stream.
Chip Select — Press the CS or ~CS softkey; then, turn the Entry
knob to select the channel that is connected to the SPI frame line.
The label (~CS or CS) for the source channel is automatically set.
The data pattern and the clock transition must occur during the
time when the framing signal is valid. The framing signal must be
valid for the entire data pattern.
• If the framing signal is set to Timeout, the oscilloscope generates
it's own internal framing signal after it sees inactivity on the serial
clock line.
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Clock Timeout — Select Clock Timeout in the Frame by softkey, then
select the Timeout softkey and turn the Entry knob to set the
minimum time that the Clock signal must be idle (not
transitioning) before the oscilloscope will search for the Data
pattern on which to trigger.
The Timeout value can be set anywhere from 100 ns to 10 s.
When you press the Frame by softkey, the Display Info graphic changes
to show timeout selection or the current state of the chip select
signal.
b Press the Threshold softkey; then, turn the Entry knob to select the
chip select signal threshold voltage level.
The threshold voltage level is used in decoding, and it will become
the trigger level when the trigger type is set to the selected serial
decode slot.
When Display Info is enabled, information about the selected signal sources
and their threshold voltage levels, as well as a waveform diagram, appears
on the screen.

SPI Triggering
To set up the oscilloscope to capture SPI signals, see "Setup for SPI
Signals" on page 386.
After the oscilloscope has been set up to capture SPI signals, you can then
trigger on a data pattern that occurs at the start of a frame. The serial
data string can be specified to be from 4 to 32 bits long.
When you select the SPI trigger type and Display Info is enabled, a graphic
is displayed showing the current state of the frame signal, clock slope,
number of data bits, and data bit values.
1 Press [Trigger].
2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select the serial slot (Serial 1 or Serial 2) on which the SPI signals
are being decoded.
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3 Press the Trigger Setup softkey to open the SPI Trigger Setup Menu.

4 Press the Trigger softkey; then, turn the Entry knob to select the trigger
condition:
• Master-Out, Slave-In (MOSI) Data — for triggering on the MOSI data
signal.
• Master-In, Slave-Out (MISO) Data — for triggering on the MISO data
signal.
5 Press the #Bits softkey, and turn the Entry knob to set the number of
bits (#Bits) in the serial data string.
The number of bits in the string can be set anywhere from 4 bits to 64
bits. The data values for the serial string are displayed in the
MOSI/MISO Data string in the waveform area.
6 For each bit in the MOSI/MISO Data string:
a Press the Bit softkey; then, turn the Entry knob to select the bit
location.
As you rotate the Entry knob, the bit is highlighted in the Data
string shown in the waveform area.
b Press the 0 1 X softkey to set the bit selected in the Bit softkey to 0
(low), 1 (high), or X (don't care).
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The Set all Bits softkey will set all bits in the data string to the value of
the 0 1 X softkey.

NOTE

For SPI decode information see "SPI Serial Decode" on page 391.

SPI Serial Decode
To set up the oscilloscope to capture SPI signals, see "Setup for SPI
Signals" on page 386.

NOTE

For SPI triggering setup see "SPI Triggering" on page 389.

To set up SPI serial decode:
1 Press [Serial] to display the Serial Decode Menu.
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2 Press the Word Size softkey; then, turn the Entry knob to select the
number of bits in a word.
3 Press the Bit Order softkey; then turn the Entry knob to select the bit
order, most significant bit first (MSB) or least significant bit first (LSB),
used when displaying data in the serial decode waveform and in the
Lister.
4 If the decode line does not appear on the display, press the [Serial] key
to turn it on.
5 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and
decode data.

NOTE

If the setup does not produce a stable trigger, the SPI signal may be slow enough that the
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode
softkey to set the trigger mode from Auto to Normal.

You can use the horizontal Zoom window for easier navigation of the
acquired data.
See Also

• "Interpreting SPI Decode" on page 393
• "Interpreting SPI Lister Data" on page 394
• "Searching for SPI Data in the Lister" on page 394
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Interpreting SPI Decode

• Angled waveforms show an active bus (inside a packet/frame).
• Mid- level blue lines show an idle bus.
• The number of clocks in a frame appears in light- blue above the frame,
to the right.
• Decoded hexadecimal data values appear in white.
• Decoded text is truncated at the end of the associated frame when
there is insufficient space within frame boundaries.
• Pink vertical bars indicate you need to expand the horizontal scale (and
run again) to see decode.
• Red dots in the decode line indicate that there is data that is not being
displayed. Scroll or expand the horizontal scale to view the information.
• Aliased bus values (undersampled or indeterminate) are drawn in pink.
• Unknown bus values (undefined or error conditions) are drawn in red.
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Interpreting SPI Lister Data

In addition to the standard Time column, the SPI Lister contains these
columns:
• Data — data bytes (MOSI and MISO).
Aliased data is highlighted in pink. When this happens, decrease the
horizontal time/div setting and run again.

Searching for SPI Data in the Lister
The oscilloscope's search capability lets you search for (and mark) certain
types of SPI data in the Lister. You can use the [Navigate] key and controls
to navigate through the marked rows.
1 With SPI selected as the serial decode mode, press [Search].
2 In the Search Menu, press the Search softkey; then, turn the Entry knob
to select the serial slot (Serial 1 or Serial 2) on which the SPI signals
are being decoded.
3 Press Search; then, select from these options:
• Master-Out, Slave-In (MOSI) Data — for searching MOSI data.
• Master-In, Slave-Out (MISO) Data — for searching MISO data.
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4 Press the Bits softkey to open the SPI Bits Search Menu.
5 In the SPI Bits Search Menu, use the Words softkey to specify the
number of words in the data value; then, use the remaining softkeys to
enter the hex digit values.
For more information on searching data, see "Searching Lister Data" on
page 128.
For more information on using the [Navigate] key and controls, see
"Navigating the Time Base" on page 60.
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I2S Serial Decode 403

I2S triggering and serial decode requires Option AUDIO or the
DSOX3AUDIO upgrade.

NOTE

Only one I2S serial bus can be decoded at a time.

Setup for I2S Signals
I2S (Inter- IC Sound or Integrated Interchip Sound) signals setup consists
of connecting the oscilloscope to the serial clock, word select, and serial
data lines and then specifying the input signal threshold voltage levels.
To set up the oscilloscope to capture I2S signals:
1 Press [Label] to turn on labels.
2 Press [Serial].
3 Press the Serial softkey, turn the Entry knob to select the desired slot
(Serial 1 or Serial 2), and press the softkey again to enable decode.
4 Press the Mode softkey; then, select I2S trigger type.
5 Press the Signals softkey to open the I2S Signals Menu.

s1
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6 For the SCLK (serial clock), WS (word select), and SDATA (serial data)
signals:
a Connect an oscilloscope channel to the signal in the device under
test.
b Press the SCLK, WS, or SDATA softkey; then, turn the Entry knob to
select the channel for the signal.
c Press the corresponding Threshold softkey; then, turn the Entry knob
to select the signal threshold voltage level.
Set the threshold levels for the SCLK, WS, and SDATA signals to the
middle of the signals.
The threshold voltage level is used in decoding, and it will become
the trigger level when the trigger type is set to the selected serial
decode slot.
The SCLK, WS, and SDATA labels for the source channels are
automatically set.
7 Press the

Back

Back/Up key to return to the Serial Decode Menu.

8 Press the Bus Config softkey to open the I2S Bus Configuration Menu
and display a diagram showing WS, SCLK, and SDATA signals for the
currently specified bus configuration.

9 Press the Word Size softkey. Turn the Entry knob to match the
transmitter word size of the device under test (from 4 to 32 bits).
10 Press the Receiver softkey. Turn the Entry knob to match the receiver
word size of the device under test (from 4 to 32 bits).
11 Press the Alignment softkey; then, turn the Entry knob to select the
desired alignment of the data signal (SDATA). The on- screen diagram
changes with your selection.
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Standard Alignment — MSB of data for each sample is sent first, LSB is
sent last. The MSB appears on the SDATA line one bit clock after the
edge of the WS transition.
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Left-Justified — Data transmission (MSB first) begins at the edge of the
WS transition (without the one- bit delay that Standard format employs).
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Right-Justified — Data transmission (MSB first) is right- justified to the
transition of WS.
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12 Press the WS Low softkey; then, turn the Entry knob to select whether
WS Low indicates Left or Right channel data. The on- screen diagram
changes with your selection.
WS Low = Left Channel — Left- channel data corresponds to WS=low;
right- channel data corresponds to WS=high. WS Low=Left is the
oscilloscope's default WS setting.
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WS Low = Right Channel — Right- channel data corresponds to WS=low;
left- channel data corresponds to WS=high.
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13 Press the SCLK Slope softkey; then, turn the Entry knob to select the
SCLK edge on which data is clocked in your device under test: either
rising or falling. The on- screen diagram changes with your selection.

I2S Triggering
To set up the oscilloscope to capture I2S signals, see "Setup for I2S
Signals" on page 397.
After you have set up the oscilloscope to capture I2S signals, you can then
trigger on a data value.
1 Press [Trigger].
2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select the serial slot (Serial 1 or Serial 2) on which the I2S signals
are being decoded.

400
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3 Press the Trigger Setup softkey to open the I2S Trigger Setup Menu.

4 Press the Audio softkey; then, turn the Entry knob to choose to trigger
on Left channel events, Right channel events, or events that occur on
Either channel.
5 Press the Trigger softkey and choose a qualifier:
• Equal — triggers on the specified audio channel's data word when it
equals the specified word.
• Not equal — triggers on any word other than the specified word.
• Less than — triggers when the channel's data word is less than the
specified value.
• Greater than — triggers when the channel's data word is greater than
the specified value.
• In Range — enter upper and lower values to specify the range in
which to trigger.
• Out of Range — enter upper and lower values to specify range in which
trigger will not occur.
• Increasing value — triggers when the data value is increasing over time
and the specified value is met or exceeded. Set Trigger >= to the data
value that must be reached. Set Armed <= to the value to which the
data must fall before the trigger circuit is re- armed (ready to trigger
again). These settings are made in the current menu when Base is
Decimal or in the Bits submenu when the Base is Binary. The Armed
control reduces triggers due to noise.
This trigger condition is best understood when the digital data
transferred over the I2S bus is considered in terms of representing
an analog waveform. The figure below shows a plot of sample data
transmitted over an I2S bus for one channel. In this example, the
oscilloscope will trigger at the 2 points shown since there are two
instances in which the data increases from a value below (or at) the
"Armed" value to a value greater than (or equal to) the specified
"Trigger" value.
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If you select an "Armed" value that is equal to or greater than the
"Trigger" value, the "Trigger" value will be increased so that it is
always greater than the "Armed" value.
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• Decreasing value — similar to the description above except the trigger
occurs on a descreasing data word value, and the "Armed" value is
the value to which the data must rise in order to re- arm the trigger.
6 Press the Base softkey and select a number base for entering data
values:
• Binary (2's complement).
When Binary is selected, the Bits softkey appears. This softkey opens
the I2S Bits Menu for entering data values.
When the trigger qualifier requires a pair of values (as with In
Range, Out of Range, Increasing value, or Decreasing value), the first
softkey in the I2S Bits Menu lets you select which value of the pair.
In the I2S Bits Menu, press the Bit softkey and rotate the Entry knob
to select each bit; then, use the 0 1 X softkey to set each bit value to
zero, one, or don't care. You can use the Set all Bits softkey to set all
bits to the value chosen on the 0 1 X softkey.
• Signed decimal.
When Decimal is selected, the softkey(s) to the right let you enter
decimal values with the Entry knob. These softkeys can be Data, <, >,
or Threshold depending on the selected trigger qualifier.

NOTE

402

If the setup does not produce a stable trigger, the I2S signal may be slow enough that the
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode
softkey to set the trigger mode from Auto to Normal.
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NOTE

To display I2S serial decode, see "I2S Serial Decode" on page 403.

I2S Serial Decode
To set up the oscilloscope to capture I2S signals, see "Setup for I2S
Signals" on page 397.

NOTE

For I2S triggering setup see "I2S Triggering" on page 400.

To set up I2S serial decode:
1 Press [Serial] to display the Serial Decode Menu.

2 Press the Base softkey to select the number base in which to display
decoded data.
3 If the decode line does not appear on the display, press the [Serial] key
to turn it on.
4 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and
decode data.

NOTE

If the setup does not produce a stable trigger, the I2S signal may be slow enough that the
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode
softkey to set the trigger mode from Auto to Normal.

You can use the horizontal Zoom window for easier navigation of the
acquired data.
See Also

• "Interpreting I2S Decode" on page 404
• "Interpreting I2S Lister Data" on page 405
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• "Searching for I2S Data in the Lister" on page 405

Interpreting I2S Decode

• Angled waveforms show an active bus (inside a packet/frame).
• Mid- level blue lines show an idle bus.
• In the decoded data:
• Right channel data values appear in green along with the "R:"
characters.
• Left channel data values appear in white along with the "L:"
characters.
• Decoded text is truncated at the end of the associated frame when
there is insufficient space within frame boundaries.
• Pink vertical bars indicate you need to expand the horizontal scale (and
run again) to see decode.
• Red dots in the decode line indicate that more data can be displayed.
Scroll or expand the horizontal scale to view the data.
• Aliased bus values (undersampled or indeterminate) are drawn in pink.
• Unknown bus values (undefined or error conditions) are drawn in red.

404
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NOTE

When the receiver word size is greater than the transmit word size, the decoder fills the
least significant bits with zeros and the decoded value does not match the trigger value.

Interpreting I2S Lister Data

In addition to the standard Time column, the I2S Lister contains these
columns:
• Left Channel — displays the left channel data.
• Right Channel — displays the right channel data.
• Errors — highlighted in red and marked with an "X".
Aliased data is highlighted in pink. When this happens, decrease the
horizontal time/div setting and run again.

Searching for I2S Data in the Lister
The oscilloscope's search capability lets you search for (and mark) certain
types of I2S data in the Lister. You can use the [Navigate] key and controls
to navigate through the marked rows.
1 With I2S selected as the serial decode mode, press [Search].
Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide
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2 In the Search Menu, press the Search softkey; then, turn the Entry knob
to select the serial slot (Serial 1 or Serial 2) on which the I2S signals
are being decoded.
3 In the Search Menu, press Search; then, select from these options:
• = (Equal) — finds the specified audio channel's data word when it
equals the specified word.
• != (Not Equal) — finds any word other than the specified word.
• < (Less than) — finds when the channel's data word is less than the
specified value.
• > (Greater than) — finds when the channel's data word is greater than
the specified value.
• >< (In Range) — enter upper and lower values to specify the range to
find.
• <> (Out of Range) — enter upper and lower values to specify range not
to find.
• Errors — finds all errors.
For more information on searching data, see "Searching Lister Data" on
page 128.
For more information on using the [Navigate] key and controls, see
"Navigating the Time Base" on page 60.
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MIL-STD-1553/ARINC 429 Triggering
and Serial Decode
Setup for MIL-STD-1553 Signals 407
MIL-STD-1553 Triggering 409
MIL-STD-1553 Serial Decode 410
Setup for ARINC 429 Signals 414
ARINC 429 Triggering 415
ARINC 429 Serial Decode 417

MIL- STD- 1553/ARINC 429 triggering and serial decode requires Option
AERO or the DSOX3AERO upgrade.
The MIL- STD- 1553 triggering and decode solution supports bi- phase
MIL- STD- 1553 signaling by using dual threshold triggering. The solution
supports the standard 1553 Manchester II encoding, data rate of 1 Mb/s,
and word length of 20 bits.

Setup for MIL-STD-1553 Signals
MIL- STD- 1553 signal setup consists of first connecting the oscilloscope to
a serial MIL- STD- 1553 signal using a differential active probe (the Agilent
N2791A is recommended), specifying the signal source, and specifying the
high and low trigger threshold voltage levels.
To set up the oscilloscope to capture MIL- STD- 1553 signals:
1 Press [Label] to turn on labels.
2 Press [Serial].

s1
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3 Press the Serial softkey, turn the Entry knob to select the desired slot
(Serial 1 or Serial 2), and press the softkey again to enable decode.
4 Press the Mode softkey; then, select MIL-STD-1553 decode mode.
5 Press the Signals softkey to open the MIL- STD- 1553 Signals Menu.

6 Press the Source softkey to select the channel connected to the
MIL- STD- 1553 signal line.
The label for the MIL- STD- 1553 source channel is automatically set.
7 Press the

Back

Back/Up key to return to the Serial Decode Menu.

8 Press the Auto Setup softkey which performs these actions:
• Sets the probe attenuation factor of the input Source channel to 10:1.
• Sets upper and lower thresholds to a voltage value equal to ±1/3
division based on the current V/div setting.
• Turns off trigger noise reject.
• Turns on Serial Decode.
• Sets the trigger type to MIL- 1553.
9 If the upper and lower thresholds are not set correctly by Auto Setup,
press the Signals softkey to return to the MIL- STD- 1553 Signals Menu.
Then:
• Press the High Threshold softkey; then, turn the Entry knob to set the
high trigger threshold voltage level.
• Press the Low Threshold softkey; then, turn the Entry knob to set the
low trigger threshold voltage level.
The threshold voltage levels are used in decoding and will become the
trigger levels when the trigger type is set to the selected serial decode
slot.
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MIL-STD-1553 Triggering
To set up the oscilloscope to capture a MIL- STD- 1553 signal, see "Setup
for MIL- STD- 1553 Signals" on page 407.
To set up a MIL- STD- 1553 trigger:
1 Press [Trigger].
2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select the serial slot (Serial 1 or Serial 2) on which the
MIL- STD- 1553 signal is being decoded.

3 Press the Trigger softkey; then, turn the Entry knob to select the trigger
condition:
• Data Word Start — triggers on the start of a Data word (at the end of a
valid Data Sync pulse).
• Data Word Stop — triggers on the end of a Data word.
• Command/Status Word Start — triggers on the start of Command/Status
word (at the end of a valid C/S Sync pulse).
• Command/Status Word Stop — triggers on the end of a Command/Status
word.
• Remote Terminal Address — triggers if the RTA of the Command/Status
word matches the specified value.
When this option is selected, the RTA softkey becomes available and
lets you select the hex Remote Terminal Address value to trigger on.
If you select 0xXX (don't cares), the oscilloscope will trigger on any
RTA.
• Remote Terminal Address + 11 Bits — triggers if the RTA and the
remaining 11 bits match the specified criteria.
When this option is selected, these softkeys become available:
• The RTA softkey lets you select the hex Remote Terminal Address
value.
• The Bit Time softkey lets you select the bit time position.
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• The 0 1 X softkey lets you set the bit time position value as a 1, 0,
or X (don't care).
• Parity Error — triggers if the (odd) parity bit is incorrect for the data
in the word.
• Sync Error — triggers if an invalid Sync pulse is found.
• Manchester Error — triggers if a Manchester encoding error is detected.

NOTE

For MIL-STD-1553 decode information see "MIL-STD-1553 Serial Decode" on page 410.

MIL-STD-1553 Serial Decode
To set up the oscilloscope to capture MIL- STD- 1553 signals, see "Setup for
MIL- STD- 1553 Signals" on page 407.

NOTE

For MIL-STD-1553 triggering setup see "MIL-STD-1553 Triggering" on page 409.

To set up MIL- STD- 1553 serial decode:
1 Press [Serial] to display the Serial Decode Menu.

2 Use the Base softkey to select between hexadecimal and binary display
of the decoded data.
The base setting is used for the display of the remote terminal address
and the data, in both the decode line and in the Lister.
3 If the decode line does not appear on the display, press the [Serial] key
to turn it on.
4 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and
decode data.
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You can use the horizontal Zoom window for easier navigation of the
decoded data.
See Also

• "Interpreting MIL- STD- 1553 Decode" on page 411
• "Interpreting MIL- STD- 1553 Lister Data" on page 412
• "Searching for MIL- STD- 1553 Data in the Lister" on page 413

Interpreting MIL-STD-1553 Decode
To display serial decode information, you must press [Run] or [Single] after
switching on serial decode.

The MIL- STD- 1553 decode display is color coded as follows:
• Command and Status decoded data is colored green, with the Remote
Terminal Address (5 bits of data) being displayed first, then the text
"C/S:", followed by the value of the remaining 11 bits of a
Command/Status word.
• Data word decoded data is colored white, preceded by the text "D:".
• Command/Status or Data words with a Parity error have the decode
text displayed in red instead of green or white.
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• SYNC errors are displayed with the word "SYNC" within red angle
brackets.
• Manchester encoding errors are displayed with the word "MANCH"
within blue angle brackets (blue instead of red because a valid Sync
pulse started the word).

Interpreting MIL-STD-1553 Lister Data

In addition to the standard Time column, the MIL- STD- 1553 Lister
contains these columns:
• RTA — displays the Remote Terminal Address for Command/Status
words, nothing for Data words.
• Word Type — "Cmd/Status" for Command/Status words, "Data" for Data
words. For Command/Status words the background color is green to
match the decode text color.
• Data — the 11 bits after the RTA for Command/Status words, or the 16
bits of a Data word.
• Errors — "Sync", "Parity", or "Manchester" errors as appropriate. The
background color is red to indicate an error.

412
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Aliased data is highlighted in pink. When this happens, decrease the
horizontal time/div setting and run again.

Searching for MIL-STD-1553 Data in the Lister
The oscilloscope's search capability lets you search for (and mark) certain
types of MIL- STD- 1553 data in the Lister. You can use the [Navigate] key
and controls to navigate through the marked rows.
1 With MIL- STD- 1553 selected as the serial decode mode, press [Search].
2 In the Search Menu, press the Search softkey; then, turn the Entry knob
to select the serial slot (Serial 1 or Serial 2) on which the
MIL- STD- 1553 signal is being decoded.
3 Press Search; then, select from these options:
• Data Word Start — finds the start of a Data word (at the end of a valid
Data Sync pulse).
• Command/Status Word Start — finds the start of Command/Status word
(at the end of a valid C/S Sync pulse).
• Remote Terminal Address — finds the Command/Status word whose RTA
matches the specified value. The value is specified in hex.
When this option is selected, the RTA softkey becomes available and
lets you select the hex Remote Terminal Address value to find.
• Remote Terminal Address + 11 Bits — finds the RTA and the remaining 11
bits that match the specified criteria.
When this option is selected, these softkeys become available:
• The RTA softkey lets you select the hex Remote Terminal Address
value.
• The Bit Time softkey lets you select the bit time position.
• The 0 1 X softkey lets you set the bit time position value as a 1, 0,
or X (don't care).
• Parity Error — finds (odd) parity bits that are incorrect for the data in
the word.
• Sync Error — finds invalid Sync pulses.
• Manchester Error — finds Manchester encoding errors.
For more information on searching data, see "Searching Lister Data" on
page 128.
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For more information on using the [Navigate] key and controls, see
"Navigating the Time Base" on page 60.

Setup for ARINC 429 Signals
Setup consists of first connecting the oscilloscope to a ARINC 429 signal
using a differential active probe (the Agilent N2791A is recommended),
then using the Signals Menu to specify the signal source, the high and low
trigger threshold voltage levels, the signal speed, and the signal type.
To set up the oscilloscope to capture ARINC 429 signals:
1 Press [Label] to turn on labels.
2 Press [Serial].
3 Press the Serial softkey, turn the Entry knob to select the desired slot
(Serial 1 or Serial 2), and press the softkey again to enable decode.
4 Press the Mode softkey; then, select ARINC 429 decode mode.
5 Press the Signals softkey to open the ARINC 429 Signals Menu.

6 Press Source; then, select the channel for the ARINC 429 signal.
The label for the ARINC 429 source channel is automatically set.
7 Press the Speed softkey to open the ARINC 429 Speed Menu.

8 Press the Speed softkey and specify the speed of the ARINC 429 signal:
• High — 100 kb/s.
• Low — 12.5 kb/s.
• User Defined — if selected, press the User Baud softkey and turn the
Entry knob to specify the speed.
9 Press the

414

Back

Back/Up key to return to the ARINC 429 Signals Menu.
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10 Press the Signal Type softkey and specify the signal type of the ARINC
429 signal:
• Line A (non-inverted).
• Line B (inverted).
• Differential (A-B).
11 Press the Auto Setup softkey to automatically set these options for
decoding and triggering on ARINC 429 signals:
• High Trigger Threshold: 3.0 V.
• Low Trigger Threshold: - 3.0 V.
• Noise Reject: Off.
• Probe Attenuation: 10.0.
• Vertical Scale: 4 V/div.
• Serial Decode: On.
• Base: Hex.
• Word Format: Label/SDI/Data/SSM.
• Trigger: currently active serial bus.
• Trigger Mode: Word Start.
12 If the high and low thresholds are not set correctly by Auto Setup:
• Press the High Threshold softkey; then, turn the Entry knob to set the
high trigger threshold voltage level.
• Press the Low Threshold softkey; then, turn the Entry knob to set the
low trigger threshold voltage level.
The threshold voltage levels are used in decoding and will become the
trigger levels when the trigger type is set to the selected serial decode
slot.

ARINC 429 Triggering
To set up the oscilloscope to capture a ARINC 429 signal, see "Setup for
ARINC 429 Signals" on page 414.
After setting up the oscilloscope to capture a ARINC 429 signal:
1 Press [Trigger].
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2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select the serial slot (Serial 1 or Serial 2) on which the ARINC 429
signal is being decoded.

3 Press the Trigger: softkey; then, turn the Entry knob to select the trigger
condition:
• Word Start — triggers on the start of a word.
• Word Stop — triggers at the end of a word.
• Label — triggers on the specified label value.
• Label + Bits — triggers on the label and the other word fields as
specified.
• Label Range — triggers on a label following in a min/max range.
• Parity Error — triggers on words with a parity error.
• Word Error — triggers on an intra- word coding error.
• Gap Error — triggers on an inter- word gap error.
• Word or Gap Error — triggers on either a Word or Gap Error.
• All Errors — triggers on any of the above errors.
• All Bits (Eye) — triggers on any bit, which will therefore form an eye
diagram.
• All 0 Bits — triggers on any bit with a value of zero.
• All 1 Bits — triggers on any bit with a value of one.
4 If you select the Label or Label + Bits condition, use the Label softkey to
specify the label value.
Label values are always displayed in octal.
5 If you select the Label + Bits condition, use the Bits softkey and submenu
to specify the bit values:
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Use the Define softkey to select SDI, Data, or SSM. The SDI or SSM
selections may not be available, depending on word format selection in
the Serial Decode Menu.
Use the Bit softkey to select the bit to change.
Use the 0 1 X softkey to set the bit value.
Use the Set all Bits softkey to set all bit values to 0, 1, or X.
6 If you select the Label Range condition, use the Lable Min and Label Max
softkeys to specify the ends of the range.
Again, label values are always displayed in octal.
You can use the Zoom mode for easier navigation of the decoded data.

NOTE

To display ARINC 429 serial decode, see "ARINC 429 Serial Decode" on page 417.

ARINC 429 Serial Decode
To set up the oscilloscope to capture ARINC 429 signals, see "Setup for
ARINC 429 Signals" on page 414.

NOTE

For ARINC 429 triggering set up see "ARINC 429 Triggering" on page 415.

To set up ARINC 429 serial decode:
1 Press [Serial] to display the Serial Decode Menu.

2 In the submenu accessed by the Settings softkey, you can use the Base
softkey to select between hexadecimal and binary display of the
decoded data.
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The base setting is used for data display in both the decode line and in
the Lister.
Label values are always displayed in octal, and SSM and SDI values are
always displayed in binary.
3 Press the Word Format softkey and specify the word decode format:
• Label/SDI/Data/SSM:
• Label - 8 bits.
• SDI - 2 bits.
• Data - 19 bits.
• SSM - 2 bits.
• Label/Data/SSM:
• Label - 8 bits.
• Data - 21 bits.
• SSM - 2 bits.
• Label/Data:
• Label - 8 bits.
• Data - 23 bits.
4 If the decode line does not appear on the display, press the [Serial] key
to turn it on.
5 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and
decode data.

NOTE

If the setup does not produce a stable trigger, the ARINC 429 signal may be slow enough
that the oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the
Mode softkey to set the trigger mode from Auto to Normal.

You can use the horizontal Zoom window for easier navigation of the
decoded data.
See Also

• "Interpreting ARINC 429 Decode" on page 419
• "ARINC 429 Totalizer" on page 420
• "Interpreting ARINC 429 Lister Data" on page 421
• "Searching for ARINC 429 Data in the Lister" on page 421
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Interpreting ARINC 429 Decode

Depending on the selected word decode format, the ARINC 429 decode
display is color coded as follows:
• When the decode format is Label/SDI/Data/SSM:
• Label (yellow) (8 bits) – displayed in octal.
• SDI (blue) (2 bits) – displayed in binary.
• Data (white, red if parity error) (19 bits) – displayed in the selected
Base.
• SSM (green) (2 bits) – displayed in binary.
• When the decode format is Label/Data/SSM:
• Label (yellow) (8 bits) – displayed in octal.
• Data (white, red if parity error) (21 bits) – displayed in the selected
Base.
• SSM (green) (2 bits) – displayed in binary.
• When the decode format is Label/Data:
• Label (yellow) (8 bits) – displayed in octal.
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• Data (white, red if parity error) (23 bits) – displayed in the selected
Base.
The Label bits are displayed in the same order as they are received on the
wire. For the Data, SSM, and SDI bits, the fields are displayed in the
order received; however, the bits within those fields are displayed in
reverse order. In other words, the non- Label fields are displayed in the
ARINC 429 Word Format, while the bits for those fields have the opposite
transfer order on the wire.

ARINC 429 Totalizer
The ARINC 429 totalizer measures the total ARINC 429 words and errors.

The totalizer is always running, counting words and errors, and is
displayed whenever ARINC 429 decode is displayed. The totalizer counts
even when the oscilloscope is stopped (not acquiring data).
Pressing the [Run/Stop] key does not affect the totalizer.
When an overflow condition occurs, the counter displays OVERFLOW.
The counters can be reset to zero by pressing the Reset ARINC 429 Counters
softkey (in the decode Settings menu).
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Interpreting ARINC 429 Lister Data

In addition to the standard Time column, the ARINC 429 Lister contains
these columns:
• Label — the 5- bit label value in octal format.
• SDI — the bit values (if included in the word decode format).
• Data — the data value in binary or hex, depending on the base setting.
• SSM — the bit values (if included in the word decode format).
• Errors — highlighted in red. Errors can be Parity, Word, or Gap.
Aliased data is highlighted in pink. When this happens, decrease the
horizontal time/div setting and run again.

Searching for ARINC 429 Data in the Lister
The oscilloscope's search capability lets you search for (and mark) certain
types of ARINC 429 data in the Lister. You can use the [Navigate] key and
controls to navigate through the marked rows.
1 With ARINC 429 selected as the serial decode mode, press [Search].

Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

421

27 MIL-STD-1553/ARINC 429 Triggering and Serial Decode

2 In the Search Menu, press the Search softkey; then, turn the Entry knob
to select the serial slot (Serial 1 or Serial 2) on which the ARINC 429
signal is being decoded.
3 Press Search; then, select from these options:
• Label — finds the specified label value.
Label values are always displayed in octal.
• Label + Bits — finds the label and the other word fields as specified.
• Parity Error — finds words with a parity error.
• Word Error — finds an intra- word coding error.
• Gap Error — finds an inter- word gap error.
• Word or Gap Error — finds either a Word or Gap Error.
• All Errors — finds any of the above errors.
For more information on searching data, see "Searching Lister Data" on
page 128.
For more information on using the [Navigate] key and controls, see
"Navigating the Time Base" on page 60.
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UART/RS232 Triggering 425
UART/RS232 Serial Decode 427

UART/RS232 triggering and serial decode requires Option COMP or the
DSOX3COMP upgrade.

Setup for UART/RS232 Signals
To set up the oscilloscope to capture UART/RS232 signals:
1 Press [Label] to turn on labels.
2 Press [Serial].
3 Press the Serial softkey, turn the Entry knob to select the desired slot
(Serial 1 or Serial 2), and press the softkey again to enable decode.
4 Press the Mode softkey; then, select UART/RS232 trigger type.
5 Press the Signals softkey to open the UART/RS232 Signals Menu.

s1
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6 For both the Rx and Tx signals:
a Connect an oscilloscope channel to the signal in the device under
test.
b Press the Rx or Tx softkey; then, turn the Entry knob to select the
channel for the signal.
c Press the corresponding Threshold softkey; then, turn the Entry knob
to select the signal threshold voltage level.
The threshold voltage level is used in decoding, and it will become
the trigger level when the trigger type is set to the selected serial
decode slot.
The RX and TX labels for the source channels are automatically set.
7 Press the

Back

Back/Up key to return to the Serial Decode Menu.

8 Press the Bus Config softkey to open the UART/RS232 Bus Configuration
Menu.

Set the following parameters.
a #Bits — Set the number of bits in the UART/RS232 words to match
your device under test (selectable from 5- 9 bits).
b Parity — Choose odd, even, or none, based on your device under test.
c Baud — Press the Baud Rate softkey, then press the Baud softkey and
select a baud rate to match the signal in your device under test. If
the desired baud rate is not listed, select User Defined on the Baud
softkey; then, select the desired baud rate using the User Baud softkey.
You can set the UART baud rate from 1.2 kb/s to 8.0000 Mb/s in
increments of 100 b/s.
d Polarity — Select idle low or idle high to match your device under
test's state when at idle. For RS232 select idle low.
e Bit Order — Select whether the most significant bit (MSB) or the least
significant bit (LSB) is presented after the start bit in the signal
from your device under test. For RS232 select LSB.
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NOTE

In the serial decode display, the most significant bit is always displayed on the left
regardless of how Bit Order is set.

UART/RS232 Triggering
To set up the oscilloscope to capture UART/RS- 232 signals, see "Setup for
UART/RS232 Signals" on page 423.
To trigger on a UART (Universal Asynchronous Receiver/Transmitter)
signal connect the oscilloscope to the Rx and Tx lines and set up a trigger
condition. RS232 (Recommended Standard 232) is one example of a UART
protocol.
1 Press [Trigger].
2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob
to select the serial slot (Serial 1 or Serial 2) on which the UART/RS232
signals are being decoded.

3 Press the Trigger Setup softkey to open the UART/RS232 Trigger Setup
Menu.

4 Press the Base softkey to select Hex or ASCII as the base displayed on
the Data softkey in the UART/RS232 Trigger Setup Menu.
Note that the setting of this softkey does not affect the selected base of
the decode display.
5 Press the Trigger softkey and set up the desired trigger condition:
• Rx Start Bit — The oscilloscope triggers when a start bit occurs on Rx.
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• Rx Stop Bit — Triggers when a stop bit occurs on Rx. The trigger will
occur on the first stop bit. This is done automatically whether the
device under test uses 1, 1.5, or 2 stop bits. You do not need to
specify the number of stop bits used by the device Under test.
• Rx Data — Triggers on a data byte that you specify. For use when the
device under test data words are from 5 to 8 bits in length (no 9th
(alert) bit).
• Rx 1:Data — For use when the device under test data words are 9 bits
in length including the alert bit (the 9th bit). Triggers only when the
9th (alert) bit is 1. The specified data byte applies to the least
significant 8 bits (excludes the 9th (alert) bit).
• Rx 0:Data — For use when the device under test data words are 9 bits
in length including the alert bit (the 9th bit). Triggers only when the
9th (alert) bit is 0. The specified data byte applies to the least
significant 8 bits (excludes the 9th (alert) bit).
• Rx X:Data — For use when the device under test data words are 9 bits
in length including the alert bit (the 9th bit). Triggers on a data byte
that you specify regardless of the value of the 9th (alert) bit. The
specified data byte applies to the least significant 8 bits (excludes
the 9th (alert) bit).
• Similar choices are available for Tx.
• Rx or Tx Parity Error — Triggers on a parity error based on the parity
you have set in the Bus Configuration Menu.
6 If you choose a trigger condition that includes "Data" in its description
(for example: Rx Data), then press the Data is softkey, and choose an
equality qualifier. You can choose equal to, not equal to, less than, or
greater than a specific data value.
7 Use the Data softkey to choose the data value for your trigger
comparison. This works in conjunction with the Data is softkey.
8 Optional: The Burst softkey lets you trigger on the Nth frame (1- 4096)
after an idle time you select. All trigger conditions must be met for the
trigger to occur.
9 If Burst is selected, an idle time (1 µs to 10 s) can be specified so that
the oscilloscope will look for a trigger condition only after the idle time
has past. Press the Idle softkey and rotate the Entry knob to set an idle
time.
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NOTE

If the setup does not produce a stable trigger, the UART/RS232 signals may be slow
enough that the oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then
press the Mode softkey to set the trigger mode from Auto to Normal.

NOTE

To display UART/RS232 serial decode, see "UART/RS232 Serial Decode" on page 427.

28

UART/RS232 Serial Decode
To set up the oscilloscope to capture UART/RS232 signals, see "Setup for
UART/RS232 Signals" on page 423.

NOTE

For UART/RS232 triggering setup see "UART/RS232 Triggering" on page 425.

To set up UART/RS232 serial decode:
1 Press [Serial] to display the Serial Decode Menu.

2 Press Settings.
3 In the UART/RS232 Settings Menu, press the Base softkey to select the
base (hex, binary, or ASCII) in which decoded words are displayed.

• When displaying words in ASCII, the 7- bit ASCII format is used.
Valid ASCII characters are between 0x00 and 0x7F. To display in
ASCII you must select at least 7 bits in the Bus Configuration. If
ASCII is selected and the data exceeds 0x7F, the data is displayed in
hex.

Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

427

28 UART/RS232 Triggering and Serial Decode

• When #Bits is set to 9 in the UART/RS232 Bus Configuration Menu,
the 9th (alert) bit is displayed directly to the left of the ASCII value
(which is derived from the lower 8 bits).
4 Optional: Press the Framing softkey and select a value. In the decode
display, the chosen value will be displayed in light blue. However, if a
parity error occurs the data will be displayed in red.
5 If the decode line does not appear on the display, press the [Serial] key
to turn it on.
6 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and
decode data.

NOTE

If the setup does not produce a stable trigger, the UART/RS232 signals may be slow
enough that the oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then
press the Mode softkey to set the trigger mode from Auto to Normal.

You can use the horizontal Zoom window for easier navigation of the
acquired data.
See Also

• "Interpreting UART/RS232 Decode" on page 429
• "UART/RS232 Totalizer" on page 430
• "Interpreting UART/RS232 Lister Data" on page 431
• "Searching for UART/RS232 Data in the Lister" on page 431
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28

Interpreting UART/RS232 Decode

• Angled waveforms show an active bus (inside a packet/frame).
• Mid- level blue lines show an idle bus.
• When using 5- 8 bit formats, the decoded data is displayed in white (in
binary, hex, or ASCII).
• When using the 9 bit format, all data words are displayed in green,
including the 9th bit. The 9th bit is displayed on the left.
• When a data word value is selected for framing, it is displayed in light
blue. When using 9- bit data words, the 9th bit will also be displayed in
light blue.
• Decoded text is truncated at the end of the associated frame when
there is insufficient space within frame boundaries.
• Pink vertical bars indicate you need to expand the horizontal scale (and
run again) to see decode.
• When the horizontal scale setting does not permit the display of all
available decoded data, red dots will appear in the decoded bus to
mark the location of hidden data. Expand the horizontal scale to allow
the data to display.
• An unknown (undefined) bus is shown in red.
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• A parity error will cause the associated data word to be shown in red,
which includes the 5- 8 data bits and the optional 9th bit.

UART/RS232 Totalizer
The UART/RS232 totalizer consists of counters that provide a direct
measure of bus quality and efficiency. The totalizer appears on screen
whenever UART/RS232 Decode is ON in the Serial Decode Menu.

The totalizer is running, counting frames and calculating the percentage of
error frames, even when the oscilloscope is stopped (not acquiring data).
The ERR (error) counter is a count of Rx and Tx frames with parity
errors. The TX FRAMES and RX FRAMES counts include both normal
frames and frames with parity errors. When an overflow condition occurs,
the counter displays OVERFLOW.
The counters can be reset to zero by pressing the Reset UART Counters
softkey in the UART/RS232 Settings Menu.
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Interpreting UART/RS232 Lister Data

In addition to the standard Time column, the UART/RS232 Lister contains
these columns:
• Rx — receive data.
• Tx — transmit data.
• Errors — highlighted in red, Parity Error or Unknown Error.
Aliased data is highlighted in pink. When this happens, decrease the
horizontal time/div setting and run again.

Searching for UART/RS232 Data in the Lister
The oscilloscope's search capability lets you search for (and mark) certain
types of UART/RS232 data in the Lister. You can use the [Navigate] key
and controls to navigate through the marked rows.
1 With UART/RS232 selected as the serial decode mode, press [Search].
2 In the Search Menu, press the Search softkey; then, turn the Entry knob
to select the serial slot (Serial 1 or Serial 2) on which the UART/RS232
signals are being decoded.
3 In the Search Menu, press Search; then, select from these options:
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• Rx Data — Finds a data byte that you specify. For use when the DUT
data words are from 5 to 8 bits in length (no 9th (alert) bit).
• Rx 1:Data — For use when the DUT data words are 9 bits in length
including the alert bit (the 9th bit). Finds only when the 9th (alert)
bit is 1. The specified data byte applies to the least significant 8 bits
(excludes the 9th (alert) bit)
• Rx 0:Data — For use when the DUT data words are 9 bits in length
including the alert bit (the 9th bit). Finds only when the 9th (alert)
bit is 0. The specified data byte applies to the least significant 8 bits
(excludes the 9th (alert) bit).
• Rx X:Data — For use when the DUT data words are 9 bits in length
including the alert bit (the 9th bit). Finds a data byte that you
specify regardless of the value of the 9th (alert) bit. The specified
data byte applies to the least significant 8 bits (excludes the 9th
(alert) bit).
• Similar choices are available for Tx.
• Rx or Tx Parity Error — Finds a parity error based on the parity you have
set in the Bus Configuration Menu.
• Rx or Tx Any Error — Finds any error.
For more information on searching data, see "Searching Lister Data" on
page 128.
For more information on using the [Navigate] key and controls, see
"Navigating the Time Base" on page 60.
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Index
Symbols
(-) Width measurement, 231
(+) Width measurement, 231

Numerics
1 M ohm input impedance, 67
50 ohm input impedance, 66

A
About Oscilloscope, 309
absolute value math function, 92
AC channel coupling, 66
AC RMS - Full Screen measurement, 226
AC RMS - N Cycles measurement, 226
accessories, 25, 334, 338, 339
acquire, 187, 197
Acquire key, 40
acquisition memory, 144
acquisition memory, saving, 279
acquisition mode, 193
acquisition mode, averaging, 197
acquisition mode, high resolution, 199
acquisition mode, normal, 194
acquisition mode, peak detect, 194
acquisition mode, preserve during
AutoScale, 304
acquisition modes, 187
active serial bus, 356, 364, 383, 393, 404,
429
activity indicator, 111
actual sample rate, 193
adding digital channels license, 341
addition math function, 77
address with no ack condition, I2C
trigger, 379
Addresses softkey, 298
ADVMATH license, 339
AERO license, 339
Agilent IO Libraries Suite, 322

aliasing, 189
aliasing, FFT, 88
alternating edge trigger, 147
AM (amplitude modulation), waveform
generator output, 270
Amplitude measurement, 222
amplitude modulation (AM), waveform
generator output, 270
analog channel inputs, 41
analog channel, probe attenuation, 69
analog channel, setup, 63
analog filters, adjusting, 83
Analyze key, 37
Analyze Segments, 200, 202, 241
annotation, adding, 312
arbitrary generated waveforms,
editing, 263
arbitrary waveform generator output, 260
arbitrary waveforms, copying from other
sources, 266
arbitrary waveforms, creating new, 264
arbitrary waveforms, editing existing, 265
Area - Full Screen measurement, 237
Area - N Cycles measurement, 237
ARINC 429 serial decode, 417
ARINC 429 totalizer, 420
ARINC 429 trigger, 415
ARINC 429 words/errors counter, 420
ARINC 429 decode, signal speed, 414
ARINC 429 decode, signal type, 415
ARINC 429 decode, word format, 418
ASCII file format, 276
attenuation, probe, 69
attenuation, probe, external trigger, 185
attenuators, 71
AUDIO license, 339
Auto Increment, 283
AUTO Option, 339
Auto Scale key, 39
Auto Setup, FFT, 84, 85
Auto trigger mode, 180
Auto? trigger indicator, 181
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AutoIP, 297, 298
automatic measurements, 215, 217
automatic setup, 109
AutoProbe interface, 41, 66
AutoScale preferences, 303
AutoScale, digital channels, 109
AutoScale, undo, 33
Average - Full Screen measurement, 225
Average - N Cycles measurement, 225
average measurement trend, 97
averaging acquire mode, 193, 197
Ax + B math function, 90

B
Back Up key, 36
bandwidth, 309
bandwidth limit, 67
bandwidth required, oscilloscope, 192
bandwidth, oscilloscope, 190
base 10 exponential math function, 94
Base measurement, 223
BIN file format, 276
binary data (.bin), 342
binary data file examples, 346
binary data in MATLAB, 343
binary data, example program for
reading, 345
bits, SPI trigger, 390
Blackman Harris FFT window, 84
blanking, 56
BMP file format, 276
brick-wall frequency response, 190
brightness of waveforms, 36
Browser Web Control, 317, 318, 319,
320, 321
Browser-Based Remote Front Panel, 320
built-in help, 47
burst width measurements, 231
burst, capture signal bursts, 199
bus display mode, 114
buttons (keys), front panel, 35
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Index

BW Limit? in DVM display, 256

C
calibrate probe, 70
calibration, 306
calibration protect button, 44, 45
calibration status, 327
CAN decode, source channels, 352
CAN frame counter, 357
CAN serial decode, 355
CAN totalizer, 357
CAN trigger, 353
capture signal bursts, 199
cardiac waveform generator output, 262
Center, FFT, 83
channel labels, 137
channel, analog, 63
channel, bandwidth limit, 67
channel, coupling, 65
channel, invert, 68
channel, on/off keys, 41
channel, position, 65
channel, probe units, 69
channel, skew, 70
channel, vernier, 67
channel, vertical sensitivity, 65
characteristics, 331
chart logic bus state math function, 99
chart logic bus timing math function, 98
choosing values, 37
cleaning, 309
clear display, 196
clear display, Quick Clear Display, 311
clear persistence, 134
clock, 304
CMOS threshold, 113
common logarithm math function, 92
COMP license, 340
compensate passive probes, 34, 41
Config softkey, 297, 298
connect probes, digital, 105
connection, to a PC, 298
connectors, rear panel, 44
control, remote, 295
controls, front panel, 35
copyright, 2
Counter measurement, 230
counter, ARINC 429 words/errors, 420
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counter, CAN frame, 357
counter, FlexRay frame, 373
counter, UART/RS232 frame, 430
coupling, channel, 65
coupling, trigger, 182
crosstalk problems, 83
CSV file format, 276
CSV files, minimum and maximum
values, 349
current probes, 337
cursor measurements, 205
cursor units, 208
Cursors key, 40
Cursors knob, 40
cursors, binary, 207
cursors, hex, 207
cursors, manual, 206
cursors, track waveform, 207

D
D*, 39, 113
d/dt math function, 79
damage, shipping, 25
data sheet, 331
DC channel coupling, 66
DC offset correction for integrate
waveform, 81
DC RMS - Full Screen measurement, 226
DC RMS - N Cycles measurement, 226
DC signals, checking, 181
DC waveform generator output, 261
dead time (re-arm), 202
decibels, FFT vertical units, 84
decimating samples, 193
decimation, for measurement record, 349
decimation, for screen, 349
default configuration, 31
default label library, 141
default setup, 31, 286
Default Setup key, 38
defaults, waveform generator, 274
delay knob, 51
Delay measurement, 218, 232
delay time indicator, 59
delayed sweep, 56
delete character, 283
delete file, 299
Demo 1 terminal, 41

Demo 2 terminal, 41
depth, AM modulation, 271
deviation, FM modulation, 272
DHCP, 297, 298
differential probes, 336
differentiate math function, 79
Digit softkey, 155
digital bus mode, 114
digital channel controls, 39
digital channel inputs, 42
digital channel menu, 112
digital channels, 112
digital channels, AutoScale, 109
digital channels, enabling, 341
digital channels, logic threshold, 112
digital channels, probing, 117
digital channels, size, 111
digital display, interpreting, 110
Digital key, 39
digital probes, 105, 117
digital probes, impedance, 117
digital voltmeter (DVM), 255
Display key, 40
display multiple acquisitions, 188
display, area, 47
display, interpreting, 46
display, persistence, 133
display, signal detail, 131
display, softkey labels, 47
display, status line, 47
displayed channels AutoScale, 303
distortion problems, 83
Divide math function, 77
DNS IP, 297
dual-channel (N2820A probe)
measurements, 219
Duty cycle measurement, 231
duty cycle measurement trend, 98
DVM (digital voltmeter, 255
DVM license, 340
Dynamic DNS, 297

E
ECL threshold, 113
edge speeds, 192
edge then edge triggering, 148
edge triggering, 146
EDK license, 340
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EEPROM data read, I2C trigger, 379
either edge trigger, 147
EMBD license, 340
energy of a pulse, 80
English user interface and Quick Help, 48
Entry knob, 37
Entry knob, push to select, 37
erase, secure, 286
event table, 126
expand about, 65, 301
expand about center, 302
expand about ground, 301
exponential fall waveform generator
output, 262
exponential math function, 93
exponential rise waveform generator
output, 261
exporting waveform, 275
EXT TRIG IN as Z-axis input, 56
EXT TRIG IN connector, 46
external memory device, 42
external trigger, 184
external trigger, input impedance, 185
external trigger, probe attenuation, 185
external trigger, probe units, 185

F
f(t), 75
factory default settings, 286
Fall time measurement, 232
fall time measurement trend, 98
falling edges count measurements, 236
fast debug AutoScale, 303
FFT aliasing, 88
FFT DC value, 88
FFT measurement hints, 86
FFT measurements, 83
FFT resolution, 87
FFT spectral leakage, 89
FFT units, 88
FFT vertical units, 84
FFT window, 84
file explorer, 299
file format, ASCII, 276
file format, BIN, 276
file format, BMP, 276
file format, CSV, 276
file format, PNG, 276

File keys, 40
file name, new, 283
file, save, recall, load, 299
filter math function, high pass and low
pass, 95
filters, math, 94
fine adjustment, horizontal scale, 58
firmware updates, 341
firmware upgrade files, 327
firmware version information, 315
firmware versions, 327
flash drive, 42
flat frequency response, 191
Flat top FFT window, 84
FLEX license, 340
FlexRay frame counter, 373
FlexRay serial decode, 371
FlexRay totalizer, 373
FlexRay trigger, 368
FM (frequency modulation), waveform
generator output, 271
folding frequency, 189
forcing a trigger, 145
frame trigger, I2C, 380
freeze display, 311
freeze display, Quick Freeze Display, 311
French front panel overlays, 44
French user interface and Quick Help, 48
frequency deviation, FM modulation, 272
Frequency measurement, 229
frequency measurement trend, 97
frequency modulation (FM), waveform
generator output, 271
frequency requirements, power source, 29
frequency, Nyquist, 189
frequency-shift keying modulation (FSK),
waveform generator output, 273
front panel controls and connectors, 35
front panel self test, 309
front panel, browser-based remote, 320
front panel, language overlay, 42
front panel, real scope remote, 318
front panel, simple remote, 319
FSK (frequency-shift keying modulation),
waveform generator output, 273

G
g(t), 75
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gateway IP, 297
Gaussian frequency response, 190
gaussian pulse waveform generator
output, 262
Generic video trigger, 168
German front panel overlays, 44
German user interface and Quick Help, 48
glitch capture, 195
glitch trigger, 149
golden waveform test, 243
GPIB address, 296
GPIB interface, remote control, 295
GPIB module, 28, 45
GPIB module installation, 28
grabber, 107, 108
graphical user interface language, 48
graticule intensity, 135
graticule type, 134
grid intensity, 135
grid type, 134
ground level, 64
Ground terminal, 41

H
Hanning FFT window, 84
hardware self test, 308
Help key, 40
help, built-in, 47
hex bus trigger, 155
Hex softkey, 155
HF Reject, 183
high pass filter math function, 95
high-frequency noise rejection, 183
high-resolution mode, 193, 199
holdoff, 184
hop frequency, FSK modulation, 273
Horiz key, 38, 49, 54, 56, 196
Horizontal controls, 38, 53
horizontal Navigate key, 38
horizontal position control, 38
horizontal position knob, 51
horizontal scale fine adjustment, 58
horizontal Search key, 38
horizontal sweep speed control, 38
horizontal time/div control, 38
horizontal Zoom key, 38
host name, 297, 315
Host name softkey, 298
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I
I/O interface settings, 295
I2C serial decode, 382
I2C trigger, 378
I2S serial decode, 403
I2S trigger, 400
identification function, web interface, 326
idle serial bus, 356, 364, 383, 393, 404,
429
Imped softkey, 66
impedance, digital probes, 117
increment statistics, 241
indeterminate state, 207
infinite persistence, 133, 188, 195
information area, 47
input impedance, analog channel input, 66
installed licenses, 309
installed options, 326
instantaneous slope of a waveform, 79
Instrument Utilities web page, 326
Integrate math function, 80
intensity control, 131
Intensity key, 36
interpolate, arbitrary waveform
option, 264
invert graticule colors, 278
invert waveform, 68
IP address, 297, 315
Italian front panel overlays, 44
Italian user interface and Quick Help, 48

label list, 141
label list, loading from text file, 140
labels, 137
labels, auto-increment, 140
labels, default library, 141
LAN connection, 297
LAN interface, remote control, 295
LAN port, 45
LAN Settings softkey, 297, 298
LAN/VGA module, 28, 45
LAN/VGA module installation, 28
landscape mode, 292
language, user interface and Quick
Help, 48
length control, 279
length softkey, 279
level, trigger, 145
LF Reject, 182
library, labels, 139
licenses, 339, 341
LIN serial decode, 363
LIN trigger, 361
line voltage, 29
Lister, 126
load file, 299
Load from, 282
localized front panel overlay, 42
Location, 282, 300
logic presets, waveform generator, 268
logic threshold, 112
low pass filter math function, 95
low-frequency noise rejection, 182

J
Japanese front panel overlays, 44
Japanese user interface and Quick
Help, 48

K
keyboard, USB, 140, 283, 292, 303, 313
keys, front panel, 35
knobs, front panel, 35
Korean front panel overlays, 44
Korean user interface and Quick Help, 48

L
Label key, 41
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M
magnify math function, 96
mask files, recall, 284
MASK license, 340
mask test, trigger output, 247, 305
mask testing, 243
mask, TRIG OUT signal, 305
math filters, 94
Math key, 39
math operators, 76
math transforms, 78
math visualizations, 96
math, 1*2, 77
math, 1/2, 77
math, addition, 77

math, differentiate, 79
math, divide, 77
math, FFT, 83
math, functions, 73
math, integrate, 80
math, multiply, 77
math, offset, 75
math, scale, 75
math, subtract, 77
math, transforms or filters on arithmetic
operations, 75
math, units, 75, 76
math, using waveform math, 73
MATLAB binary data, 343
Maximum measurement, 222
maximum sample rate, 193
Meas key, 40, 215
Measure controls, 40
measure, Quick Measure All, 311
measurement category, definitions, 332
measurement definitions, 217
measurement record, 279
measurement statistics, 239
measurement thresholds, 237
measurement trend math function, 97
measurement window with zoom
display, 239
measurements, 217
measurements, automatic, 215
measurements, delay, 218
measurements, overshoot, 218
measurements, phase, 219
measurements, preshoot, 219
measurements, time, 228
measurements, voltage, 221
MegaZoom IV, 4
mem4M, 340
memory depth and sample rate, 193
memory, segmented, 199
menu line, 47
MIL-STD-1553 serial decode, 410
MIL-STD-1553 trigger, 409
Minimum measurement, 222
missing acknowledge condition, I2C
trigger, 379
Mode/Coupling key, trigger, 179
model number, 309, 315
Modify softkey, 298
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modulation, waveform generator
output, 269
module installed, 309
module slot, 45
MSO, 4
MSO feature upgrade, 341
MSO license, 340
Multicast DNS, 297
multiplexed position knob, 39
multiplexed scale knob, 39
Multiply math function, 77

N
N2820A high-sensitivity current
probe, 219
N8900A InfiniiView oscilloscope analysis
software, 276
natural logarithm math function, 93
navigate files, 299
Navigate key, 38
navigating the time base, 60
negative pulse width measurement
trend, 97
network configuration parameters, 315
network printer connection, 290
network, connecting to, 297
new label, 139
noise rejection, 183
noise waveform generator output, 261
noise, adding to waveform generator
output, 269
noise, high-frequency, 183
noise, low-frequency, 182
noisy signals, 179
non-volatile memory, secure erase, 286
normal acquire mode, 194
normal mode, 193, 194
Normal trigger mode, 180
notices, 2
Nth edge burst trigger, 158
Nth edge burst triggering, 158
number of negative pulses
measurements, 236
number of positive pulses
measurements, 235
Nyquist frequency, 88
Nyquist sampling theory, 189

O
offset (DC) correction for integrate
waveform, 81
operators, math, 76
options, print, 292
OR trigger, 155
oscilloscope bandwidth, 190
oscilloscope bandwidth required, 192
oscilloscope rise time, 191
oscilloscope sample rate, 191
output load expected, waveform
generator, 267
output, trigger, 304
overlay, localized, 42
Overshoot measurement, 218, 224
overvoltage category, 333

P
palette, 278
pan and zoom, 50
parts, replacement, 122
passive probes, 335
passive probes, compensating, 34
password (network), reset, 329
password (network), setting, 327
pattern trigger, 152
pattern, SPI trigger, 390
PC connection, 298
peak detect mode, 193, 194, 195
Peak-peak measurement, 222
Period measurement, 229
period measurement trend, 97
persistence, 133
persistence, clearing, 134
persistence, infinite, 188
Phase measurement, 219, 233
phase X cursor units, 208
PNG file format, 276
point-to-point connection, 298
Polish front panel overlays, 44
pollution degree, 333
pollution degree, definitions, 334
Portuguese front panel overlays, 44
Portuguese user interface and Quick
Help, 48
position digital channels, 113
position knob, 113
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position, analog, 65
positive pulse width measurement
trend, 97
post-processing, 215
post-trigger information, 51
Power App measurements, 219
power consumption, 29
power cord connector, 45
power requirements, 29
power supply, 45
power switch, 30, 36
power-on, 29
predefined labels, 138
Preshoot measurement, 219, 225
Press to go, 282, 300
pre-trigger information, 51
print, 311
Print key, 40
print options, 292
print screen, 289
print, landscape, 292
print, Quick Print, 311
printer, USB, 42, 289
printing the display, 289
probe attenuation, 69
probe attenuation, external trigger, 185
probe compensation, 41
probe head, 71
probe units, 69
probe, AutoProbe interface, 41
probe, calibrate, 70
probes, 334, 338, 339
probes, connecting to oscilloscope, 30
probes, current, 337
probes, differential, 336
probes, digital, 105
probes, passive, 335
probes, passive, compensating, 34
probes, single-ended active, 335
programmer's guide, 323
pulse polarity, 150
pulse waveform generator output, 261
pulse width trigger, 149
PWR license, 340

Q
qualifier, pulse width, 151
Quick Action key, 37, 311
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Quick Clear Display, 311
Quick Freeze Display, 311
Quick Help, 47
Quick Help language, 48
Quick Measure All, 311
Quick Print, 311
Quick Recall, 311
Quick Save, 311
Quick Trigger Mode, 311

R
ramp waveform generator output, 261
random noise, 179
ratio measurement, 228
ratio measurement trend, 97
ratio X cursor units, 208
ratio Y cursor units, 208
raw acquisition record, 279
Real Scope Remote Front Panel, 318
rear panel connectors, 44
re-arm time, 202
recall, 311
recall files via web interface, 324
recall mask files, 284
recall setups, 284
recall, Quick Recall, 311
Rectangular FFT window, 84
Ref key, 39, 101
reference point, waveform, 301
reference waveforms, 101
remote control, 295
Remote Front Panel, 321
remote programming, Agilent IO
Libraries, 322
remote programming, web interface, 321
replacement parts, 122
required oscilloscope bandwidth, 192
reset network password, 329
restart condition, I2C trigger, 379
return instrument for service, 310
Rise time measurement, 232
rise time measurement trend, 98
rise time, oscilloscope, 191
rise time, signal, 192
rise/fall time triggering, 157
rising edge count measurements, 236
RMS - AC measurement trend, 97
roll mode, 53
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RS232 trigger, 425
Run Control keys, 38
runt pulses, 229
runt triggering, 160
Russian front panel overlays, 44
Russian user interface and Quick Help, 48

S
safety warning, 31
sample rate, 3
sample rate and memory depth, 193
sample rate, current rate displayed, 50
sample rate, oscilloscope, 190, 191
sampling theory, 189
sampling, overview, 189
save, 311
save file, 299
save files via web interface, 323
save segment, 279
save setup files, 277
save times, data, 280
Save to, 282
save, Quick Save, 311
save/recall from web interface, 323
Save/Recall key, 40
saver, screen, 302
saving data, 275
SCL, I2C trigger, 378
SCLK, I2S trigger, 398
SCPI Commands window, 321
screen image via web interface, 325
screen saver, 302
SDA, 377
SDA, I2C trigger, 378
Search key, 38
secure erase, 286
segmented memory, 199
segmented memory, re-arm time, 202
segmented memory, saving segments, 279
segmented memory, statistical data, 202
select digital channels, 113
select knob, 113
Selected, 300
selecting, values, 37
self test, front panel, 309
self test, hardware, 308
serial clock, I2C trigger, 378
serial clock, I2S trigger, 398

serial data, 377
serial data, I2C trigger, 378
serial decode controls, 39
Serial key, 39
serial number, 309, 315
service functions, 305
Set all Digits softkey, 155
setup and hold triggering, 162
setup files, saving, 277
setup, automatic, 109
setup, default, 31
setups, recall, 284
SGM, 199
SGM license, 340
shipping damage, 25
shipping precautions, 310
Sigma, minimum, 246
Simple Remote Front Panel, 319
Simplified Chinese front panel overlays, 44
Simplified Chinese user interface and Quick
Help, 48
sinc waveform generator output, 261
sine waveform generator output, 261
single acquisition, 38
Single key, 187
single-ended active probes, 335
single-shot acquisitions, 181
single-shot events, 187
size, 111
skew, analog channel, 70
slope trigger, 146
Snapshot All measurements, 220
snapshot all, quick action, 311
softkey labels, 47
softkeys, 7, 36
software updates, 341
software version, 309
Span, FFT, 83
Spanish front panel overlays, 44
Spanish user interface and Quick Help, 48
specifications, 331
spectral leakage, FFT, 89
SPI serial decode, 391
SPI trigger, 389
square math function, 91
square root, 90
square waveform generator output, 261
square waves, 190
stand-alone connection, 298
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start acquisition, 38
start condition, I2C, 379
state logic bus chart, 99
statistics, increment, 241
statistics, mask test, 248
statistics, measurement, 239
statistics, using segmented memory, 202
status line, 47
status, User Cal, 309
Std Deviation measurement, 226
stop acquisition, 38
stop condition, I2C, 379
storage locations, navigate, 282
subnet mask, 297
subtract math function, 77
sync pulse, waveform generator, 267

T
template, front panel, 42
test, mask, 243
Thai front panel overlays, 44
theory, sampling, 189
threshold, analog channel
measurements, 237
threshold, digital channels, 112
thumb drive, 42
tilt for viewing, 28
time measurements, 228
time reference indicator, 59
time, re-arm, 202
timebase, 53
times for saving data, 280
timing logic bus chart, 98
Tools keys, 37
Top measurement, 222
totalizer, ARINC 429, 420
totalizer, CAN, 357
totalizer, FlexRay, 373
totalizer, UART/rs232, 430
tracking cursors, 207
trademarks, 2
Traditional Chinese front panel overlays, 44
Traditional Chinese user interface and Quick
Help, 48
transforms, math, 78
transient withstand capability, 333
Transparent backgrounds, 302
TRIG OUT connector, 45, 304

Trig'd trigger indicator, 181
Trig'd? trigger indicator, 181
Trigger controls, 37
trigger coupling, 182
trigger indicator, Auto?, 181
trigger indicator, Trig'd, 181
trigger indicator, Trig'd?, 181
trigger level, 145
trigger mode, auto or normal, 180
trigger mode, Quick Trigger Mode, 311
trigger output, 304
trigger output, mask test, 247, 305
trigger type, ARINC 429, 415
trigger type, CAN, 353
trigger type, edge, 146
trigger type, edge then edge, 148
trigger type, FlexRay, 368
trigger type, glitch, 149
trigger type, hex bus, 155
trigger type, I2C, 378
trigger type, I2S, 400
trigger type, LIN, 361
trigger type, MIL-STD-1553, 409
trigger type, Nth edge burst, 158
trigger type, OR, 155
trigger type, pattern, 152
trigger type, pulse width, 149
trigger type, rise/fall time, 157
trigger type, RS232, 425
trigger type, runt, 160
trigger type, setup and hold, 162
trigger type, slope, 146
trigger type, SPI, 389
trigger type, UART, 425
trigger type, USB, 175
trigger type, video, 163
trigger types, 143
trigger, definition, 144
trigger, external, 184
trigger, forcing a, 145
trigger, general information, 144
trigger, holdoff, 184
trigger, mode/coupling, 179
trigger, source, 146
triggers, TRIG OUT signal, 305
TTL threshold, 113
turn channel on, 41

Agilent InfiniiVision 3000 X-Series Oscilloscopes User's Guide

U
UART totalizer, 430
UART trigger, 425
UART/RS232 frame counter, 430
UART/RS232 license, 340
UART/RS232 serial decode, 427
under-sampled signals, 189
units, cursor, 208
units, external trigger probe, 185
units, math, 75, 76
units, probe, 69
updating software and firmware, 341
upgrade files, 327
upgrade options, 339
upgrading the oscilloscope, 341
upload new firmware, 315
usb, 301
USB device port, 46
USB device port, remote control, 295
USB host port, 46, 289
USB host ports, 42
USB printer, 289
USB printers, supported, 289
USB storage device, 42
USB, CD device, 301
USB, eject device, 42
USB, storage device numbering, 301
USB, trigger type, 175
usb2, 301
user cal, 306
user calibration, 306
user interface language, 48
User-defined threshold, 113
utilities, 295
Utility key, 37

V
V RMS, FFT vertical units, 84
values, choosing, 37
variable persistence, 133
ventilation requirements, 29
vernier, channel, 67
Vertical controls, 41
vertical expansion, 65
vertical position, 65
vertical position knobs, 41
vertical scale knobs, 41

439

Index

vertical sensitivity, 41, 65
Vertical Units, FFT, 84
VGA video output, 45
VID license, 340
video trigger, 163
video trigger, custom Generic, 168
viewing, tilt the instrument, 28
VISA connect string, 315
visualizations, math, 96
voltage measurements, 221

X at Min Y on FFT, 219
XY mode, 53, 54

Z
Z-axis blanking, 56
zoom and pan, 50
zoom display, measurement window
with, 239
Zoom key, 38

W
warranted specifications, 331
warranty, 310
Wave Gen key, 37, 42
waveform generator, 259
waveform generator defaults,
restoring, 274
waveform generator expected output
load, 267
waveform generator logic presets, 268
waveform generator sync pulse, 267
waveform generator sync pulse, TRIG OUT
signal, 305
waveform generator, arbitrary
waveforms, 263
waveform generator, waveform type, 259
Waveform keys, 40
waveform type, waveform generator, 259
waveform, cursor tracking, 207
waveform, intensity, 131
waveform, printing, 289
waveform, reference point, 301
waveform, saving/exporting, 275
WAVEGEN license, 341
web interface, 315
web interface, accessing, 316
white noise, adding to waveform generator
output, 269
Width - measurement, 231
Width + measurement, 231
Window, FFT, 84

X
X at Max Y measurement, 235
X at Max Y on FFT, 219
X at Min Y measurement, 234
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